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Call Accounting
Mitel® Call Accounting ensures businesses have a true picture of how and where their telecommunication
budgets are spent. It helps businesses track phone use, reconcile carrier bills, and bill back departments. Call
Accounting can also help businesses detect toll fraud. Using Call Accounting, businesses can better manage
telecommunication expenses and set up telecommunication systems for optimal performance. Informative
reports help businesses bill back departments and detect telecommunications misuse. The following optional
applications combine with Call Accounting to provide additional features.

Subscriber Services
Subscriber Services is an optional application that works with Call Accounting. Using detailed subscriber
reports, businesses can bill subscribers for the use of services provided. They canmark up or discount prices
based on fixed rates or percentage rates.

Traffic Analysis

Traffic Analysis is an optional application that works with Call Accounting. Traffic Analysis helps businesses
analyze trunk traffic so they canmake adjustments to optimize trunk use and decrease costs. Traffic
Analysis attendant console reports include performance and attendant console call traffic data.

Contact Center Management
Call Accounting enables managers to track, understand, and ultimately predict call patterns. When combined
with Contact Center Management, businesses enjoy both contact center and general business costing, and
advanced datamining and reporting for telecommunications management.

Contact Center Softphone
Contact Center PhoneSet Manager and Contact Center Softphone applications provide employees with the
ability to use their desktop computers as IP-based phones. Contact Center PhoneSet Manager and Contact
Center Softphone are designed for the 3300 ICP telephone system.

Contact Center Screen Pop
Contact Center Screen Pop is an optional application that requires Intelligent Queue with ANI / DNIS and/or
Collect Caller Entered Digits options, Contact Center Management, and Contact Center Softphone or
Contact Center PhoneSet Manager.

Contact Center Screen Pop launches applications orWeb pages. In addition, it enables extensions to
automatically receive caller and account information via pop-ups on their computer monitors every time they
receive calls. The Intelligent Queue with ANI / DNIS option provides extensions with the caller name, caller
phone number (ANI), called number (DNIS), and the queue used in the call. The Intelligent Queue Collect
Caller Entered Digits option displays the digits the customer entered. Contact Center Screen Pop displays the
information in the pop-up based on the Intelligent Queue options enabled.

CTI Developer Toolkit
CTI Developer Toolkit is a programmable .NET C#Dynamic-link library (DLL) that can be used in any .NET
(Release 2.0+) application or website. The CTI Developer Toolkit completes themigration fromMitel Agent
Portal to Mitel Contact Center Screen Pop.
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Salesforce.com Integration
Salesforce.com Integration is an optional application that enables Salesforce.com customer records to
display when calls are received. This integration enables employees to perform all call-related functions
through a single user interface. In addition, call details are automatically logged for reporting purposes.

What’s new in Version 6.0.2?
Technology changes
Contact Center Solutions and Call Accounting now support the following:

l Windows Server 2012
l Windows 8 Client
l Windows 8 Server (supported as a server for Contact Center Business Edition or Call Accounting only)
l MCD 6.0
l Salesforce.comWinter 2013

Licensing
You license Call Accounting based on the total number of physical extensions in your enterprise, on which
you will generate reports. Your license reflects themaximum number of extensions on which you can
generate reports.

To view details on your software licenses
l Click Help=>About your Mitel applications.

To view details on your installed professional services
l Click Help=>About your Mitel applications=>Professional Services.

About this user guide
TheMitel Call Accounting User Guide provides information on how to use Call Accounting to track and report
your telephone system costs.

To report an issue with this document, please email techpubs@prairiefyre.com.

Chapter 1 Call Accounting
Chapter 1 describes

l The features and benefits of Call Accounting
l Licensing
l The layout of the user guide
l Document conventions
l How to install client applications from the Call Accounting website

Chapter 2 Call Accounting Concepts
Chapter 2 describes how to

l Track phone use
l Reconcile carrier bills
l Bill back departments
l Detect toll fraud
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Chapter 3 Call Accounting Planning and Management
Chapter 3 helps you determine which configuration scenario best suits your company

l Extension based costing
l Account Code costing
l Contact center costing
l Contact center costing with “hot desking”

Chapter 4 Getting Started
Chapter 4 describes how to

l Register your software
l Set up Call Accounting on the Enterprise Server
l Set up Call Accounting on client computers
l UseClient Role Selector to select your Contact Center Client role
l Set up user preferences
l Set up the SMTP Mail Server for report distribution

Chapter 5 Services and Database Administration
Chapter 5 describes how to

l Start and stop the Contact Center Management services
l Perform database andmaintenance functions

Chapter 6 Configuration
Chapter 6 describes how to configure

l Enterprise settings, schedules, and security
l Call Accounting devices
l Subscriber Services devices

Chapter 7 Real-Time Monitors
Chapter 7 describes how to

l View real-time extension statistic.
l Customizemonitor display characteristics
l Chat online with other employees
l Alarm on call thresholds in real time

Chapter 8 Reports
Chapter 8 describes how to

l Generate on-demand reports
l Set up timetables for generating reports

Chapter 9 Data-Mining Tools
Chapter 9 describes how to

l Search for SMDR event records
l View the historical real-time events that occurred on a particular date, in the sequence they occurred

Chapter 10 Call Accounting Node
Chapter 10 describes how to

l Configure data collection nodes inmulti-site enterprises

About this user guide
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Chapter 11 Subscriber Services
Chapter 11 describes

l Subscribers
l Subscriber plans

Chapter 12 Traffic Analysis
Chapter 12 describes how to

l Set up the telephone system and YourSite database so you can collect data and generate reports on
the traffic data stream

Chapter 13 Contact Center PhoneSet Manager and Contact Center Softphone
Chapter 13 describes how to

l Enable employees to use their desktop computers as IP-based phones

Chapter 14 Contact Center Screen Pop
Chapter 14 describes how to

l Launch applications orWeb pages when employees receive calls
l Provide employees with caller and account information via pop-ups on their computer monitors when

they receive calls

Chapter 15 CTI Developer Toolkit
Chapter 15 describes

l Common uses of the CTI Developer Toolkit
l Examples of how to use the CTI Developer Toolkit to customize applications

Chapter 16 Salesforce.com Connector
Chapter 16 describes how to

l Integrate your Mitel phone directly into the Salesforce.com user interface

Locating the latest version of our guides
prairieFyre recommends you obtain the latest version of theCall Accounting User Guide.

l Start Internet Explorer and type
http://www.prairiefyre.com/wp-content/rscs/documentation/CallAccounting_UserGuide.pdf

Document conventions
This document uses the following conventions.

UI syntax
The following terms apply to actions you perform on the user interface:

l Click precedes items you select with themouse, such as buttons, menus, and items in list boxes.
l Press precedes items you select on the keyboard.
l Select or clear precedes items you turn on or turn off, such as check boxes.
l Select precedes items you select in combo boxes (text boxes with attached list boxes).
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For example,
 1. Click OK.
 2. Press ENTER.
 3. Select thePFdatabase check box.

Italics
Italic typeface is used

l For emphasis (for example, hot desking)
l To set off words, letters, and numbers referred to as themselves in the text (for example, overflow is the

routing of calls to more than one queue; the application saves text files as MMDDYYYY.sql)
l For characters or words you type in the UI (for example, type your Enterprise Server IP address

http://[your Enterprise Server address]/CCMWeb/

Bold
Bold typeface designates paths you select in your root directory and items you click, press, or select.

For example
 1. Click OK.
 2. Delete 50 and insert 60.
 3. Select theCheck database integrity check box.

UI Menu items
UI menu items you select are separated by an arrow [=>]. For example, File=>Open tells you to select the
Openmenu on the File menu.

Note
The wordNOTE: designates essential user information.
 1. Click Search.

Required and optional software components
Call Accounting Client Component Pack contains Contact Center Client software for client computers. You
require administrator privileges to run this installation. You use Contact Center Client to configure your
database (YourSite Explorer), monitor devices in real time (Extension State by Positionmonitor), and run
Management Console and Network Monitor.

Call Accounting applications have a number of required and optional applications you install on client
computers. You can download these applications from the prairieFyre FTP Server. For details, see
http://www.prairiefyre.com, log in to the Dealer Portal, and click Download Center.

Required and optional software components
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Required components
In order to use Contact Center Solutions and Call Accounting applications, the following components must be
installed on client computers.

l Microsoft .NET Framework enables your computer to run applications created with .NET. All client
computers must have the latest version of .NET Framework installed.

l Microsoft Internet Explorer updates your browser software to the latest version. All client computers
require IE 6.0 or greater.

l Microsoft Report Viewer 2005 Redistributable Package includes Windows Forms and ASP.NETWeb
server controls for viewing reports designed usingMicrosoft reporting technology.

l WebServices Enhancements (WSE) 3.0 for Microsoft .NET is theMicrosoft .NET Framework version
3.0 redistributable package that installs the common language runtime and associated files required to
run applications developed to target the .NET Framework.

l Microsoft DirectX significantly enhances graphics, sound, music, and 3-D animation inWindows
applications.

Optional components
You can install the following application on client computers.

l Adobe Reader enables you to view documents and reports in .pdf format. You require Acrobat Reader
to view the online user guide, user tutorial, reporting guide, and reports. If you haveMicrosoft Excel or
Microsoft Excel Viewer, you can also use it to view reports.

l Remote Server installs media servers (for voice, email, fax, or chat), and selected prairieFyre services
on a computer other than the Enterprise Server. For more information on the services included with
Remote Server installation, see theMitel Call Accounting Installation Guide.
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Call Accounting Concepts
Call Accounting ensures businesses have a true picture of how and where their telecommunication budgets
are spent. This chapter discusses how Call Accounting can be used to track phone use, reconcile carrier bills,
and bill back departments, and how it costs calls and detects toll fraud.

Tracking phone use
You can use Call Accounting to track phone use and to determine

 • The average duration of calls.
Generate the EmployeeGroup Accounting Summary report. This report provides the average
duration and cost of calls made by each employee of an employee group.

 • Wheremost of your long-distance budget is spent, and which employees make themost and longest
calls.
Generate the Employee Accounting by Phone number/Location report. If you have added these
phone numbers and names to your database (YourSite Explorer=>Phone numbers), they will also
appear in the report. This report also provides you with a list of the 100most often dialed phone
numbers by employee, and the 100 longest calls by employee.

 • If your telephone system is being abused, in real time
Monitor call costs and other call statistics by extension in real time. You can set alarms, for any or all
extensions, for all call statistics, including caller ID information (such as caller name and number).
You can also set alarms based on call cost thresholds and toll fraud parameters. Alarm notifications
alert you when event thresholds are reached. You can choose to be notified by visual changes in the
monitor, sound prompts, pop ups, email, or SMS. By setting alarms based on the thresholds you
define, you canmonitor telephone system abuse and stop it as it occurs.

Reconciling carrier bills
You can set up Call Accounting to detect billing errors. When you configure Call Accounting tomimic your
phone carrier charges, youmight notice discrepancies between your amounts and your carrier amounts.

Billing back departments
To bill back departments, your call costing informationmust be accurate. If your call costing information is
inaccurate, and you charge your subscribers less than you yourself are charged by the phone company, then
you are losingmoney. Of course, you do not have to assign the same rates to subscriber calls that the phone
company charges you for your calls. You canmodify the rate to include amarkup or intentionally provide a
discount.

Monitor telephone system use in real time
You can set alarms, for any or all extensions, for all call statistics, including caller ID information (such as
caller name and number). You can also set alarms based on call cost thresholds and toll fraud parameters.
Alarm notifications alert you when event thresholds are reached. You can choose to be notified by visual
changes in themonitor, sound prompts, pop ups, email, or SMS. By setting alarms based on the thresholds
you define, you canmonitor telephone system abuse and stop it as it occurs.
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Costing calls
How Call Accounting costs calls depends on whether calls are associated to a trunk group or media server,
and on the direction of the calls.

Trunk group or media server
NOTE: If you cost calls based on trunk groups, youmust add the IP trunk from eachmedia server to each
trunk group and ensure all media servers are associated to a carrier plan.

Call Accounting can cost a call only if there is a carrier plan assigned to either the call’s media server or trunk
group, and if Call Accounting is programmed and enabled. After Call Accounting determines the carrier plan
assigned to the call, it then determines the call direction, and then determines the call cost. (See Figure 2 - 1.)

In a clustered telephone system environment, inter switch trunks can be used to link calls between telephone
systems. Intra switch trunks can be used to ensure that calls follow the best bath when routing calls. For
example, if you had two telephone systems, one in Toronto and one in Ottawa, calls could be routed out of the
Toronto telephone system to ensure they were local calls as opposed to long distance calls. If you use intra
switch trunks, there are several important configuration requirements youmust make in YourSite Explorer or
calls will not be reported on correctly. For complete details on configuring trunk groups that use intra switch
trunks, see "Adding trunk groups" on page 100.

Outbound calls
Outbound calls are outgoing calls from your company. For outbound calls, the rate charged is determined by
the digit pattern. Digit patterns are defined on carrier plans. A digit pattern is one or more numbers used to
identify and cost a call, and can be part or all of a phone number.

If a phone number has a specific call rate, youmust enter the phone number (for example, 613-599-0045).
When groups of phone numbers have the same call rate, you enter just those digits they have in common. For
example, you enter 613-599-xxxx if the cost of the call is the same nomatter what the last four digits are.

Inbound calls
Inbound calls are incoming calls to your company. For inbound calls, the rate charged is determined by the
Dialed Number Identification Service (DNIS) call rate. DNIS is a feature of toll-free lines that identifies the
phone number a caller dials.

Internal calls
Internal calls are calls that do not interact with the public telephone system, only your own. For internal calls,
the rate charged is determined by the call rate assigned.
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Figure 2 - 1 Determining if an outbound call can be costed

Costing calls
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Detecting toll fraud
Toll fraud is themisuse of the telephone system. Using Call Accounting, you define what your company
considers to be toll fraud. Toll fraud can be specific digit patterns, internal calls, or calls that cost more than a
set rate.

Digit patterns
When adding outbound digit patterns to a carrier plan, you can define specific ones as toll fraud. Digit patterns
defined as toll fraud can consist of

l Toll charge numbers such as 1-900 calls.
l Calls to specific countries. For example, you dial 1-011-33 to call France.
l Calls to specific cities or areas. For example, you dial 1-714 to call Anaheim, California.
l Calls to individual companies or homes.

Internal calls
You can define all (or none) of the internal calls as toll fraud.

Calls costing more than a set rate
You can configure Call Accounting to report on all calls costingmore than a pre-defined rate. For example, if
you decide calls that cost more than $10 are toll fraud, all calls that cost $10.01 and greater are listed in toll
fraud reports. The Extension and Extension Group Accounting Toll Fraud reports show the toll fraud activity
by extension and extension group. The Enterprise Site Accounting Toll Fraud report shows toll fraud activity
by site.
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Call Accounting Planning and Management
This chapter describes commonCall Accounting and Subscriber Services configuration scenarios.

Determining your Call Accounting configuration needs
Each Call Accounting configuration scenario provides

l Examples of companies suited to the configuration scenario
l Instructions on configuring Call Accounting
l A list of pertinent reports

Extension based costing configuration scenario
Generally, companies configure Call Accounting so that each employee is associated with one or more
extension reporting numbers that are unique to the employee. The employee uses one phone extension only to
make calls. Calls are costed by employee ID and extension reporting number. See "Extension based costing
configuration scenario" on page 15.

Account Code (PIN) costing configuration scenario
You can configure Call Accounting so that each employee/subscriber is associated with one or more Account
Code reporting numbers (PINs) that are unique to that employee/subscriber. The employee/subscriber uses a
forced verified Account Code to access an outside line. Calls are costed by employee ID/subscriber ID, and
Account Code reporting number. See "Account Code (PIN) based costing configuration scenario" on page 16.

Contact center costing configuration scenario
You can configure Call Accounting in conjunction with Contact Center Management. If your contact center
does not “hot desk” then you configure Call Accounting so that each employee has an agent ID and extension
reporting number unique to that employee. Calls are costed by employee ID, agent ID, and extension reporting
number.

Contact center costing with “hot desking” configuration scenario
NOTE: If you use Contact Center Management in conjunction with Call Accounting and have hot desking
agents programmed in Contact Center Management, youmust program an extension with an identical
reporting number or real-time call costing will not work.

You can configure Call Accounting in conjunction with Contact Center Management. If your contact center
“hot desks” then you configure Call Accounting so that each employee has an agent ID and Account Code
reporting number that is unique to that employee. Calls are costed by employee ID, agent ID, and Account
Code reporting number.

An employee who hot desks is one who does not have a dedicated work area, but rather works at whatever
workstation is available. The “hot desking” employee uses an agent ID to log on to the phone extension at that
workstation. The extension cannot be reached while the “hot desking” employee is logged on. See "Contact
center costing with “hot desking” configuration scenario" on page 19.

Determining your Call Accounting configuration needs
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Extension based costing configuration scenario
In the extension based costing scenario, calls are costed by extension reporting numbers. Each employee
has one or more unique extension reporting numbers. Employees use only the phone extensions assigned to
them. You run employee and/or extension reports to track call costs. (See Figure 3 - 1.)

To verify employees are using assigned phone extensions, you can assign a unique forced verified Account
Code to each employee. See "Account Code (PIN) based costing configuration scenario" on page 16.

Figure 3 - 1 Extension based costing

The extension based costing scenario is themost common scenario. It suits companies that have a dedicated
work area for each employee.

If each employee has only one extension reporting number, the report data in the Employee Accounting by
Interval report data will be identical to that of the Extension Accounting by Interval report.

If you have a 3300 ICP, 5000, or Axxess, you can use Synchronization to synchronize the Call Accounting
database with your telephone system. See "Configuring the YourSite database using synchronization" on
page 77.

Reports to run
If each employee has one extension reporting number, the Employee Accounting by Interval report data will be
identical to the Extension Accounting by Interval report data.

The reports that most accurately reflect the phone costs incurred are as follows.

Subscriber and Subscriber Group Accounting by Interval
The Subscriber and Subscriber Group Accounting by Interval reports show the call activity and call cost by
subscriber and subscriber group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. All subscriber information is displayed regardless of which phone extension is used.

Employee and Employee Group Accounting by Interval
The Employee and EmployeeGroup Accounting by Interval reports show the call activity and call cost by
employee and employee group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. All employee information is displayed regardless of which phone extension is used. For example,
if Jeff has two extensions and you want to see what Jeff did as a whole, you run the Employee Accounting by
Interval report. If your subscriber has only one extension, you get the same information from the Extension
Accounting by Interval report.



- 16 -

Employee and Employee Group Accounting by Extension
The Employee and EmployeeGroup Accounting by Extension report shows the Call Accounting data
distributed across the extensions of a single employee/each employee in the group for the shift duration and
days you specify. It reports the call statistics in hours, minutes, and seconds, and provides call counts. For
example, if Jeff has two extensions and you want to run a report that shows what he is doing on each
extension, you run the Employee Accounting by Extension report.

Extension and Extension Group Accounting by Interval
The Extension and Extension Group Accounting by Interval reports show the call activity and call cost by
extension and extension group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. For example, if Jeff has two extensions and you want to run a report with information on just one
extension, you run the Extension Accounting by Interval report.

Account Code (PIN) based costing configuration scenario
Depending on whether you are using forced Account Codes or non forced Account Codes, you can attribute
an entire call, or segments of a call to particular Account Codes. You can configure forced Account Codes for
employees or subscribers.

NOTE: When you enter a traditional Account Code, the duration of the call or call segment is attributed to the
Account Code until another event (for example, entering another Account Code or transferring the call) occurs.
If a person on a call forgets to enter an Account Code until late in the call, the Account Code will only be
applied to the last segment of the call (after it is entered).

Account Codes can also be labeled with call classification codes. This option attributes the entire call duration
to calls of this Account Code type, enabling supervisors to report on the entire amount of time spent on these
calls.

NOTE:When you enter an Account Code labeled as a call classification code, the entire duration of the call is
attributed to this Account Code even if another event occurs (for example, if a traditional Account Code is
entered). If a person forgets to enter a call classified Account Code until late in the call, the Account Code is
still applied to the entire call duration.

The Account Code PIN is a forced verified Account Code. You run employee, subscriber, and/or Account
Code reports to track call costs. (See Figure 3 - 2.)

Figure 3 - 2 Account code (PIN) based costing

The Account Code (PIN) based costing scenario suits dormitories and retirement homes.

If you have a 3300 ICP, 5000, or Axxess, you can use Synchronization to synchronize the Call Accounting
database with your telephone system. See "Configuring the YourSite database using synchronization" on
page 77.

Determining your Call Accounting configuration needs
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Reports to run
The reports that most accurately reflect the phone costs incurred are as follows.

Subscriber and Subscriber Group Accounting by Interval
The Subscriber and Subscriber Group Accounting by Interval reports show the call activity and call cost by
subscriber and subscriber group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. All subscriber information is displayed regardless of which Account Code is used. For example, if
Jeff has two Account Codes and you want to see what Jeff did as a whole, you run the Subscriber Accounting
by Interval report.

Employee and Employee Group Accounting by Interval
The Employee and EmployeeGroup Accounting by Interval reports show the call activity and call cost by
employee and employee group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. All employee information is displayed regardless of which Account Code is used. For example, if
Jeff has two Account Codes and you want to see what Jeff did as a whole, you run the Employee Accounting
by Interval report.

Employee and Employee Group Accounting by Account Code
The Employee and EmployeeGroup Accounting by Account Code report shows the call accounting data
distributed across the Account Codes of a single employee/each employee in the group for the shift duration
and days you specify. It reports the call statistics in hours, minutes, and seconds, and provides call counts.
For example, if Jeff has two Account Codes and you want to run a report that shows information for each
Account Code, you run the Employee Accounting by Account Code report.

Account Code Accounting by Interval
The Account Code Accounting by Interval report shows the call activity and call performance by Account
Code for the interval (15-, 30-, 60-minute, day of week, day of month, or monthly) you specify. It provides call
counts, and report statistics in hours, minutes, and seconds. For example, if Jeff has two Account Codes and
you want to run a report with information on only one Account Code, you run the Account Code Accounting by
Interval report.

Contact center costing configuration scenario
The contact center costing scenario applies to companies that have contact centers and use Call Accounting
in conjunction with Contact Center Management. Each employee has only one extension. You cost all calls
by agent ID, employee ID, and/or extension reporting number. You run agent, employee, and/or extension
reports to track call costs. (See Figure 3 - 3.)

If you are unsure whether each employee is using the assigned phone extension, you can assign a unique
forced verified Account Code reporting number to each employee. See "Account Code (PIN) based costing
configuration scenario" on page 16.
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Figure 3 - 3 Contact center costing

If you have a 3300, 5000, or Axxess, you can use Synchronization to synchronize the Call Accounting
database with your telephone system. See "Configuring the YourSite database using synchronization" on
page 77.

Reports to run
The Agent Accounting by Interval report data is similar to that of the Employee Accounting by Interval report
data. The Employee Accounting by Interval report also includes phone costs incurred while an employee is
not logged on to the ACD. If the employee has one extension reporting number, the Employee Accounting by
Interval report data will be identical to that of the Extension Accounting by Interval report data.

Agent and Agent Group Accounting by Interval
The reports that most accurately reflect the phone costs incurred are the Agent and Agent Group Accounting
by Interval reports. These reports show the call activity and call cost by agent and agent group for the intervals
(15-, 30-, 60-minute, day of week, day of month, or monthly) you specify. All agent information is displayed
regardless of which extension is used.

Employee and Employee Group Accounting by Interval
The Employee and EmployeeGroup Accounting by Interval reports show the call activity and call cost by
employee and employee group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. All employee information is displayed regardless of which phone extension is used. For example,
if Jeff has two extensions and you want to see what Jeff did as a whole, both while logged on and not logged
on to the ACD, you run the Employee Accounting by Interval report.

Employee and Employee Group Accounting by Extension
The Employee and EmployeeGroup Accounting by Extension reports show the call accounting data
distributed across the extensions of a single employee/each employee in the group for the shift duration and
days you specify. It reports the call statistics in hours, minutes, and seconds, and provides call counts. For
example, if Jeff has two extensions and you want to run a report that shows what he is doing on each
extension, both while logged on and not logged on to the ACD, you run the Employee Accounting by
Extension report.

Extension and Extension Group Accounting by Interval
The Extension and Extension Group Accounting by Interval reports show the call activity and call cost by
extension and extension group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. For example, if Jeff has two extensions and you want to run a report with information on just one
extension, you run the Extension Accounting by Interval report.

Determining your Call Accounting configuration needs
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Contact center costing with “hot desking” configuration scenario
NOTE: If you use Contact Center Management in conjunction with Call Accounting and have hot desking
agents programmed in Contact Center Management, youmust program an extension with an identical
reporting number or real-time call costing will not work.

The contact center costing with “hot desking” scenario applies to companies that have contact centers with
flexible andmobile employees/subscribers, and that use Call Accounting in conjunction with Contact Center
Management. Employees can access more than one phone extension. Employees/subscribers enter forced
verified Account Codes to access outside lines for outbound calls.

To track outbound calls, each employee is given one or more unique Account Code Personal Identification
Numbers (PINs) for accessing an outside line. The Account Code PIN is a forced verified Account Code.
Each employeemust enter an Account Code tomake an outgoing call. The cost is associated with the
employee regardless of which phone extension is used. (See Figure 3 - 4.)

Figure 3 - 4 Contact center costing with “hot desking”

If you have a 3300 ICP, you can use Synchronization to synchronize the Call Accounting database with your
telephone system. See "Configuring the YourSite database using synchronization" on page 77.
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Reports to run
The reports that most accurately reflect the phone costs incurred are as follows.

Employee and Employee Group Accounting by Interval
The Employee and EmployeeGroup Accounting by Interval reports show call activity and call cost by
employee and employee group for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly)
you specify. All employee information is displayed regardless of which Account Code is used. For example, if
Jeff has two Account Codes and you want to see what Jeff did as a whole, both while logged on and not
logged on to the ACD, you run the Employee Accounting by Interval report.

Employee and Employee Group Accounting by Account Code
The Employee and EmployeeGroup Accounting by Account Code report shows the Call Accounting data
distributed across the Account Codes of a single employee/each employee in the group for the shift duration
and days you specify. It reports the call statistics in hours, minutes, and seconds, and provides call counts.
For example, if Jeff has two Account Codes and you want to run a report that shows information for each
Account Code, you run the Employee Accounting by Account Code report.

Account Code and Account Code Group Accounting by Interval
The Account Code Accounting by Interval report shows the call activity and call performance by Account
Code for the intervals (15-, 30-, 60-minute, day of week, day of month, or monthly) you specify. It provides call
counts, and report statistics in hours, minutes, and seconds. For example, if Jeff has two Account Codes and
you want to run a report with information on only one Account Code, you run the Account Code Accounting by
Interval report.

Determining your Subscriber Services configuration
needs
Subscribers are clients or customers outside your organization to whom you provide a communication product
or service. Each Subscriber Services configuration scenario provides

l Examples of companies suited to the configuration scenario
l Instructions on configuring Subscriber Services
l A list of pertinent reports

Bill back departments
You can use Subscriber Services to bill back departments for their phone use and equipment rental each
month. See "Billing back departments scenario" on page 21.

Bill back college students by dorm room
You can use Subscriber Services to bill back students for phone use wherever it might occur across campus,
and equipment rental eachmonth. See "Billing back college students by dorm room scenario" on page 22.

Bill back clients on a case-by-case basis
You can use Subscriber Services to bill customers for phone use on a case-by-case basis and show the
customer the call details for each case. See "Billing back clients on a case-by-case basis scenario" on page
23.

Determining your Subscriber Services configuration needs
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Billing back departments scenario
In the billing back departments scenario, you cost calls by associating a particular subscriber plan with a
billing option and subscribers/employees. The billing option enables you to add amonthly equipment rental
charge. You associate each subscriber/employee with an extension. The subscribers/employees and the
associated extensions enable you to track whomade each call. You group subscribers/employees by
department to enable you to track total call use and cost by department. You group employee groups by
enterprise to enable you to track total call use and cost by enterprise.

The billing back departments scenario is suited to cities, university faculties, corporations, retirement/nursing
facilities, and tenants (rooming houses).

You configure subscriber plans using YourSite Explorer. You associate subscribers/employees with a
subscriber plan. You group them by department so that a subscriber group or employee group includes all call
activity and costs for the department. You can also group all employee groups (departments) together to form
a division. Call activity and cost for the entire enterprise is displayed in the division report.

Reports to run
You can generate reports that show call cost and call activity by subscriber, employee, subscriber group,
employee group, or division by employee group. You generate subscriber reports if you associate subscribers
to the subscriber plan. You generate employee reports if you associate employees to the subscriber plan.

Employee and Employee Group Billing Trace
(Previously, the Employee Billing Trace was the Subscriber Employee Inbound/Outbound Accounting Trace
Report and the EmployeeGroup Billing Trace report was the Subscriber Accounting Top 100 Called
Destinations for Employee by Cost/Count/Duration report.) This report shows subscriber calls sent to and
received by the extension. It lists the call type and cost.

Employee and Employee Group Billing Summary
(Previously, the Employee and EmployeeGroup Billing Summary report was the Subscriber Employee Billing
and Accounting Summary (All Calls) report or the Subscriber Employee Billing and Accounting Summary
(Costed Calls Only) report (with the call cost filter set to >0).) This report provides a list of the employee calls,
when the calls weremade, and the associated cost, if any, of each call.

Employee Billing Usage and Service Charges
(Previously, the Employee Billing Usage and Service Charges report was the Subscriber Employee Billing
Usage and Service Charge Summary report.) This report provides the duration and cost of each call the
employeemade and lists any optional billing charges that have been applied to the subscriber plan. The report
shows a subtotal of the phone use costs, a subtotal of the billing options, and a total of the two.

Subscriber and Subscriber Group Accounting Summary
These reports provides a list of subscriber/subscriber group calls, when the calls weremade, and the
associated cost, if any, of each call.

Subscriber and Subscriber Group Billing Trace
This report shows subscriber calls sent to and received by the extension. It lists the call type and cost.
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Subscriber Billing Usage and Service Charges
This report provides the duration and cost of each call the subscriber made and lists any optional billing
charges that have been applied to the subscriber plan. The report shows a subtotal of the phone use costs, a
subtotal of the billing options, and a total of the two.

Division Billing by Employee Group Summary
(Previously, the Division Billing by EmployeeGroup Summary report was the Subscriber Division Accounting
by EmployeeGroup report.) This report provides the subscriber’s call counts and call costs for each employee
within the employee groups that make up each division.

Billing back college students by dorm room scenario
In the billing back college students by dorm room scenario, you cost calls by associating a particular
subscriber plan with a billing option and subscribers/employees. The billing option enables you to add a
monthly equipment rental charge. You associate each subscriber/employee with an Account Code. The
Account Code enables you to accurately attribute calls to callers, wherever they occur across campus.

The Billing back college students by dorm room scenario is suited to amobile workforce, and calls made by
clients, and at universities/colleges.

You configure subscriber plans using YourSite Explorer. You associate subscribers/employees with the
subscriber plan.You associate each student (subscriber/employee) with a unique Account Code Personal
Identification Numbers (PINs) for accessing an outside line. The Account Code PIN is configured as a forced
verified Account Code on the telephone system.

Reports to run
You can generate reports that show call cost and call activity by subscriber, employee, subscriber group, or
employee group. You generate subscriber reports if you associate subscribers to the subscriber plan. You
generate employee reports if you associate employees to the subscriber plan.

Employee and Employee Group Billing Trace
(Previously, the Employee Billing Trace was the Subscriber Employee Inbound/Outbound Accounting Trace
Report and the EmployeeGroup Billing Trace report was the Subscriber Accounting Top 100 Called
Destinations for Employee by Cost/Count/Duration report.) This report shows employee calls sent to and
received by the extension. It lists the call type and cost.

Employee and Employee Group Billing Summary
(Previously, the Employee and EmployeeGroup Billing Summary report was the Subscriber Employee Billing
and Accounting Summary (All Calls) report or the Subscriber Employee Billing and Accounting Summary
(Costed Calls Only) report (with the call cost filter set to >0).) This report provides a list of the employee calls,
when the calls weremade, and the associated cost, if any, of each call.

Employee Billing Usage and Service Charges
(Previously, the Employee Billing Usage and Service Charges report was the Subscriber Employee Billing
Usage and Service Charge Summary report.) This report provides the duration and cost of each call the
employeemade and lists any optional billing charges that have been applied to the subscriber plan. The report
shows a subtotal of the phone use costs, a subtotal of the billing options, and a total of the two.

Determining your Subscriber Services configuration needs
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Subscriber and Subscriber Group Billing Trace
This report shows subscriber calls sent to and received by the extension. It lists the call type and cost.

Subscriber Billing Usage and Service Charges
This report provides the duration and cost of each call the subscriber made and lists any optional billing
charges that have been applied to the subscriber plan. The report shows a subtotal of the phone use costs, a
subtotal of the billing options, and a total of the two.

Billing back clients on a case-by-case basis scenario
When billing back clients (subscribers) on a case-by-case basis, you associate each subscriber with an
Account Code. A new Account Code is applied to each bill. Because a client’s call could be answered by one
of several extensions in your company, you associate an Account Code with each call rather than an
extension.

The billing back departments scenario suits law offices.

You configure subscriber plans using YourSite Explorer. You associate subscribers with a particular plan. You
associate each subscriber with an Account Code for each case. For your own financial records, youmight
want to generate Subscriber Billing by Account Code reports to determine the cost per subscriber.

Reports to run
You can generate reports that show call cost and call activity by Account Code.

Subscriber and Subscriber Group Billing by Account Code
This report provides all Account Codes used by the subscriber, call types, and the call cost. This report is
useful when a subscriber has been assignedmore than one Account Code.

Subscriber and Subscriber Group Billing Summary
This report provides one row for each call type and shows the number of incoming and outgoing call count per
call type.

Subscriber Billing Usage and Service Charges
This report provides the duration and cost of each call the subscriber made and lists any optional billing
charges that have been applied to the subscriber plan. The report shows a subtotal of the phone use costs, a
subtotal of the billing options, and a total of the two.

Subscriber and Subscriber Group Billing Trace
These reports provide a list of all of the subscriber/subscriber group calls that incurred a cost, when the calls
weremade, and the associated cost of each call.
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Getting Started
After you install Call Accounting on the Enterprise Server, youmust set up the Enterprise Server and client
computers to use Call Accounting. This section provides basic information on post-installation procedures.
For detailed information on installation and post-installation procedures, see theCall Accounting Installation
Guide.

Registering Call Accounting
NOTE:

l If you have not registered your Call Accounting software, seven days after you install it you will no
longer be able to log on to Call Accounting and will be required to contact prairieFyre to register the
software. After you register your software, prairieFyre emails permanent license files to you. You
implement these license files on the Enterprise Server to activate your software.

l Registration information is processed during regular business hours only (Monday to Friday from 8:00
A.M. to 8:00 P.M. ET).

When you initially register your software with prairieFyre, for one year you receive
l The latest Call Accounting software updates.
l A quarterly newsletter.
l Free technical support.

To register with prairieFyre
l Call prairieFyre at (613)-599-0045 (North American customers) or your approvedMitel vendor (for

customers residing in Latin America, Europe, theMiddle East, Africa, and Asia Pacific).. The turn
around is immediate. (Recommended)

l Visit the www.prairiefyre.com website, fill out a registration form, and submit the form. The turn around
time is four hours.

l In Call Accounting, click Help=>Register Now, fill out a registration form, and submit, email, or courier
the form to prairieFyre.

Activating Call Accounting
If you did not activate Call Accounting during installation, you can activate it now. If you have access to the
Internet, you can rerun the InstallationWizard at any time to register Call Accounting online. If you do not have
access to the Internet or if you cannot access our license server, you can register offline.

To activate the Call Accounting software online
 1. On the Enterprise Server, navigate to theMitel program folder and openMitel Contact Center

Management Licensing.
 2. Click Register Online.

TheOnline Registration window opens.
 3. Type your 26-digit site serial number and click Register.

Registering Call Accounting
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To activate the Call Accounting software offline
 1. On the Enterprise Server, navigate to theMitel program folder and openMitel Contact Center

Management Licensing.
 2. Click Register Offline.

TheOffline Registration window opens.
 3. Click the here link in the first step to open the directory that contains the license package.
 4. Email the license package to support@prairiefyre.com.

prairieFyre will sign the license files and send them back to you.
 5. After you receive the signed license files, save them to a directory.

NOTE:We recommend you place the license files in the original directory.
 6. Repeat steps 1-2 to open theOffline registration window.
 7. Type your 26-digit site serial number.
 8. Click Browse and specify the directory that contains your .dlsc license file.
 9. Click Apply License.

The license registration is complete.

Updating license files on the Enterprise Server
Youmust update the license files on your Enterprise Server with the new license files prairieFyre sends you.

To implement new license files
 1. On the Enterprise Server, start Windows Explorer.
 2. Save the new license files in the following directory, <drive>:\program files\prairiefyre

software\CCM.
 3. Click Yes to overwrite the existing files.

Setting up Call Accounting on the Enterprise Server
After you install the server software, that server becomes the Enterprise Server. You need to set up the server
and client computers to use Call Accounting. To view detailed installation procedures, click
Help=>Documentation and click theCall Accounting Installation Guide to open it.

Setting up Call Accounting on client computers
NOTE:

l The date format for Call Accounting is tied to server settings. For example, if you configure the server to
display the date as mm/dd/yyyy, when you browse to the Call Accounting web UI, the Call Accounting
applications and any reports you generate display the date as mm/dd/yyyy.

l The system administrator must provide all Call Accounting users with a user name and password.

To set up a client computer to use Call Accounting
 1. Install Client Component Pack.
 2. Use Client Role Selector to select your Contact Center Client role.



- 27 -

Installing the latest version of Client Component Pack
Microsoft .NET Framework 4.0must be installed on your system before you install Client Component Pack. If
you attempt to install Client Component Pack, and .NET Framework is not installed, Client Component Pack
will prompt you to install a list of required components, including .NET Framework.

You can install Client Component Pack on individual client computers or servers running Citrix Terminal
Services.

NOTE: If the client is on an external network, you can either:
l VPN to the internal network and install the Contact Center Client, or
l Copy the Contact Center Client from the server to the client using a CD or USB key
l Use an administrative procedure to silently install Client Component Pack on remote desktops

See "Installing Client Component Pack using an administrative procedure" on page 27.

To install Client Component Pack on the client computer
 1. On the client computer, start Internet Explorer and type http://[your Enterprise Server IP

address]/CCMWeb.
 2. If prompted, type your user name and password and click Submit.
 3. Click Help=>Software downloads/Installations.
 4. Click Client Component Pack.

The File Download - Security Warning window opens.
 5. Click Run.
 6. Close the Software downloads window.

The Internet Explorer - Security Warning window opens.
 7. Click Run.

TheMitel Contact Center Solutions Client Component Pack Se... window opens.
 8. To install Updater Service Clean Up, click Install.

TheMitel Contact Center Solutions Client Component Pack - InstallShieldWizard opens.
 9. Click Next.
 10. AfterEnterprise IP Address, type the IP address of the Enterprise Server.
 11. If your Enterprise uses SSL, select theSSL check box.
 12. Click Install.

The program features you selected are installed.
 13. Click Finish.

The Select role window opens.

Installing Client Component Pack using an administrative
procedure
You can install the Client Component Pack silently on remote desktops using anMSI (Microsoft Installer)
administrative installation procedure. A silently installed program is a program that can be installed with no
user interaction.

To install client software silently on remote desktops
 1. Install the prerequisite software.
 2. Locate the client_setup_x86_x64.exe and extract Client Component Pack.msi.
 3. Perform the .msi procedure for the administrative installation.
 4. Run the silent installations.

Setting up Call Accounting on client computers
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Installing the prerequisite software
Before you install client software, youmust install the prerequisite software.

To install the prerequisite software
 1. Go to the src folder located in your Contact Center Solutions Installation folder.

NOTE: The default location of this folder is C:\CCM\src.
 2. Open theWindows Installer 3_1 folder.
 3. InstallWindows Installer 3.1.
 4. Go back to the src folder.
 5. Open the vcredist_x86 folder.
 6. Install vcredist_x86.
 7. Log onto your Enterprise Server.
 8. Click Help.
 9. Click on the Software downloads/Installations tab.
 10. Click Software Downloads.
 11. Install the following components:

l Microsoft .NET Framework 4.0.
l WebServices Enhancements (WSE) 3.0 for Microsoft .NET.
l Microsoft Report View Redistributable 2005.

Locating the client_setup_x86_x63.exe and extracting Client Component
Pack.msi
To locate the client_setup_x86_x64.exe and extract Client Component Pack.msi
 1. Go to the src folder located in your Contact Center Solutions Installation folder.

NOTE: The default location of this folder is C:\CCM\src.
 2. Open client_setup_x86_x64.exe.
 3. Open the folder that was modified the same day you extracted client_setup.exe. The folder naming

format will be xxx_xxxx.
Client Component Pack.msi will be in that folder.

Performing the MSI procedure for the administrative installation
NOTE: For a list of programs that must be installed on each computer before you install Client Component
Pack, see "Installing the prerequisite software" on page 28.

Youmust create a command for the administrative installation that is similar to the following example:
msiexec /a”\\Mitel Installations\Setup\Client Component Pack.msi” SSLSTATUS=0
ENTERPRISEIPADDRESS=10.1.4.12

To perform theMSI procedure for the silent installation
 1. Open the command prompt window.
 2. Open the folder where themsi file is located.
 3. TypeMsiExec.exe /a.
 4. Press the spacebar.
 5. Drag themsi file from the folder where it is located to the command prompt window.
 6. Press the spacebar.
 7. TypeSSLSTATUS=.
 8. If the Enterprise Server uses a secure socket layer, type 1. If it does not, type 0.
 9. Press the spacebar.
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 10. TypeENTERPRISEIPADDRESS=.
 11. Type the Enterprise Server IP address or DNS name.
 12. Press Enter.

The InstallShieldWizard opens.
 13. Follow the instructions of theWizard.
 14. Ensure the file is saved to a network drive.

Running the silent installation
NOTE:Subsequent updates are done via the prairieFyre Updater Service.

To silently install Client Component Pack
 1. InWindows, open theRun command.
 2. Type “\\<path to administrative installation package>\Client Component Pack.msi” /qb

Contact Center Client and the prairieFyre Updater Service are installed.

Using Client Role Selector
The Call Accounting client installation includes Client Role Selector. It is a wizard that helps you select a role
that pertains to the Contact Center Client applications the employee requires. For Call Accounting, youmust
have access to the real-time Extension by Positionmonitor, management functions, Network Monitor, and
YourSite Explorer. In order to access Management Console and Network Monitor, youmust select
Administrator or Power user as your role.

l TheAdministrator role is for employees whomanage the Enterprise Server.
l ThePower user role is for employees perform the functions of a supervisor, employee, and/or

administrator. To customize the client role, select Power user then select the components and
applications the user needs.

You can re-run Client Role Selector on a client computer at any time to change the components and
applications installed on the computer.

NOTE:
l If you want to customize the client installation, select Power User. For example, if a supervisor also

performs administrative functions, select the Power User role and choose the components and
applications the supervisor will need.

l For Version 6.0.1 of Contact Center Solutions support for the 5000 and Axxess telephone systems,
client applications are limited to Real-timemonitors, Management Console, Network Monitor,
Multimedia Contact Center, and YourSite Explorer. All other client applications will bemade available in
a future release of Contact Center Solutions.

Table 4 - 1 lists the components and applications available for the client role installations. The list includes
only the applications for which you are licensed.

Using Client Role Selector
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Components/applications Supervisor Administrator Power User

Real-timemonitors x x

Flexible Reporting*1 x x

Contact Center Softphone*1/2 x x

Mitel Border Gateway Connector*1/2 x x x

Management Console x x

Network Monitor x x

Salesforce.com Connector*1/2 x x x

Workforce Scheduling*1 x x x

Schedule Adherence*1 x x x

Employee Portal*1 x x x

Multimedia Contact Center*1 (requires
Outlook) x

YourSite Explorer x x

Table 4 - 1 Client role installation

*1Flexible Reporting, Contact Center Softphone, Mitel Border Gateway Connector, Salesforce.com
Connector, Workforce Scheduling, Employee Portal, andMultimedia Contact Center are optional applications
to Contact Center Management that you purchase separately.
*2Contact Center Softphone, Mitel Border Gateway Connector, and Salesforce.com Connector are not
currently supported with theMitel 5000 and Axxess telephone systems.

Running client role selector
To run Client Role Selector:
 1. If you are installing software on the client computer for the first time, go to step 2. Otherwise, click

Start=>Programs=>Mitel=>Client Role Selector.
 2. Click a client role.
 3. Click Next.
 4. Select the check boxes of the features to be installed.

l Real-timemonitors
l Contact Center Softphone
l Mitel Border Gateway Connector
l Management Console
l Network Monitor
l YourSite Explorer
l Salesforce Integration
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 5. Click Finish.
After the wizard installs the features you selected, the Contact Center Client log on window opens.

 6. Close the Contact Center Client log on window.

Setting up user preferences
You can change your user preferences at any time on the Call Accounting website, under My options. You can

l Specify your language preference.
l Specify the number of records displayed on a page.
l Change your password.
l View your security role properties.
l Configure email contacts.

Specifying your language preference
To specify your language preference
 1. On the Call Accounting website, underMy options tab, click My preferences.
 2. AfterDisplay this language, select a language.
 3. Click Save.

Specifying the number of records displayed on a page
Call Accounting enables you to configure the number of items that will display in the YourSite=>Configuration.

To specify the number of records that display on a page
 1. On the Call Accounting website, underMy options tab, click My preferences.
 2. AfterDisplay this number of records, select a number.
 3. Click Save.

Changing your password
To change the password for your login
 1. On the Call Accounting website, underMy options tab, click My password.
 2. AfterOld password, type your old password.
 3. AfterNew password, type your new password.
 4. AfterConfirm new password, type your new password.
 5. Click Save.

Viewing security role properties
You can view your security role to see which applications and devices you can access. Only employees who
can access YourSite=>Configuration can change the security role properties of employees. See "Security
roles" on page 124.

To view the security role associated with your login ID
l Click My options=>My security role.

Setting up user preferences
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Configuring email contacts
You can create a list of email contacts and contact groups to whom you email reports.

NOTE: Youmust configure SMTP settings in YourSite Explorer before you can configure email contacts. See
"Configuring the SMTP server" on page 33.

To create a contact group
 1. Add email contacts
 2. Add contact groups
 3. Add email contacts to the groups

Adding email contacts
You add email contacts on the Call Accounting website.
 1. Click My options=>My contacts=>My email contacts.
 2. Specify the contact information.
 3. Click Save.

Adding contact groups
You add email contacts on the Call Accounting website.
 1. Click My options=>My contacts=>My email contacts.
 2. Specify the contact information.
 3. Click Save.

Adding email contacts to contact groups
To add an email contact to a contact group
 1. On theMy contacts tab, click My email contact groups.
 2. Click Members for the contact group with which you want to associate.
 3. UnderAvailable contacts, select the check boxes of themembers to be added to the group and click

Add >>.

Setting up reports distribution
Before you can generate reports, youmust
 1. Configure SMTP mail server settings.
 2. Configure user printer settings
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Configuring the SMTP server
The SMTP mail server settings for Reporting Service are typically configured during the installation process.
However, if the server information is not entered during installation or the information is incorrect, the settings
can be configured in YourSite Explorer, as follows.

To configure an SMTP mail server
 1. In YourSite Explorer, click SMTP Servers.
 2. Click Add.
 3. UnderSMTP Server, type the IP address or name of themail server (for example, PFEXCHANGE).
 4. UnderSMTP Port, type the port number of the SMTP mail server.

NOTE: The default value of this port is 25.
 5. If theMail server uses Secure Sockets Layer, select theUse SSL check box.
 6. Under Logon Information, select the Is SMTP Authentication Required check box if the email

server requires authentication and type theUsername, Password, andDomain.
 7. UnderUser Information, type the name and email address from which all Contact Center Management

reports will bemailed.
NOTE: The email address field is mandatory as some email servers will not relay mail messages
without a valid sender.

 8. To send a test email, click the Test Email button.
 9. Click Save.

Providing Mitel Border Gateway functionality to remote
employees
In Version 6.0, theMitel Border Gateway Connector replaces what was formerly called Teleworker support for
Contact Center Solutions and Call Accounting software. UsingMitel Border Gateway Version 7 or greater,
remote employees can connect to the Enterprise Server using a VPN-like connection, and use all Contact
 Center Solutions and Call Accounting applications as if they were in the office. Customers who useMitel
Border Gateway Version 6 can still benefit from remote agent support, however, only Contact Center Client
real time, soft phone, and Contact Center Management / Call Accounting website functionality is supported.

With theMitel Border Gateway Connector, customers can now optionally configure connections tomultiple
instances of theMitel Border Gateway. When employees connect to the system using theMitel Border
Gateway Connector, they can specify whichMitel Border Gateway they will connect to. After remote
employees attempt to connect to the system for the first time, aMitel Border Gateway system administrator
must approve theMitel Border Gateway certificate from theMitel Border Gateway web application. Once
approved, remote users are connected and have access to all of the Contact Center Solutions and Call
Accounting applications for which they are licensed and have the required security permissions. While active,
theMitel Border Gateway Connector is visible in theWindows system tray and displays the name of the
active connection. Only one connection can bemade at a time. The name of theMitel Border Gateway
connection will become the address in all application login windows and users sign in with their normal
username and password.

TheMitel Border Gateway Connector offers the same trusted characteristics as with a standardMitel Border
Gateway deployment: local streaming, secure RTP, jitter buffering and packet handling QoS, andG.729 and
G.711 encoding. For more information on how to configure Contact Center and Call Accounting software to
support Mitel Border Gateway, see theCall Accounting Installation Guide.

Configuring the SMTP server
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NOTE:
l TheMitel Border Gateway Connector supports Mitel Border Gateway V6 and V7 or greater.
l The following corporate firewall ports must be open in order to take advantage of the full features and

functionality provided by theMitel Border Gateway Connector: 80, 443, 1433, 5024, 5025, 5026, 5030,
7001, 7003, 8083, 8084, 36000-36004, 35001-35007, and 42440.

l Youmust disable IIS and SQL Server Reporting Service services as they consume port 80, which is
required for theMitel Border Gateway Connector. Any other applications or services that consume port
80 should also be disabled or shut down.

l You cannot use theWindows Authentication sign-in model for Contact Center Solutions and Call
 Accounting

l Ensure the Start button is enabled at all times on theMitel Border Gateway web application user
interface or theMitel Border Gateway Connector will fail.

l Youmust be logged in as an administrator on a client computer in order to configure a connection to a
Mitel Border Gateway. Once the connection has beenmade, any user on the computer can connect
using theMitel Border Gateway Connector.

Setting up phones for remote agents and employees
If you are working at the office and select Remembermy credentials when you log on to Contact Center
Client, and then subsequently attempt to log on at home, your log on will fail. Contact Center Client does not
recognize your office IP address when you log on remotely.

NOTE:Before you set up the soft phone on your client computer, ensure your network administrator has
configured your soft phone as a 5020 IP phone on the telephone system.

To set up Contact Center Softphone and Contact Center PhoneSet Manager to support theMitel Border
Gateway Connector, youmust
 1. Register your phones for use with Mitel Border Gateway V6 or V7.
 2. Approve theMitel Border Gateway V6 or V7 certificate.
 3. Log in to client computers using an administrative account and set up the connection to theMitel Border

Gateway from theMitel Border Gateway Connector.

Registering phones for use with Mitel Border Gateway
The system administrator must register your phone before you can use theMitel Border Gateway Connector.
Contact Center PhoneSet Manager treats new extensions like new phones; each time you enter a new
extension youmust use the dial pad to type the password (provided by your system administrator) to register
the phone.

To register your phone with Mitel Border Gateway
 1. Ensure you have completed the steps listed under "ConfiguringMitel Border Gateway on theMitel

Application Server" in theCall Accounting Installation Guide and that you have added an ICP to the
Mitel Border Gateway.

 2. Click Services=>MiNet Devices.
 3. Click Add a MiNet device.
 4. For Contact Center Softphone phones, afterDevice ID, type a1:21:00:00:xx:xx, where xx:xx is the

extension.
 5. For Contact Center PhoneSet Manager phones, afterDevice ID, type theMAC address located under

the agent’s Mitel phone.
 6. If required, specify other optional settings.
 7. Click Save.
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Running the Mitel Border Gateway Connector
In order to use Contact Center Solutions and Call Accounting applications with Mitel Border Gateway, you
must run theMitel Border Gateway Connector and configure the connection to theMitel Border Gateway.

NOTE:A user with administrative credentials must be logged in to client computers when configuring
connections to theMitel Border Gateway for the first time. After this is complete, any user can sign in to the
computer, run theMitel Border Gateway Connector, and connect to aMitel Border Gateway.

To install and configure theMitel Border Gateway Connector
 1. If this is not the first time you have run theMitel Border Gateway Connector, skip to step 9. Otherwise,

consult your network administrator to confirm your soft phone extension number.
 2. Ensure your headphone is connected.
 3. Run Client Component Pack.

See theCall Accounting Installation Guide.
 4. If you are installing software on the client computer for the first time, go to step 5. Otherwise, open the

Client Role Selector.
 5. Click a client role.

l Supervisor—The Supervisor role is for supervisors andmanagers whomonitor devices, such as
agents and queues, and schedule agents.

l Agent—The Agent role is for agents whomonitor themselves and/or other agents and queues.
l Power user—The Power user role is for employees whomay perform the functions of a

supervisor, agent, and administrator.
 6. Click Next.
 7. SelectMitel Border Gateway Connector and all other options you need, such as Contact Center

Softphone.
 8. Click Finish.
 9. InWindows, open theMitel Border Gateway Connector.

Ensure you are logged in to the computer with administrative credentials.
 10. Click New.
 11. AfterName, type a name for the connection to theMitel Border Gateway.
 12. After IP address, type the IP address of theMitel Border Gateway.
 13. AfterMAC address

l If you have a desk phone, type theMAC address located on the sticker under your desk phone.
l If you have a soft phone, click Extension, type your soft phone extension number, and click OK.

 14. If you are connecting to a pre-Version 7Mitel Border Gateway, enable the checkbox afterConnect to
legacy MBG (pre v7).

 15. Click OK.
The connection to theMitel Border Gateway you just created will display in theMitel Border Gateway
Connector list.

ProvidingMitel Border Gateway functionality to remote employees
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To run the Mitel Border Gateway Connector
 1. Start theMitel Border Gateway Connector.
 2. Select a connection to aMitel Border Gateway from the list.
 3. Optionally, enable theConnect automatically checkbox.

Enabling this checkbox will automatically connect you to the configuredMitel Border Gateway when
you launch theMitel Border Gateway Connector.

 4. Click Connect.
A message displays stating "Waiting for certificate approval." If the request is rejected, contact your
system administrator to approve the certificate.
Once your certificate has been approved, you can begin using all Contact Center Solutions and Call
Accounting applications remotely as if you were in the office. Any user configured with administrative
credentials on the computer can change theMitel Border Gateway connection settings and delete
connections from theMitel Border Gateway Connector at any time.

Approving the Mitel Border Gateway certificate
TheMitel Border Gateway system administrator must approve theMitel Border Gateway V6 or 7 certificate
before agents and employees can use theMitel Border Gateway Connector.

To approve theMitel Border Gateway certificate
 1. Log on to theMitel Border Gateway server.
 2. In the left pane under Security, select Certificate Management.

TheManage Certificates window opens.
 3. UnderQueued CSRs, select the certificate that needs approval.
 4. Select Approve orRevoke.
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Chapter 5
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Services and Database Administration
This chapter includes a description of how to back up data and of the functions available in Management
Console (updating server IP addresses, running themaintenance routine immediately, summarizing data,
creating a support package, controlling services, and converting Toolbox and Contact Center Solutions data
files to prairieFyre data files).

Backing up data
NOTE:We recommend you back up the SQL server data files, YourSite Database configuration data files,
and raw phone data files to an off-boardmedia type (DVD, CD, tape, alternate network drive) each day as a
precaution in case of server failure.

In the event of server failure, you can restore your company history and configuration with
l A backup copy of .xml files.
l A backup copy of the SQL server data files.
l A backup copy of the Enterprise Server configuration data.
l The raw telephone system data files stored on the local hard drive.

Backing up .xml files
Themaintenance routine automatically backs up an .xml file of the YourSite database every night. This
backup file is stored in the directory: <drive>:\program files\prairiefyre software inc\CCM\Backup Files. The
maintenance routine keeps an .xml file for each of the last 30 days maintenance ran.

To back up or restore the .xml files
 1. Start Contact Center Client.
 2. Click View=>Administration.
 3. Click Management.
 4. Click Configuration.
 5. Click Back up/Restore configuration data.
 6. Follow the steps in the Backup and RestoreWizard to back up or restore the .xml file.

Backing up SQL Server data files
You back up SQL Server data files to ensure you can replace corrupted or lost data in the event of media
problems, user errors, hardware failures, and natural disasters. Please review theMicrosoft procedure for
creating a recovery model that controls the backup and restoration operations for a database. See
http://www.exforsys.com/tutorials/sql-server-2005/sql-server-backing.html

Understanding SQL Server recovery models
The following section details SQL Server recovery models and how they relate to backups and disk space
usage. There are three recovery models available for use with SQL Server:
 1. Simple
 2. Full
 3. Bulk logged

For detailed information on backing up SQL Server through SQL Server Management Studio, see
http://msdn.microsoft.com/en-us/library/ms187510.aspx.

Backing up data
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For a complete overview of SQL Server recovery models, see
http://msdn.microsoft.com/en-us/library/ms175987(SQL.90).aspx

By default, SQL Server Express uses the Simple recovery model. Retail versions of SQL Server use the Full
recovery model. There are two things youmust consider when deciding which recovery model to use:
 1. The importance of the data being stored in the SQL Server database.
 2. The amount of disk space used by the transaction log file.

The only way to recover a SQL Server database is to restore it from a SQL Server backup. The type of
recovery model you use impacts the ability to restore the database.

The Simple recovery model is recommended for customers who do not have an IT department upon which to
rely for regular backups and who believe the summarization process is sufficient to re-generate historical data.
There are several things that should be considered when using the Simple recovery model:

l The log file does not continually grow and is truncated each time a successful transaction is completed.
l When the log file is 80% full, the log will automatically clear out old transactions and rewrite the log file

with the newer transactions.
l Point-in-time recovery is not supported with this model and the database can be restored only from the

last full or differential backup.
l This model is ideal when the data in the database is not consideredmission critical, is being backed up

periodically, or can be restored from another means, such as summarization.

The Full recovery model is recommended for customers who have an IT department that canmanage
scheduled backups. There are several things that should be considered when using the Full recovery model:

l The log file will grow until a transaction log backup is successfully completed against the SQL Server
database. Transaction logs can be applied to full database backups to ensure point-in-time recovery, up
to the time when the last transaction log backup was taken.

l Point-in-time recovery is supported with this model
l This model requires a regular backup schedule and sufficient disk space to house the log file as it grows

between backups.

Frequency and scope of configuration changes may be a suitable indicator in determining which recovery
model to use. If configuration changes are infrequent and point-in-time recovery is not critical, the Simple
recovery model may be sufficient. However, when using the Simple recovery model, we highly recommend
that SQL Server backups are performed after any significant configuration changes have beenmade to the
database.

Regardless of the recovery model used, it is strongly recommended that the data files collected by the Call
Accounting applications are backed up on a regular basis, as these files are used in the summarization
process to re-generate historical data.

Backing up Enterprise Server configuration data
CAUTION: Restoring the YourSite database deletes all of the current database table entries and replaces
them with the entries defined at the time of your last database backup. Any changes made to the database in
the interim are lost.

Backing up and restoring Enterprise Server configuration data protects your data in case you program the
database incorrectly, or a careless user reconfigures it. prairieFyre recommends you perform this backup
weekly, in addition to regular databasemaintenance. If required, you can later recover the YourSite database
data exclusively, rather than restoring the entire SQL database.
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To back up or restore the YourSite database
 1. Start Contact Center Client.
 2. Click View=>Administration.
 3. Click Management.
 4. Click Configuration.
 5. Click Back up/Restore configuration data.
 6. Follow the steps in the Backup and RestoreWizard to back up or restore the database.

For any additional information contact prairieFyre Software technical support at 613-599-0045 (North
American customers) or your approvedMitel vendor (for customers residing in Latin America, Europe, the
Middle East, Africa, and Asia Pacific).

Backing up raw telephone system data files
To back up raw telephone system data files
 1. On the Enterprise Server, right-click Start=>Explore.
 2. Copy the <drive>:\program files\prairiefyre software inc\CCM\DataDirectory folder to the desktop,

a network share, or optionally store it on a CD.

Management Console
TheManagement Console application resides in Contact Center Client. UsingManagement Console, you can
administer the database, perform maintenance functions, create support packages, and update your Call
Accounting software.

Management Console consists of the followingmenus:
l Configuration
l Maintenance
l Support
l System

Opening Management Console
Management Console is available to users whose security permissions permit them to useManagement
Console.

To openManagement Console
 1. OpenContact Center Client.
 2. If prompted, type your user name and password.
 3. Verify the Enterprise Server IP address.
 4. Click Log on.

The Contact Center Client window opens.
 5. Click Tools in the ribbon.
 6. Click theManagement Console icon.

TheManagement Console window opens.
See Figure 5 - 1.

Management Console
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Figure 5 - 1 Management Console

 7. Access the Configuration, Maintenance, Support, and System options by clicking on the applicable icon
in the window.

NOTE:Whether Management Console displays and is available depends on individual user's security
settings.

Configuration
The Configurationmenu enables you to update the server IP address.

Updating server IP addresses
To apply Enterprise Server or SQLDatabase Server IP address changes to all Call Accounting applications,
you use the Update Server IP Address Wizard.

To apply the IP address change to all Call Accounting applications
 1. Click Configuration.
 2. Click Update server IP address.
 3. Follow the steps in the wizard to apply the IP address change universally.
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Maintenance
Using theMaintenancemenu, you can

l Run themaintenance routine
l Summarize data

Running the maintenance routine immediately
Call Accounting runs the prairieFyreMaintenance Service by default at 2:00 A.M. However, you canmanually
invoke the prairieFyreMaintenance Service at any time with the Runmaintenance command.

To run themaintenance routine
 1. Click Maintenance.
 2. Click Run maintenance.

A message notifies you that processing is complete.

Summarizing data
The Summarize DataWizard uploads historical telephone system data to the SQL database for a specific
date range.

If you run a report and notice that data for a particular device is missing from the report output, verify the
device is programmed in the telephone system and in the YourSite database. If you determine the device is
missing from the database, add it to the database and use the Summarize command to update Collector
Service and the SQL database with the complete raw telephone system data (stored on the local hard drive).
You can then produce reports on the device.

NOTE:
l When a summarize is performed the devices not programmed in the telephone system or YourSite

database are identified and logged to an XML file located in the Logs directory. The files are named as in
the following example, summarizeInspection[29-01-2007][29-01-2007][29-01-2007].xml, where the first
date is the current date, the second is the start date of the summarize, and the third is the end date of
the summarize.

l If you attempt to summarize data and there is no data for that date an error opens. Please select
another date.

To summarize data
 1. Click Maintenance.
 2. Click Summarize data.
 3. Follow the steps in the Summarize DataWizard to summarize the data.

Support
Using the Support menu, you can

l Create an Enterprise Server support package
l Create a client support package
l View contact information

Management Console
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Creating an Enterprise Server support package
You can package your Enterprise Server telephone system records and YourSite configuration data to send to
prairieFyre for troubleshooting issues using the Support PackageWizard. The Support package formats your
data in a way that helps to resolve any problems.

To create an Enterprise Server support package
 1. In Management Console, click Support.
 2. Click Create support package.
 3. Follow the steps in the Support PackageWizard to package your telephone system records and

YourSite configuration data.
 4. Click Finish.

Creating a client support package
You can package your client configuration data to send to prairieFyre for troubleshooting issues using the
Client Support PackageWizard. The Client Support PackageWizard formats your data in a way that helps to
resolve any problems.

To create a client support package
 1. Browse to http://www.prairiefyre.com/wp-content/rscs/cspwizard.
 2. Click Install.
 3. Click Install.

The Client Support PackageWizard opens.
 4. Follow the steps in the Client Support PackageWizard to package your client configuration data.
 5. Click Finish.

Viewing contact information
Should you need to contact prairieFyre Software for support, contact information is provided inManagement
Console.

To view contact information
 1. Click Support.
 2. Click View contact information.
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System
Using the Systemmenu, you can

l Control services
l Convert data files

Controlling services
Services Manager controls all Call Accounting services andmandatory system services. These include the
prairieFyre Collector Service (v5), DataService, prairieFyre .NET Enterprise Server, MTCEService,
prairieFyre Report Writer (v5), prairieFyre Reporting Service, prairieFyre SQLWriter, AuditorServer,
ForecastingServer, WallboardServer, CCSServer, MitaiProxy, MCCExchangeObjects,
MCCExchangeSetup, and IIS Admin.

To control services
 1. Click System.
 2. Click Services Manager.
 3. Select the service to be controlled.
 4. Right-click the service.

The right-click menu opens. This enables you to control the service the following ways:
l Start
l Stop
l Pause
l Resume
l Restart
l Refresh
l Restart All Running Services

 5. Select the action to be performed.

Converting data files
The Data file conversion tool enables you to convert Toolbox data files to prairieFyre data files. This enables
you to restore all historical data from competitor products when changing your solution to Call Accounting.

To convert data files
 1. Click System.
 2. Click Data file conversion tool.

The Data file conversion tool opens.
NOTE: The pathmust be accessible from the server. We recommend you use a Universal Naming
Convention (UNC) share.

 3. Click Next.
The data file conversion will then process.

 4. Click Finish to complete the data file conversion.

Management Console
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Converting Callview and Contact Center Suite data
If you were previously using an Inter-Tel telephone system with Contact Center Suite/Callview and Toolbox
software, you can convert historic data to Contact Center Solutions format and create a historical media
server so you can retain data for reporting purposes.

Historical media servers enable
l Historical reporting for queues, agents, and extensions
l Forecasting
l ACD and SMDR Inspector functionality
l Auditor functionality

Inter-Tel summary-based options, such as service level and spectrum values, can bemodified in YourSite
Explorer. Summarize is performed on an on-demand basis fromManagement Console in Contact Center
Client. Historical media servers have no real-time functionality. All devices associated with historical media
servers are historical by default and can not be edited or used to collect any new data.

If you want to report on Call Accounting related call statistics and call costing, youmust have all Call
Accounting devices configured in YourSite Explorer and run summarize before running any historical reports.

NOTE:
l In order to convert Callview or Contact Center Suite data to Contact Center Solutions and Call

Accounting format, the Callview and Contact Center Suite databasemust be Version 3.x or 4.x.
l The conversion tool requires the following files: System.mdw, config.mdb, and one or any combination

of the following: Ha<MMYYYY>.mdb, Hc<MMYYYY>.mdb, Haday.mdb, Hcday.mdb, Hamonth.mdb,
Hcmonth.mdb. For version 4.11 or earlier, select cvgwcfg.mdb instead of config.mdb.

To convert Callview and Contact Center Suite data
 1. InWindows, open the Inter-Tel Import Tool.
 2. AfterAccess Databases, click Browse.
 3. Browse to the location of the files to convert.

The conversion tool requires the following files: System.mdw, config.mdb, and one or any combination
of the following: Ha<MMYYYY>.mdb, Hc<MMYYYY>.mdb, Haday.mdb, Hcday.mdb, Hamonth.mdb,
Hcmonth.mdb. For version 4.11 or earlier, select cvgwcfg.mdb instead of config.mdb.

 4. Click OK.
 5. AfterStart Date, select the start date of the data to import.
 6. AfterEnd Date, select the end date of the data to import.
 7. If you are upgrading from a 5000/Axxess telephone system to a 3300 ICP or SX-200 telephone system,

but want to retain historic Inter-Tel data for reporting purposes, click Create historic media server.
Otherwise, continue to step 9.
The Inter-Tel DatabaseMigration Tool will import the telephone system configuration information, such
as agents, extensions, and trunks, and associate it to the 5000/Axxess media server. It will also
convert all historic telephone system records to ACD and SMDR files.
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 8. If you are upgrading to Contact Center Solutions or Call Accounting and continuing to use your
5000/Axxess telephone system, after Target to Import, select the Inter-Tel 5000/Axxess media to
associate the converted data with. Otherwise, continue to step 10.
NOTE: If you are upgrading to Contact Center Solutions or Call Accounting and continuing to use your
5000/Axxess telephone system, youmust run Synchronization before running the Inter-Tel Database
Migration Tool. See "Configuring the YourSite database using synchronization" on page 77.
The Inter-Tel DatabaseMigration Tool will not import configuration data because synchronization
provides amore accurate configuration. However, telephone system records will be converted
telephone system records to ACD/SMDR.

 9. If you have remote 5000/Axxess telephone systems and use a CT Gateway, select Synchronized
system uses CT Gateway.
NOTE:Before you run the Inter-Tel DatabaseMigration Tool, youmust have created an Inter-Tel media
server for each of the telephone systems connected to the CT Gateway, selected This media server
belongs to a CT Gateway and provided the Gateway ID in YourSite Explorer. See "Adding
5000/Axxess media servers" on page 72.

 10. If you want to summarize the data immediately after the conversion, select Summarize upon
completion.

 11. Click Import.

Management Console
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Chapter 6

Call Accounting

Configuration

Enterprise setup
YourSite Explorer
Addingmedia servers
NetworkMonitor alarms
Subscriber Services configuration
Business hour schedules
Security roles
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Configuration
Youmust configure Call Accounting before you are able to report on call activity.

You configure devices in the following order. (See Figure 6 - 1.)
 1. In YourSite Explorer, under YourSite, add devices in the following order:

l Sites, see "Adding sites" on page 60.
l Media servers, see "Addingmedia servers" on page 61.
l Employees and employee groups (optional), see "Adding employees" on page 94.
l Subscribers and subscriber groups (optional), see "Adding subscribers" on page 112.
l Extensions and extension groups, see "Adding extensions" on page 98.
l Trunks and trunk groups, see "Adding trunks" on page 100.
l DNIS and DNIS groups (optional), see "Adding DNIS" on page 101.
l Account Codes (optional), see "Adding Account Codes" on page 102.
l Phone numbers and phone number groups (optional), see "Adding phone numbers" on page 104.

 2. In YourSite Explorer, under Call Accounting, add Call Accounting components in the following order:
l Call types, see "Adding call types" on page 105.
l Time slots, see "Adding time slots" on page 106.
l Call rates, see "Adding call rates" on page 106.
l Carrier plans, see "Adding carrier plans" on page 107.
l Add digit patterns to carrier plans and associate call types and call rates to the digit patterns, see

"Adding outbound digit patterns" on page 108.
l Assign carrier plans tomedia servers and/or trunk groups, see "Associating carrier plans to

media servers and/or trunk groups" on page 110.
 3. In Contact Center Client, in Network Monitor, specify the days and times that data alarms will be

activated, see "Configuringmedia server alarms" on page 75.
 4. In YourSite Explorer=>YourSite, create schedules that specify the business hours of your operation to

be used for media servers and Network Monitor alarms, see "Creating schedules" on page 116.
 5. On the Call Accounting website, under YourSite=>Security, restrict user access to specific areas of the

Call Accounting website. See "Security roles" on page 124.
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Figure 6 - 1 Call Accounting configuration flowchart

For themost part, configuration is done using YourSite Explorer, however, there are a few exceptions where
configuration is done in the Contact Center Management website. See Table 6 - 1 for a list of where
components are configured.
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YourSite Explorer simplifies datamanagement by enabling you to configure and administer devices for
Contact Center Solutions and Call Accounting in one application.

If you have a 3300 ICP, 5000, or Axxess, you configuremedia servers, Network Monitor alarms, devices, and
business hour schedules and perform Synchronization in YourSite Explorer.

NOTE: If youmake configuration changes for the 3300 ICP, 5000, and Axxess using the Contact Center
Management website, your updates will not write back to the telephone system during Synchronization or
nightly maintenance.

If you have an SX-200, youmust configuremedia servers, Network Monitor alarms, devices, and business
hour schedules in the Contact Center Management website.
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Table 6 - 1 Configuration outline

Item
Contact
Center

Management
website

YourSite
Explorer

Enterprise Settings x x

Sites x x

Security x

Adding 3300 ICP media servers x

Adding SX-200media servers x

Adding 5000 / Axxess media servers x

AddingMultimedia Contact Center Email, WebChat, and Fax
media servers x

Adding Intelligent Queuemedia servers x

Call recording x

Network Monitor alarms x x

Business hour schedules x x

Agents, agent groups, and queues that you will synchronize
with/write back to the telephone system x

Editing telephone system assignment forms (System Options,
SMDR Options, Class of Service, and Class of Restriction) x

Quick Setup device configuration (employees, agents, extensions,
trunks, trunk groups, DNIS, account codes, make busy reason
codes, teams, and device groups)

NOTE:To achieve optimal results, use YourSite Explorer
exclusively for Quick Setup of devices.

x x

Quick Setup device configuration (extension divisions and account
code groups) x

Quick Setup device configuration (queues) x

.csv file import device configuration x

Manual device configuration (ANI and Intelligent Queue devices) x
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Item
Contact
Center

Management
website

YourSite
Explorer

Manual device configuration (account code groups, do not disturb
reason codes, extension divisions, phone numbers, and phone
number groups)

x

Manual device configuration (account codes, agents, agent
groups, DNIS, DNIS groups, employees, employee groups,
extensions, extension groups, make busy reason codes, queues,
queue groups, teams, trunks, trunk groups, and employee
divisions)

NOTE: To achieve optimal results, in accordance with the Contact
Center Solutions Version 6.0.1 Simplified Licensingmodel, use
YourSite Explorer exclusively to configure devices.

x x

Call Classification codes x

Contact CenterWork Timer x

Queue Spectrum settings x x

Interactive Contact Center queue control x

Multimedia Contact Center queue configuration x

Workforce Scheduling employees and schedule attributes x

Call Accounting extensions, trunks, and phone numbers x

Call Accounting location information x

Call Accounting Subscriber Services and Traffic Analysis
components x

YourSite Explorer
YourSite Explorer streamlines configuration. For example, you can

l Multiselect devices and change their attributes in one step.
l View groupmembership information on the samewindow as the devices are listed.
l View multiple windows of devices simultaneously and tab between them.
l Edit inline in an extended grid.

NOTE:
l YourSite Explorer enables you to havemultiple device tabs open simultaneously. As a best practice,

we recommend you only have the device tabs open that you are currently using.

YourSite Explorer
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l We recommend you avoidmodifying large data sets from within YourSite Explorer as performance
levels will be negatively affected. As a best practice, all large dataset modifications should bemade on
the telephone switch directly and synchronized back to Contact Center Management. If you prefer to
perform modifications inside YourSite Explorer, we recommend you partition the changes into smaller
chunks of data.

For detailed information regarding which devices are configured in YourSite Explorer see "Configuration" on
page 41.

Starting YourSite Explorer
To start YourSite Explorer
 1. Open YourSite Explorer.
 2. If prompted, type your user name and password and verify the Enterprise Server IP address.
 3. Click Log on.

YourSite Explorer Start Page
The YourSite Explorer Start Page is a startup resource that provides links to both information resources for
getting started as well as system information for Contact Center Solutions. By default, if enabled, the Start
Page opens automatically with each new session of YourSite Explorer.

The Start Page has two tabs: Getting Started and System Information.
l Getting Started—provides configuration overviews for Contact Center Solutions and includes the

following tabs:
l Welcome—details the contents of both the Getting Started tab and the System Information tab
l Contact Center Management—overview of Contact Center Management YourSite Explorer

configuration
l Call Accounting—overview of Call Accounting YourSite Explorer configuration
l Workforce Scheduling—overview of Workforce Scheduling YourSite Explorer configuration for

employees and schedules
NOTE:Youmust be licensed forWorkforce Scheduling to view this tab.

l Visual Workflow Manager—overview of IVR Routing configuration
NOTE:Youmust be licensed for IVR Routing to view this tab.

l System Information—provides documentation as well as system and license information and
includes the following tabs:

l Documentation—provides links to Contact Center Solutions and Call Accounting
documentation

l About—provides system information, custom reports, and contact information for prairieFyre
l Alarms—provides information on currently active Contact Center Management alarms, with

links to corresponding prairieFyre Knowledge Base articles

Configuring the YourSite Explorer Start Page
You can configure whether or not the Start Page opens automatically when you start YourSite Explorer. You
can also configure whether or not the Start Page automatically loads in View tab of YourSite Explorer.

To prevent the Start Page from opening automatically
 1. Start YourSite Explorer.
 2. On the Start Page, clear theShow page on startup checkbox.

The Start Page will no longer automatically open on startup.
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To configure whether the Start Page opens in the View tab
 1. In YourSite Explorer, in the ribbon, click theView tab in themenu of YourSite Explorer.
 2. If you want to prevent the Start Page from loading automatically on startup, clear theShow start page

checkbox.
If you want to enable the Start Page to load automatically on startup, select theShow start page
checkbox.

Searching
When you perform searches in YourSite Explorer, you can filter on specific criteria to narrow the search.
YourSite Explorer searches on criteria you type into the Search box. The search result will consist of all
instances of the search item. For example, if you ran a search for ext, you search result could contain:
extension, text, and next time.

After you perform an initial search, you can type additional criteria in the box to narrow the search. If no words
or numbers match your search request, the resultant list will be blank.

YourSite Explorer searches on the following variables:
l Employees, employee groups—first and last name
l Extensions, extension groups—reporting number
l Trunks, trunk groups, DNIS, DNIS groups, Account Codes, divisions—name and reporting number
l Phone numbers, phone number groups—search on information found in all columns except Created by,

Created date, Last modified by, or Last modified.

To search for a specific word or number
l In theSearch box, type a word or number surrounded by quotationmarks.

For example, to search for an extension named Extension1, type “Extension1.”
A list of devices that match the search criteria displays.

Paging
Paging enables you to specify the number of items to be included per page. You can reduce the page size to
increase the application speed. By default, the page size allows for 100 items. When changing the page size,
youmust close and re-open the device window.

To change the number of items viewed per page
 1. In YourSite Explorer, on the ribbon, click Call Accounting.
 2. Click theView tab.
 3. AfterPage size, select number of items to be viewed per page.
 4. Click Save.

Filtering
The filtering bar enables you to access records alphabetically.

YourSite Explorer filters records on the following variables:
l Employee—last name
l Phone number—country name
l Employee group, extension, extension group, trunk, trunk group, DNIS, DNIS group, Account Code,

division, and phone number group)—name.

To filter records alphabetically

YourSite Explorer
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l On the filter bar, click the letter with which the record begins.

To filter numerically
l On the filter bar, click # to view records that start with numbers 0 through 9.

To reset filtering
l On the filter bar, click All to view all records.

You can filter and then search within the filtered records. For example, click F to filter for all records that start
with the letter F. Then type th to search within that list for any record with th.

Customizing the user interface
You can customize the user interface by minimizing aspects of it, changing the order of the columns,
changing column options, and adjusting the page size. This customization is referred to as a profile. Your
profile is associated with the user name you use to access YourSite Explorer. Each time you close YourSite
Explorer, your profile is automatically saved. When you reopen YourSite Explorer using the same user name,
the user interface displays your profile.

Minimizing aspects of the user interface
To add space to the user interface so you can view additional rows of data, you canminimize the following
window elements.

l Filter bar
The filter bar is the bar on which the alphabet is displayed

l Page bar
The page bar is located above the filter bar. The page number is displayed on the left side of the page
bar

l Ribbon
The ribbon is located at the top of the user interface. The ribbon includes Home, View, and
Configuration tabs, and enables you to add devices and change the view (horizontal, vertical, or data
grid). Ribbon attributes change depending on the area you are viewing

To hide the filter bar
 1. In YourSite Explorer, on the ribbon, click theView tab.
 2. Click Call Accounting.
 3. Clear theShow filter bar check box.

To hide the page bar
 1. In YourSite Explorer, on the ribbon, click theView tab.
 2. Click Call Accounting.
 3. Clear theShow page bar check box.

Tominimize the ribbon
 1. In YourSite Explorer, on the ribbon, click the Customize Quick Access Toolbar.
 2. Click Minimize the ribbon.

The ribbon at the top of YourSite Explorer is hidden.

Selecting the first record of each list
You can save time by configuring YourSite Explorer to automatically select the first record on a page.
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To select the first record of each list
 1. In YourSite Explorer, on the ribbon, click theView tab.
 2. Click Call Accounting.
 3. Select theSelect first record check box.

Changing the order of the columns
You can reorder columns in either of two ways. You can drag a column heading to a different position on the
table, or you can change column order using Column options. See "Changing column options" on page 56.

To drag column headings
 1. With the device window open, select the column heading to bemoved.
 2. Drag it to a different position on the table.

Changing column options
You can adjust the width and order of columns, and hide or show columns in device windows.

To adjust columnwidth
 1. Drag the column to the left or right to adjust its width.
 2. Click OK.

To hide a column
 1. Right-click a column heading.

The Column options window opens.
 2. Select Column options.
 3. Select the column heading to be hidden.
 4. Click <<.
 5. Click OK.

To change the order of columns
 1. Right-click a column heading.

The Column options window opens.
 2. Select Column options.
 3. Select the column heading to bemoved.
 4. Use the arrows to change the order of the column headings.

The top column displays first in the device window.
 5. Click OK.

Grouping device criteria by column headers
You can group devices by column heading in the grid view. For example, if you click the Site column heading
on the Employees window, you can group employees by site. Grouping enables you to quickly select like
devices andmake changes to them simultaneously. For example, if you click theMedia server column
heading on the Extensions window (to group the extensions by media server), you can then readily select the
extensions associated with a particular media server and change their attributes, such as licensing or failover
media server. See "Makingmultiple changes" on page 57.

To group device criteria by column headers
 1. Open the device with the criteria to be grouped.
 2. Click Group by.

YourSite Explorer
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 3. Select themethod of grouping.

Making multiple changes
In one action, you can edit common information across multiple devices of the same type. If, for example, you
recently set up your system to be resilient, youmust configure your employees as resilient. You assign
resiliency tomultiple employees by selectingmultiple employees and then selecting the This employee is
resilient check box.

You can change information that is common across multiple devices only. For example, you cannot change
Name and Reporting number across multiple employees because they are specific to each device item.

When you edit common information across multiple devices of the same type, but the devices have different
options selected, text boxes show as blank, combo boxes are blank, option buttons are cleared, and check
boxes are filled.

You canmakemultiple changes to
l Employees
l Trunk groups
l DNIS

Changing the YourSite Explorer view
You can select from three window orientations or views: horizontal, vertical, and data grid. The horizontal view
displays information in a horizontal layout. The vertical view displays information in a vertical layout.

The data grid view contains a table in which you can readily edit device attributes. Pressing the Tab key
enables you tomove from column to column. When viewing a device group in grid view, you can associate
members within the samewindow.

When you close YourSite Explorer and then restart it, Call Accounting displays the view and device windows
that were open the last time you used YourSite Explorer.

NOTE:Carrier plans and subscriber plans do not support the data grid view.

To select a particular view
 1. In YourSite Explorer, on the ribbon, click theView tab.
 2. Click Call Accounting..
 3. Select Horizontal, Vertical, orData grid.

See Figure 6 - 2.
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Figure 6 - 2 Data grid view

Importing and exporting data
You can import or export call types, call rates, or carrier plans in .xml format to Call Accounting. The
import/export tool overwrites call types, rates, and carrier plans only, and will not affect any other
configuration (including subscriber plans). Importing and exporting data works similar to the backup and
restore functionality for Call Accounting devices and is designed primarily for dealers to configure the software
for customers with similar configurations. However, it does not work similar to .csv import functionality, and
customer and dealers wanting to import a specific set of data (such as call rates) are recommended to use the
.csv import tool. For details on .csv imports, see "Importing a range of devices using a .csv file" on page 94.

To import a file
 1. In YourSite Explorer, on the ribbon, click theConfiguration tab.
 2. Click Call Accounting.
 3. Click Import.
 4. Locate the file to be imported.
 5. Click Open.

The file is imported.
 6. Click Save.

To export a file
 1. In YourSite Explorer, on the ribbon, click the Configuration tab.
 2. Click Call Accounting.
 3. Click Export.
 4. Locate the file to be exported.
 5. Click Open.

The file is exported.
 6. Click Save.

Enterprise setup
For all telephone system types, you set up your site structure in YourSite Explorer.

Enterprise setup
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To set up your enterprise structure
 1. Specify enterprise settings.
 2. Add a site.
 3. Addmedia servers to the site.

Youmust understand the following terms to set up your enterprise structure.
l Enterprise

The enterprise is all of the contact center sites that comprise your company.
l Site

A site is an office location with one or moremedia servers. It can be the office where the Call
Accounting Enterprise Server is installed or a branch office.

l Media server
Themedia servers are themeans by which customers communicate with you.

Starting Call Accounting
To start Call Accounting on the Enterprise Server or on a client computer
 1. Start Internet Explorer and type your Enterprise Server IP address http://[your Enterprise Server IP

address]/CCMweb/.
 2. Click Favorites=>Add to Favorites to add the Enterprise Server IP address to your list of favorite

addresses.
 3. Click OK.
 4. Click Favorites, locate the Call Accounting entry (at the bottom of the list) and drag it to the top of the

list.
 5. Optionally click Make Home Page to set the Enterprise Server IP address as your home page.
 6. If prompted, type your user name and password and click Submit.

Configuring enterprise settings
When programming the enterprise, you configure Enterprise server general settings, somemaintenance
services, and email alarms. The Enterprise Server is the computer on which Contact Center Management is
installed.

Configuring the Enterprise Server settings
To configure the Enterprise Server settings
 1. In YourSite Explorer, click YourSite=>Enterprise.
 2. UnderGeneral settings, after IP address, verify the IP address of the Enterprise Server.
 3. If the IP address is incorrect, after IP address, type the IP address of the Enterprise Server.

NOTE: If you want to change the Enterprise IP address, use the Contact Center Client Update Server
IP Wizard. See "Updating server IP addresses" on page 41.

 4. AfterReal-time port, type the real-time port number.
The default real-time port is 5024.
The real-time port is used to communicate real-time events.

 5. AfterAuditor port, type the Auditor port number.
The default Auditor port is 5025.
The auditor port is used to run Auditor events.

 6. AfterMiTAI proxy server port, type theMiTAI proxy server port number.
The default MiTAI proxy server port is 5026.

 7. If you want Lifecycle reports, select theEnable LifeCycle reports check box.
 8. If you use Secure Socket Layer, select the This server uses Secure Socket Layer (SSL) check box.
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 9. UnderSystem Messages, if you want to be notified when your warranty is about to expire, select the
Display warranty warning and expiration message check box.

 10. UnderUpdater settings, if you want client applications to be automatically updated, select theAuto
update client applications check box.

 11. Click Save.
 12. Specify enterprisemaintenance functions.

See "Configuring enterprisemaintenance functions" on page 60.

Configuring enterprise maintenance functions
To configure enterprisemaintenance functions
 1. In YourSite Explorer, click YourSite=>Enterprise.
 2. Click theMaintenance tab.
 3. After Zip files older than, select the number of days after which you want to zip data files.
 4. AfterPurge reports older than, select the age after which reports will be discarded.
 5. AfterDelete maintenance logs older than, select the age after whichmaintenance logs will be

discarded.
 6. AfterDelete configuration backup files older than, select the age after which configuration backup

files will be discarded.
 7. After Time Maintenance Service runs, select the time themaintenance service summarizes data.

Themaintenance service is set to run at 2:15 A.M. by default. Select a time for themaintenance
manager to run when your contact center is closed or is the least busy.

 8. AfterPurge Life cycle reports older than, select the age after which Life cycle reports will be
discarded.

 9. Click Save.
 10. Configure email alarms.

See "Configuring email alarms" on page 60.

Configuring email alarms
You configure email alarms so you are notified by email about Enterprise server and real-time performance
issues.

To configure email alarms
 1. In YourSite Explorer, click YourSite=>Enterprise.
 2. Click theEmail alarms tab.
 3. AfterSMTP Mail Server address, select the IP address of the SMTP Mail Server.
 4. AfterEmail notification interval minutes, select the duration (in minutes) after which you will be

notified when an alarm occurs.
 5. If you want the system to send an email notification when an alarm occurs, select theEnable email

alarms check box.
 6. AfterSend Enterprise Server alarms to the following address(es), type the email address of the

employee(s) who will receive the email notification.
 7. Click Save.

Adding sites
Your site structure determines how you view statistics and reports. When you set up your site structure, you
specify site andmedia server information. When you add a site, you add the name of the site and the time
zone. By making each site distinct, you can restrict user access to sites. See "Security roles" on page 124.

To add a site

Enterprise setup
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 1. In YourSite Explorer, click YourSite=>Enterprise.
 2. Click Add.
 3. AfterSite name, type the name of the site.

You can add a number to the name of the site to indicate the number of sites in this location.
 4. After Time zone, select the time zone for the site.
 5. AfterSite language setting, select your preferred language for your Call Accounting website.

NOTE: The language setting you specify here becomes the default language for all of the client
computers. However, you can customize this setting for individual employees in the Call Accounting
website, under My Options=>My preferences.

 6. AfterChat settings, select theChat enabled check box to enable Contact Center Chat.
NOTE:Contact Center Chat is enabled by default.

 7. If you want to use Lync Client as your default instant messaging client and view enhanced presence on
real-timemonitors, select theEnable enterprise presence and chat integration check box.
NOTE:Employees who are associated to sites where the above option is not enabled will not be able to
communicate using Contact Center Client.

 8. Click Save.

Adding media servers
NOTE:MixingMitel 5000/Axxess (formerly Inter-Tel 5000/Axxess) and 3300/SX-200media servers in the
same enterprise is supported by Contact Center Solutions and Call Accounting applications.

Youmust give eachmedia server a distinct namewhen setting up your site to distinguish between the various
types of media for management and reporting purposes.

To verify themedia server types and the number of employees for which you are licensed, click Help=>About
Call Accounting.

You add 3300 ICP, 5000, and Axxess media servers to your site in YourSite Explorer.

You add SX-200media servers to your site in the Contact Center Management website.

You select your media servers from the followingmedia server types and add them to your site.

NOTE:As of Call Accounting Version 6.0, the SX-2000 telephone system is no longer supported.

3300 IP Communications Platform (ICP)
The 3300 ICP system streams SMDR over TCP/IP.
See "Adding 3300 ICP media servers" on page 62.

SX-200 ACD / Call Accounting
The SX-200 system has SMDR records delivered over a single data connection, RS-232, or TCP/IP.
See "Adding an SX-200 Call Accountingmedia server".

5000 / Axxess
The 5000 and Axxess systems stream ACD andOAI data over TCP/IP.
See "Adding 5000/Axxess media servers" on page 72.

../../../../../Content/NewImport/Adding_an_SX_200_Call_Accounting_media_server.htm#CA_user_guideCMP_2154496662_1000641
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../../../../../Content/NewImport/Adding_an_SX_200_Call_Accounting_media_server.htm#CA_user_guideCMP_2154496662_1000641
../../../../../Content/NewImport/Adding_an_SX_200_Call_Accounting_media_server.htm#CA_user_guideCMP_2154496662_1000641
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Adding 3300 ICP media servers
You add 3300 ICP media servers in YourSite Explorer.

Youmust first add the 3300 ICP media server and then configure its location settings, telephone system
settings, data summary options, Network Monitor settings, data collection settings, MiTAI options and,
optionally, write-back functionality and call recording.

NOTE:
l As a best practice, we recommend you perform Full Synchronization after adding and configuring a

media server in YourSite Explorer and before configuring telephone system settings for themedia
server. For more information on synchronization, see "Configuring the YourSite database using
synchronization" on page 77. For information on performing synchronization, see "Performing
synchronization" on page 80.

l If you are addingmedia servers as part of a new installation, we recommend you perform
synchronization after all media servers have been added. For more information, see theCall
Accounting Installation Guide.

To add a 3300 ICP media server
 1. In YourSite Explorer, click YourSite=>Media servers.
 2. Click Add=>3300 ICP.
 3. AfterName, type the name of themedia server.

NOTE:
l To distinguish between the various types of media for management and reporting purposes,

youmust name eachmedia server distinctly when setting up your site.
l TheMedia server ID field will be populated with a unique number after themedia server has

been saved.
 4. AfterSite, select the site where themedia server resides.
 5. AfterComputer name, select the computer where the server resides.
 6. AfterMedia server type, select the type of media server.

NOTE: The typical media server type is ‘Enterprise Node’. If you select ‘Queueing gateway’, no agent
data will be filed to SQL. If you select ‘Agent/extension gateway’, no queue data will be filed to SQL.
When amedia server is configured as an ‘Agent/extension gateway’, no queues are loaded and, as a
result, no call activity is displayed in the Interactive Visual Queue real-timemonitor.

 7. If you have hot desking agents, select theUses hot desking agents check box.
NOTE: If this is selected, all created agents will be hot desking agents. You cannot mix hot desking
and standard agents.

 8. To be informed of media server alarms, select theEnabled for alarms check box.
NOTE: Selecting this check box will inform you of media server alarms via RSS and email. For more
information, see "Monitoring and alarming subsystem" on page 117.

 9. Select Licensed for Call Accounting if you are applying for a Call Accounting license.
NOTE: This check box is selected by default when you add a 3300 ICP media server and have
remaining Call Accountingmedia server licenses. If you are licensed for Contact Center Management
and Call Accounting, youmust select "Licensed for Call Accounting" to have access to Call
Accounting. If you are not licensed for a product, you will not be able to select the check box for that
product.
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 10. If you want to designate themedia server for historical reporting use only, click Make Historical.
Making amedia server historical terminates all active licenses for devices associated with that media
server. Historical data is retained on themedia server but no new data is collected.

 11. After IP/DNS address, specify the IP/DNS address of themedia server.
 12. AfterUsername, type the username used to connect to the telephone system.
 13. AfterPassword, type the password used to connect to the telephone system.
 14. AfterConfirm password, type the password used to connect to the telephone system.
 15. Click the Test Connection button to test the connection between themedia server and the Enterprise

Server.
This connection is required to ensure Synchronization functionality.

 16. If this media server is part of a Mitel cluster, underCluster setting, select the This media server is
part of a Mitel cluster check box.

 17. If this media server is part of a Mitel cluster, afterCluster ID, type the cluster ID.
The cluster ID can be found on the telephone system.

 18. If this media server is part of a Mitel cluster, afterCluster ID Digits, type the digits used to identify the
cluster.

 19. If this media server is part of a Mitel cluster, afterCluster name, select the cluster name.
NOTE:After synchronization, Cluster settings will automatically align with the telephone system
settings and these fields will auto-populate.

 20. Click Save.
 21. Configure the location settings.

See "Configuring location settings for 3300 ICP media servers" on page 63.

Configuring location settings for 3300 ICP media servers
To configure location settings for a 3300 ICP media server
 1. Click the Location tab.
 2. AfterCountry, click the ... button and select the country where themedia server is located.
 3. AfterArea, click the ... button and select the appropriate area code for themedia server's location.
 4. AfterMinimum digits to dial locally, specify theminimum number of digits dialed for a local call in the

city in which themedia server is located.
 5. AfterMaximum digits to dial locally, specify themaximum number of digits dialed for a local call in

the city in which themedia server is located.
 6. AfterOutbound dialing prefix, specify the number dialed to access an outside line.
 7. Configure the data summary options for the 3300 ICP.

See "Configuring data summary options for 3300 ICP media servers" on page 63.

Configuring data summary options for 3300 ICP media servers
To configure data summary options for a 3300 ICP media server
 1. Click theData summary options tab.
 2. To generate trace reporting, select the Inbound/Outbound/Make Busy Trace reporting check box.
 3. If your business operates around the clock, select the This enterprise operates 24 hours a day check

box.
 4. To track outbound calls that were not answered, select theCredit unanswered outbound calls check

box.
 5. If you want to display when calls ring at extensions, select theMonitor Agent Ringing state check

box.
 6. AfterDigits dialed prefix, type the digits that must precede a telephone number tomake an outbound

call.
 7. AfterDigits dialed postfix, type the digits that must follow a telephone number tomake an outbound

call.
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 8. AfterMaximum MiTAI monitors, specify themaximum number of MiTAI monitors.
 9. Skip theAgent state timeout audit section. Agent state information does not apply to Call Accounting

users.
 10. UnderACD Options, to store ACD redundant events, select the File all ACD stream redundant

events check box.
 11. If you do not consider ACD real-time sequence errors as record errors, select the Ignore ACD real-

time sequence errors as record errors check box.
 12. Configure Network Monitor settings.

See "Configuring Network Monitor settings for 3300 ICP media servers" on page 64.

Configuring Network Monitor settings for 3300 ICP media servers
You can configure Network Monitor settings for 3300 ICP media servers by modifying the default alarm and
the default media server schedule, or by creating new alarms and new media server schedules.

To configure Network Monitor settings for a 3300 ICP media server
 1. Click theNetwork Monitor tab.
 2. AfterAlarm name, click the ... button.

The Select amedia server alarm window opens.
 3. Select an alarm from the list and click OK.
 4. Tomodify an existing alarm, click Manage alarms andmake any changes to the alarm's configuration.

For more information on alarm configuration options, or to create a new alarm, see "Configuringmedia
server alarms" on page 75.

 5. Tomodify a schedule for themedia server, on the Network Monitor tab, click Manage schedule and
make any changes to the schedule.
For more information on schedule configuration options, or to create a new schedule, see "Creating
schedules" on page 116.

 6. On the ribbon, click Save.
 7. Configure data collection settings for themedia server.

See "Configuring data collection settings for 3300 ICP media servers" on page 64.

Configuring data collection settings for 3300 ICP media servers
CAUTION:Selecting the TCP, EnterpriseManager (OPS Manager), or Simulation tabs will change themedia
server’s data collectionmode. Ensure that you select the tab for the appropriate data collectionmode. Be
aware that Simulationmode halts data collection and is used for demonstration purposes only. We do not
recommend you runmedia servers in simulationmode. However, if you want to simulate media server real-
time data collection and reporting, see the following prairieFyre Knowledge Base article:
http://www.prairiefyre.com/kb/KnowledgebaseArticle51207.aspx

To configure data collection settings for a 3300 ICP media server
 1. Click theData collection tab.
 2. If you do not use EnterpriseManager (OPS Manager), click TCP. Otherwise, skip to step 8.
 3. AfterSMDR, type the SMDR port number of themedia server.
 4. If you will be entering ACD information, select theACD check box.

This is optional. If you are running Call Accounting in conjunction with Contact Center Management,
you need to provide ACD information.

 5. AfterACD, type the ACD port number of themedia server.
 6. If you use Traffic Analysis, select the Traffic Analysis check box.
 7. After Traffic Analysis, type the Traffic Analysis port number of themedia server.
 8. If you use Enterprise Manager (OPS Manager), click Enterprise Manager (OPS Manager).
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 9. After IP address/DNS name, type either the IP address or the DNIS name of the Enterprise Manager
(OPS Manager) computer.

 10. After FTP port, type the FTP port number.
 11. After FTP user name, type the FTP user name to gain access to EnterpriseManager (OPS Manager).
 12. After FTP password, type the FTP password to gain access to EnterpriseManager (OPS Manager).
 13. AfterRemote directory to data files, type the directory path where the data from the telephone system

is stored by EnterpriseManager (OPS Manager).
 14. Configure themedia server's MiTAI options.

See "ConfiguringMiTAI options for 3300 ICP media servers" on page 65.

Configuring MiTAI options for 3300 ICP media servers
To configureMiTAI options for a 3300 ICP media server
 1. Click theMiTAI Options tab.
 2. AfterMaximum messages per second, select the number of messages per second from the drop-

down list.
The default number of messages is 10 per second. The higher the version of MiTAI, the greater the
number of messages per second.

 3. AfterMiTAI auto-synchronization will occur at, select the time from the list that you want Automatic
Synchronization to run.

 4. AfterSpecify the port used for the MiTAI data stream, type the port number used for theMiTAI data
stream.

 5. To enable write-back functionality, see "Enabling write-back functionality" on page 65.

Enabling write-back functionality
For changes that youmake to the configuration settings in YourSite Explorer to be written back to the
telephone switch, youmust enable the read/write option in YourSite Explorer.

NOTE: The user account must an Enterprise Administrator in Contact Center Management to have read/write
access.

To enable write-back functionality
 1. In YourSite Explorer, click YourSite=>Media servers.
 2. Select themedia server for which you want to enable read/write functionality.
 3. On the ribbon, click the Telephone System tab.
 4. In theSettings section, select Read/Write.
 5. Configure the telephone system settings for themedia server.

See "Configuring telephone system settings for 3300 ICP media servers" on page 65.

Configuring telephone system settings for 3300 ICP media servers
To configure telephone system settings for a 3300 ICP media server
 1. Click the Telephone system settings tab.
 2. Click System options.
 3. After Feature access code for silent monitoring, type the feature access code used for silent

monitoring, as programmed on the 3300 ICP telephone system.
NOTE: The feature access code for silent monitoringmust be unique and up to four digits in length. Do
not use * and # alone to define feature access codes.

 4. If applicable, afterReplacement Access Code, enter the replacement access code programmed on the
telephone system.
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 5. If applicable, afterRegistration Access Code, enter the registration access code programmed on the
telephone system.

 6. AfterACD 2000 - Automatically log out last agent on no answer, select Yes by default.
 7. AfterACD Real-Time Events Feature Level, set the value to 1.
 8. AfterACD Make Busy Walk Away Codes, select Yes by default.
 9. Click SMDR options.
 10. If applicable, correct the SMDR Options settings.

For the SMDR Options settings list, see Table 6 - 2.
 11. Click Class of Service and select a Class of Service number.

The properties for the selected Class of Service are shown in the right-hand pane.
 12. AfterDefault type, enter the Class of Service type.
 13. AfterComment, enter a description for the Class of Service.
 14. Select Yes for the following Class of Service options:

l HCI/CTI/TAPI call control allowed
Selecting Yes enables the softphone extensions and IVR Routing ports to be controlled by the
host computer.

l HCI/CTI/TAPI monitor allowed
Selecting Yes enables an HCI monitor to be initiated against softphone extensions and IVR
Routing ports.

l SMDR external
Selecting Yes enables trunking SMDR.

l SMDR internal
Selecting Yes enables SMDR internal records to be generated.

 15. AfterCall forward delay, enter the amount of time to wait before forwarding a call.
 16. AfterCall forward no answer timer, enter the amount of time to wait for a forwarded call to be

answered.
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 17. Select Yes orNo for the following additional Class of Service options:
NOTE:Youwill receive a warning in YSE if you choose a Class of Service option that is not
recommended.

l Message waiting
This option permits a phone to enable and disable message waiting notification on another phone.

l Message waiting audible tone notification
This option enables message waiting notifications to take the form of a tone every time the phone
goes off-hook.

l Do not Disturb
This option enables users to change their Do not Disturb status and prevents the phone from
ringing on incoming calls.

l Do not Disturb permanent
This option sets the phone permanently in Do not Disturb.

l Public network access via DPNSS
This option enables devices to originate calls to directory numbers on the PSTN. Selecting “No”
disables network access.

l Suppress simulated CCM after ISDN progress
This option prevents the PBX from sending an answermessage to a party calling on an ISDN
trunk, preventing systems usingMiTAI or HCI to play ringback or call processing tones when the
call is answered.
NOTE:Enable this option on end nodes only. Do not enable this option on transit nodes.

l Recorded announcement device
This option enables RAD ports to play recordedmessages for one-way, outgoing audio.

l Accept hot desk login
This option enables a hot desk login on a device.

l Voice mail port
This option enables the voicemail system to uniquely identify the party that is receiving a
message.

l External hotdesk user – answer confirmation
This option forces an external hotdesk user to press a DTMF key to answer incoming calls.

 18. AfterAnswer Plus Message Length Timer, specify an amount of time to apply to MCD RAD
messages. The time specified should equal the time it takes for the RAD message to play.

 19. AfterAnswer Plus Expected Off-hook Timer, specify the amount of time the RAD can be off-hook
and not playingmessages before it requires servicing and is removed.

 20. Click Class of Restriction.
 21. Select a Class of Restriction.

The properties for the selected Class of Restriction are shown in the right-hand pane.
 22. AfterDo you want this Class of Restriction to be the default setting?, select Yes orNo.
 23. AfterClasses of Restriction for the group, enter the Class of Restriction numbers to include in the

group.
Youmay specify a range of numbers. Separate numbers using dashes or commas. For example, 1
though 9may be entered as 1-9, or a combination of individual numbers and ranges may be entered as
1,2,3,7-10,13.
NOTE:Class of Restriction numbers must be entered in ascending order within each group.

 24. On the ribbon, click Save.
 25. If you want to enable call recording, see "Call recording" on page 69.
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Table 6 - 2 SMDR Option Settings

SMDR Option Value

Extended digit length Yes

MCD - Report transfers All

Network format Yes

Report Account Codes Yes

Report incoming calls Yes

Report internal calls Yes

Report meter pulses No

Report outgoing calls Yes

SMDR record transfer Yes

System identification Yes

Time change report Yes

24-hour time reporting Yes

ANI/DNIS/ISDN/CLASS number delivery reporting Yes

OLI node ID format for incoming trunk calls

Extended time to answer Yes

Standardized network OLI Yes

Standardized call ID format Yes

Suite services reporting No

Report internal unanswered calls No

SMDR extended reporting level 1 Yes

SMDR extended reporting level 2 Yes

Report attendant name Yes

Account Code number for internal calls Yes

Path reporting number for internal ACD2 calls Yes

SMDR Meter Unit Per Station No
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Call recording
Call Accounting offers 24/7 call recording by integrating with OAISYS Tracer (Version 6.2 or greater) or
dvsAnalytics Encore (Version 2.3 or greater) call recording software. For enhanced call security, Call
Accounting also integrates with theMitel Secure Recording Connector service to facilitate the recording of
Mitel encrypted voice streams by third party software. OAISYS Tracer can optionally be used in conjunction
with theMitel Secure Recording Connector service. dvsAnalytics Encoremust be used in conjunction with
theMitel Secure Recording Connector service.

Configuring call recording integration
Using the OAISYS Tracer, Call Accounting can optionally record calls based on pre-defined schedules. With
OAISYS Tracer, call recording can be temporarily started or stopped in Contact Center Client to ensure
customer confidentiality or to create a record of volatile or sensitive calls. See "Recording calls" on page 236.

When a call recording is complete, a hyperlink to the recording is appended to call-specific Lifecycle reports.
See theMitel Call Accounting Reports Guide for more information about Lifecycle reporting.

NOTE:
l OAISYS Tracer or dvsAnalytics Encore call recording integration is supported for use with theMitel

3300 ICP only.
l Before you can configure call recording in YourSite Explorer, youmust configure your OAISYS Tracer

or dvsAnalytics Encore by following the recommended installation and configuration guidelines
included with these products.
Contact your OAISYS or dvsAnalytics approved vendor for all set up and troubleshooting issues.

l Contact OAISYS or dvsAnalytics for information on integrating call recording with theMitel Secure
Recording Connector.

l Ensure call recordings are working properly for all configured extensions before activating the call
recording integration in YourSite Explorer.

l If you use theMitel Secure Recording Connector and Contact Center Softphone, youmust enter the IP
addresses of theMitel Secure Recording Connector in YourSite Explorer.

To configure OAISYS call recording integration
 1. In YourSite Explorer, underEnterprise, click Media servers.
 2. Select amedia server from the list.
 3. Click theCall recording options tab.
 4. UnderCall recording provider options

l AfterRecorder type, select OAISYSfrom the drop-down list.
l AfterOAISYS server address, type the IP address of the call recorder.
l AfterOAISYS server port, specify the port of the call recorder.
l AfterUsername, type the username to log into the call recorder.
l AfterPassword, type the password to log into the call recorder.

 5. Click Save.
Call recordings are enabled and can be accessed from hyperlinks in call-specific Lifecycle reports.
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To configure dvsAnalytics Encore
 1. In YourSite Explorer, underEnterprise, click Media servers.
 2. Select amedia server from the list.
 3. Click theCall recording options tab.
 4. UnderCall recording provider options

l AfterRecorder type, select dvsAnalytics Encore from the drop-down list.
l AfterEncore Web API address, type http://<Encore Server IP address>/WebAPI/ECAPI.svc

 5. Click Save.
Call recordings are enabled and can be accessed from hyperlinks in call-specific Lifecycle reports.

Configuring the Mitel Secure Recording Connector service
Call Accounting integrates with Mitel Border Gateway’s Secure Recording Connector service, which
facilitates the recording of Mitel encrypted voice streams by third-party call recording equipment. In order to
use Contact Center Softphone in conjunction with theMitel Secure Recording Connector service, youmust
complete the configuration process described below.

NOTE:
l Before you can configure call recording in YourSite Explorer, youmust configure the Secure Recording

Connector service in Mitel Border Gateway. For Mitel Border Gateway configuration information, see
theMitel Border Gateway Installation andMaintenanceGuide.

l If multiple Mitel Border Gateways are used in a clustered environment to take advantage of load
balancing and the soft phone is connected to the primary Secure Recording Connector when that
connector goes offline, the soft phone will re-connect as determined by the cluster. New soft phones
will attempt to connect to the first Mitel Border Gateway configured in YourSite Explorer, then try the
secondMitel Border Gateway configured in YourSite Explorer and as a final attempt, try registering with
themedia server itself. If it registers with themedia server, call recording will not be possible.

For soft phone balancing in a Secure Recording Connector service environment to function properly,
youmust alter a configuration file on theMitel Border Gateway server. If you do not, you will have to
restart Contact Center Client and the soft phone in the event of a failover. For instructions on how to
make alterations, contact prairieFyre Software Inc. Technical Support at 613-599-0045 or
support@prairiefyre.com (North American customers). For customers residing in Latin America,
Europe, theMiddle East, Africa, and Asia Pacific, contact your approvedMitel vendor.

To configure the Secure Recording Connector service
 1. In YourSite Explorer, underEnterprise, click Media servers.
 2. Select a 3300 ICP media server from the list.
 3. Click theCall recording options tab.
 4. UnderMitel Secure Call Recording, after IP address 1, type the primary IP address of the Secure

Recording Connector.
 5. If you usemultiple Secure Recording Connectors, type the IP address of the secondary Secure

Recording Connectors after IP address 2.
If the soft phone fails to connect to the primary Secure Recording Connector, it will attempt to connect
to the secondary. If that fails, then soft phone will use the IP address of themedia server programmed
in the data collection field. If it uses the IP address of themedia server, call recording will not be
possible.

 6. Click Save.
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Adding SX-200 Call Accounting media servers
You add an SX-200 Call Accountingmedia server in the Contact Center Management website.

Youmust first add the SX-200, and then configure its data collection settings, data summary options, and
Network Monitor settings.

To add an SX-200 Call Accountingmedia server
 1. In Contact Center Management, click YourSite=>Enterprise.
 2. Click Add media server=>SX-200 ACD/Call Accounting.

NOTE: To distinguish between the various types of media for management and reporting purposes, you
must give eachmedia server a distinct namewhen setting up your site.

 3. AfterName, type the name of themedia server.
TheMedia server ID field will be populated with a unique number after themedia server has been
saved.

 4. AfterSite, select the site where themedia server resides.
 5. After This media server is installed on the computer you named, select the computer on which the

media server is installed.
CAUTION: The following four steps determine location information in your reports. Ensure these steps
are accurately configured to ensure accurate reporting.

 6. AfterCountry, select the country where themedia server is located.
If you are setting up a node, select the country in which the node is located.

 7. AfterArea, select the area where themedia server is located.
If you are setting up a node, select the area in which the node is located.

 8. AfterMinimum digits dialed, type theminimum number of digits dialed for a local call in your city.
 9. AfterMaximum digits dialed, type themaximum number of digits dialed for a local call in your city.
 10. AfterApply license for, select the product to which you are applying a license.

For example, select Call Accounting if you are applying a Call Accounting license. If you are not
licensed for a product the check box for that product does not show. If you have no remaining licenses,
although the check box still shows, an error message indicates that all available licenses have been
used.

 11. Configure the data collection settings.
See "Configuring data collection settings for SX-200 Call Accountingmedia servers" on page 71.

Configuring data collection settings for SX-200 Call Accounting media
servers
To configure data collection settings for an SX-200 Call Accountingmedia server
 1. Click theData collection tab.
 2. If themedia server streams SMDR data over RS-232, underSpecify data collection settings, click

Com port. Otherwise, skip to step 4.
 3. Accept the default SMDR settings for Com port, baud rate, data bits, parity bit, and stop bits. Skip to

step 10.
 4. If themedia server streams SMDR data over RS-232, click TCP. Otherwise, skip to step 7.
 5. Click IP address, orDNS, and type the IP address, or name, of the collection point.
 6. AfterSpecify ports, type the SMDR port number of the telephone system.

NOTE:Youmust select the Traffic Analysis check box to enable data collection.
 7. If you have clustering, select the This media server is part of a Mitel cluster check box.
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 8. AfterCluster ID, type the cluster ID.
 9. AfterCluster name, type the cluster name.
 10. Configure the data summary options.

See "Configuring data summary options for SX-200 Call Accountingmedia servers" on page 72.

Configuring data summary options for SX-200 Call Accounting media
servers
To configure data summary options for an SX-200 Call Accountingmedia server
 1. Click theData summary options tab.
 2. To generate trace reporting, select the Inbound/Outbound/Make Busy Trace reporting check box.
 3. If your business operates around the clock, select the This enterprise operates 24 hours a day check

box.
 4. If you want to To track outbound calls that were not answered, select theCredit unanswered

outbound calls check box.
 5. If you want reports andmedia servers to have a 24-hour clock format (for example, if you want 1:00 P.M.

to show as 13:00), select the 24-hour clock format check box.
 6. Skip theAgent state timeout audit section. Agent state information does not apply to Call Accounting

users.
 7. If your telephone system outputs leading digits in SMDR, afterPrefix digits, type the digits.
 8. If your telephone system outputs trailing digits in SMDR, afterPostfix digits, type the digits.
 9. Configure Network Monitor settings.

See "Configuring Network Monitor settings for SX-200 Call Accountingmedia servers" on page 72

Configuring Network Monitor settings for SX-200 Call Accounting media
servers
To configure Network Monitor settings for an SX-200 Call Accountingmedia server
 1. Click theNetwork Monitor tab.
 2. AfterAlarm name, select an alarm.
 3. If youmust create or modify an alarm that will warn you if data is not being collected for this media

server, click Manage alarms and configure an alarm.
See "Configuringmedia server alarms" on page 75.

 4. UnderNotify me during these business hours, afterSchedule name, select a schedule that reflects
the hours of operation for themedia server.

 5. If youmust create or modify a schedule for themedia server, click Manage schedule and configure a
schedule.
See "Creating schedules" on page 116.

 6. Click Save.

Adding 5000/Axxess media servers
You add 5000/Axxess media servers in YourSite Explorer.

Youmust first add the 5000/Axxess media server and then configure its location settings, data summary
options, data collection settings, and Network Monitor settings.

NOTE: To ensure optimal functionality, we recommend you perform Full Synchronization as part of adding
and configuring amedia server in YourSite Explorer. For more information on synchronization, see
"Configuring the YourSite database using synchronization" on page 77. For information on performing
synchronization, see "Performing synchronization" on page 80.
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To add a 5000/Axxess media server
 1. InYourSite Explorer, click Media servers.
 2. Click Add=>5000/Axxess.

NOTE: To distinguish between the various types of media for management and reporting purposes, you
must give eachmedia server a unique namewhen setting up your site.

 3. AfterName, type the name of themedia server.
NOTE: The typical media server type is ‘Enterprise Node’. If you select ‘Queueing gateway’, no agent
data will be filed to SQL. If you select ‘Agent/extension gateway’, no queue data will be filed to SQL.
When amedia server is configured as an ‘Agent/extension gateway’, no queues are loaded and, as a
result, no call activity is displayed in the Interactive Visual Queue real-timemonitor.

 4. AfterSite, select the site where themedia server resides.
 5. AfterComputer name, select the computer where the server resides.
 6. AfterMedia server type, select the type of media server.
 7. Specify the licenses to use for themedia server.

For example, select Call Accounting if you are applying a Call Accounting license. If you are not
licensed for a product the check box for that product does not show. If you have no remaining licenses,
although the check box still shows, an error message indicates that all available licenses have been
used.

 8. After IP/DNS address, specify the IP address of themedia server.
If you use a CT Gateway, the IP address entered in this field must be the IP address of the CT
 Gateway and not that of themedia server.

 9. AfterPassword, type the password used to connect to the telephone system.
 10. AfterConfirm password, type the password used to connect to the telephone system.
 11. If the 5000/Axxess is connected to a CT Gateway, underGateway settings, select This media server

belongs to a gateway and specify the Gateway ID.
 12. Click Save.
 13. Configure the location settings.

See "Configuring location settings for 5000/Axxess media servers" on page 73 .

Configuring location settings for 5000/Axxess media servers
To configure location settings for a 5000/Axxess media server
 1. Click the Location tab.
 2. AfterCountry, select the country where themedia server is located.

If you are setting up a node, select the country in which the node is located.
 3. AfterArea, select the area where themedia server is located.

If you are setting up a node, select the area in which the node is located.
 4. AfterMinimum digits to dial locally, type theminimum number of digits dialed for a local call in your

city.
 5. AfterMaximum digits to dial locally, type themaximum number of digits dialed for a local call in your

city.
 6. AfterOutbound dialing prefix, the number you dial to access an outside line.

This information is required if you use a general business model and want to view when phone
extensions are active or inactive.

 7. Configure the data summary options.
See "Configuring data summary options for 5000/Axxess media servers" on page 74.
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Configuring data summary options for 5000/Axxess media servers
To configure data summary options for a 5000/Axxess media server
 1. Click theData summary options tab.
 2. If you want to use Trace reporting, select the Inbound/Outbound/Make Busy Trace reporting.
 3. If your business operates around the clock, select the This enterprise operates 24 hours a day check

box.
NOTE: If you do not select the This enterprise operates 24 hours a day check box, but have agents
logged in to Contact Center Solutions applications overnight, youmay experience problems with shift-
related statistics, such as agent shift monitor andMake Busy Reason codes. For example, if logged in
to Contact Center Client overnight with aMake Busy Reason code, when you change theMake Busy
Reason code the following day, Contact Center Client will display “UnknownMake Busy code.” This
can be remedied by logging out of the application and logging back in.

 4. If you want to track outbound calls that were not answered, select theCredit unanswered outbound
calls check box.

 5. AfterDigits dialed prefix, type the digits that must precede a telephone number tomake an outbound
call.

 6. AfterDigits dialed postfix, type the digits that must follow a telephone number tomake an outbound
call.

 7. AfterMaximum monitors, specify themaximum number of MiTAI monitors.
 8. Skip theAgent state timeout audit section. Agent state information does not apply to Call Accounting

users.
 9. UnderACD options, if you want to file all ACD stream redundant events, select the File all ACD

stream redundant events check box.
 10. If you want to ignore data stream sequence number errors, select the Ignore stream sequence

number errors.
 11. Configure the data collection settings.

See "Configuring data collection settings for 5000/Axxess media servers" on page 74.

Configuring data collection settings for 5000/Axxess media servers
To configure data collection settings for a 5000/Axxess media server
 1. Click theData collection tab.
 2. AfterOAI Listening Port, specify the port number.

The default Listening Port is 4000.
 3. Specify the Network Monitor settings.

See "Configuring Network Monitor settings for 5000/Axxess media servers" on page 74.

Configuring Network Monitor settings for 5000/Axxess media servers
To configure Network Monitor settings for a 5000/Axxess media server
 1. Click theNetwork Monitor tab.
 2. AfterAlarm name, select an alarm.
 3. If youmust create or modify an alarm that will warn you if data is not being collected for this media

server, click Manage alarms and configure an alarm.
See "Configuringmedia server alarms" on page 75.
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 4. UnderNotify me during these business hours, afterSchedule name, select a schedule that reflects
the hours of operation for themedia server.

 5. If youmust create or modify a schedule for themedia server, click Manage schedule and configure a
schedule.
See "Creating schedules" on page 116.

 6. Click Save.

Deleting media servers
CAUTION: If you delete amedia server, you will delete all of the devices associated to themedia server.

To delete amedia server in YourSite Explorer
 1. InYourSite Explorer, click Media servers.
 2. Select themedia server you want to delete.
 3. Click Delete.

A window opens with themessage “All of the data associated with this media server will be
permanently deleted. Are you sure you want to delete this media server?”

 4. Click OK.

To delete amedia server in the Contact Center Management website
 1. In Contact Center Management, click YourSite=>Enterprise.
 2. Expand the Enterprise tree and select themedia server to be deleted.
 3. Click Delete.

A window opens with themessage “All of the data associated with this media server will be
permanently deleted. Are you sure you want to delete this media server?”

 4. Click OK.

Network Monitor alarms
In YourSite Explorer, you can configure one or more data alarm schedules for your media servers. You specify
the days and times during which data alarms will be activated. For those days and times, the system will
notify you if the Enterprise Server Collector Service is not receiving data from your media servers, or if the
server disk space is low. The Low Disk Threshold setting detects if the disk space is low on the disk housing
the text files and SQL database. If the disk space is less than the threshold you specify, the system sets off
an alarm.

In Network Monitor, you can verify if alarms are enabled for your media servers and if themedia servers are
reporting any alarms. The Network Monitor icon in your system tray is marked with a red line and blinks when
the system is reporting alarms.

Youmust configure Network Monitor alarms for SX-200media servers in the Contact Center Management
website. You configure Network Monitor alarms for 3300 ICP, 5000, and Axxess media servers in YourSite
Explorer.

Configuring media server alarms
In YourSite Explorer or in the Contact Center Management website, you set the days and times during which
data alarms will be activated and a threshold for low disk space. The Collector Service adheres to the settings
you specify.
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To configure amedia server alarm in YourSite Explorer
 1. InYourSite Explorer, click Media server alarms.
 2. Click Add.
 3. AfterName, type the name of themedia server alarm.
 4. AfterSchedule, click ... and select the schedule that reflects the company’s hours of operation.

The schedulemust accurately reflect the hours and days of the week the business is open and data is
being received somedia server alarms are not activated after hours.

 5. After Low disk threshold, select the value in MB for the threshold below which you want themedia
server alarm to be activated. (For example, select 50. An alarm will be activated when the disk space is
less than 50MB).

 6. If you want to automatically restart the data ports in the event Collector Service detects a problem with
the Com ports, enable theAuto restart data ports check box.

 7. After Data alarm timeout minutes, select the duration of the time lapse inminutes from when the data
stops streaming to when you want the alarm to display.
This setting relates to the SMDR Data timeout and ACD Data timeout Network Monitor alarms.
NOTE: In a resilient environment, SMDR and ACD Data timeout alarms may trigger unnecessarily. To
prevent this, set Data alarm timeout minutes to zero.

 8. Click Save.

To configure amedia server alarm in the Contact Center Management website
 1. In Contact Center Management, click YourSite=>Network Monitor=>Configure alarms.

The Configure alarms window displays.
 2. Click Add.
 3. AfterName, type the name of themedia server alarm.
 4. AfterSchedule, select the schedule that reflects the company’s hours of operation.

The schedulemust accurately reflect the hours and days of the week the business is open and data is
being received somedia server alarms are not activated after hours.

 5. After Low disk threshold, select the value in MB for the threshold below which you want themedia
server alarm to be activated. (For example, select 50. An alarm will be activated when the disk space is
less than 50MB).

 6. If you want to automatically restart the data ports in the event Collector Service detects a problem with
the Com ports, select theAuto restart data ports check box.

 7. After Data alarm timeout minutes, select the duration of the time lapse inminutes from when the data
stops streaming to when you want the alarm to display.
This setting relates to the SMDR Data timeout and ACD Data timeout Network Monitor alarms.
NOTE: In a resilient environment, SMDR and ACD Data timeout alarms may trigger unnecessarily. To
prevent this, set Data alarm timeout minutes to zero.

 8. Click Save.

Network Monitor alarms
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Configuring YourSite database devices
You can configure the YourSite database in the following ways:

l Synchronization
If you have a 3300 ICP, 5000, or Axxess, you can synchronize the YourSite database with the trunks
and extensions programmed on the telephone system using Synchronization. You can perform
Synchronization on individual telephone systems or all telephone systems in your enterprise.
See "Configuring the YourSite database using synchronization" on page 77.

l Active Directory synchronization
If you specified theWindows Authenticationmodel during the Contact Center Management / Call
Accounting ConfigurationWizard, you can synchronize your system with Active Directory at any time
from within YourSite Explorer. When you run Active Directory synchronization, employees in YourSite
Explorer are synchronized with users in Active Directory groups. If you useWindows Authentication
and Active Directory synchronization, users will not be prompted to authenticate themselves with a
username and password when they start Contact Center Solutions and Call Accounting applications.

l Quick Setup
To add a range of employees, extensions, trunks, DNIS numbers, and Account Codes, you can use
Quick Setup to configure your system.
See "Configuring devices and device groups using Quick Setup" on page 86.

l Manual configuration
If you have the SX-200 youmust configure your systemmanually.
See "Configuring devices manually" on page 94.

Configuring the YourSite database using synchronization
Synchronization functionality differs depending on the telephone system in use.

Synchronization for the 3300 ICP
YourSite Explorer enables you to configure and write 3300 ICP queues, agent skill groups, and agents
(including skill level), and validate/edit contact center related Class of Service, Class of Restriction, System
Options, and SMDR Options settings using synchronization.

During synchronization, the queues, agent skill groups, and agents configured in YourSite Explorer are written
to the telephone system. This enhanced functionality enables you to configure Contact Center Solutions
applications from your desktop. Validation of device and assignment form settings ensures quality data
collection and accurate reporting. After running synchronization, Class of Service and Class of Restriction
settings programmed in the telephone system can be edited in YourSite Explorer.

During synchronization, administrators can preview device changes, identify devices that should be excluded
from synchronization, andmanage the business rules related to synchronization of device names and
associated device creation.

While synchronizing data, the telephone system continues to operate without experiencing downtime. After
synchronization is complete, the Contact Center Client applications open on agent desktops will be refreshed
with a device update. After synchronization is complete, all critical programming, such as SMDR Options,
System Option, Class of Service, and Class of Restriction settings will be validated. A report is then
generated to summarize the results of synchronization. We highly recommend that you correct invalid
programming, as detailed on the Telephone system settings tab of media servers in YourSite Explorer,
immediately.
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In Mitel 3300 releaseMCD 4.0 SP2, configuring your network using SDS Directory synchronizationmode is
optional. Customers can continue to operate in the Classic mode, with OPS Manager if operating in a
clustered environment. In Mitel 3300 releaseMCD 4.1, configuring your network using SDS Directory
synchronizationmode is mandatory for all sites operating with 20 nodes or less.

Classic mode synchronization
Using YourSite Explorer and the 3300 ICP in Classic mode, you can add, edit, and delete standard agents,
agent groups, and queues, as well as ACD related Class of Service (COS), Class of Restriction (COR),
SMDR Options, and System Options. When not in a clustered environment, you can also continue to add hot
desk agents and all synchronization device names. Adding hot desk agents in a clustered environment
requires the use of Mitel OPS Manager.

SDS Directory synchronization mode
Using YourSite Explorer and the 3300 ICP in SDS Directory synchronizationmode, you can now add, edit and
delete standard and hot desk agents, agent groups, queues, trunks, trunk groups, and extensions,
synchronize device names, as well as ACD related Class of Service (COS), Class of Restriction (COR)
SMDR options and System Options in both a single site and in a clustered environment. When operating in
SDS Directory synchronizationmode, you can configure Network ACD queue set up on the 3300 ICP without
any manual configuration previously required usingMitel OPS Manager.

NOTE:
l You can only use synchronization to synchronize the YourSite database with resilient, Network ACD,

and clustered telephone systems if you are using 3300 ICP ReleaseMCD 4.0 SP2 or greater, with the
SDS Directory synchronization option enabled on all of the telephone systems in your enterprise.

l If you edit the feature access code used for silent monitoring on themedia server, youmust also
manually edit the feature access code on the telephone system. The feature access code entered in
YourSite Explorer must be identical to that on the telephone system and be valid for use with silent
monitoring.

l Intelligent Queue port settings are not programmed during synchronization.

Synchronization for the 5000 and Axxess
If you have a 5000 or Axxess, you can synchronize the YourSite database with the queues, agents, agent
groups, extensions, Do Not Disturb Reason codes, and trunks programmed on the telephone system using
synchronization.

NOTE: The device write-back functionality available in YourSite Explorer for the 3300 ICP is not currently
available for the 5000 and Axxess telephone systems.

During synchronization, queues, agents, extensions, Do Not Disturb Reason codes, and trunks programmed
on the 5000 or Axxess will be synchronized with the YourSite database. Reporting numbers for queues and
agent groups will be automatically generated during synchronization.

NOTE: If agents, queues, and extensions on the telephone system have the same reporting or dialable
number as the devices programmed in the YourSite database, but they do not have the same name,
synchronization will change the name of the device in the YourSite database tomatch the name of the device
on the telephone system.

For Network ACD environments, synchronization looks for agents configured in the cluster. If not found,
agents are added to themedia server being synchronized. Once agents are created, or matches are found,
agent group associations are synchronized for those agents. Agent name changes are only synchronized for
the agent's primary media server. Name changes found on other telephone systems are ignored.
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While synchronizing data, the telephone system continues to operate without experiencing downtime. After
synchronization is complete, the Contact Center Client applications open on agent desktops will be refreshed
with a device update. After synchronization is complete, all critical programming will be validated. A report is
then generated to summarize the results of synchronization. We highly recommend that you correct invalid
programming, as detailed in the report, immediately.

Preparing for synchronization
NOTE:

l Superset phones are not currently supported for synchronization. See theMitel Contact Center
Solutions and Call Accounting System Engineering Guide for a list of devices that are supported for
synchronization.

l Only Mitel telephones that are programmed on the IP Multiline set assignment form will synchronize
with the YourSite database. For details on the phones that are supported, please refer to your Mitel
3300 ICP documentation.

Before you perform synchronization for the 3300 ICP
l Ensure the 3300 ICP is V8.x or greater. You can only use synchronization to synchronize the YourSite

database with resilient, Network ACD, and clustered telephone systems if you are using 3300 ICP
ReleaseMCD 4.0 SP2 or greater, with the SDS Directory synchronization option enabled on all of the
telephone systems in your enterprise.

l Ensure that you have completed programming the 3300 ICP and created a username and password for
synchronization (on the 3300 ICP User Authorization Profile form). The 3300 ICP User Authorization
Profile must include Application Access and System Admin Access. Desktop Admin andGroup Admin
options can be disabled. These steps must be completed for all 3300 ICPs in your Enterprise.

l Ensure your MiXML service is started by navigating to the Control Panel inWindows and selecting
"MiXML". Verify that port 18000 is entered on the Settings tab and click Start.

l Ensure that yourWindows or Corporate firewall is not blocking the following ports
l SOAP: 18000 (HTTPS)
l UDP: 53
l TCP: 7011
l TCP: 22
l TCP: 443 (SSH)

l Configure the user name and password for each of the 3300 ICP media servers in YourSite Explorer.
See theCall Accounting Installation Guide.

l If you havemultiple NICs on your Enterprise Server, youmust specify the NIC to use for synchronizing
data to the telephone system. To do this, navigate to the Control Panel inWindows and select
"MiXML". After NIC IP Address specify the primary NIC to be used to send back data to the telephone
system.

l If you are running 3300 ICP Release 9.x or earlier, resilient Network ACD, and clustered telephone
systems must be programmed using OPS Manager, RDNs, and cluster element IDs. 3300 ICPs
programmedwith Remote Agent Subgroups and ARS are not supported. Contact Center Management
clusters and cluster element IDs must match what is programmed on the telephone system.

Before you perform synchronization for the 5000 and Axxess
l If you have a 5000, ensure it is Version 2.20 or greater. If you have an Axxess, ensure it is Version

10.00 or greater.
l Ensure that you have programmed anOAI IP address and port number on the 5000/Axxess.
l If there is a firewall between your Enterprise Server and the 5000/Axxess, ensure that yourWindows or

corporate firewall is not blocking port 4000 (TCP).
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Specifying synchronization settings
YourSite Explorer enables you to specify the synchronization settings, read options, and write options used
by synchronization. When you select amedia server in YourSite Explorer, the following synchronization
options are available from the ribbon, on the Telephone system tab:

l Settings
l Disabled
This option will fully disable synchronization.

l Read
This option will read devices programmed on your telephone systems and synchronize them with
the YourSite database.

l Read/Write
This option will read the devices programmed on your telephone systems and synchronize them
with the YourSite database and enable devices programmed in YourSite Explorer to be written to
the telephone systems.

l Read Options
l Create employees with new agent
For every new agent added to the YourSite database, a new employee will be created and
associated with the agent.

l Create employees with new extensions
For every new extension added to the YourSite database, a new employee will be created and
associated with the agent.

l Use telephone system device names
Override device names programmed in YourSite Explorer with the device names configured on
the telephone system.

l Default employee license
The default employee license for Call Accounting only customers is None.

l Write Options
l Update telephone directory names
Override telephone directory names with agent, agent group, queue, and extension names
configured in YourSite Explorer.

Performing synchronization
There are two ways to perform synchronization:

l Full synchronization
Running full synchronization will synchronize the devices programmed on the telephone system and
enable you to review all devices, and optionally exclude any devices, before committing changes to
YourSite Explorer.

l Telephone system settings synchronization
Running telephone system settings synchronization will read the current telephone system settings
and enable you to view any errors or warnings related to the telephone system configuration.
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NOTE:
l You can only use synchronization to synchronize the YourSite database with resilient, Network ACD,

and clustered telephone systems if you are using 3300 ICP Release 10.0 (MCD 4.0 SP2) or greater,
with the SDS Directory synchronization option enabled on all of the telephone systems in your
enterprise.

l As a best practice, we recommend all new installations run Full synchronization to ensure the
telephone systems in your enterprise are synchronized with the YourSite database and that there are no
critical telephone system programming errors.

l Youmust program your 3300 ICPs and perform synchronization before you can configure telephone
system assignment form options in YourSite Explorer.

l We recommend you do not exchange the reporting number of one device with that of another device.
l Synchronization will not synchronize a device being added to the YourSite database with the telephone

system if the device has the same reporting number as an existing device with a different dialable
number.

l If you run synchronization for a 3300 ICP media server containing a queue that has not been configured
in YourSite Explorer a default 24/7 business hour schedule will be applied to that queue.

l If you are synchronizing a single telephone system, agents and queues must be programmed on the
same telephone system. Single node synchronization can disassociate agents and queues if agents
and queues reside on separate telephone systems.

l If you are running 3300 ICP Release 9.x or earlier and you synchronized your network ACD
assignments and/or resilient agents using OPS Manager, youmust synchronize all of the 3300 ICPs in
your enterprise. Otherwise, agent group and queue group associations will be lost.

To perform full synchronization
 1. In YourSite Explorer, underEnterprise, click Media servers.
 2. Select a 3300 ICP or a 5000/Axxess media server from the list.
 3. Click the Telephone system tab.
 4. In the ribbon, specify the settings to use with synchronization.

See "Specifying synchronization settings" on page 80.
 5. In the ribbon, click Run.

The Synchronization window opens.
 6. Select themedia servers to synchronize.
 7. Ensure Full synchronization is selected.
 8. If this is the first time you have run synchronization, click Synchronize and continue to step 11. If you

have already run full synchronization, click Next.
 9. Optionally, select the telephone systemmedia servers and devices to include with synchronization.

All media servers and devices are selected by default.
 10. Specify how you would like to proceed with synchronization:

l Synchronize—selecting this option will synchronize the devices programmed on the telephone
system and enable you to review all entries and optionally exclude any devices before committing
them to YourSite Explorer. If you select this option, continue to step 11.

l Save settings—selecting this option will save the device settings you specified to be used for the
next scheduled or on-demand synchronization. If you select this option, the synchronization window
will close.

l Cancel—selecting this option will cancel the synchronization. No changes will bemade to YourSite
database or the telephone systems. If you select this option, the synchronization window will close.

l Auto commit—selecting this option and clicking Synchronize will synchronize the devices
programmed on the telephone systems and automatically commit them to YourSite Explorer. There
will be no opportunity for you to review the entries and optionally exclude any devices before
committing them to YourSite Explorer.
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 11. When the synchronization report displays, you have the following three options:
l Commit—selecting this option will commit the specified changes and synchronize telephone

system devices with YourSite Explorer.
l Cancel—selecting this option will cancel the specified changes. No devices will be synchronized

and the synchronization window will close.
l Edit—selecting this option will rerun synchronization and enable you tomodify the devices to be

included in synchronization. If you select this option, return to step 9.
If this is the first time you have run synchronization, any telephone system errors and warnings will
display in the synchronization report. You can correct any errors or warnings found in this report by
clicking Edit, clicking the Telephone system settings tab and changing the telephone systems settings
to the recommended settings. If this is not the first time you have run synchronization, the
synchronization window will close once it is complete and you can review any telephone system
setting errors and warnings on by selecting amedia server in YourSite Explorer and clicking the
Telephone system settings tab.

To perform telephone system synchronization
 1. In YourSite Explorer, underEnterprise, click Media servers.
 2. Select a 3300 ICP or a 5000/Axxess media server from the list.
 3. Click the Telephone system tab.
 4. In the ribbon, specify the settings to use with synchronization.

See "Specifying synchronization settings" on page 80.
 5. In the ribbon, click Run.

The Synchronization window opens.
 6. Select themedia servers to synchronize.
 7. Ensure Telephone system settings is selected.
 8. Click Synchronize.

The Synchronization report window will open and display the progress and status of the
synchronization. Once synchronization is complete, any telephone system errors and warnings will
display in the synchronization report. You can correct any errors or warnings found in this report by
clicking Edit, clicking the Telephone system settings tab and changing the telephone systems settings
to the recommended settings.

Viewing Synchronization reports
NOTE: The Synchronization report is currently available in English only.

To view a Synchronization report
 1. In Contact Center Management, click Tools=>Administrative tools=>Administrative reports.
 2. AfterStatus, click View.

Understanding Synchronization reports
After you perform Synchronization, a report summarizing the results of the synchronization is generated. The
Synchronization report contains a synchronization summary, synchronization details, validation results, and
any warnings and errors. Table 6 - 3 describes the information provided in the Synchronization report.
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Table 6 - 3 Synchronization report overview

Contents Description

Synchronization
Summary

For eachmedia server in your enterprise, the number of devices added and updated are
listed.

A license summary is also included in the Synchronization Summary section of the
Synchronization report. The License Summary lists the number of employee licenses
added and the number of licenses that remain. If you have exceeded the number of
employee licenses you currently own, a warning will be displayed and you will be
instructed to resolve the problem.

Synchronization
Details

The Synchronization Details section of the Synchronization report lists specific details
that pertain to the devices added and updated, or associations made or deleted during
the synchronization.

Validation
Results

The Validation Results section of the Synchronization report lists any system and
device level warnings and any critical programming errors.

Warnings

TheWarnings section of the Synchronization report lists any non-critical warnings that
may have affected the results of the synchronization process. We highly recommend
that you immediately correct any invalid programming that may have caused warnings
to display.

Errors

The Errors section of the Synchronization report lists any critical errors that would have
prevented synchronization from occurring. If critical errors are detected, the
Synchronization report will display theWarnings and Errors sections of the report only.
We highly recommend you immediately correct any invalid programming that may have
caused the error, to ensure your contact center functions properly.

Subscribing to the Synchronization report RSS feed
You can subscribe to a Really Simple Syndication (RSS) feed using a RSS aggregator of your choice (for
example, Microsoft Outlook or Internet Explorer), so you are informed every time a Synchronization report is
generated. RSS enhances management productivity because you can automatically receive reports without
having to browse to the Administrative Reports inbox in Contact Center Management.

To subscribe to the Synchronization report RSS feed
 1. In Contact Center Management, click Tools=>Administrative tools=>Administrative reports.
 2. Click Access RSS feed.
 3. Click Subscribe to this feed.
 4. Follow the steps required by your RSS aggregator to subscribe to the Synchronization report feed.

NOTE:When you browse to a webpage that contains RSS information, the orange RSS button displays next
to the Home icon.
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To add a RSS feed throughMicrosoft Internet Explorer 7+
 1. Click the RSS feed button.

A list of all available RSS feeds on theWeb page is displayed.
 2. Click the RSS feed you want to subscribe to.

You can optionally click theRSS orXML buttons in theWeb page to subscribe to a RSS feed.

To add a RSS feed throughMicrosoft Office Outlook 2007
 1. On the Tools menu, click Account Settings.
 2. On theRSS Feeds tab, click New.
 3. In theNew RSS Feed dialog box, type or copy and paste the URL of the RSS feed, for example,

http://www.example.com/feed/main.xml.
 4. Click Add.
 5. Click OK.

Active Directory synchronization
You can synchronize your system with Active Directory at any time from within YourSite Explorer.

Active Directory is a directory service created by Microsoft that is used for managing a domain. Active
Directory Synchronization will align Active Directory security groups and users with Contact Center
Management / Call Accounting employees and employee groups within selected organizational units.

At any time, you can optionally re-synchronize or reset all client computers running Contact Center Solutions
and Call Accounting applications and refresh them with the latest configuration changes. Re-synchronizing
will send a delta of the latest configuration changes to client computers, while resetting will completely drop
client computer configurations and send the latest configurations from YourSite Explorer.

When you run Active Directory synchronization, employees and employee groups in YourSite Explorer are
synchronized with users in Active Directory groups.

To run Active Directory synchronization
 1. In YourSite Explorer, underYourSite, click Enterprise orEmployees.
 2. On the ribbon, click Active Directory.
 3. UnderSync frequency, select how often you want automatic synchronization to occur.

The default frequency is every hour.
 4. Click Sync paths.

The Select paths to sync window opens.
 5. Click > or < to add or remove Active Directory entities from the Active Directory tree on the left to the

selected items list on the right and click OK.
The list of selected items on the right includes the Active Directory entities that will be synched.

 6. UnderSecurity Role, click ...and select a default security role to apply to newly created employees.
 7. Click OK.
 8. UnderSites, click ... and select a default site to apply to newly created employees.
 9. Click OK.
 10. Click Run.

Active Directory synchronization is initiated and pertinent information is updated in YourSite Explorer.

To send recent configuration changes to client computers
 1. In YourSite Explorer, underYourSite, click Enterprise orEmployees.
 2. On the ribbon, click Tools.
 3. Click Re-synchronize clients.
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To completely reset client computers with the latest YourSite database configuration information
 1. In YourSite Explorer, underYourSite, click Enterprise orEmployees.
 2. On the ribbon, click Tools.
 3. Click Reset clients.

Editing telephone system assignment forms
After you run Synchronization for the 3300 ICP in YourSite Explorer, you can edit a subset of contact center
related 3300 ICP SMDR Options, Class of Service, and Class of Restriction assignment forms. Any changes
made to the telephone system assignment forms in YourSite Explorer are written to the telephone system
when a user clicks Save.

After running Active Directory Synchronization, if the 3300 ICP System options, SMDR options, Class of
Service options, or Class of Restriction assignment forms are incorrectly configured, alerts will display
describing what modifications need to bemade to achieve accurate telephone system settings.

NOTE:Youmust have read/write capabilities enabled in YourSite Explorer before running Active Directory
synchronization if you want to receive these alerts. See "Specifying synchronization settings" on page 80.

Editing SMDR options
Using YourSite Explorer, you can edit a subset of contact center related SMDR options. YourSite Explorer
displays the recommended value for these SMDR options.

To edit SMDR Options
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderEnterprise, click Media servers.
 3. UnderMedia servers, select a 3300 ICP media server.
 4. Click the Telephone system settings tab.
 5. In the left pane, click SMDR options.
 6. Specify the SMDR options.
 7. Click Save.

Editing Class of Service options
Using YourSite Explorer, you can edit a subset of contact center related Class of Service options. YourSite
Explorer displays the recommended value for these Class of Service options.

NOTE: When first provisioning or changing work timer values, youmust synchronize with your telephone
system. See "Performing synchronization" on page 80.

To edit Class of Service options
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderEnterprise, click Media servers.
 3. UnderMedia servers, select a 3300 ICP media server.
 4. Click the Telephone system settings tab.
 5. In the left pane, click Class of Service.
 6. UnderName, select the Class of Service to edit.
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 7. In the right pane, afterDefault type, select a default class of service. Alternatively, select None and,
afterComment, type a description for the Class of Service.

 8. Specify the remainder of system options for each Class of Service.
NOTE:Work timer durations are dependent upon your telephone system.

l MCD 5.0 and greater – 4 hours maximum
l MCD 4.x or earlier – 10minutes maximum

 9. Click Save.

Editing Class of Restriction options
Using YourSite Explorer, you can edit a subset of contact center related Class of Restriction options.

To edit Class of Restriction options
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderEnterprise, click Media servers.
 3. UnderMedia servers, select a 3300 ICP media server.
 4. Click the Telephone system settings tab.
 5. In the left pane, click Class of Restriction.
 6. UnderNumber, select the Class of Restriction to edit.
 7. AfterDo you want this Class of Restriction to be the default setting, click Yes orNo
 8. AfterClasses of restriction for the group, enter the Class of Restriction numbers to include in the

group.
A range of numbers may be specified. Separate numbers using commas or dashes. For example, 1
though 9may be entered as 1-9 or a combination of individual numbers and ranges may be entered as
1,2,3,7-10,13.
NOTE:Class of Restriction numbers must be entered in ascending order within each group.

 9. Click Save.

Configuring devices and device groups using Quick Setup
You can add a range of devices in one action with Quick Setup. When you add a range of devices, you should
group all of the devices together by site, and then, for each site, group devices with similar characteristics. For
example, some employees are from the sales division (similar characteristic) and some employees are from
the accounting division (similar characteristic). You group the sales employees together and group the
accounting employees together. Using Quick Setup, you can then create employee IDs for eachmember of
the group.

If you have a 3300 ICP or 5000/Axxess telephone system, you add a range of devices in YourSite Explorer
using Quick Setup.If you have an SX-200 ACD, youmust configure your systemmanually. See "Configuring
devices manually" on page 112.

NOTE:Quick Setup is not offered in the Data grid view.

You can useQuick Setup to add a range of devices and device groups.
l Employees and employee groups
l Employee divisions
l Extensions and extension groups
l Extension divisions (YourSite Explorer only)
l Queue groups and virtual queue groups
l Trunks and trunk groups
l DNIS and DNIS groups
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l Account Codes
l Account Code groups (YourSite Explorer only)
l Subscriber groups

Employee Quick Setup
If you have an SX-200, you add a series of employees in the Contact Center Management website under
YourSite=>Configuration, Employee=>Employee.

If you have a 3300 ICP, 5000, or Axxess, to add a series of employees
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employees.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, type a range of device numbers.
 5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/orName

postfix type the prefix and/or postfix.
 6. To create an extension for each employee, on theExtension associations tab, select theCreate an

extension number for each employee check box.
 7. Select themedia server and failover media server the extension will use.
 8. To enable Call Accounting reporting for the extension, select theCost this extension check box.
 9. AfterStart the extension numbers at, type the first extension number to associate with the employee

ID range.
 10. After Increment the extension numbers by, type the increment by which the extension numbers will

increase.
 11. If you want to create Account Code associations, on theAccount Code associations tab, select the

Create anAccount Code for each employee check box.
 12. AfterStart the Account Code numbers at, type the first Account Code number to associate to the

employee ID range.
 13. After Increment the Account Code numbers by, type the increment by which the Account Code

numbers will increase.
 14. Click Run.

Extension Quick Setup
If you have an SX-200, you add a series of extensions in the Contact Center Management website under
YourSite=>Configuration, Extension=>Extension.

If you have a 3300 ICP, 5000, or Axxess, to add a series of extensions
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Extensions.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, type a range of device numbers.
 5. If you want to add a prefix or postfix to this range of device numbers, afterName prefix and/orName

Postfix type the prefix and/or postfix.
 6. On theGeneral tab, select amedia server and a failover media server for the extension.
 7. To enable Call Accounting reporting for the extension, select theCost this extension check box.
 8. If you want to create an employee for each extension, on theEmployee associations tab, select the

Create an employee ID for each extension check box.
NOTE:Select this check box only if you have not already added employee IDs to the database.
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 9. AfterStart the employee IDs at, type the first employee ID to associate to the extension number
range.

 10. After Increment the employee IDs by, type the increment by which the employee IDs will increase.
 11. Click Run.

Trunk Quick Setup
If you have an SX-200, you add a series of trunks in the Contact Center Management website under
YourSite=>Configuration, Trunk=>Trunk.

If you have a 3300 ICP, 5000, or Axxess, to add a series of trunks
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Trunks.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, type a range of device numbers.
 5. To add a prefix or postfix to this range of device numbers, afterName prefix and/orName postfix type

the prefix and/or postfix.
 6. On theGeneral tab, select amedia server.
 7. Click Run.

Trunk group Quick Setup
NOTE: If you cost calls based on trunk groups, IP trunks from eachmedia server must be added to each trunk
group.

If you have an SX-200, you add a series of trunk groups in the Contact Center Management website under
YourSite=>Configuration, Trunk=>Trunk group.

If you have a 3300 ICP, 5000, or Axxess, to add a series of trunk groups
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Trunk groups.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, enter a range of device numbers.
 5. To add a prefix or postfix to this range of device numbers, afterName prefix and/orName postfix type

the prefix and/or postfix.
 6. On theGeneral tab, afterMedia server, click ... and select themedia server associated with the trunk.
 7. If this trunk group uses an intra switch trunk, select the Intra switch check box.
 8. If you do not want to cost calls using this trunk, select theDo not cost calls check box.
 9. Click Run.

DNIS Quick Setup
If you have an SX-200, you add a series of DNIS in the Contact Center Management website under
YourSite=>Configuration, DNIS=>DNIS.

If you have a 3300 ICP, 5000, or Axxess, to add a series of DNIS
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click DNIS.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, type a range of device numbers.
 5. To add a prefix or postfix to this range of device numbers, afterName prefix and/orName postfix type

the prefix and/or postfix.
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 6. On theGeneral tab, afterAssociate the devices to this media server, select amedia server.
 7. AfterShort Abandon, type the Short Abandon threshold for the DNIS.
 8. AfterService Level, type the Service Level time for the DNIS.
 9. Click Run.

Account Code Quick Setup
If you have an SX-200, you add a series of Account Codes in the Contact Center Management website under
YourSite=>Configuration, Account Codes=>Account Codes.

If you have a 3300 ICP, 5000, or Axxess, to add a series of Account Codes
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Account Codes.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, type a range of device numbers.
 5. To add a prefix or postfix to this range of device numbers, afterName prefix and/orName postfix type

the prefix and/or postfix.
 6. To create an employee for each Account Code, on theEmployee Associations tab, select theCreate

an employee ID for each Account Code check box.
NOTE:Select this check box only if you have not already added employee IDs to the database.

 7. AfterStart the employee IDs at, type the first employee ID number to associate to the Account Code
range.

 8. After Increment the employee IDs by, type the increment by which the employee ID numbers will
increase.

 9. Click Run.

Device group Quick Setup
If you have an SX-200, you add a series of employee groups, extension groups, and DNIS groups in the
Contact Center Management website under YourSite=>Configuration.

If you have a 3300 ICP, 5000, or Axxess, to add a series of employee, extension, DNIS, or Account Code
groups or divisions
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click the device name.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, type a range of device numbers.
 5. To add a prefix or postfix to the range of device numbers, afterName prefix and/orName postfix type

the prefix and/or postfix.
 6. Click Run.
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Subscriber group Quick Setup
Youmust configure subscribers first before you configure subscriber groups.

To add a series of Subscriber groups
 1. In YourSite Explorer, in the left pane, click Call Accounting.
 2. UnderCall Accounting, click Subscriber Groups.
 3. Click Quick Setup.
 4. In theActive number from andActive number to boxes, enter a range of device numbers.
 5. To add a prefix or postfix to this range of device numbers, afterName prefix and/orName postfix type

the prefix and/or postfix.
 6. Click Run.

Configuring devices using .csv files

You can import devices to YourSite Explorer using comma-separated value (.csv) files. The following device
types are currently supported for use with the YourSite Explorer .csv import tool: employees, employee
groups, employee divisions, extensions, extension groups, extension divisions, trunks, trunk groups, DNIS,
DNIS groups, call rates,and Account Codes.

A .csv file is used for the digital storage of data structured in a table of lists form, where each associated item
(member) in a group is in association with others also separated by the commas or tabs of its set.

There are two ways to create .csv files: Notepad or Microsoft Excel. We recommendmaking .csv files in
Excel, as adding and editing a large number of entries at once using auto-fill functions is much simpler and
more convenient than using Notepad.

Alternatively, you can also import tabbed delimited text files created in Excel. Tabbed delimited text files are
almost identical to .csv files, but use tabs to differentiate data fields instead of commas.

NOTE:When creating .csv files, youmust save the file as either a .csv or .txt file. Simply renaming an Excel
file or changing a file type extension to .csv will not work and you will be unable to import device data into
 YourSite Explorer.

Figure 6 - 3 and Figure 6 - 4 provide two examples of how .csv files can be formatted. The following figures
display Microsoft Excel .csv formatting and Notepad .csv formatting. Both .csv examples contain the
following data: first name, last name, employeelogin ID, andmedia server.

NOTE: To import configuration options that display in the YourSite Explorer grid view as a check box, you
must enter True or False as the field data. For example, if an extension was enabled to be costed, you would
enter the value True in your .csv file andmap it to the Cost this extension field.
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Figure 6 - 3 Microsoft Excel .csv formatting example

Figure 6 - 4 Notepad .csv formatting example

Fields required for successful .csv imports
Table 6 - 4 details the fields that are required in order to successfully import devices into YourSite Explorer
using a .csv file.

NOTE:Datamust be entered in .csv files using the exact order detailed in Table 6 - 4 below. Failure to import
data in the order specified will result in import errors.
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Table 6 - 4 Mandatory device fields for .csv imports

Device Mandatory fields Optional fields

Employees First name, last name, employee
ID (reporting number)

Full time, middle name,
email address, suffix, real-
time license, nickname,
resiliency license activated,
scheduling license, site,
password, is a supervisor,
username, supervisor, is
active, security role, pre-
ferred printer, print locally,
use employee email for
report distribution, fax
number, hire date, birth
date, business phone
number, emergency contact
phone number, emergency
contact relationship, emer-
gency contact name, coun-
try, ZIP or postal code,
street address, city, state,
or province, pager number,
phone number

Employee groups Name, employee group ID (report-
ing number) N/A

Employee divisions Name, reporting number
Failover media server,
employee, is active

Extensions Name, reporting number, media
server

Extension type, failover
media server, real-time
license, is active, cost this
extension, notes, is general
business hot desking

Extension groups Name, reporting number N/A

Extension divisions Name, reporting number N/A

Trunks Name, reporting number, media
server N/A

Trunk groups Name, reporting number
Media server, do not cost
calls, carrier plan, intra
switch
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Device Mandatory fields Optional fields

DNIS Name, reporting number, media
server

Short abandon, service
level, carrier plan, call type,
call rate

DNIS groups Name, reporting number N/A

Account Codes Name, reporting number Use as classification code

Call types Name N/A

Rates Name

Cost boundary percent sur-
charge, cost boundary dura-
tion, boundary crossing
surcharge, surcharge per
call, round to cost interval

Subscribers Name, reporting number, sub-
scriber plan N/A

Subscriber groups Name. reporting number N/A

Importing call rates and digit patterns
When importing call rates and digit patterns, please ensure you follow the best practices:

l Other than Rate name, no fields aremandatory
l Charge bands have the following fields for import:

l Cost Per Minute (decimal value)
l Cost Interval (time in seconds or hh:mm:ss format)
l First Cost (decimal value)
l First Cost Interval (time in seconds or hh:mm:ss format)
l Subsequent Cost Increment (decimal value)
l Subsequent Cost Interval (time in seconds or hh:mm:ss format)

l In order to import rates and charge bands, youmust have configured a default timeslot that covers a
24/7 time period

l Ensure there are no gaps or overlaps in times or the .csv import tool will not complete successfully
l Time durations can be imported in either hh:mm:ss or second format, but they must be consistent, and

a single .csv file cannot contain both time duration formats
l Do not include Cost Per Minute along with First Cost or Subsequent Cost Increment in the same .csv

file
l Do not include Cost Interval along with First Interval or Subsequent Cost Interval in the same .csv file
l When importing digit patterns, youmust select the correct level on the digit pattern tree in YourSite

Explorer before importing device data

For more information and sample .csv files, browse to <installation directory>:\Program Files\prairieFyre
Software Inc\CCM\Support\Call Accounting CSV\Samples For RateWith Charge Band.
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Importing a range of devices using a .csv file
NOTE:Before you attempt to import a device using a .csv file, ensure

l The .csv file contains data for all of the fields required to save a device in YourSite Explorer as detailed
in the following table.

l If a device requires a dependency to be specified, for example specifying amedia server is required in
order to save an employee, the dependency must already exist in YourSite Explorer. The Import Wizard
cannot create new dependencies and will fail if the dependency does not already exist in the database.

To import a range of devices using a .csv file
 1. In YourSite Explorer, underDevices, click the name of the device you will add using a .csv file.
 2. Click Import.
 3. AfterSelect file type, specify whether the .csv file uses Comma separated values or Tab separated

values.
 4. AfterSelect file, click Browse and specify the location of the .csv file.
 5. UnderOptions, specify how the Import Wizard will handle duplicate items.

If duplicates are found:
l Overwrite entries if duplicates are found will use the .csv file as themaster and overwrite

duplicate entries in the YourSite database with data in the .csv file.
l Skip duplicate entries during import will retain data configured in YourSite Explorer as themaster

and import any new data entries from the .csv file into the YourSite database.
l Do not import if duplicates are found will scan the .csv and YourSite database for duplicates. If

duplicates are found in either the .csv or the YourSite database, the import is cancelled and no
data is imported to the YourSite database.

 6. Click Next.
 7. On the Field Mappings window, map the fields in theAvailable columns list to theSelected

columns list using the arrow buttons, so they display in the same order as they do in your .csv file.
 8. Click Next.
 9. When the import has completed, click Finish.

NOTE: If the import fails, the Import Wizard will notify you of whether the YourSite database or .csv file
contained the duplicate(s) and which row(s) of the .csv file contained the error(s) that resulted in the
failure. Fixing these errors will allow devices to be successfully imported.

Configuring devices manually
CAUTION:Print a copy of your telephone system assignment forms to use as a guide for programming
YourSite Explorer. The numbers you enter in YourSite for extensions, trunks, and Account Codes must be
identical to those of the telephone system.

Adding employees
You add employees to the YourSite database so you can generate reports on employee activities. When you
add employees, youmust add a user name and password for employees who need to use the Call Accounting
website, YourSite Explorer, and Contact Center Client. If you want to generate reports on employee groups,
youmust add them to the database and associate employees with them.
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Configuring employee licensing information
To configure licensing information for an employee.
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employees.
 3. Click Add.
 4. UnderGeneral, specify employee identification information.

Youmust provide the date the employee became an active part of the enterprise if you want to generate
administrative employee reports.
Youmust enter a unique employee ID number for each employee.

 5. Under Licensing, select the applicable licensing options for employees, supervisors, and phone types.
UnderEmployee License, select None.

l A designation of None enables the employee to run Call Accounting employee and extension
reports on employees who are associated with costed extensions. See "Adding extensions" on
page 98. If this is a non-ACD user, when configured with an Integrated Client license, the user
will have access to Contact Center Management / Call Accounting website and Contact Center
Client for Contact Center PhoneSet Manager. Associated extensions can be viewed in real time,
either for general business purposes or Call Accounting (if associated extensions are configured
to be call costed).
CAUTION: If data exists for an employee whowas previously licensed but is currently
unlicensed, that data can be accessed in reports. However, if a summarization is done after the
employee is no longer licensed, there is a risk that the collected data could be lost.
NOTE:Basic, Standard, Advanced, and Premium employee licenses are only available to Call
Accounting customers who also ownContact Center Enterprise Edition. Call Accounting
customers who also ownContact Center Business Edition choose between Reporting or
Desktop employee licensing.

UnderSupervisor Licensing, depending on licensing, select from None, Advanced, orSystem
Administrator.

l None: is used for general business extensions.
l Advanced supervisor: has access to the Contact Center Management website (reporting and

My Options), Contact Center Client, and YourSite Explorer (read access only).
l System Administrator (orDesktop supervisor if you ownContact Center Business Edition

and Call Accounting): has full access to all Call Accounting software for the purposes of
configuration and network and system administration.
NOTE:Only one supervisor type can be selected for each employee.

UnderPhone type license, depending on licensing, select fromMitel desk phone orSoftphone
and/or Mitel desk phone.

l Mitel desk phone: select this option if the employee will use aMitel desk phone. This is the
default option.

l Softphone and/or Mitel desk phone: select this option if the employee will use and is licensed
for Contact Center Softphone.
NOTE: The Contact Center Softphone and/or Mitel desk phone option is available to Call
Accounting customers who also ownContact Center Enterprise Edition with Advanced or
Premium employees. Non-ACD Call Accounting employees and Contact Center Business
Edition with ACD agents must select 'Licensed for Integrated Client' to have access to Contact
Center PhoneSet Manager, CTI Developer Toolkit Client, or Salesforce.com Client functionality.
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Select additional licensing options as required.
l Under Integrated client license, select Licensed for integrated clients if this is a non-ACD

employee who needs access to Contact Center PhoneSet Manager, CTI Developer Toolkit
Client, or Salesforce.com Client.
Salesforce.com Connector is required to activate Salesforce.com Client.
See theContact Center Solutions and Call Accounting System Engineering Guide for in-depth
licensing information.

l UnderScreen Pop license, select Licensed for Screen Pop if this is a non-ACD employee
(designated as employee type 'None') or a Contact Center Business Edition agent who needs
access to Contact Center Screen Pop.
Integrated Client is a prerequisite for Screen Pop.

 6. Configure employee user account information.
See "Configuring employee user account information" on page 96.

Configuring employee user account information
To configure employee user account information
 1. On theUser account tab, underUser account, specify login credentials for the employee and select

the site to which the employee is associated.
 2. UnderSecurity, select a security role for the employee.

The default security role permits users full access to all applications and devices.
 3. UnderReport distribution, specify the path of the network printer and select print and email options.

Youmust configure the network printer as the default printer on the Enterprise Server. The printer path
name is case sensitive.

 4. Create employee extensions and Account Codes.
See "Creating employee extensions and Account Codes" on page 96.

Creating employee extensions and Account Codes
To create employee extensions and Account Codes
 1. On theCreate Associated devices tab, underExtension, select theCreate an extension number for

the employee check box.
 2. Select amedia server for the extension.
 3. If the extension will be costed with Call Accounting, select theCost this extension check box.
 4. On theCreate associated devices tab, click Account Code.
 5. Select theCreate an Account Code for each employee check box.
 6. On the ribbon, click Save.
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Associating extensions and Account Codes with employees
After creating extensions and Account Codes, you can associate them with employees.

To associate extensions and Account Codes with an employee
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employees.
 3. Select an employee from the list.
 4. Click Extensions.
 5. Click > to move the extension(s) you want to associate to the employee from theAvailable members

list to theSelected members list.
 6. Click Account Codes.
 7. Click > to move the Account Code(s) you want to associate to the employee from theAvailable

members list to theSelected members list.
 8. On the ribbon, click Save.

Configuring employee personal information
To configure employee personal information
 1. On theDetails tab, specify contact, hire, and emergency information for the employee.
 2. On the ribbon, click Save.

Adding employee groups
After adding employees, you add employee groups and associate employees to these groups.

You add employee groups to the YourSite database so you can generate reports on employee group activities.

Adding employee groups (in YourSite Explorer)
To add an employee group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employee groups.
 3. Click Add.
 4. Configure employee group identification information.
 5. On the ribbon, click Save.

Associating employees with employee groups (in YourSite Explorer)
To associate an employee with an employee group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employee groups.
 3. Select an employee group from the list.
 4. On theMembership tab, underAvailable members, select an employee and click > to move the

employee to theSelected members list.
 5. On the ribbon, click Save.
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Adding employee divisions
An employee division is composed of one or more employee groups. You add employee divisions to the
YourSite database so you can generate reports on employee division activities.

In order to add employee divisions youmust have first created employee groups. See "Adding employee
groups" on page 97.

To add an employee division
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employee Divisions.
 3. Click Add.
 4. Type aName andReporting number for the employee division.
 5. On the ribbon, click Save.

To associate an employee group with an employee division
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Employee Divisions.
 3. Select an employee division from the list.
 4. On theMembership tab, underAvailable members, select an employee group and click > to move the

employee group to theSelected members list.
 5. On the ribbon, click Save.

Adding extensions
You add extensions to the YourSite database so you can generate reports on extension activities and view
extension performance in real time. If you want to generate reports on extension groups, youmust add them to
the database and associate extensions with them. You license Call Accounting based on the total number of
extensions you want to cost in your enterprise.

When you perform Synchronization, YourSite Explorer is configured tomirror the phone set extension
numbers/base directory numbers (DNs) on the 3300 ICP. If you have traditional agents that can sit at multiple
locations within your organization, hot desking agents, or general business hot desking extensions, we
recommend you give these base extensions generic names based on the position of the physical DNs (for
example, Base DN: Floor 2, Desk 1). We recommend only general business hot desking extensions assigned
to specific hot desking users be given user-based names (for example, Hot desking extension: John, Smith).
If you have traditional ACD agents who sit at the same desk every day, or traditional extension phone sets
that belong to single users, we recommend that the base DNs be configured with the user's names.

NOTE: If you use Contact Center Management in conjunction with Call Accounting and have hot desking
agents programmed in Contact Center Management, youmust program an extension with an identical
reporting number or real-time call costing will not work.

To add an extension
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Extensions.
 3. Click Add.
 4. UnderGeneral, specify extension identification information and click ... to select themedia server and

failover media server for the extension.
 5. Select theClass of Service for themedia server, from the drop-down list.
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 6. UnderNotes, select theDisable real-time monitoring and data collection on this device check
box if you do not want to enable the extension to be set with aMiTAI monitor, viewed in Contact Center
Client, and use Contact Center Softphone or Salesforce.com Integration.
By default, this check box is not selected.

 7. If the extension is a general business hot desking extension, select the Is general business hot
desking check box.

 8. If the extension will be costed with Call Accounting, under Licensing, select theCost this extension
check box.

 9. If you want to enable this extension for external hot desking, select theExternal hot desk user
enabled check box.
Extensions that are enabled as external hot desk users can handle non-ACD calls while logged in
externally.

 10. AfterExternal dialing prefix, type the dialing prefix for the external device to which calls will be routed.
 11. AfterExternal dialing number, type the dialing number for the external device to which calls will be

routed.
 12. On the ribbon, click Save.

Adding extension groups
Extension groups are groups of extensions. You add extension groups and then associate extensions with
these groups. You add extension groups to the YourSite database so you can generate reports on extension
group activities.

In order to add extension groups youmust have first created extensions. See "Adding extensions" on page 98.

To add an extension group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Extension groups.
 3. Click Add.
 4. Type aName and aReporting number for the extension group.
 5. On the ribbon, click Save.

To associate an extension with an extension group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Extension groups.
 3. Select an Extension group from the list.
 4. On theMembership tab, underAvailable members, select an extension and click > to move the

extension to theSelected members list.
 5. On the ribbon, click Save.

Adding extension divisions
Extension divisions are groups of extension groups. You add extension divisions and then associate
extension groups to these divisions. You add extension divisions to the YourSite database so you can
generate reports on extension division activities.

In order to add extension divisions youmust have first created extension groups. See "Adding extension
groups" on page 99.
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To add an extension division
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Extension Divisions.
 3. Click Add.
 4. Type aName and aReporting number for the extension division.
 5. On the ribbon, click Save.

To associate an extension group to an extension division
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Extension Divisions.
 3. Select an Extension division from the list.
 4. On theMembership tab, underAvailable members, select an extension group and click > tomove the

extension group to theSelected members list.
 5. On the ribbon, click Save.

Adding trunks
You add trunks to the YourSite database so you can generate reports on trunk activities. If you want to
generate reports on trunk groups, youmust add them to the database and associate trunks with them.

NOTE:
l If you want to report on SMDR information for SIP trunks youmust ensure you SMDR tag is numbered.

Please see theCall Accounting Installation Guide.
l If you cost calls based on trunk groups, youmust add the IP trunk from eachmedia server to each trunk

group and ensure all media servers are associated to a carrier plan.
l We recommend you name trunks and trunk groups in a way that helps you identify them as either SIP

or TDM trunks, enabling the trunk type to be easily identified in reports.

Adding trunks (in YourSite Explorer)
To add a trunk
 1. In YourSite Explorer, underYourSite, click Trunks.
 2. Click Add.
 3. Type aName and aReporting number for the trunk.
 4. Click ... and select aMedia server to associate with the trunk.
 5. On the ribbon, click Save.

Adding trunk groups
You add trunk groups and then associate trunks with the trunk groups.

NOTE:
l If you have Traffic Analysis and/or Call Accounting and use the same trunk group numbers across

multiple telephone systems, youmust associate each trunk group with amedia server.
l We recommend you name trunks and trunk groups in a way that helps you identify them as either SIP

or TDM trunks, enabling the trunk type to be easily identified in reports.

If you have Traffic Analysis and/or Call Accounting and use the same trunk group numbers across multiple
telephone systems, youmust associate each trunk group with amedia server.
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Adding trunk groups (in YourSite Explorer)
To add a trunk group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Trunk groups.
 3. Click Add.
 4. Type aName and aReporting number for the trunk group.
 5. Click ... and select aMedia server to associate with the trunk group.
 6. Click ... and select aCarrier plan to associate with the trunk group.
 7. If you use intra switch trunks, enable the Intra switch check box.
 8. If you do not want to cost calls, select theDo not cost calls check box.
 9. On the ribbon, click Save.

Associating trunks with trunk groups (in YourSite Explorer)
To associate a trunk with a trunk group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Trunk groups.
 3. Select a trunk group from the list.
 4. On theMembership tab, underAvailable members, select a trunk and click > to move the trunk to the

Selected members list.
 5. On the ribbon, click Save.

Adding DNIS
Dialed Number Identification Service (DNIS) is a feature of toll-free lines that identifies the telephone number
the caller dials.

Adding DNIS (in YourSite Explorer)
To add a DNIS
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click DNIS.
 3. Click Add.
 4. Specify DNIS identification information and click ... to select themedia server for the DNIS.
 5. AfterCarrier Plan, Call Type, andCall rate, click ... to select a carrier plan, call type, and call rate.
 6. On the ribbon, click Save.

Adding DNIS groups
After adding DNIS, you can create DNIS groups and then associate DNIS numbers for specific businesses or
product lines to those groups.

Adding DNIS groups (in YourSite Explorer)
To add a DNIS group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click DNIS groups.
 3. Click Add.
 4. Type aName and aReporting number for the DNIS group.
 5. On the ribbon, click Save.
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Associating DNIS to DNIS groups (in YourSite Explorer)
To associate a DNIS with a DNIS group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click DNIS groups.
 3. Select a DNIS group from the list.
 4. On theMembership tab, underAvailable members, select a DNIS and click > to move the DNIS to

theSelected members list.
 5. On the ribbon, click Save.

Adding Account Codes
Account Codes can be verified, non-verified, or forced.

l Verified and Non-Verified Account Codes
Verified and Non-Verified Account Codes allow callers to complete a call without entering a code.
These codes are used to categorize calls or portions of calls. You define Account Codes in the YourSite
database to generate reports for specific departments, services, and companies. For example, an
agent who receives calls for three catalog companies enters Account Code 01 for calls to company X,
Account Code 02 for calls to company Y, and Account Code 03 for calls to company Z. When you
configure the Account Codes, Call Accounting generates reports on the number, origin, and handling of
calls for each of the departments, services, or companies.

l Forced Account Codes
Both Verified and Non-verified Account Codes can be forced. With Forced Verified Account Codes, you
must enter the Account Code as soon as the phone is off-hook. With Forced Non-verified Account
Codes, youmust enter the Account Code after you dial the phone number.

For example, youmight have 03 programmed on the telephone system as the trunk access code for
calling England. Before youmake a call to England, youmust preface the telephone number with the
Account Code 03, otherwise the call will not go through. To report on these verified Account Codes, you
define them in the YourSite database.

NOTE:
l If you will used forced account codes and have aMake Busy button programmed on your Mitel phone

set, youmust remove theMake Busy button, or forced account codes will not work with Contact
Center PhoneSet Manager.

l If a Forced verified Account Code is not entered in before work timer expires, then a -1 Non Compliant
Code will be automatically assigned to the call.

You can add Account Codes for individual departments, projects, and services. You can tag calls with
Account Code numbers and generate reports on them.

Call Accounting works with verified and non-verified Account Codes that you configure in your telephone
system.

Configuring YourSite database devices
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Adding Account Codes (in YourSite Explorer)
To add an Account Code
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Account Codes.
 3. Click Add.
 4. Type aName andReporting number for the Account Code.
 5. On the ribbon, click Save.

Adding Account Code groups
After adding Account Codes, you can create Account Code groups and then associate Account Codes to
these groups.

To add an Account Code group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Account Code Groups.
 3. Click Add.
 4. Type aName andReporting number for the Account Code group.
 5. On the ribbon, click Save.

Associating Account Codes with Account Code groups
To associate an Account Code with an Account Code group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Account Code groups.
 3. Select an Account Code group from the list.
 4. On theMembership tab, underAvailable members, select an Account Code and click > to move the

Account Code to theSelected members list.
 5. On the ribbon, click Save.

Adding Account Code categories
In businesses that use a large number of Account Codes, Account Code categories can be used to provide a
hierarchical and grouped listing of the Account Codes available to agents and employees from the soft phone
toolbar within Contact Center Client. You configure Account Code categories from within YourSite Explorer.
Once you have configured Account Codes, they can be nested under specific Account Code categories. An
Account Code can only be in one category. Call Classification Codes, which are treated the sameway as
Account Codes, can optionally be nested in Account Code categories. Account Code category availability to
agents and employees can optionally be controlled using Contact Center Management / Call Accounting
security. When Account Code categories are enabled, Contact Center Management / Call Accounting reports
will display the Account Code category path (for example, Sales=>Automotive=>Tires).

To enable Account Code categories
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Account Codes.
 3. In the ribbon, click theConfiguration tab.
 4. Enable theDisplay Account Codes in categoriescheckbox.
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To add an Account Code category
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Account Codes.
 3. In the ribbon, click theConfiguration tab.
 4. Ensure theDisplay Account Codes in categories checkbox is enabled.
 5. Click Edit categories.

The Account Code category designer displays.
 6. Using the Account Code category designer, add and name Account Code categories in the left pane and

then add the Account Codes you have configured, which display in the left pane) to the custom
categories.
Account Code categories are sorted by category name and Account Code reporting number. Account
Code categories will display in soft phone toolbars exactly as you have designed them in the Account
Code category designer. If you have Account Code categories enabled, but do not assign Account
Codes to categories, leaving them in the right pane of the designer, these Account Codes will not be
available in the soft phone toolbar.

Adding phone numbers
The phone number device enables you to

l Add contacts.
l Edit location information that displays in reports.

When adding a phone number to the database, you select
l Area/City codewhen you are adding or updating the area code for a province/state/city

For the phone number 613-599-0045, 613 is the area code.
l City exchangewhen you are adding a new exchange

For the phone number 613-599-0045, 599 is the city exchange (Kanata).
l Contactwhen you are adding a phone number with contact information

For the phone number 613-599-0045, 5990045 is the contact.

To add a phone number area/city code
 1. In YourSite Explorer, underYourSite, click Phone numbers.
 2. Click Add=>Add an area/city code.
 3. Select a country and type an area/city name and area code.

An area can be a city, region, province, or state.
 4. On the ribbon, click Save.

To add city exchange information
 1. In YourSite Explorer, underYourSite, click Phone numbers.
 2. Click Add=>Add a city exchange.
 3. AfterCountry name, select a country.
 4. AfterArea/City name, select a city, region, province, or state (for example, Greater Toronto Area).
 5. AfterCity name, type the name of a city or suburb (for example, Thornhill).
 6. AfterCity exchange, type a city exchange number (for example, 231).

For the phone number 416-231-5555, 231 is the city exchange.
 7. On the ribbon, click Save.
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To add phone number contact information
 1. In YourSite Explorer, underYourSite, click Phone numbers.
 2. Click Add=>Add a contact.
 3. AfterCountry name, select a country.
 4. AfterArea/City name, select a city, region, province, or state (for example, Washington).
 5. AfterCity name, select a city or suburb (for example, Des Moines).
 6. Type a contact name and number.

This information displays in the Phone Number Accounting Trace and Phone Number Group
Accounting Trace reports.

 7. If you want to hide the contact name and number in reports select theHide the name and number in
reports check box.
The hidden phone numbers appear as 10 zeros and the name/location field is blank.

 8. On the ribbon, click Save.

Adding phone number groups
You can associate Phone numbers with Phone number groups. Phone number groups are added in YourSite
Explorer and then Phone numbers are associated with them.

To add a Phone number group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Phone number groups.
 3. Click Add.
 4. Type aName andReporting number for the Phone number group.
 5. On the ribbon, click Save.

To associate a Phone number with a Phone number group
 1. In YourSite Explorer, in the left pane, click YourSite.
 2. UnderDevices, click Phone number groups.
 3. Select a phone number group from the list.
 4. On theMembership tab, underAvailable members, select a Phone number and click > to move the

Phone number to theSelected members list.
 5. On the ribbon, click Save.

Adding call types
A call type describes the type of call, whether it is local, long distance, or international. You can create a new
call type or select from the default call types. Default call types include local, long distance, and international
and are based on the country you select during installation. You can rename all call types, including default
call types.

You add call types for geographical regions and business needs. Each digit pattern is associated with a call
type and call rate.

NOTE: You cannot delete a call type that is associated to a carrier plan or a subscriber plan. To delete a call
type, youmust remove the call type from the plan, then under Call types, select the call type and press
Delete.
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To add a call type
 1. In YourSite Explorer, underCall Accounting, click Call types.
 2. Click Add.
 3. AfterName, type the name of the call type.
 4. On the ribbon, click Save.

Adding time slots
NOTE:

l Time slots can be configured for any time of the day, but they cannot span time periods from one day to
the next (for example, fromMonday at 8:00 PM to Tuesday at 4:00 AM).

l To delete a time slot that is associated to a charge band on a call rate, youmust remove the time slot
from any associated charge bands, then under Time slots, select the time slot and click Delete.

A time slot describes the days and hours that a rate for a call is active. Using a time slot, you can configure
different rates for different time periods. For example, you can create rates for discountedmornings and
evenings, while maintaining regular costs for business hours.

To add a time slot
 1. In YourSite Explorer, in the left pane, click Call Accounting.
 2. Click Time slots.
 3. Click Add.
 4. Specify the name, days of week, and start and end times for the time slot.
 5. If you want to automatically create charge bands based on default timeslots when generating new call

rates, select Use as default.
 6. On the ribbon, click Save.

Adding call rates
NOTE: To delete a call rate that is associated to a carrier plan or a subscriber plan, youmust remove the call
rate from the plan, then under Call rates, select the rate, and click Delete.

A call rate is the amount your company charges you per call. Call rates are composed of charge bands, which
are composed of time slots. Charge bands represent the rate your carrier charges you during the time period
specified by the associated time slot. After call rates are defined, digit patterns can be associated with a call
type and a call rate.

NOTE: In order to cost calls accurately, ensure your call rates match those of your carrier.

You can define the following call costs associated to call rates:
l Duration—the duration after which a surcharge is applied to a call
l Crossing surcharge—a flat rate applied to the call after the duration boundary is crossed
l Crossing percentage surcharge—apercentagemarkup added to the total cost of a call once the

duration boundary is crossed
l Surcharge per call—an additional charge applied to calls regardless of their duration
l Round to Cost Interval—when enabled, rounds the call cost to the cost interval associated to the

charge band of the current call. If not enabled, the call will be costed in real time.
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You can define the costs for your charge bands by modifying the following fields:
l Cost per minute—the cost of the call on a per minute basis
l Cost interval—the interval at which the call is costed
l First cost—the rate applied to the first segment of a call to the first cost interval

The first increment is always charged at the full first cost, regardless of whether the call exceeds the
first interval or not

l First cost interval—the duration of the first segment of a call, to which the First cost is applied
l Subsequent cost increment—the cost applied to subsequent segments of the call
l Subsequent cost interval—the duration of the subsequent call segments after the first cost interval

NOTE: The First cost, First cost interval, Subsequent cost increment, and Subsequent cost interval fields will
automatically populate after you specify the Cost per minute and Cost interval fields. You can, however, alter
these fields to suit your needs.

Example 1:
l Cost per minute = $1.00

A 40 second call will cost $1.00

Example 2:
l First cost = $0.1667/min
l Cost interval = 0:00:10

A 45 second call will cost $0.75.

Example 3:
l First cost = $1/min
l Subsequent cost increment/Subsequent cost interval = $0.10/1minute
l Round to Cost Interval is not selected

A four minute and 45 second call will cost $1.46

Example 4:
l First cost = $1/min
l Subsequent cost increment/Subsequent cost interval = $0.30/1minute
l Round to Cost Interval is selected

A four minute and 45 second call will cost $1.50

To add a call rate
 1. In YourSite Explorer, in the left pane, click Call Accounting.
 2. Click Rates.
 3. Under Rates, click Add.
 4. Specify the name, surcharge per call, Round to Cost Interval, and boundary settings.
 5. Under Charge Bands, click Add.
 6. Under Time slot, click ... and select a Time Slot to define the Charge band.

NOTE:Charge bands must cover 24 hours of a day for the full 7 days of the week without overlapping.
 7. On the ribbon, click Save.

Adding carrier plans
A carrier plan is used to determine the cost of your calls. It represents an agreement you have with a phone
carrier about the call rates you are charged for your phone service. Carrier plans enable you to cost outgoing
calls using digit patterns, cost incoming calls using DNIS rates, and cost internal calls by assigning rates.
Carrier plans are assigned tomedia servers and/or trunk groups to cost the calls from these devices.



- 108 -

Call Accounting attempts to cost outbound calls at the trunk group level first. If it cannot cost the call there,
then it costs at themedia server level. It costs inbound calls based on the rates associated with DNIS.

NOTE:
l Youmust add outbound, inbound, and internal information before you can save the carrier plan.
l Carrier plans must be saved before importing digit patterns. (See "Adding outbound digit patterns" on

page 108.)

CAUTION:
l In YourSite Explorer, youmust configure call types, time slots, and call rates before you add carrier

plans. Do not add devices when you are configuring carrier plans or you could lose carrier configuration
data.

l When you configure a carrier plan, youmust complete all required fields (for outbound, inbound, and
internal information) before you are able to save.

To add a carrier plan
 1. In YourSite Explorer, underCall Accounting, click Carrier plans.
 2. Click Add.
 3. AfterName, specify the name.
 4. AfterMinimum duration to cost, select the duration in seconds.
 5. Click theOutbound tab.
 6. UnderOutbound, specify a call type and call rate.

NOTE: If Call Accounting cannot match a digit pattern to a call, it will cost the call at the Outbound rate.
Typically, use Outbound to specify the local rate.

 7. Click the Inbound tab.
 8. Under Inbound, specify the call type and call rate for DNIS numbers.

NOTE: If no DNIS numbers are selected, the call will be costed based on the Inbound information.
 9. Click Internal.
 10. Under Internal, click ... and select the call type and call rate to associate the DNIS numbers to the

internal information.
 11. On the ribbon, click Save.

You can now add digit patterns to the carrier planmanually or by .csv import.

Adding outbound digit patterns
You add digit patterns to cost outbound calls.

To cost outbound calls, Call Accounting uses a digit tree comprised of digit patterns. A digit pattern is part or
all of the digits dialed. Because all North American long distance calls begin with a 1, you can use 1 as the
digit pattern to cost all North American long distance calls. You then add any exceptions to the digit pattern.
For example, if you call the Caribbean from New York City, you will be charged a different long distance rate
than the North American long distance rate. Because the Caribbean digits dialed begin with 1-768, you can
nest 768 under 1 in the digit pattern tree. Youmust assign call rates and call types to digit patterns to cost
outbound calls.

The following characters are valid:
l Explicit: 0 to 9, * and #
l Wild card: x or X
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When you add Xs in the digit pattern, they explicitly define the number of digits for the digit pattern. If a
specific number of digits determines the cost of a call, you use the wild card X as the place holder for the
digits. For example, if a ten-digit phone number that ends with a 7 needs to be costed a certain way, youmust
enter the digit pattern xxxxxxxxx7. If no X appears in the digit pattern, the number is explicit. If you add a digit
pattern that does not include Xs, there is no restriction to the digits dialed.

To view the list of calls made using restricted digit patterns, you generate the following reports:
l Extension and Extension Group Accounting Toll Fraud reports

These reports show the toll fraud activity by extension and extension group.

To view the list of calls made using restricted digit patterns in the Phone Number and Phone Number Group
Accounting Trace by Phone Number reports, youmust first configure them in YourSite Explorer under
YourSite=>Phone numbers. The reports will list all instances, if any, of that phone number.

Digit patterns can be addedmanually or by .csv import. You canmodify and reimport the .csv files to
reference the rates for your carrier plans.

NOTE:Youmust configure the call types and call rates used by the .csv file before you can import digit
patterns.

To add a digit pattern to a carrier planmanually
 1. In YourSite Explorer, underCall Accounting, click Carrier plans.
 2. Select the carrier plan to which you are adding a digit pattern.
 3. Click theOutbound tab.

NOTE:You can nest digit patterns. For example, 001may represent international calls. If you want to
nest specific country codes under 001, click the 001 digit pattern in the tree and add digit patterns
beneath it.

 4. In the outbound tree, right-click the digit pattern under which you are adding another digit pattern and
select New.
A blank digit pattern window opens.

 5. Type the digit pattern and press Enter.
 6. AfterCall type, select a call type.
 7. AfterCall rate, select a call rate.
 8. After Toll fraud, select the check box if calls with this digit pattern are treated as toll fraud.

See "Adding inbound call information" on page 110.
 9. On the ribbon, click Save.

To add a digit pattern to a carrier plan by .csv import
 1. In the left pane, underCall Accounting, click Carrier plans.
 2. Select the carrier plan to which you are adding a digit pattern.
 3. Click theOutbound tab.
 4. Select Outbound and click Import.

The import wizard opens.
 5. Select the file type to import.
 6. Browse to the location of your .csv file.

Default digit patterns for each region are located on the Enterprise Server in the Contact Center
Solutions installation directory under src\Support. The default installation directory is
C:\CCM\src\Support.

 7. In the options window, select the appropriate result if duplicate digit patterns are imported.
 8. Click Next.

The field mappings window opens.
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 9. Add andmap the available columns in the wizard to the columns in your .csv file.
NOTE:Youmust place the selected columns in the order that reflects the contents of your .csv file. For
example, if digit patterns are the first column in your .csv file, youmust ensure that digit patterns are the
first item in your selected columns list.

 10. Click Next.
The wizard imports the .csv file.

Adding inbound call information
Youmust assign call rates and call types to cost inbound calls.

To add inbound call information to a carrier plan
 1. In YourSite Explorer, underCall Accounting, click Carrier plans.
 2. Select the carrier plan to which you are adding inbound call information.
 3. Click the Inbound tab.

The Inbound tab lists all of the DNIS found in the YourSite database.
 4. Select a DNIS.
 5. AfterCall type, click ... and select a call type.
 6. AfterCall rate, click ... and select a call rate.

See "Adding internal call information" on page 110.

Adding internal call information
Youmust assign call rates and call types to cost internal calls.

NOTE: If you select the Toll fraud check box, all internal calls will be considered toll fraud.

You can define all internal calls as toll fraud. To view a comprehensive list of internal calls, after you have
defined internal calls as toll fraud, generate the appropriate reports:

l Extension and Extension Group Accounting Toll Fraud report
These reports show the toll fraud activity by extension and extension group.

To add internal call information to a carrier plan
 1. In YourSite Explorer, underCall Accounting, click Carrier plans.
 2. Select the carrier plan to which you are adding internal call information.
 3. Click the Internal tab.
 4. AfterCall type, click ... and select a call type.
 5. AfterCall rate, click ... and select a call rate.
 6. After Toll fraud, select the check box if all internal calls are treated as toll fraud.

See "Associating carrier plans tomedia servers and/or trunk groups" on page 110.

Associating carrier plans to media servers and/or trunk groups
NOTE: If you cost calls based on trunk groups, all media servers must be associated to carrier plans.

Call Accounting attempts to cost outbound calls at the trunk group level first. If it cannot cost the call there,
then it costs at themedia server level.

Ensure you assign the carrier plan you configured in YourSite Explorer to themedia servers and/or trunk
groups by carrier.
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To associate carrier plans tomedia servers and/or trunk groups
 1. In YourSite Explorer, underCall Accounting, click Carrier plans.
 2. In theCarrier planswindow, underName, select the carrier plan to be associated to amedia server or

trunk group.
 3. Click theMedia servers or Trunk groups tab.
 4. UnderAvailable members, select themember to be added toSelected members.
 5. Click > to move the selectedmember to the Selectedmembers list.
 6. On the ribbon, click Save.

Specifying toll fraud settings
You can configure toll fraud for calls

l That exceed a specific amount (for example, $5.00) - you configure this on the ribbon
l To specific phone numbers - you configure this in the outbound digit tree
l To specific countries or area codes - you configure this in the outbound digit tree
l To toll charge numbers - you configure this in the outbound digit tree
l That are internal - you configure this on the Internal tab of the carrier plan

See "Adding internal call information" on page 110.

Specifying the call cost threshold
Toll fraud can be defined as calls that exceed a pre-set call cost threshold. For example, you can define the
specified call cost threshold as $20.00. If an employee were tomake a call that cost $20.01 or more, the call
would be defined as toll fraud.

To specify the call cost threshold
 1. In YourSite Explorer, on the ribbon, click theConfiguration tab.
 2. Click Call Accounting.
 3. AfterCall cost threshold, define the threshold over which calls are considered toll fraud.
 4. On the ribbon, click Save.

Defining toll fraud
Toll fraud can be defined as

l Calls to a restricted country (for example, calls to Australia use the country code 61)
l Calls to restricted phone numbers (for example, your employees' home phone numbers)
l Calls to restricted area codes (for example, you know your business does not deal with Alaska, so any

call with the area code 907)
l Toll charge calls (any calls with the digits 1900)

To define toll fraud
 1. In YourSite Explorer, underCall Accounting, click Carrier plans.
 2. Click theOutbound tab to set toll fraud for outgoing calls, or the Internal tab to set toll fraud for internal

calls.
 3. Select the digit pattern to be defined as toll fraud.
 4. Select the Toll fraud check box.
 5. On the ribbon, click Save.
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Subscriber Services configuration
Subscriber Services is an optional application to Call Accounting. Using Subscriber Services, you can create
customized plans to cost subscriber calls. Because the plans are customizable, you can bill back some
subscribers a fraction of the cost of their calls and others you canmark up the cost of the calls. Using
Subscriber Services you can also add surcharges for the billing period.

Configuring devices manually
You configure subscribers, subscriber groups, billing options, and subscriber plans in YourSite Explorer.

Adding subscribers
When you add subscribers to the database, youmust associate an extension or an Account Code to the
subscriber.

To add a subscriber
 1. In YourSite Explorer, underCall Accounting, click Subscribers.
 2. Click Add.
 3. AfterName, type the name of the subscriber.
 4. AfterReporting number, type the subscriber reporting number.
 5. Optionally, afterSubscriber plan, click ... and select the plan.
 6. You can add subscribers to a subscriber plan now or later.

See "Adding subscriber plans" on page 113.
 7. On theExtension tab, underAvailable members, select themember to be added to theSelected

members.
 8. Click > to add the selectedmember to the Selectedmembers list.
 9. On theAccount Code tab, underAvailable members, select themember to be added to theSelected

members.
 10. Click > to add the selectedmember to the Selectedmembers list.
 11. On the ribbon, click Save.

Adding subscriber groups
To add a series of subscriber groups
 1. In YourSite Explorer, underCall Accounting, click Subscriber Groups.
 2. Click Add.
 3. AfterName, type the name of the subscriber group.
 4. After theReporting number, type the subscriber group reporting number.
 5. Click theMembership tab.
 6. UnderAvailable members, select themember to be added to theSelected members.
 7. Click > to add the selectedmember to the Selectedmembers list.
 8. On the ribbon, click Save.

Adding billing options
Billing options are applied to subscriber plans so that you can apply surcharges. Surcharges can occur daily,
weekly, monthly, yearly, or once as a flat rate.Billing options include the ability to generate percentage
markups. For example, if you have a weekly charge of $5.00 and run your subscriber report monthly (four
weeks), the total surcharge on the report is $20.00.
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CAUTION: The billing frequency of surcharges is always rounded up. For example, if you generate a report
that spans eight days, and you have selected a weekly charge of $5.00, the report will show a charge of
$10.00 because eight days is rounded up to two weeks.

To add a billing option
 1. UnderCall Accounting, click Billing options.
 2. Click Add.
 3. AfterName, type the name of the surcharge.
 4. AfterDescription, optionally type the description of the surcharge.
 5. After Frequency, select the occurrence of the surcharge (by report period, day, week, month, or year).
 6. UnderService Charge Types, select a billing option.

l If you selectedSurcharge amount, type the amount of the surcharge.
l If you selectedSimple percent markup, type the percent to markup. Optionally, to add the

percent markup to the bill subtotal, select Apply to subtotal.
NOTE:When Apply to subtotal is selected, the percent markup is applied to the billing usage and
service charges subtotal. If Apply to subtotal is not selected, the percent markup is applied to
billing usage only.

 7. On the ribbon, click Save.

Adding subscriber plans
You configure the following options in the subscriber plans.

Minimum duration to cost
You can specify the seconds after which a subscriber plan applies to a call. For example, if theminimum
duration to cost is 10 seconds, the subscriber plan applies to calls over 10 seconds only. This plan will not
charge subscribers for calls under 10 seconds.

NOTE: If theMinimum duration to cost value is $0.00, the subscriber plan will apply to the entire cost of the
call.

Percentage markup
You can charge the subscriber a percentage of the rate per call. The percentage can bemarked up (for
example, 50%) or discounted (for example, -10%).

Fixed cost markup
You can charge the subscriber a fixed amount per call based on the rate. If the carrier charges $1.00, the fixed
amount can bemarked up (for example, $2.00) or discounted (for example, ($0.50)).

Fixed cost
You can apply a flat rate per call. This cost will override all other subscriber costs. For example, the fixed cost
can be $2.00 per call. That rate includes the cost and themarkup or discount.

Cost ceiling
NOTE: If the cost ceiling value is Unlimited, no cost ceiling applies and the subscriber plan will apply to the
entire cost of the call.

You can specify a cost ceiling when you do not want to charge a subscriber more than a specific amount. For
example, if the cost ceiling is $50.00, a subscriber will not be chargedmore than $50.00 for a call.
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Billing options
Billing options are applied to subscriber plans so that you can apply surcharges. Surcharges can occur daily,
weekly, monthly, yearly, or once as a flat rate. For example, if you have a weekly charge of $5.00 and run your
subscriber report monthly (four weeks and three days), the total surcharge on the report is $25.00.

CAUTION:
l In YourSite Explorer, youmust configure call types, time slots, call rates, billing options, employees,

and subscribers before you add subscriber plans. Do not add devices when you are configuring
subscriber plans or you could lose subscriber configuration data.

l When you configure a subscriber plan, youmust complete all required fields (for outbound, inbound, and
internal information) before you are able to save.

You configure subscriber plans to help you determine the cost of calls made by subscribers or employees, and
to charge amarkup/discount for each call or amarkup/discount of a summary.

To configure a subscriber plan
 1. In YourSite Explorer, underCall Accounting, click Subscriber plans.
 2. Click Add=>Basic. Otherwise, click Add=>Advanced and select a carrier plan from the list.

For a basic subscriber plan, the subscriber rates are based on the rates of the carrier plan associated to
the subscriber’s or employee’s extension and/or Account Code.
For an advanced subscriber plan, the subscriber rates are based on the altered rates of the carrier plan
you selected from the list.

 3. AfterName, type the name of the subscriber plan.
 4. AfterMinimum duration to cost, specify the threshold above which the subscriber plan applies to the

call.
For example, if theminimum duration to cost is 10 seconds, when the 10 second threshold is met or
surpassed the subscriber plan applies. The subscriber plan does not apply to calls under 10 seconds.
If theMinimum duration to cost value is $0.00, the subscriber plan applies to the entire cost of the call.

 5. After Fixed cost markup, select themarkup/discount as a dollar amount added to/subtracted from the
rate.
NOTE: If you specify a percent markup, Call Accounting applies the percent markup to the rate and
then applies the fixed cost markup to the rate.
A fixed cost markup refers to a fixed amount added to the cost of a call. If the rate is 5 cents per minute
+ $2, the $2 is the fixedmarkup.

 6. After Fixed cost, select the cost.
A fixed cost calls is charged a fixed amount that does not depend on the duration of the call. If the cost
is $5 per call, then $5 is the fixed cost. Fixed costs override all other costs.

 7. AfterPercent markup, select themarkup/or discount as a percent of the rate.
 8. To charge subscribers amaximum amount per call, afterCost ceiling, type a value.

If the cost ceiling value is $0.00, no cost ceiling applies and the subscriber plan applies to the entire
cost of the call.

 9. UnderAvailable members, select themember to be added to theSelected members.
 10. Click > to add the selectedmember to the Selectedmembers list.
 11. Click theBilling options tab.
 12. UnderAvailable members, select themember to be added to theSelected members.
 13. Click > to add the selectedmember to the Selectedmembers list.
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 14. Optionally, add outbound, inbound and internal call information. Add this information only if you plan to
adjust the carrier plan rate.
See "Adding outbound digit patterns" on page 108.
See "Adding inbound call information" on page 115.
See "Adding internal call information" on page 110.

 15. On the ribbon, click Save.

Adding outbound digit patterns
Ensure you configure the outbound call types and call rates you need for your subscriber plan before you
begin.

To add a digit pattern to a subscriber plan
 1. UnderCall Accounting, click Subscriber plans.
 2. Select the subscriber plan to which you are adding a digit pattern.
 3. Click theOutbound tab.
 4. In the outbound tree, click the digit pattern under which you are adding another digit pattern.
 5. On theOutbound tab, click Add.
 6. Type the digit pattern.
 7. Press Enter.
 8. AfterCall type, click ... and select an outbound call type from the list.
 9. AfterCall rate, click ... and select the call rate from the list.
 10. On the ribbon, click Save.

Adding inbound call information
Ensure you configure the DNIS call types and call rates you need for your subscriber plan before you begin.

To add inbound call information to a subscriber plan
 1. UnderCall Accounting, click Subscriber plan.
 2. Select the subscriber plan to which you are adding inbound call information.
 3. Click the Inbound tab.
 4. AfterCall type, click ... and select a DNIS call type from the list.
 5. AfterCall rate, click ... and select the call rate from the list.
 6. On the ribbon, click Save.

Adding internal call information
Ensure you configure the internal call types and call rates you need for your subscriber plan before you begin.

To add internal call information to a subscriber plan
 1. UnderCall Accounting, click Subscriber plan.
 2. Select the subscriber plan to which you are adding internal call information.
 3. Click the Internal tab.
 4. AfterCall type, click ... and select an internal call type from the list.

If the call type you require is not listed here, youmust create it before you can select it and save the
digit pattern.
See "Adding call types" on page 105.

 5. AfterCall rate, click ... and select the call rate from the list.
 6. On the ribbon, click Save.
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Business hour schedules
You create schedules so that Call Accounting can accurately reflect the business hours of your operation.
You can create yearly or seasonal schedules. When you install Call Accounting, the 24/7 default schedule is
created. This schedule is for businesses that operate 24 hours a day, seven days a week.

Your Call Accounting software performs certain tasks during business hours and other tasks after business
hours. You create schedules so that Call Accounting knows what the hours of operation are for your business.

You create schedules for the SX-200 Call Accountingmedia server in the Contact Center Management
website, under YourSite=>Schedule.

Creating schedules
The schedules you create do not expire. The weekly schedule configuration applies week after week until you
change the schedule or apply a different schedule to the device. You can exclude specific dates from the
schedule for national holidays.

To create a schedule in YourSite Explorer
 1. InYourSite Explorer, click Schedules.
 2. Click Add.
 3. AfterName, type the name of the schedule (for example, type Fall 2002 schedule).
 4. AfterSchedule exclusion list, click ... and select a schedule exclusion list.
 5. If youmust create or modify an exclusion list for the schedule, click Manage schedule exclusion list

and configure a list.
See "Managing schedule exclusion lists" on page 117.

 6. After Start time, select the business day start time.
 7. AfterEnd time, select the business day end time.
 8. AfterDisable for day, select the check box for each day your business is closed.
 9. Click Save.

To create a schedule in the Contact Center Management website
 1. In Contact Center Management, click YourSite=>Schedule.
 2. Click Add.
 3. AfterName, type the name of the schedule (for example, type Fall 2007 schedule).
 4. AfterSchedule exclusion list, select a list.
 5. If youmust create or modify an exclusion list for the schedule, click Manage schedule exclusion list

and configure a list.
See "Managing schedule exclusion lists" on page 117.

 6. After Start time, select the business day start time for each day of the week.
 7. AfterEnd time, select the business day end time for each day of the week.
 8. AfterDisable for day, select the check box for each day your business is closed.
 9. Click Save.
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Managing schedule exclusion lists
Tomanage schedule exclusion lists in YourSite Explorer
 1. InYourSite Explorer, click Schedules.
 2. Click Add.
 3. Click Manage schedule exclusion list.
 4. AfterName, type the name of the exclusion list.
 5. On the calendar, click the dates you want to exclude from a schedule.
 6. Click Save.
 7. Click Apply to apply the schedule exclusion list to the schedule.

Tomanage schedule exclusion lists in the Contact Center Management website
 1. In Contact Center Management, click YourSite=>Schedule.

The Schedule window opens.
 2. Click Add orEdit.
 3. Click Manage schedule exclusion list.
 4. AfterName, type the name of the exclusion list.
 5. On the calendar, click the dates you want to exclude from a schedule.
 6. Click Save.
 7. Click Apply to apply the schedule exclusion list to the schedule.

Applying schedules
You apply schedules you create in the Contact Center Management website (YourSite=>Schedule) and in
YourSite Explorer (YourSite Explorer=>Schedules) to media servers.

You can apply the schedules you create to
l Media servers

See "Addingmedia servers" on page 61
l Network Monitor alarms

See "Network Monitor alarms" on page 75

Monitoring and alarming subsystem
Call Accounting uses a centralized alarming system that is entirely configured in YourSite Explorer. The
Maintenance Alarm Dispatcher service is located on the Enterprise Server and performs server maintenance
activities as well as controlling all alarming in the network. Alarm notifications are sent for each device that is
triggering an alarm and distributed in the following ways:

l Email:Summary emails are sent to valid email subscribers and list all current, active alarm statuses as
well as a list of alarms that triggered the alert.

l RSS:AnRSS feed is published on the server and can be subscribed to by any RSS reader that has
been given access to the server.

l SNMP:A count of alerting alarms for each category can be viewed in an SNMP manager.
l Start Page:A list of currently active Contact Center Management alarms with a Knowledge Base

article list of descriptions, severity, impact on contact centers, and troubleshooting can be viewed on
the Start Page of YourSite Explorer. (See "YourSite Explorer Start Page" on page 53.)

By default, alarms are configured to expire after 24 hours.
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The Server Monitoring Agent is a standalone service that is deployed on each server in the enterprise. It
monitors performance counter values based on alarm configuration, collects external alarm data from
services, and notifies theMaintenance Alarm Dispatcher service when alarm states surpass configured
thresholds.

Alarms may also be viewed with the Enterprise Status icon and RSS feed link, located in the lower-right
corner of the YourSite Explorer window. The Enterprise Status icon is a circular, colored status indicator. The
color indicates the highest level of severity for all alarms currently alerting (Normal = Green, Minor = Yellow,
Major = Orange, Critical = Red, Unknown = Gray). If you subscribe to the RSS feed and your RSS reader is
open, you will be notified with changes to alarm states. If you don’t subscribe to the RSS feed, you can click
the RSS feed link and view active alarms in your default browser.

In addition to receiving notification of alarms, you can quickly view Enterprise status and active alarms using
the YourSite Explorer Start Page’s Alarms tab. The Alarms tab consists of two panes: the Feed Preview and
the prairieFyre Knowledge Base pane. The Feed Preview contains an RSS feed of the active alarms. The
prairieFyre Knowledge Base pane contains a table of contents linking to relevant Knowledge Base (KB)
articles for each alarm. Each KB article contains a description of the reason for the alarm, the severity of the
alarm, the impact on contact centers, and troubleshooting steps.

Alarms are categorized based on the type of data they analyze. There are three types of alarms:
l Performance counter and Registered services performance counters alarms: based on

performance counters
l Media server alarms: independently tracked for eachmedia server
l General alarms: all other alarms

Alarms are configured in YourSite Explorer=>Enterprise=>Alarms.

To configure performance counter and Registered services performance counter type alarms
 1. In YourSite Explorer, click YourSite=>Alarms.

NOTE: Alarms is located in the Enterprise pane.
 2. Select the performance counter or Registered services performance counters alarm you want to

configure.
 3. Click theGeneral tab.
 4. Select a category type from the drop-down list afterCategory, if you want to specify in which SNMP

category you want this alarm to display.
 5. Set minor, major, and critical thresholds and threshold durations for the alarm.

The threshold duration you specify determines the length of time an alarm state is active before an
alarm is triggered and notification is sent.
You can disable any of the thresholds by selecting Disabled from the drop-down list next to the
threshold.

 6. Select theRealert on value change check box if you want to be notified every time the alarm value
changes.

 7. If you want to disable this alarm, click Disable.
 8. If you want to temporarily disable this alarm, click Snooze and choose a length of time for which the

alarm will be disabled. If you want to disable the alarm for a length of time outside of the available
choices, click Customize and choose a time by using the options in theSelect Wake Timewindow.

 9. Click theActions tab.
 10. Select theEnabled check box if you want subscribers to receive emails when alarms are triggered.
 11. Click… and select a business hour schedule to apply to this alarm.
 12. If you want to receive notifications for critical alarms outside of specified business hours, select the

Ignore business hours for critical alerts check box.
 13. Click Save.

Monitoring and alarming subsystem
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To configuremedia server type alarms
 1. In YourSite Explorer, click YourSite=>Alarms.

NOTE: Alarms is located in the Enterprise pane.
 2. Select themedia server type alarm you want to configure.
 3. Click theGeneral tab.
 4. Select a category type from the drop-down list afterCategory, if you want to specify in which SNMP

category you want this alarm to display.
 5. AfterSeverity, select the level of severity you want to apply to this alarm (minor, major, or critical).
 6. AfterDuration, select the length of time the alarm state is active before an alarm is triggered and

notification is sent.
 7. Select theRealert on value change check box if you want to be notified every time the alarm value

changes.
 8. If you want to disable this alarm for specific media servers, afterDisable media servers, click…,

select themedia server from theSelect disabled media serverswindow, and click OK.
 9. If you want to disable this alarm, click Disable.
 10. If you want to temporarily disable this alarm, click Snooze and choose a length of time for which the

alarm will be disabled. If you want to disable the alarm for a length of time outside of the available
choices, click Customize and choose a time by using the options in theSelect Wake Timewindow.

 11. Click theActions tab.
 12. Select theEnabled check box if you want subscribers to receive emails when alarms are triggered.
 13. Click… and select a business hour schedule to apply to this alarm.
 14. If you want to receive notifications for critical alarms outside of specified business hours, select the

Ignore business hours for critical alerts check box.
 15. Click Save.

To configure general type alarms
 1. In YourSite Explorer, click YourSite=>Alarms.

NOTE: Alarms is located in the Enterprise pane.
 2. Select the general type alarm you want to configure.
 3. Click theGeneral tab.
 4. Select a category type from the drop-down list afterCategory, if you want to specify in which SNMP

category you want this alarm to display.
 5. AfterSeverity, select the level of severity you want to apply to this alarm (minor, major, or critical).
 6. AfterDuration, select the length of time the alarm state is active before an alarm is triggered and

notification is sent.
 7. Select theRealert on value change check box if you want to be notified every time the alarm value

changes.
 8. If you want to disable this alarm, click Disable.
 9. If you want to temporarily disable this alarm, click Snooze and choose a length of time for which the

alarm will be disabled. If you want to disable the alarm for a length of time outside of the available
choices, click Customize and choose a time by using the options in theSelect Wake Timewindow.

 10. Click theActions tab.
 11. Select theEnabled check box if you want subscribers to receive emails when alarms are triggered.
 12. Click… and select a business hour schedule to apply to this alarm.
 13. If you want to receive notifications for critical alarms outside of specified business hours, select the

Ignore business hours for critical alerts check box.
 14. Click Save.
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Validating alarms
Some alarms require the system to be validated before the alarms will clear. The Validate buttonmust be
clicked after the values have been corrected, otherwise the alarm will not be cleared until nightly
synchronization. The alarm may not clear with nightly synchronization if the value is still wrong.

Consult the alarm’s Knowledge Base article for validation information.

Enabling SNMP agent for alarms
Contact Center Solutions/Call Accounting includes an SNMP agent that enables you tomonitor Contact
Center Solutions/Call Accounting alarms through an SNMP manager. Contact Center Solutions/Call
Accounting SNMP agent integrates with theWindows SNMP service and requires that aWindows SNMP
Service be added and configured on the Enterprise Server.

The Contact Center Solutions/Call Accounting SNMP agent is primarily configured for traps only, but also
responds to Get-request messages for trapmessages.

SNMP Agent provides information on nine categories of alarms:
l General Category Alarm
l Data Collection Alarms
l Server Resource Alarm
l Communication Alarm
l License Violation Alarm
l IVR Alarm
l Reporting Alarm
l Performance Alarm
l Configuration Alarm

The value reported for each alarm category is the highest severity of alarm currently triggered in that category.

Configuring Windows SNMP service for the SNMP agent
Contact Center Solutions and Call Accounting requires the use of theWindows SNMP service for the Contact
Center Solutions SNMP agent.

To configureWindows SNMP service for the SNMP agent
 1. If you do not have SNMP Service installed on your server, install it using theAdd/Remove Program,

Add Features, orAdd roles and features function of yourWindow server.
 2. After the installation has completed, navigate toServices.
 3. Right-click onSNMP and select Properties.
 4. Select the Traps tab.
 5. UnderCommunity name, type a community name, such as Public, and click Add to list.
 6. Under Trap destinations:, click Add.
 7. UnderHost name, IP or UPX address:, type the destination for Contact Center Solutions SNMP

Agent traps.
 8. Click Add.
 9. Select theSecurity tab.
 10. Click Add.
 11. In theCommunity rights drop-down list, select READ WRITE.
 12. UnderCommunity name:, typePublic.

Monitoring and alarming subsystem
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 13. Select the Log On tab.
 14. Under Log on as:, select Local System Account.
 15. Click OK.

NOTE:After setting up your SNMP Agent, it is recommended you test it using an appropriate tool to
confirm that it has been configured correctly.

SNMP MIB summary
Table 6 - 5 and Table 6 - 6 summarize object information from theMIB. TheMIB is located in
<drive>]/CCM/Services/MaintenanceAlarmDispatcher/Snmp.

Table 6 - 5 prairieFyre sub-tree

Object Type Object Identifier

enterpriseAlarms prairieFyre 1

enterpriseAlarms prairieFyre 2

enterpriseAlarms prairieFyre 3
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Table 6 - 6 MIB enterpriseAlarms sub-tree summary

Object Type Syntax Integer Max
Access Description Object Identifier

manufacturer manufacturer read-
only

prairieFyre Soft-
ware's Contact
Center Suite

enterpriseAlarms 1

overridingSystemAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

This is the cumulative
total of all reporting
active alarms and
should be viewed as
the overriding alarm
state that the prair-
ieFyre suite is now
reporting.

enterpriseAlarms 2

generalCatagoryAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

When a software
entity raises an alarm
not covered in the fol-
lowing list then it is
categorized as a gen-
eral alarm.

enterpriseAlarms 3

dataCollectionAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

One of theMedia Con-
troller Data Link Con-
nections within the
prairieFyre Enterprise
is offline. This could
be a connection to a
PBX or an e-Mail
Server or SMS trans-
port server or some
other controller of a
media transaction
that is configured to
be connected to the
prairieFyre suite.

enterpriseAlarms 4

serverResourceAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

One or more software
services in the prair-
ieFyre suite is report-
ing an unusual
consumption of com-
puter resources. This
may a result of an
exceptionally high
CPU consumption or
running low on phys-

enterpriseAlarms 5
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Object Type Syntax Integer Max
Access Description Object Identifier

ical memory, for
example. This may
require a service
restart to resolve.

communicationsAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

One or more service
endpoints is reporting
an error in its control
channel with an asso-
ciated endpoint. This
may be a socket or
WCF channel or may
be anMSMQ error
that is preventing nor-
mal process flow in
the prairieFyre soft-
ware suite.

enterpriseAlarms  6

licenseViolationAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

The prairieFyre Enter-
prise LicensingMan-
ager is reporting that
the installation is vio-
lating or has
attempted to exceed
enforced license lim-
its for their instal-
lation. This may be
configuring the YSE
services for features
or capacity they have
not purchased.

enterpriseAlarms  7

ivrAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

The IVR services are
reporting an alarm,
whichmay be due to
media ports being out
of service or an inabil-
ity to load a call flow.

enterpriseAlarms  8
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Object Type Syntax Integer Max
Access Description Object Identifier

reportingAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

The reporting engine
is reporting an error
that implies it cannot
generate a requested
report due to a sys-
tem inoperability
error. This may be a
corrupt report tem-
plate or could be a
transaction error on
the retrieval of SQL
data to fill the report.

enterpriseAlarms  9

performanceAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

One or more of the
service endpoints in
the prairieFyre suite
is reporting an over-
load condition

enterpriseAlarms  10

configurationAlarm

unknownAlarm(0)
noAlarm(1)
minorAlarm(2)
majorAlarm(3)
criticalAlarm(4)

read-
only

One or more of the
service endpoints in
the prairieFyre suite
is reporting an error
when loading con-
figuration data.

enterpriseAlarms  11

Security roles
You create security roles to restrict employees from specific devices and Call Accounting application areas.

NOTE: In order for you to assign security roles, your account must be associated to a security role that does
not restrict you from administering security.

The Call Accounting default security setting ofLocal Administrator allows employees full access to all of the
devices except Write Back for synchronization. Call Accounting security roles are inclusive. This means that
a security role assigned to an employee defines the application areas an employee can access.

When you install Call Accounting, a default user is created. This assures you there is at least one account
with which you can access the Call Accounting website.

The default user name and password are
l Username: _admin
l Password: _password
l Security Role: Local Administrator

Security roles
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Security roles have two components.
l Basic

Basic security controls user access to specific areas of Call Accounting.
l Advanced

Advanced security controls user access to customized lists of devices, real-timemonitors, profiles,
reports, sites, and users.

Creating and applying security roles
You can create security roles that have an unlimited number of combinations of basic and advanced
authorizations applied to them. For example, you can create a security role with minimal security restrictions,
granting users access to as many Contact Center Management reports and applications as you designate.
You do this by leaving the security components listed under the Advanced tab set to "Not restricted".
Alternatively, you can create a security role that has full access to someCall Accounting application areas but
is restricted from accessing other reports and devices..

To create and apply a security role with basic and advanced components, youmust
 1. Ensure employees are configured in the YourSite database.

See "Adding employees" on page 94.
 2. Create security lists.
 3. Configure basic security.
 4. Configure advanced security.
 5. Assign the security role to one or more employee.

To create and apply a security role with basic security components only, youmust
 1. Ensure employees are configured in the YourSite database.
 2. Specify basic security.
 3. Assign the security role to one or more employees.

To create and apply a security role with advanced security components only, youmust
 1. Create security lists to apply advanced security.
 2. Configure basic security.
 3. Configure advanced security.
 4. Ensure all employees are configured in the YourSite Explorer.
 5. Assign the security role to one or more employees.
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Creating security lists
You can use advanced security to restrict user access to sites, reporting, and real-time functions.

Before you can specify advanced security, youmust create security lists (device lists, real-timemonitor lists,
report lists, site lists, and/or user lists). Each list must contain the devices, real-timemonitors, reports, sites,
and/or users to which employees are granted access.

You use the following security lists to define advanced security:
l Device list—Device lists specify devices for which employees may view real-time information. You

create device lists to restrict access to statistics on specific employees. For example, youmight want
amanager to view certain employees only (specific device - Kanata employees). The device list must
contain the device (employee group - in this case, Kanata employees) to which the user may gain
access.

l Profile list—You create a profile list to restrict users frommanaging specific real-timemonitor profiles.
l Real-time monitor list—The real-timemonitor list specifies real-timemonitors to which you are

granted access. You create a real-timemonitor list to restrict access to particular real-timemonitors.
The real-timemonitor list must contain themonitors to which the user may gain access.

l Report list—You create report lists to restrict users from viewing specific report types. For example,
youmight want managers to view employee reports only (specific report category). The report list must
contain the reports the user may run. If you do not assign a report list to the employee, then the
employee will see every YourSite group and team when running reports andmonitoring real-time
activities (unless basic security is assigned to that employee that does not permit the employee to gain
access to any reports).

l Site list—The site list specifies sites youmay manage. You create a site list to restrict access to
devices by site. For example, youmight want a supervisor to view the employees at a particular site
only. The site list must contain the site (in this case, Kanata) to which the user may gain access.

l User list—You create a user list to restrict a user from chatting online with certain employees. The user
list must contain the employees with which the user may chat. For example, youmight want managers
to chat online with only the employees they supervise. If Janemanages Bill, Sue, andGeorge, then you
assign Jane an advanced security role that permits Jane to chat with Bill, Sue, andGeorge (the user list
would contain Bill, Sue, andGeorge).

l Card design list—You create a card design list to restrict users frommanaging card designs (card
designs specify the information displayed on extension real-timemonitors).

To create a security list
 1. On the Call Accounting website, click YourSite=>Security=>Security lists=>select the security list to

be created.
 2. Click Add.

The Add list tab opens.
 3. AfterName, type the list name (for example, type Jane’s chat group).
 4. AfterDescription, type the list description (for example, type Jane’s group).
 5. Click the Members tab.
 6. If you are creating a device or reports list, after Filter by, select a category to narrow the items that

display in the list (for example, Employee group).
 7. Select the check boxes of themembers to be included in the list.
 8. Click Save.

The security list displays in the list tree.

Security roles
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Configuring security roles
Security is configured on the Call Accounting website.

NOTE:When users first access the Call Accounting website, by default, they can access all of the Call
AccountingWeb applications.

You can create a basic security role to restrict user access to specific areas of the Call Accounting website.
For example, to restrict users from viewing Contact Center Client and Enterprise Configuration, then you
must create a security role with those characteristics.

Youmust create a security list before you can create an advanced security role. Using these lists, you define
a security role. See "Creating security lists" on page 126.

After you create device security lists you can create an advanced security role that restricts access to
reports, real-time statistics, ChatLine, sites, and real-timemonitors.

To configure security roles
 1. In Contact Center Management, click YourSite=>Security=>Security roles.

The Security roles window opens. It lists all of the security roles that have been created.
 2. Click Add a role.
 3. AfterRole name, type the name of the security role.
 4. AfterRole description, type the description of this security role.
 5. On theBasic tab, clear the check boxes of the items the user is not permitted to use. For example, if

agents are not permitted to administer security, clearMay manage security.
See Table 6 - 7 for a description of the YourSite Explorer security setting options.

 6. If required, click theAdvanced tab and specify advanced security components.
An advanced security role restricts access to reports, real-time, Chat, sites, and real-timemonitors.

 7. Click Save.

Table 6 - 7 describes the security setting options for YourSite Explorer synchronization that display in the
Basic security tab.

Table 6 - 7 YourSite Explorer synchronization - security setting options

Option Description

No access If NoAccess is enabled you cannot configure Enterprise settings or devices in YourSite
Explorer.

Allow Read
Access

Allow Read Access enables you to read Enterprise/device configuration settings on the tel-
ephone system(s).

Allow
Read/Write
Access

Allow Read/Write Access enables you to read Enterprise/device configuration settings on
the telephone system(s) and write them to the YourSite database.

Allow Full
Control

Allow Full Control enables you to read Enterprise/device configuration settings on the tel-
ephone system(s), write them to the YourSite database, and write back devices pro-
grammed in YourSite Explorer to the telephone system.
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Verifying security role properties
To verify the properties of a security role
 1. In Contact Center Management, click YourSite=>Security=>Security roles.

The Security roles window opens. It lists all of the security roles that have been created.
 2. Click View adjacent to the security role to view its properties.

You can assign the security roles to new users and to existing users.

Assigning security roles to employees
NOTE: Users who are currently logged on will not be affected by changes made to their associated role until
the next time they log on. To ensure security role changes take effect immediately, start and stop the Call
Accounting website from the Internet Server Manager. All of the clients will be disconnected and forced to log
on again.

To assign a security role to an employee
 1. In Contact Center Management, click YourSite=>Configuration.
 2. Click Employee=>.
 3. Across from the record to be edited, click Edit.
 4. Click theCall Accounting user tab.
 5. AfterSecurity role, select a security role to assign to the employee.

All security roles are listed here.
 6. Click Save.

Validating YourSite Explorer configuration
The Validate buttonmanually triggers a validation of your contact center system configuration by going
through Class of Service system options, SMDR options, agent groups, voice queues, andmedia servers,
firing or clearing alarms as appropriate. Validation automatically takes place with the synchronization that
occurs during nightly maintenance, but manual validation is required to clear some alarms.

To validate YourSite Explorer configuration
 1. In YourSite Explorer, click the Tools tab.
 2. Click theValidate button.

Validating YourSite Explorer configuration
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Chapter 7

Call Accounting

Real-time Monitors

Contact Center Client
Providing Contact Center Client functionality to remote
employees
Troubleshooting real-time issues
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Real-time Monitors
Using the telephone system, the Enterprise Server continuously updates the real-time applications with
telephone system data, and simultaneously updates connected clients through Transmission Control
Protocol-Internet Protocol (TCP/IP).Contact Center Client real-timemonitors are automatically updated to
reflect device and device group changes made in YourSite Explorer. Supervisors and agents are provided with
point-and-click access to real-time performance statistics for their contact center, enabling them to identify
issues in contact center performance and see who is available to answer or assist with calls. For a
demonstration of real-timemonitors, click http://www.youtube.com/watch?v=oL-pXMSdOFc.

Employees view real-time voice statistics and the phone availability of general business employees on the
Extension State by Positionmonitor in Contact Center Client.

In addition to real-timemonitors, Contact Center Client includes the following application areas:
l Network Monitor

Network Monitor provides information on the status of media server real-time data collection. See
"Viewing the Network Monitor" on page 195.

l Management Console
UsingManagement Console you can restart services, administer the database, and perform
maintenance functions. See "Management Console" on page 40.

l Contact Center Chat
Contact Center Client provides instant messaging capabilities. Contact Center Chat provides the
online chat presence of employees, including Online, Offline, and Away. Employees can view the
availability and presence of other employees before they transfer calls or send online chat messages.
With the Enterprise Presence / Chat Integration license, Call Accounting integrates with Lync Server
2010 to provide enhanced presence. See "Using Contact Center Chat" on page 149.

The following optional applications and features reside in Contact Center Client:
l Contact Center PhoneSet Manager and Contact Center Softphone

Contact Center PhoneSet Manager and Contact Center Softphone are optional applications that enable
employees to use their desktop computers as IP-based phones.
See "Contact Center PhoneSet Manager and Contact Center Softphone" on page 209.

l Contact Center Screen Pop
Contact Center Screen Pop is an optional application that launches applications orWeb pages. In
addition, it enables agents to automatically receive caller and account information via pop-ups on their
computer monitors every time they receive calls.
See "Using Contact Center Screen Pop" on page 239.

l Enterprise Presence / Chat Integration
With the addition of Lync Server 2010, employees and supervisors useMicrosoft Lync as their default
instant messaging client. The presence of all company employees is natively delivered in Contact
Center Client. Contact center employees can view the presence of both internal and external contacts
to determine if they are available to communicate. In addition to Available, Offline, and Away,
employees see In aMeeting, Busy, In a call, Do Not Disturb, Be Right Back, and other presence
indicators.

http://www.youtube.com/watch?v=oL-pXMSdOFc
http://www.youtube.com/watch?v=oL-pXMSdOFc
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Lync Server 2010 extends the capabilities of Contact Center Chat enabling employees to communicate with
people who are

l In the same company, but are not using Contact Center Client
l In the same company, but are not on the same intranet
l External to the company, where the companies in which they work have a Lync Server environment

and use Lync
l External to the company, communicate over the public Internet, and use popular instant message

services (MSN, AIM, Yahoo!)

In aMicrosoft Lync environment, you can take advantage of other forms of communication: computer voice
calls, video conferencing, white boarding, and desktop sharing capabilities. Communication with MSN, AIM
and Yahoo! is typically limited to instant messaging only.

Contact Center Client
NOTE:

l By default, all employees can view the Extension State by Positionmonitor and devices in Contact
Center Client.

l The number of extensions logged on at any timemust be consistent with your software license.

Contact Center Client uses ribbons for device andmonitor control. (See Figure 7 - 1.)

Figure 7 - 1 Contact Center Client ribbon

Some tabs that display in the ribbon are dependent upon whichmonitor is active. These are referred to as
context sensitive tabs. When you enable context sensitivity for monitors, the associated context sensitive tab
for the activemonitor automatically becomes the active tab. See Table 7 - 1 for a list of the associated context
sensitive tabs for eachmonitor. See Figure 7 - 2 for an example of context sensitivity enabled for the
Extension State by Positionmonitor. Note that the Extension andMonitor Control tabs display in the ribbon.

NOTE: The options that display in the Contact Center Client ribbon are dependent upon your individual
security settings. Options which you are not given access to will not display.
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Table 7 - 1 Context sensitivity options display per monitor

Monitor Associated context sensitive tabs

Agent State
by Position Agent andMonitor Control tabs

Employee
State by
Position

Employee andMonitor Control tabs

Extension
State by
Position

Extension andMonitor Control tabs

NOTE:When an agent is logged into an extension, the context
sensitivity tab displays 'Agent Control'. When no agent is
logged into the extension, the context sensitivity tab displays
'Extension Control'.

Agent State
by Time Agent andMonitor Control tabs

Agent State
by Time for
Queue

Agent andMonitor Control tabs

Employee
State by
Time

Employee andMonitor Control tabs

Agent Shift Agent andMonitor Control tabs

Queue by
Period Monitor Options tab

Queue Now Monitor Options tab

Queue
Group Now Monitor Options tab

Queue Per-
formance Chart Options tab

Queue
Group Per-
formance

Chart Options tab

Queue Chart Options tab

Queue
Group Chart Options tab

Contact Center Client
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Monitor Associated context sensitive tabs

Interactive
Visual
Queue

n/a

NOTE:Context sensitivity is not supported for the Interactive
Visual Queuemonitor

Figure 7 - 2 Context sensitivity example - Extension Control tab

Starting Contact Center Client
You start Contact Center Client to access real-time functionality. After starting Contact Center Client, you
can choose tominimize it to either the system tray or the taskbar, depending on your operating system.

To start Contact Center Client
 1. OpenContact Center Client.
 2. If prompted, type your user name and password and verify the Enterprise Server IP address.
 3. If you use Secure Socket Layer, select SSL.

CAUTION:Do not select “Remembermy credentials” if you intend to work both at the office and from
home.

 4. Click Log on.
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When youminimize Contact Center Client and you are usingWindows XP as your operating system, the
Contact Center Client icon displays in your desktop system tray.

If you are usingWindows Vista, you can optionally configure Contact Center Client to display in your desktop
taskbar.

To display Contact Center Client in the taskbar
 1. In Contact Center Client, click the Contact Center Client icon button in the upper-left of the ribbon.
 2. Click Options.
 3. Clear theHide when minimized check box and click OK.

Contact Center Client, whenminimized, will display in the taskbar.
 4. To save the profile, click the Contact Center Client icon button and click Save as.
 5. Type aName for the profile and click OK.

The profile is saved and will automatically be applied each time you open Contact Center Client.
When device associations to device groups are changed in YourSite Explorer (add, delete, rename),
these changes will be automatically made in Contact Center Client real-timemonitors saved with user
profiles

Extension states
NOTE: If your Contact Center Client becomes disconnected from the server, upon re-connection the
extension states will automatically be synchronized with the server.

Table 7 - 2 lists the extension states and their corresponding icons.

Icon Term Meaning

Ringing Call is ringing on the extension and waiting to be handled

Idle Extension is waiting to receive a call

Non ACD Extension is involved in an incoming call or an internal extension-
originated call

Non-ACD Hold Extension has placed an incoming call or an internal extension-originated
call on hold

Outbound Call Extension is on an outgoing call

Table 7 - 2 Extension states

Contact Center Client
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Outbound Hold Extension has placed an outgoing call on hold

Off Hook Extension's phone is off the hook, so cannot receive calls

Camp on Extension is on a call and an incoming call is camped on (waiting to be
answered)

Forwarded to Extension has set all incoming calls to be forwarded to an alternate
answer point

Do Not Disturb Extension has activated DoNot Disturb and is not available to receive
calls

LoggedOff Extension is not currently logged on and is unavailable to take calls

Understanding Contact Center Client features
You can perform the following tasks on themonitors by either right-clicking within themonitor or selecting
options via the Contact Center Client ribbon:

l Openmonitors
l Dock monitors
l Add and remove device IDs
l Sort monitor devices
l Rearrange cells
l Set monitor dimensions
l Freeze and unfreeze columns
l Hide and show columns
l Filter device variables
l Set alarms
l Clear alarms
l Definemonitor styles
l Group data
l Print monitors
l Arrange windows
l Modify the view
l Build marqueemonitors to broadcast statistics andmessages
l Chat online with other employees
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Contact Center Client options
The following options apply to real-timemonitors.

Clear alarms
The Clear alarms command clears any current performance variable threshold alarms.

Add/Remove devices
The Add/Remove devices command adds or removes devices or device groups from themonitor. If you add
extension, they are added to the bottom of themonitor.

Set table dimensions
On the Extension State by Positionmonitor, the Set table dimensions command adds or deletes columns or
rows. If you delete devices, they are deleted them from the lower-right side of themonitor.

Size table to frame
On all monitors, the Size table to frame command adjusts the table to fit within the frame

Sort monitor
On the Extension State by Positionmonitors, the Sort monitor by name, state, or extension command sorts
employees by name, state and time in state, or extension.

General
On all monitors, under Properties, the General option specifies themonitor name and enables the horizontal
and vertical scroll bars.

On the extensionmonitors, you can also display tool tips, display a pattern upon failover, and display instant
messaging online presence indicators.

Cascade
When you right-click amonitor tab, underWindows, the Cascade command distributes activemonitors down
and across the Contact Center Client window.

Tile vertically
When you right-click amonitor tab, underWindows, the Tile vertically command distributes activemonitors
across the Contact Center Client window.

Tile horizontally
When you right-click amonitor tab, underWindows, the Tile horizontally command distributes activemonitors
down the Contact Center Client window.

Dock Contact Center Client
When you right-click amonitor tab, underWindows, the Dock Contact Center Client command docks Contact
Center Client at the top, bottom, left, or right of your desktop.

Always on top
When you right-click amonitor tab, underWindows, and select the Always on top command, Contact Center
Client always displays on your desktop on top of all other open applications.

Contact Center Client
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View
The View command hides or displays themainmenu, status bar, real-timemonitors, and email, fax, chat, and
voice legends.

Extension State by Position
The Extension State by Positionmonitor provides real-time information in cells that you can arrange tomirror
your floor plan: you can view phone extensions by their physical position. In addition, this monitor enables you
to view the current status of general business extensions. Card designs enable you to customize the
information displayed in the cells. See "Selecting and customizing card designs" on page 147.

When a phone is out of service, the extension and employee cells in real-timemonitors are grayed out. The
out of service state applies to phones that are not connected to the network, Teleworker employees that have
lost their Internet connection, phones that are physically disconnected or malfunctioning, or employees that
are not logged into their soft phone.

When you first open the extensionmonitor, you can select a card design:
l The Classic card displays the state, time in the state, presence, employee name, employee ID, and

extension number and presence.
l The Caller ID card displays the caller name and number (ANI), the number the caller/employee dials for

incoming/outgoing calls (DNIS), and caller collected digits (requires Intelligent Queue Collect Caller
Entered Digits), such as account numbers, the state, time in the state, presence, employee name,
employee ID, and extension number.

l The Call Cost card displays the same statistics as the Caller ID card, with the addition of call cost
statistics.

l Custom cards you create and share

Caller ID information is displayed when
l Extensions are in the following real-time states: Inbound andOutbound

You can set alarms for all statistics and for caller ID information, such as the caller name and number.

NOTE: If you are upgrading to Call Accounting Version 6.0 or greater, before you can select the Caller ID card
on the Add devices window ofthe extensionmonitor, youmust make the card available. To do so, right-click
an openmonitor, select the Caller ID card under Properties, Layout=>Card design and click Apply.

Viewing extension availability
NOTE:Users who will use the Extension by Positionmonitor must have the Class of Service HCI settings
enabled.

In your business, youmay bemonitoring
l General business, traditional extensions (non-contact center employees) who sit at the same desks

each day, are assigned their own desk phone extensions, and do not log on to their phones (their
phones are programmedwith their personal settings and are always active)

l General business, hot desking extensions (non-contact center employees) who log on to any phone in
the enterprise with a virtual extension configured with their personal settings. When the employee logs
on the extension becomes active. When the employee logs off of the extension it goes out of service.
(See Figure 7 - 3.)
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Figure 7 - 3 Extension State by Position

You can set up your real-timemonitor profile to include two or more Extension by Positionmonitors: one with
cells that are arranged to show the whereabouts of employees in your contact center, and another that shows
the status of general business extensions: active/inactive, inbound/outbound.

When a phone is out of service, the extension and employee cells in real-timemonitors are grayed out. The
out of service state applies to phones that are not connected to the network, remote employees that have lost
their Internet connection, phones that are physically disconnected or malfunctioning, or employees that are
not logged into their soft phone.

Extension Inbound
Extension Inbound refers to a general business extension on an inbound call.

Extension Outbound
Extension Outbound refers to a general business extension on an outbound call.

General business, traditional extensions who sit at the same desks each day
If you have general business, traditional extensions who sit at the same desks each day, you use the
Extension State by Positionmonitor to view where they are sitting in the contact center. After you add their
extensions to themonitor, you can arrange the cells to match the layout of your business, or arrange them
alphabetically or by department.

When a general business employee is in Idle, the cell for the employee’s phone extension in the Extension
State by Positionmonitor displays the employee’s name and extension number, and the General business
active icon. When the employee is on an incoming/outgoing call, the cell displays the Extension
Inbound/Extension Outbound icon, the employee’s name and extension number, and the time in state. If the
Caller ID card design is selected, you will also see the caller name and phone number. Either card enables
you to readily determine the online and phone availability of general business subject matter experts.

General business hot desking employees who sit at different desks each day
General business, hot desking extensions can log on to any phone in the enterprise and access their personal
settings. When adding extensions to the Extension State by Positionmonitor, you can arrange them
alphabetically or by department.

Contact Center Client
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When an employee is logged on, themonitor cell displays the General business active icon and the
employee’s name and extension. When the employee is on an incoming/outgoing call, the cell displays the
Extension Inbound/Extension Outbound icon and the time in state. If the Caller ID card design is selected,
you will also see the caller name and phone number. When the employee logs off, themonitor cell is grayed
out (inactive)

Viewing Web pages
While using Contact Center Client, you can view Web pages using theWeb browser monitor.

To view aWeb page within Contact Center Client
 1. Click theReal Time tab in the Contact Center Client ribbon.
 2. Click theWeb icon.

TheWeb Browser Properties window opens.
 3. AfterMonitor title, type a name for themonitor.
 4. AfterStart URL, type theWeb address of the website to view.

NOTE: The website address must begin with http:// or you will not be able to view themonitor.
 5. Optionally, select a value for theWeb BrowserRefresh Rate.
 6. Click OK.

Viewing and customizing the monitor
NOTE:

l Contact Center Client has a tabbed interface for managing and arranging windows. You can dock
multiple Extension State by Positionmonitors, displaying them on overlapping tabbed panels to
maximize real estate. This enables you to readily navigate betweenmonitors.

l You can save threshold settings and display characteristics you define for monitors. When you click
File=>Save, Contact Center Client saves all openmonitors under one profile name. You can click
File=>Open to open another profile, or File=>New to create a new profile.

Opening monitors
To open amonitor in Contact Center Client
 1. In the Contact Center Client ribbon, click Real time to view the Contact Center Client monitor icons.
 2. In theState by Position column on the ribbon, click Agent .

This selects the Agent State by Positionmonitor and the Add/Remove device IDs window opens.
See Figure 7 - 4.

 3. UnderAgent groups, select agent groups tomonitor and/or underAgents, select agents to monitor.
 4. UnderCard designs, select a card design.

Card designs specify the information displayed on agent, employee, and extensionmonitors.
 5. Click OK.
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Figure 7 - 4 Add/Remove devices

Docking multiple versions of the Extension State by Position monitor
You can dock monitors and readily navigate between them. You can dock amonitor to the top, bottom, left, or
right of another monitor. Alternatively, you can dock amonitor on the top, bottom, left, or right side of the
Contact Center Client window. You can dock monitors on top of one another, displaying them on overlapping
tabbed panels to maximize real estate.

To dock amonitor on top of another monitor
 1. In the upper-right corner of an openmonitor, right-click the title bar and select Dock.
 2. Repeat step 1 for all openmonitors.
 3. Click the title bar of amonitor and drag themonitor on top of a secondmonitor placing your cursor in the

center of the four-headed arrow that displays.
See Figure 7 - 5.

Contact Center Client
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Figure 7 - 5 Docking monitors

 4. Release themouse button.
Your monitors are displayed on overlapping tabbed panels.
See Figure 7 - 6.

Figure 7 - 6 Docked monitor
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Adding and removing devices
You can add and remove devices from the Extension State by Positionmonitor.

To add devices to the bottom of amonitor
 1. Right-click an openmonitor and click Add/Remove devices.
 2. UnderExtension groups, select additional extension groups to add to themonitor, or under

Extensions, select additional extensions to add to themonitor.
 3. Click OK.

On the Extension State by Positionmonitors a blank row of cells separates the original extensions
from those you just added. To remove the blank row youmust sort themonitor.
See "Sortingmonitor devices" on page 142.

To remove devices from amonitor
 1. Right-click an openmonitor and click Add/Remove devices.
 2. UnderExtensions, clear the check boxes of the extensions to be removed.
 3. Click OK.

Sorting monitor devices
When you select devices to display on amonitor, you can specify the devices be sorted by ID or name
(alphabetically) in ascending or descending order. When themonitor opens, the devices display in the order
you selected.

To sort the devices displayed on amonitor
l In the left pane of theAdd/Remove deviceswindow, click Media server to sort themembers by

media server, click Name to sort themembers alphabetically, or click Reporting to sort themembers
by ID, in either ascending or descending order.

You can sort information by extension on the Extension by Positionmonitor.

Rearranging cells
You can rearrange cells on the Extension State by Positionmonitor.

To rearrange cells
l On an openmonitor, drag a cell to a different position on themonitor.

Setting monitor dimensions
You can specify the numbers of rows and columns of cells to display on the Extension by Positionmonitor.
You can then adjust the table to fit within themonitor frame.

To set table dimensions
 1. Right-click amonitor and click Set table dimensions.
 2. AfterColumns, type a number.
 3. AfterRows, type a number.
 4. Click OK.

Columns or rows are added or deleted from themonitor. You can redistribute the cells using a drag-and-
drop operation.

Contact Center Client
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To size the table to fit the frame
l Right-click on the Extension by Positionmonitor and select Size table to frame.

Setting alarms
You can define alarms in Contact Center Client to alert you about specific events occurring on your telephone
system, that you deem inappropriate, as they occur. These activities include toll fraud and exceeding call cost
thresholds you define. Using these alarms, you canmonitor telephone system abuse and stop it as it occurs.
For a demonstration of alarm configuration and functions, click http://www.youtube.com/watch?v=cDdUa1l-
Q1o.

Client alarms are specific to each computer. To notify you that toll fraud or call costing thresholds are being
exceeded, you can configure alarms so

l Monitor cells and statistics change color.
l A pop-up notification opens on your desktop.
l A sound prompt, such as a beep or .wav file, plays.
l You are notified by email.
l Contact Center Client opens on top of all open applications.

To set alarms for real-timemonitors
 1. Determine whether you want to monitor all extensions, or some extensions.
 2. Add performance variables tomonitor.
 3. Specify alarm threshold (where applicable).
 4. Specify method of alarm notification.

Adding alarm thresholds
There are two ways to add alarm thresholds to extensions in Call Accounting. You can add alarm thresholds
to all extensions or to specific extensions.
 1. Right-click amonitor and click Set alarms.

Alternatively, select an openmonitor and click Set alarms in the Alarms column, found in theMonitor or
Chart Options tab in the Contact Center Client ribbon.
The Set alarms window open.
NOTE:You can select theApply the alarm thresholds to all devices displayed on the monitor
check box to apply the threshold settings for performance variables across all queues or agents.
Alternatively, you can select Apply the alarm thresholds to a specific list of devices to apply the
threshold settings for a performance variable to a list of queues or agents.

 2. UnderDevices, select one or more queues or agents or select theSelect all check box to select all
queues or agents.

 3. In thePerformance variables list, select a variable.
 4. UnderAlarm Thresholds, click Add threshold and type a value for the upper boundary of the

threshold.
The lower boundary cannot bemodified. The lower boundary of the next threshold is always slightly
greater than the upper boundary of the previous threshold.

 5. Click OK.

http://www.youtube.com/watch?v=cDdUa1l-Q1o
http://www.youtube.com/watch?v=cDdUa1l-Q1o
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Adding alarm thresholds to all extensions
To add an alarm threshold to all extensions in order to be notified of telephone system abuse
 1. Right-click amonitor and click Set alarms.

The Set alarms window appears.
 2. Select theApply the alarm thresholds to all devices displayed on the monitor check box.

Any new extensions added after selecting this option will inherit the alarm rules.
 3. In thePerformance variables list, select a variable.

NOTE:Skip step 5 if defining alarms for toll fraud. Toll fraud thresholds are defined during configuration
in YourSite Explorer. See "Specifying toll fraud settings" on page 111.

 4. UnderAlarm Threshold, click Add Threshold and type a value for the upper boundary of the
threshold.
The lower boundary cannot bemodified. The lower boundary of the next threshold is always slightly
greater than the upper boundary of the previous threshold.

 5. Click OK.
For instructions on how to define the appearance and sounds generated by alarms, see "Defining alarm
notification settings" on page 144.

Adding alarm thresholds to specific extensions
To add an alarm threshold to a specific extension in order to be notified of telephone system
 1. Right-click amonitor and click Set alarms.

The Set alarms window appears.
 2. Select theApply the alarm thresholds to a specific list of devices check box. Click Yeswhen

prompted by the warning window.
Any new extensions added after selecting this option will not inherit the alarm rules.

 3. In theDeviceswindow, select the extension to which you want to add alarm monitors or click theSelect
all check box to select all the extensions on the list.
NOTE:Hold theCTRL key downwhen selecting extensions to select multiple extensions.

 4. In thePerformance variables list, select a variable.
NOTE:Skip step 5 if defining alarms for toll fraud. Toll fraud thresholds are defined during configuration
in YourSite Explorer. See "Specifying toll fraud settings" on page 111.

 5. UnderAlarm Threshold, click Add Threshold and type a value for the upper boundary of the
threshold.

 6. The lower boundary cannot bemodified. The lower boundary of the next threshold is always slightly
greater than the upper boundary of the previous threshold.

 7. Click OK.
For instructions on how to define the appearance and sounds generated by alarms, see "Defining alarm
notification settings" on page 144.

Defining alarm notification settings
You can define the alarm notifications to alarm you when certain event thresholds are reached. The following
section explains how to change the various options available to signify an alarm.

Contact Center Client
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Defining alarm colors
To define an alarm color

 1. For the alarm threshold for which you want to specify colors, underBackground, click the arrow.
A color palate appears.

 2. Select a color.
 3. Under Font color, click the arrow.

A color palate appears.
 4. Select the font color for the alarm threshold.
 5. Click OK.

Defining alarm sound notification
To define an alarm sound notification
 1. For the alarm threshold for which you want to be notified by a sound, underSound, select the check

box.
The Sound window appears.

 2. Specify the alarm triggering properties.
 3. Specify the sound you want played when the alarm is triggered.
 4. Click Save.

Defining alarm pop-up window notification
To define a pop-up window notification

 1. For the alarm threshold for which you want to be notified by a pop-up window, underPop-up, select
the check box.
The Pop-up window appears.

 2. AfterDuration, type the number of seconds you want the pop-up alarm to be displayed when
threshold conditions are satisfied.

 3. If you want to display the pop-up alarm on top of all of the other applications, select theKeep this
message visible on mouse over check box.

 4. Optionally, click the Format font button to specify font attributes for the pop-up alarm message.
 5. In the text box, type themessage for the performance threshold and click theAdd variable button to

insert performance variables.
 6. Click Save.

Bringing Contact Center Client to the top during an alarm
To specify Contact Center Client appear to the front, on top of all other open applications, when a performance
threshold is satisfied

l For the alarm threshold for which you want to be notified, underBring to front, select the check box.
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Defining alarm email notification
To define an alarm email notification

 1. For the alarm threshold for which you want to be notified, or notify others by email, underEmail, select
the check box.
The Email window appears.

 2. AfterDistribution, specify which contacts are to be notified by email when threshold conditions are
satisfied.
See "Emailing reports" on page 163.

 3. AfterSubject, type the subject of the email to be sent (for example, type Toll Fraud occurring on an
outbound call!).

 4. In themessage box, type the body of the email.
 5. Click Save.

Consider the alarm threshold programming in Figure 7 - 7. When an extension is on a long distance call and
has spent less than two dollars, the cell housing remains white. When the extension has spent between two
and five dollars, the cell turns orange. When the extension has spent more than five dollars, the cell turns red.
In addition, audible alarms and pop-up alarms appear.

Figure 7 - 7 Set alarms window

Removing alarms
To remove an alarm

l Right-click themonitor and click Clear alarms.

Contact Center Client
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Selecting and customizing card designs
When you first open an agent, employee, or extensionmonitor, you can select a card design on the
Add/Remove device IDs window:

l The Classic card displays the agent state, time in the state, presence, agent/employee name, agent
login ID/employee ID, and extension number (or queue name for voice agents on ACD or on ACD Hold)
and presence.

l The Caller ID card displays the caller name and number (ANI), the number the caller/employee dials for
incoming/outgoing calls, (DNIS) caller collected digits (requires Intelligent Queue Collect Caller
Entered Digits), such as account numbers, the state, time in the state, presence, agent/employee
name, agent login ID/employee ID, and extension number (or queue name for voice agents on ACD or
on ACD Hold.

l The Call Cost card displays the same statistics as the Caller ID card, with the addition of call cost
statistics.

l Custom cards you create and share

The Caller ID card is the default card design. You can use this card design, or select the Classic card or a
customized card. You can create new card designs or copy existing card designs andmodify them. For
example, you can add or remove text and variables from cards and rearrange the information displayed. You
can share card designs with other employees. When you select a card design for an agent, employee, or
extensionmonitor, it is applied to all monitors of that type.

To select a card design profile
 1. Right-click themonitor and click Properties.
 2. Click Layout=>Card design.
 3. UnderProfile name, select a profile.
 4. Click OK.

To customize cards
 1. UnderCard design,

l If you want to create a card design, click New.
l If you want to edit an existing card design, select a card design and click Edit.
l If you want to create a card design based on the Caller ID card or the Classic card, select either

card and click Copy.
 2. On theNew card designwindow, type the name of the new card design.
 3. If you want to share the design with other employees, select Share design.
 4. Click OK.
 5. Select the card and click Edit.

See Figure 7 - 8.
 6. AfterState, select a state for the card design.

You can use the same card design for all states or you can customize cards for specific states.
 7. Under Fields, select a field type and drag and drop it to the card design.
 8. If you want to resize the field, click the field and use your pointer to move or resize the field.
 9. If you want to change the properties for a field, click the field and change the properties in the right pane

of Card Designer.
 10. If you want to change the size of the card design preview, after Zoom, select a different magnification

value from the list.
 11. Add additional fields to the card.
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 12. Select Copy to if you want to copy the current design to the card of a different state.
 13. Click OK.

The new card design displays on the Card design list.
 14. Click OK.

Figure 7 - 8 Card Designer window

Adding text to card designs
You can use a text box to add custom text to a card.

To edit text that you have added to a card
 1. Select the text box.

Properties displays on the right.
 2. UnderProperties, in the box to the right of Text, type the text to be added to the card.
 3. Click OK.
 4. Click OK.

Defining monitor styles
You can customize the appearance of individual monitor elements. For example, you can configure the font
size and color of column headings or apply a skin of predefined colors and font attributes to the entire monitor.

To customize the appearance of monitor elements
 1. Right-click an openmonitor and click Properties.
 2. Click General=>General settings.
 3. If you want to change the title of themonitor, after Title, type a name.
 4. If you want to scroll horizontally on themonitor, select theEnable horizontal scroll bars check box.
 5. If you want to scroll vertically on themonitor, select theEnable vertical scroll bars check box.
 6. If you want to groupmonitor headings, select theEnable grouping check box.
 7. If you want to apply a skin to themonitor, click Layout=>Monitor style.
 8. Click Load style and select a skin.
 9. Otherwise, underProperties, manually configure the column settings, column font, row settings, and

row-alternate settings.
 10. Click OK.
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Using Contact Center Chat
Contact Center Client provides instant messaging capabilities. It provides the online chat presence of
employees, including Online, Offline, and Away.

Using Contact Center Chat, you can communicate essential information to one or more extensions, extension
groups, or supervisors quickly and securely. You can coach employees and send timely messages, such as
asking an employee to delay going on break when it is busy.

NOTE:
l Youmust have a security role that does not restrict you from gaining access to Contact Center Chat.
l Youmust log on to Contact Center Client in order to send and receive onlinemessages.
l When you receive amessage it is displayed immediately on top of all open windows.
l Contact Center Chat requires server to client hostname resolution to properly function.

Contact Center Chat is enabled by default. If you want to disable Contact Center Chat you do so in the
Contact Center Management website in YourSite=>Enterprise=>local site. If you want to disable Contact
Center Chat in YourSite Explorer, you do so in YourSite=>Site=>Chat Settings.

NOTE:
l In order to use Enterprise / Presence Chat integration, youmust enable Contact Center Chat.
l If Contact Center Chat is disabled for a particular site all employees associated to that site will be

unable to communicate with each other using Contact Center Client.
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Sending an initial Contact Center Chat message
You can right-click a cell and click Send instant message to send an onlinemessage to that extension.The
example below demonstrates integration with Microsoft Lync Server 2010, enablingMicrosoft Lync as the
default instant messaging client.

To send a chat message
 1. Click Chat in the Contact Center Client ribbon.
 2. Double-click the ID that displays besideContact Center Chat in the toolbar.

The Send an Instant Message window opens.
See Figure 7 - 9.

 3. Type the recipient's name in the contact text box or double-click a contact from the contact list.
The Conversation window displays.

 4. Type amessage.
 5. Click Enter.

Figure 7 - 9 Instant message window

To send a chat message while viewing the Extension State by Positionmonitor
 1. Right-click a cell and select Send instant message.

NOTE: If Send instant message is not listed as an option, the employee has not been associated with
the extension.
The Conversation window opens.

 2. Type amessage.
 3. Click Send.

Contact Center Client
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Adding someone to a conversation
To add someone to a conversation
 1. On the Conversation window, click the Invite someone to join this conversation icon.
 2. Double-click a contact to add the contact to the conversation.
 3. Click Send.

Responding to a Contact Center Chat message
Employees can receive Contact Center Chat messages only if they are logged on to Contact Center Client.

To respond to a chat message
 1. Type amessage.
 2. Click Send.

Contact Center Chat sends your response to all chat session participants.

Using Contact Center Client with Lync
NOTE: In order to use Enterprise Presence / Chat integration, an employee’s email address, as configured in
YourSite Explorer under Employee, must be the same as the SIP address configured in Lync Server 2010.

With the addition of Lync Server 2010, employees use Lync Client as their default instant messaging client.
The presence of all company employees is natively delivered in Contact Center Client. Employees can view
the presence of both internal and external contacts to determine if they are available to communicate. In
addition to Available, Offline, and Away, employees see In aMeeting, Busy, In a call, Do Not Disturb, Be
Right Back, and other presence indicators.

Table 7 - 3 provides details on the presence indicators that are available when Contact Center Client is used in
conjunction with Lync Client andMitel Enterprise Presence / Chat integration.
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Table 7 - 3 Lync presence indicator icons

Presence
Icon
(Large)

Presence
Icon
(Small)

Status
Text Description

Available

The contact is online and can participate in con-
versations. Users canmanually set this status,
but the next automatic state change will over-
ride this setting.

Busy

The contact is available, but is engaged by
another activity. Busy contacts will not be
routed ACD calls, but may receive non-ACD
calls. Possible activities include the following:

In a Call—the contact is in a phone,
voice, or video conversation.
In a Meeting—theOutlook calendar
shows that the contact has a scheduled
meeting.

Users canmanually set this status.

Do Not Dis-
turb

The contact is engaged by another activity and
is unavailable. Contacts in Do Not Disturb will
neither receive ACD or non-ACD calls. Users
canmanually set this status.

Away /
Inactive

Be Right
Back

Off Work

The contact is likely unavailable. Possible
reasons include the following:

The contact’s computer has been idle for
more than the away time period setting (5
minutes by default).
NOTE:By default, the transition from
Available to Inactive occurs after 5
minutes. Then, after fivemoreminutes,
the status changes to Away if there is still
no activity on the computer.

The contact’s Outlook calendar or Out of
Office Assistant indicates that they are
out of the office.

The contact is temporarily unavailable
NOTE:As soon as activity is detected on
the contact’s computer, Ignite
automatically resets the presence status
to the appropriate state.

Contact Center Client
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The contact has locked their computer.

The contact has manually set their
presence to Away or Be Right Back.

Users canmanually set this status.
NOTE:When a user manually sets themselves
as Away, they are still available to receive calls,
such as from a transfer.

Offline

The contact is not available. Possible reasons
for this include the following:

The contact has manually set their
presence status to Appear Offline.

The contact has not signed into Lync.

The contact has blocked you from seeing
their presence status.

Lync is not running on the contact’s
computer.

Presence
unknown

Lync cannot determine the status of the con-
tact. This status is typically displayed because
the contact’s presence status is unavailable to
Lync, such as for a contact who is part of an
organization that is not a federated partner.

Sending an instant message
On an employeemonitor, you can right-click an employee’s cell and click Send instant message to send an
onlinemessage to the employee. You can also send instant messages usingMicrosoft Lync. Using Lync, you
can send instant messages to individuals or multiple contacts. After initiating a conversation, you can invite
additional contacts to the conversation.

To send an instant message while viewing employees on an employee or extensionmonitor
 1. Right-click a cell and click Send instant message.

The Conversation window displays.
 2. Type amessage.
 3. Click Send.

To send an instant message to an individual in Lync
 1. Double-click a contact in theContact list in Lync.

The Conversation window displays.
 2. Type amessage in theConversation window.
 3. Press Enter.
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To send an instant message tomultiple contacts in Lync
 1. To send an instant message to a contact group, right-click the group's name in theContact list and click

Send an Instant Message.
 2. If you want to select specific contacts from a group, expand the group in theContact list, press Ctrl,

and select the contacts to which you want to send an instant message. Right-click the last contact
selected and click Send an Instant Message.

 3. Type amessage in theConversation window.
 4. Press Enter.

To invite additional contacts to a conversation in Lync
 1. In theConversation window, click thePeople Options icon and select Invite by Name or Phone

Number.
 2. Select the contacts you want to invite to the conversation and click OK.

Alternatively, drag one or more contacts from the Contact list to the Conversation window.

NOTE:
l When you invite people to a conversation, conferencing features become active.
l A group instant messaging conference cannot exceed 100 participants.

Hot desking
When an employee is configured as a hot desking employee, the employee can sit at any extension on the
network and log on to the extension. After the employee is logged on, the employee takes control of the
extension. The employee's Contact Center Client and soft phone real-time profile settings are available. Any
previous associations with the extension are taken out of service. When an employee logs off, the employee
disconnects from the extension and the default settings for the extension are restored automatically.

External hot desk agents
External hot desk agents can work remotely using, for example, a standard PSTN analog telephone or a
cellular telephone. External hot desk agents are similar to regular hot desk agents with additional configuration
available to specify external number information. To access external hot desk agent functionality youmust
configure the following options in the User and Device Configuration form for the 3300 ICP:

l External Hot Desking Enabled:Select “Yes” to enable external hot desk agent functionality.
l External Hot Desking Dialing Prefix: Type the prefix digit(s) required to dial out to the external hot

desk device.
l External Hot Desking Number: Type the telephone number of the external hot desk device. This

number will be used by the telephone system to route ACD calls to the external hot desk agent.

NOTE: The combined length of the external dialing prefix and external number cannot exceed 26 digits.

An agent ID can be associated to only one external dialing number. If an external hot desk agent will usemore
than one external device for handling calls they must be associated to one agent ID for each external dialing
number.

An external hot desk agent can either log in externally or internally. When they log in internally (locally) the
telephone system recognizes them as a standard hot desk agent. When they log in externally the telephone
system recognizes them as an external hot desk agent.

Contact Center Client
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WARNING: If an external hot desk agent is using a personal phone to handle calls, incoming calls that are not
answered could reach their personal voicemail.

NOTE:
l 3300 ICP releaseMCD 5.0+ is required to access external hot desk agent capabilities.
l External hot desk agent functionality is only supported for use with hot desk agents, not traditional ACD

agents.

The following options are available for external hot desk agent login:
l Log in locally from aMiNET phone: agent displays as a regular hot desk agent
l Log in locally from an analog, cellular, or MiNET phone and connect through a loopback trunk: agent

displays as an external hot desk agent
l Log in externally from an analog or cellular phone: the agent ID is registered as an external pivot device

number and the external number dialing that has been configured in the telephone system is overlaid on
this external pivot device number. The external number is then used by the telephone system to deliver
ACD calls to the external hot desk agent. The agent displays as an external hot desk agent.

NOTE:An external hot desk agent can also log in externally by directly contacting a specific trunk
configured for this purpose. In this case, the agent would not need to log in via Contact Center Client.
For more information, log into Mitel Edocs, open theMitel Communications Director System
Administration Help Tool, and browse to "External Hot Desking - Operation".

Troubleshooting real-time issues
Note the following procedures for Contact Center Client, Interactive Contact Center, and Enterprise Presence
/ Chat Integration.

Interactive Contact Center and resiliency
When the collector is started while the telephone system is in resilient fail-over mode, Interactive Contact
Center device control will not function. Should this happen, the DoNot Disturb status of the queue in the
Queue Now monitor will not update.

Enabling Enterprise Presence / Chat Integration
If you want to use Lync as your default instant messaging client and view enhanced presence on real-time
monitors, youmust enable Enterprise Presence / Chat Integration.

NOTE: For Enterprise Presence / Chat Integration to function correctly, employees configured in YourSite
Explorer must be configured with the Lync (SIP) email address in the Employee email field. See "Adding
employees" on page 94.

To enable Enterprise Presence / Chat Integration
 1. In Contact Center Management, click YourSite=>Enterprise.
 2. In the Enterprise tree, click local site.
 3. AfterChat settings, select theChat enabled check box.
 4. Select theEnable Enterprise Presence and Chat Integration check box.
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Ensuring Contact Center Client recognizes Lync users
In some instances, Contact Center Client employee, and extensionmonitors will display an employee’s
instant message presence as Unknown even though the employee is online. The following solutions address
themost common problems in displaying instant message presence on real-timemonitors.

Extension monitor displays instant message presence as Unknown
If your extensionmonitor is displaying a user’s presence as Unknown even though the user’s extension is
configured in YourSite Configuration, this means

l Lync does not have a user associated with the extension, or
l The user is not configured as a contact in Lync.

Tomake the extension known to Lync Server
 1. On the Lync Server, browse toActive Directory Users and Computers.
 2. In the right pane, right-click the user and select Properties.
 3. On theGeneral tab, after Telephone Number, type the user’s phone extension.
 4. On the Lync tab, afterSIP URI, verify the SIP email address for the user.

Troubleshooting real-time issues
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Chapter 8

Call Accounting

Reports

Understanding reports
Reporter
Scheduled reports
Reporting Inbox
Displaying report properties



- 158 -

Reports
NOTES:

l Microsoft Excel Viewer is required as aminimum on all client computers to view reports. Microsoft
Excel 2003 or greater is required on the Enterprise Server to generate and view reports. TheMicrosoft
Excel Viewer can be downloaded for free at
http://www.microsoft.com/downloads/en/details.aspx?familyid=1cd6acf9-ce06-4e1c-8dcf-
f33f669dbc3a&displaylang=en.

l As a best practice, we recommend you limit the reports you run to under 65,000 rows of data. If you
need to run reports with more than 65,000 rows of data youmust take the following requirements into
consideration. Reports with more than 65,000 rows can only be viewed inMicrosoft Excel 2007 or
greater. In addition to this, youmust ensure that your Enterprise Server hardwaremeets theminimum
memory requirements. If you are running reports with more than 65,000 rows of data, we recommend
you use Server Configuration 4 as the hardware and software guidelines for the Enterprise Server. For
more information, see theContact Center Solutions and Call Accounting System Engineering Guide.

The Reporter and Scheduled Reports applications provide detailed telecommunication statistics. You use
Reporter to produce run-on-demand reports, and Scheduled Reports to automate report generation. You can
generate reports for day of week, day of month, week, or 15-, 30-, or 60-minute intervals. You can create
presentation-quality tables in Microsoft Excel or Adobe Acrobat .pdf format.

The prairieFyre Service analyzes the raw telephone system data with respect to the YourSite Explorer
configuration details. The service then writes the statistical data to Structured Query Language (SQL). It is
this statistical data that sources the reports.

You can view reports in Excel or Adobe .pdf format. Youmust install Excel and Adobe Reader on the
Enterprise Server to view reports. Whether you will be viewing reports in .pdf or Excel, youmust set up
contacts and contact groups to which you will email reports.

Understanding reports
Call Accounting reporting has improved in the following ways

l The report format has improved.
l Report data can be filtered.
l Lifecycle reports have been added.
l Call types are for description only.
l Reports can be viewed in .pdf format.

New report format
You can filter reports by day of week, month, and day of month, as well as by the standard 15, 30, and 60
minutes. The addition of the day of week, month, and day of month report parameters remove the need for
variants of the same report with different durations. For example, the Extension by Day of Month Cost
Allocation report is now produced using the Extension Accounting by Interval report and selecting the “by Day
of Month” filter.

Table 8 - 1 lists pre-V5.4 report names and their corresponding current report names. For a complete list of
new report names, see theCall Accounting Reports Guide.

Understanding reports
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Pre-V5.4 report names V6.0 report names

Extension Accounting by Day of Month Report Extension Accounting by Interval

Extension Accounting by Day of Week Report Extension Accounting by Interval

Extension Accounting by Month Report Extension Accounting by Interval

Extension Accounting by Period Report Extension Accounting by Interval

Table 8 - 1 Pre-V5.4 report names and the corresponding V6.0 report names

New report filtering feature
The new report filtering feature helps you to further define and customize report data output. After you create a
filter, you use it to generate scheduled reports. You can filter using a variety of variables, depending on the
type of report you generate.

For example, for the Employee Accounting Trace report, you can filter by the following information. (See
Figure 8 - 1.)

l Call direction (incoming or outgoing)
l Account Code
l Phone number
l DNIS
l Extension
l Trunk
l Call duration
l Call cost
l Call type (The call types displayed here are based on the call types configured in YourSite

Explorer=>Call Accounting=>Call Types.)
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Figure 8 - 1 Reporter Filter tab

Lifecycle reports
Lifecycle reports provide detailed information on all of the events related to the life of a specific call, from the
moment the call enters the telephone system to call termination. You can generate Lifecycle reports on the
following devices: DNIS, DNIS group, extension, extension group, trunk, trunk group, media server, and site.
Lifecycle reports can be filtered by call direction, DNIS, trunk, Account Code, hold duration, call duration,
phone number, and extension. If you have clustered your enterprise into a single site, you can run a Lifecycle
report on site to report on your entire enterprise. Lifecycle reports also include call notes and links to call
recordings. For detailed information on configuring Lifecycle reports, see theCall Accounting Installation
Guide.

Call types versus call rates
Call types in pre-V5.4 reports were assigned specific call rates. In V6.0, call types are for description only. For
outbound calls, the rate is determined by digit patterns. For inbound calls, the rate is determined by DNIS. For
internal calls, the rate is determined by the rates assigned to the calls. Call rates do not appear in reports. You
must go to your carrier plan or subscriber plan to determine the call rates assigned.

Reporter
Using the Reporter application, you can generate on-demand reports with which tomonitor call activity.

You can restrict access to any or all reports with advanced security roles using reports lists. See "Security
roles" on page 124.

Reporter
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Report types
We recommend you generate several reports to determine those that best suit your business needs. For a
complete description of report types and fields, see theCall Accounting Reports Guide.

Call Accounting report types include
l Account Code reports
l ANI reports
l Extension reports
l Trunk reports
l Employee reports
l Division reports
l DNIS reports
l Phone number reports
l Subscriber reports
l Enterprise reports

Subscriber Services report types include
l Employee reports
l Division reports
l Subscriber reports

Traffic Analysis report types include
l Traffic trunk reports
l Traffic route reports
l Traffic attendant reports
l Traffic DTMF receiver group reports

Reporter options
The complete list of Reporter options follows.

l Report type—specifies the report name.
l Start date and End date—specify the range of dates used in the report. You can pick any calendar

date as the start date and any date later in the calendar year as the end date.
l Start hour and End hour—specify the hours of the day included in the report.
l Days to include—specifies the days of the week to include in the report.
l Interval—specifies the report period: by 15-, 30-, or 60-minute intervals, by day of the week, by day of

themonth, or by month.
l Report mode—gives you the option of a default report that spans one day, or an over-midnight report

that spans two days. (For example, an over-midnight report can cover from 10:00 P.M. on day one to
10:00 A.M. on day two. It cannot exceed a time span of 24 hours.)

l Email to — emails the report spreadsheet and associated graph to the email address selected in the
Email to list. You add contacts and contact groups to the Email to list under theMy options menu.

l Print—prints the report spreadsheet and the associated graph.

Setting up contacts and contact groups
Before you generate a report, to email that report, youmust set up

l My email contacts—includes personal email addresses
l My email contact groups—includes mailing lists comprised of global contacts andMy email contacts
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Setting up email contacts for emailing reports
To set up groups for emailing reports
 1. Click My options=>My contacts=>My email contacts.

TheMy email contacts window opens.
 2. Click Add.

The Add contact window opens.
 3. Type the first name, last name, and email address of the person to whom you will email reports.
 4. Click Save.

Setting up email contact groups for emailing reports
If you intend to email the report to more than one recipient youmust add the recipients to amailing list and
then associate the recipients with a group.

To set up groups for emailing reports
 1. Click My options=>My contacts=>My email contact groups.

TheMy email contacts window opens.
 2. Click Add.

The Add contact window opens.
 3. Type the name and description of the email group to which you will email reports.
 4. Click Save.

The new email contact group opens on theMy email contact groups window.
 5. Across from the record of the contact group, click Members.
 6. UnderAvailable contacts, select the check boxes of the contacts to be added to the group.
 7. Click Add>>.

Generating on-demand reports
NOTES:You can generate reports on licensed extensions only. The number of extensions you license in
YourSite Explorer must be consistent with your software license.

To generate an on-demand report
 1. Generate the report.
 2. Print or email the report.

Generating reports
The following steps detail how to run an Extension Accounting by Interval report.

To generate a report
 1. Click Reporter=>Call Accounting=>Carrier reports=>Extension reports.
 2. On theBasic tab, afterReport type, select theExtension Accounting by Interval report.
 3. UnderExtension, click one or more extension.
 4. AfterStart date andEnd date, specify the start and end dates for the report.
 5. AfterStart hour andEnd hour, specify the start and end hours for the report.
 6. After Interval, specify the time/day interval of the statistics that will display in the report.
 7. AfterDays to include, select the days of the week to include in the report.
 8. Click the Filter tab.

NOTE: The Filter tab is available for Call Accounting, Lifecycle, andWorkforce Scheduling reports
only. For all other report types, skip to step 10.

Reporter
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 9. Specify the filtering options to include in the report.
 10. Click theAdvanced tab.
 11. If you want to create a separate report for each day in the date range you selected, select theCreate

one report for each day in the selected date range check box.
 12. AfterReport output language, select the language used in the report output.
 13. AfterRender type, specify how you will view reports, either in Excel or .pdf format.

This option is available for Call Accounting, Lifecycle, Workforce Scheduling, and Flexible Reporting
reports only.

 14. If you want to email the report, select theEmail to check box and specify to whom you will email the
report:

l A contact group, select the this contact group check box, and select a group
l One contact only, select the this contact check box, and select a contact
l A contact that is not listed, select the this email address check box, and type the email

address
You add contacts and contact groups to the Email to list under My options=>My contacts.

 15. If you want to print the report spreadsheet, select thePrint the report check box.
 16. If you want to print the report chart, select the Include charts when printing check box.
 17. Click Submit.

The Report submitted screen appears.
 18. Click View Report Inbox.

The Report Inbox window opens, listing all created reports.
 19. Click View to open a report.

The report opens in the format you specified.

Emailing reports
To email a report
 1. After selecting a report to email, click the Advanced tab.
 2. AfterReport output language, select the language of the report from the list.
 3. To email the report spreadsheet, underExcel distribution, select either the this contact group or this

contact check box.
 4. Or, to email to a specific address, select the this email address check box and type the email address.
 5. Click Submit.

The Report submitted screen opens.
 6. Click View report inbox.
 7. AfterComplete, click View.

Printing reports
To print a report
 1. After selecting a report to print, click the Advanced tab.
 2. AfterReport output language, select the language of the report from the list.
 3. To print the report spreadsheet, underExcel distribution, select thePrint the report check box.
 4. Click Submit.

The Report submitted screen opens.
 5. Click View report inbox.
 6. AfterComplete, click View.

Scheduled Reports
You use Scheduled Reports to automate the generation of reports.
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Scheduled reports options
To create a scheduled report youmust complete the following options:

l Schedule name is a user defined name to describe the contents of the schedule.
l Schedule will run specifies how often the schedule will be generated.
l At defines when the scheduled report will be generated.
l Reports time span defines the dates of report activity to appear in the report.
l Output language specifies the language used in the report tables and charts.
l Email the report to defines the email contact group to which the report is sent.
l Print the report indicates the scheduled report will be printed every time it is generated.

Generating scheduled reports
NOTE:

l Ensure Contact Center Client is running before you generate a report or execute a report schedule,
otherwise the report or the schedule will fail.

l You can generate reports on licensed employees only. The number of employees you license in
YourSite Explorer must be consistent with your software license.

To generate a scheduled report, youmust follow these steps:
 1. Create a report schedule.
 2. Add reports to the schedule.

Creating report schedules
NOTE: If you select printing andmailing options, Reporting Service prints and emails all of the reports
included in the schedule on the date the system runs the reports.

You can create report schedules for Call Accounting reports.

Creating Call Accounting Report schedules
To create a schedule for Call Accounting reports
 1. Click Reporter=>Scheduled Reports.
 2. Click Next>>.

See Figure 8 - 2.

Figure 8 - 2 Scheduled Reports: Properties tab

Scheduled Reports
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 3. AfterSchedule name, type a schedule name.
 4. AfterSchedule will run, select the schedule frequency, for example, every day, every Wednesday, or

the start of month.
When you select the day, all the reports associated with this schedule will be generated that day, every
week.

 5. After at, click the time of day the schedule will be activated.
For example, if you select Wednesday at 7:00 A.M., all the reports associated with this schedule will be
generated every Wednesday at 7:00 A.M.
NOTE:Reports are based on the data in the SQL database. We recommend you schedule your reports
to run after the nightly maintenance routine runs, that is, after 2:00 A.M., to ensure the reports are based
on the entire day’s raw telephone system data.

 6. AfterReports time span, select a time span.
If you select Year to date, the report output includes all days from 1 January to the present date. If you
select From given start date to current date option you will produce reports for your fiscal year.

 7. Click theDistribution tab.
Figure 8 - 3.

 8. To email the report to a contact group, underExcel distribution, select theEmail the report to check
box, select the this contact group check box, and then select a group.
NOTE:You add contacts and contact groups to the email to list under My options=>My contacts.

 9. To email the report to one contact only, select theEmail the report to check box, select the this
contact check box, and then select a contact.

 10. To email the report to a contact that is not listed, select theEmail the report to check box, select the
this email address check box, and then type an email address.

 11. Click Save.
 12. Add the reports to be generated using the schedule you just created.

See "Adding reports to schedules".

Figure 8 - 3 Scheduled Reports: Distribution tab
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Adding Call Accounting reports to schedules
NOTE:

l Before you can add reports to schedules, youmust create and save the schedules
l You can select the time interval for reporting by 15-, 30-, or 60-minute intervals, by day of the week, by

day of themonth, or by month for interval reports only.

To add a report to a schedule
 1. On theManage schedulewindow, click Add Report.
 2. Select the report category, for exampleExtension Reports.
 3. UnderReport type, select a report to add to the schedule.
 4. UnderExtension Group, select the extension on which to report.
 5. AfterDays to include, select the days of the week to include in the report (for example, if you select a

date range of September 1 to September 30, and select Wed and Friday as the days to include, you will
produce a report for theWednesdays and Fridays that fall between September 1 and September 30).

 6. AfterStart hour andEnd hour, select a start hour and end hour for the report.
 7. If you are generating an event by period report, after Interval, select the time interval for reporting.
 8. AfterReport mode, select Default.
 9. Click theAdvanced tab.
 10. AfterReport Output language, select a language.
 11. Click Submit.

Generating scheduled reports immediately
To generate your scheduled reports at a specific time (other than immediately), you specify the date and time
they will be generated when you create the schedule. See "Creating report schedules" on page 164.

To generate scheduled reports immediately
 1. Click Reporter=>Scheduled Reports.
 2. AfterSelect a schedule, select the schedule to be generated.
 3. Click Execute schedule now.

The Execute schedule now window opens.
 4. In theStart date and End date calendars, click a start date and end date the report will generate.
 5. Click Submit.

The reports associated with the schedule are generated immediately and placed in your Report Inbox.

Report Inbox
The Report Inbox application displays the on-demand and scheduled reports generated under your user name
over the past 30 days. Inbox manager deletes reports from your inbox by date range.

NOTE:
l In Report Inbox, if the report status is Pending for an extended period of time, start Client Component

Pack Manager and confirm the Enterprise Server IP address and your user name and password are
correct.

l In Report Inbox, if Data Limit Exceeded opens, re-generate the report using a shorter time span.

Report Inbox
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Report Inbox includes
l Today's reports displays all of the reports generated today under your user name.
l Yesterday's reports displays all of the reports generated yesterday under your user name.
l All of your reports displays all of the reports generated under your user name over the last 30 days.
l Inbox Manager deletes reports from your inbox by date range.

Reporter Inbox options
The Report Inbox has the following options.

Report type
The Report typefield lists the report name.

Media server
TheMedia server field defines themedia server against which you are generating the report.

Reporting
If you are creating an Employee group report, then theReporting field specifies the reporting number of the
Employee group. If you are creating an Employee report, then theReporting field specifies the reporting
number of the Employee.

Name
If you are creating an Employee group report, then theName field specifies the name of the Employee group.
If you are creating an Employee report, then theName field specifies the name of the Employee.

Request date
The Request date field is the date and time the report was generated.

Status
The Status field confirms if your report is ready. When Complete appears in the status field the report is
waiting in your Report inbox. When Pending appears, the report is not ready. No datameans no records were
available for the parameters you specified. Failedmeans the report did not generate. If a report fails, the
Report writer logs errors in the NT event log.

View
The Viewcommand displays reports generated inMicrosoft Excel.

Delete
The Delete command deletes reports from your report inbox.

Displaying report properties
To display report properties:
 1. Click View Report Inbox (upon submitting a report) or click Report Inbox=> Today’s reports.

Your personal report inbox appears. It contains all of the reports generated under your user name for the
interval selected.
NOTE: Using the Report properties information, you can avoid regenerating reports for the same
information and you can quickly check the report variables you selected for each report.

 2. UnderReport type, click the report name.
A window appears that displays the parameters you defined for the report.
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Viewing reports
The Report Inbox application displays all of the on-demand, scheduled, and forecast reports generated under
your user name.

To view report details
 1. Click View Report Inbox (upon submitting a report) or click Report Inbox=>Today’s reports.
 2. Select theAutomatically refresh this page every 10 seconds check box to automatically update the

Status column.
The Status column indicates if your reports are ready:

l Complete—the report is waiting in your report inbox
l Pending—the report is not ready
l No data—no records were available for the parameters you specified
l Data limit exceeded—the time span selected was too great. Select a shorter time span and rerun

the report
l Failed—the report did not generate. If a report fails, the Report writer logs errors in the event log.

Re-submit regenerates the report
 3. Click View to view the report.

Editing reports in Excel
You can graph specific data by highlighting one or more columns of data in the Excel spreadsheet and using
the Excel Chart Wizard. For more information, seeMicrosoft Excel Help.

Deleting reports
Maintenance Service deletes any reports that are 30 days or older from your report inbox. Youmust save any
reports you want to retain beyond 30 days to your hard drive or network directory.

Report Writer uses the following criteria to determine a report’s age:

On-demand reports
For on-demand reports, the request date governs the report’s age.

Scheduled reports
For scheduled reports, the date the system generates the report governs the report’s age. Inbox manager does
not delete reports you schedule to generate in the future.

To delete all of the reports submitted on a given date
 1. Click Report Inbox=>Inbox manager.
 2. Select fixed dates or a date range for deleting reports.
 3. Select the status types.
 4. Click Delete.

The Inbox manager deletes all of the reports submitted on the dates you specified.

Displaying report properties
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Configuring user printer settings
You can configure reports to print on either a network or a local printer, for each employee.

To configure user printer settings
 1. In YourSite Explorer, click Employees.
 2. Select the employee for which you want to configure user printer settings.
 3. UnderReport Distribution, specify the path of the network printer and select print and email options.

Youmust configure the network printer as the default printer on the Enterprise Server. The printer name
is case sensitive.

Troubleshooting reporting issues
Common reporting troubleshooting issues are described below.

Troubleshooting missing data
NOTE:You can run reports on licensed employees only.

If you run a report and notice that the data for a device is missing from the report output, verify the device is
programmed in the telephone system and in YourSite Explorer. If you determine the device is missing from the
database, add it to the database and use the Summarize Data command (in theManagement Console
application) to update the prairieFyre Service and the SQL database with the complete telephone system data
stored on the local hard drive. You can then produce reports on the device.

To summarize data
 1. OpenContact Center Client.
 2. If prompted, type your user name and password.
 3. Click Log on.

The Contact Center Client window opens.
 4. On themain toolbar, click Management.
 5. Click Maintenance.
 6. Click Summarize data.
 7. Follow the steps in the Summarize DataWizard to summarize the data.

Configuring reports to exclude Junk Mail from completed email
statistics
Using the Registry Editor on the Enterprise Server, you can configuremultimedia reports to exclude Junk Mail
from the completed email statistics. If you exclude Junk Mail from completed email statistics, the following
statistics will be affected:

l Completed count
l Completed total duration
l Hold count
l Hold total duration
l Short handled count
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To exclude Junk Mail from completed email statistics
 1. InWindows, open theRun command, type regedit, and click OK.

The Registry Editor opens.
 2. Expand the tree toHKEY_LOCAL_MACHINE\Software\prairieFyre Software Inc\CCM.
 3. Right-click Common and select New=>String Value.
 4. TypeSubtractJunkEmailStatsFromCompletedStats and click Enter.
 5. Right-click theSubtractJunkEmailStatsFromCompiledStats string and selectModify.

The Edit String window opens.
 6. UnderValue data, type 1.
 7. Click OK.

Troubleshooting Reporting Service
Why is Reporting Service not emailing or printingmy reports?

l Ensure the SMTP Mail settings are correctly configured.
l Ensure the printer settings are correctly configured.
l View the log file for Reporting Service to find out why reports are not being printed/emailed the way you

expect in the installation/Log file.

Displaying report properties
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Chapter 9

Call Accounting

Data-Mining Tools

SMDR Inspector
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Data-Mining Tools
SMDR Inspector is a flexible data-mining tool that searches through SMDR data according to your search
variables.

NOTE: For SMDR Inspector to function effectively when using Internet Explorer 9 as your browser, youmust
add Contact Center Management to the Internet Explorer Trusted Sites category and set the Internet security
to medium. See theCall Accounting Installation Guide.

SMDR Inspector
SMDR Inspector searches through SMDR data to find specific telecommunication events. The search
follows a wild card format. Your specifications do not have to be exact. You canmake the search as inclusive
or exclusive as you wish. The results are placed in an easy-to-interpret grid that can be printed or saved to file.
You can verify that your reports are valid by conducting searches against raw telephone system data.

Starting SMDR Inspector
To start SMDR Inspector on the client computer
 1. Click Tools in the Contact Center Client ribbon.
 2. In theData Mining column, click Inspectors to open the Data Inspectors tool.

Running searches in SMDR Inspector
When you run a search, SMDR Inspector searches through the raw telephone system data on the local hard
drive. Each search requires the following information:

Select dates/Delete dates
The Select dates button specifies the date range within which to search. The Delete dates button deletes
days within the range you selected. The date is displayedmonth first, then day, then year.

Select media servers
The Select media servers check boxes specify the origin of the data used in the search. You can perform
searches on phone activity.

In addition to the date andmedia server options, SMDR Inspector has the following search criteria tabs.
l Call parties
l Call types
l Options

Call parties criteria for searches
The Call parties criteria helps you to find call events such as the calls an extension received (Called party),
the calls an extensionmade (Calling party), or the extension the call was transferred to (Third party). (See
Figure 9 - 1.)

SMDR Inspector
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Figure 9 - 1 SMDR search criteria - Call parties tab

The Call parties tab search options are as follows.

Digits dialed
The Digits dialed box specifies the queue number of the queue that picks up the call (for inbound calls).

The ANI digits box specifies the area code and telephone number for an inbound call. The search results
contain records that match the data the user typed in the ANI field.

The DNIS digits box specifies the phone number the caller dialed. The DNIS could be product specific, or it
could specify demographic variables or marketing targets.

The Account Code box specifies the Account Code number used in the search. Employees enter Account
Code numbers to tag inbound and outbound calls.

Outbound calls
TheOutbound calls box specifies telephone number the employee dials (for outbound calls).
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Call parties
The Calling party box specifies the extension or agent number (for an outbound call), or the trunk number (for
an inbound call) used in the search.

The Called party box specifies the answering extension or agent number (for an inbound call), or the trunk
number (for an outbound call) used in the search.

The Third party box searches for call records on the extension number used in a transfer.

Call identification
The Call identification box specifies theMitel call IDs assigned to a call segment.

The Sequence ID box specifies the sequence number assigned to the call record by the telephone system.

The Associated ID box specifies the number attached to associated data records of the call assigned by the
telephone system.

Call types criteria for searches
The Call types tab displays the types of calls the extension receives, for example, abandoned, interflowed,
requeued, unavailable, or outbound calls. (See Figure 9 - 2.)

SMDR Inspector
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Figure 9 - 2 SMDR search criteria - Call types tab

The Call types tab search options are as follows.

Call types
TheCall types check boxes specify one or more categories of calls used in the search. The telephone system
generates an Unavailable (Queue unavailable calls) event record when a caller dials a queue and the queue is
not available (in DND) or there are no agents logged on to handle the call.

Answer supervision
TheAnswer supervision check box searches for instances where calls were answered by the called party. If
you have answer supervision and youmake an outbound call but the called party does not answer (you hang
up) then an SMDR record is generated with no duration. If you do not have answer supervision then no SMDR
record is generated at all.

Busy call
TheBusy call check box searches for call records on queues or extensions the caller dials but finds busy.
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Error by caller
TheError by caller check box searches for call records on numbers the caller dials that are not recognized by
the telephone system.

TAFAS answered
The TAFAS Answered check box searches for call records that involve calls manually picked up by agents at
alternate extensions. In a TAFAS answered call, an employee hears another employee's phone ring and dials
a number to pick up the call.

Internal call
The Internal call check box searches for call records on calls between employees that do not involve trunks.

Blank
TheBlank check box searches for call records that have no data in the Call completion box. That is, when the
check box is selected, the search output contains records where there is nothing recorded in the Call
completion box.

Attendant involved
TheAttendant involved options specify whether or not call records for calls involving an automated attendant
are used in the search.

Transfer/Conference
The Transfer/Conference check box searches for records on transferred or conferenced calls.

Speed call/Forward
TheSpeed call/Forward check boxes search for call records involving a speed dial and/or conference
function. When the Blank check box is selected, the search output contains records where there is nothing
recorded in the Speed or Fwd check boxes.

System ID
TheSystem ID check box searches for call records that pertain to a specific telephone system. In amulti-site
enterprise, you program each telephone system with a 3-digit system ID number. You can distinguish records
by their system ID number. The telephone system appends it to all of the SMDR records.

Options criteria for searches
When you click Tools=>Inspectors=>SMDR Inspector, the Options tab opens. TheOption criteria work in
conjunction with the Call parties criteria and the Call types criteria to narrow down the search. (See Figure 9 -
3.)
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Figure 9 - 3 SMDR search criteria - Options tab

TheOptions tab search options are as follows.

Time ranges
The Time ranges boxes specify the time interval used for the search.

Call duration
The Call duration boxes specify a range of values for the Call duration statistic used in the search.

Time to answer
The Time to answer boxes specify a range of values for the Time to answer statistic used in the search. For
example, if you select a time to answer of 240 to 999 seconds, the search records include calls that were
answered by an agent after waiting at least 240 seconds to be answered.

Exception records
The Collector Service tags telephone system records that contain errors with anE (telephone system 1) or e
(telephone system 2). You select the Error records check box to include these records in the search output.
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The Collector Service writes a log record to the data stream upon start up. It tags the log record with an I to
indicate it is an information record. You select the Information records check box to include log records in the
search output. SMDR Inspector displays the error and information search result records on the Exception
Records tab.

In companies that have two telephone systems, the Collector Service tags records from the second telephone
system with anS. You specify the COM ports used by your telephone systems on the Data collection tab in
YourSite Configuration.

Output record count
TheOutput record count specifies themaximum number of rows of records to display.

SMDR search results information
The SMDR Search results tab shows the search results for Call parties, Call types, andOptions searches.
Table 9 - 1 describes the SMDR information the SMDR Search results tab provides.

Column
heading Description

Media server TheMedia server box identifies the telephone system (with or without MiTAI) that
produced the event record.

Start time The Start time of a call is reported in hours andminutes in either a 12- or 24-hour format. If a
12-hour clock is used, the letterP indicates P.M. (hh:mmp)

Date The Date box displays the date of the event record (month/day/year).

Total duration
The duration of a call is reported in hours, minutes and seconds (hh:mm:ss). Leading zeros
are output (Maximum time = 99 hours, 59minutes, 59 seconds). If the call duration
exceeds 100 hours, a call duration of 99 hours, 99minutes, 99 seconds will be recorded.

Calling party

The Calling party is the identity of the party that originated the call. It may be a station, an
attendant, or an incoming trunk, as described below.

(a) Station number as Calling party (cccc). A station number (extension number or agent
ID) may be one to four digits (0-9, *, #) which are left-justified; that is, no leading zeros.

(b) Attendant as Calling party (ATTm). Calls originated by an attendant that do not involve
a third party are reported as a calling party by ATT followed by the console number. When
the console number is in the range of 10 through 99, the format is modified to be ATmm. If
an attendant calls an outside party on behalf of a station or trunk, that station or trunk is
reported as the caller but the attendant flag symbol [*] appears in the Attendant was
Involved box.

(c) Trunk number as Calling party (Tnnn or Xnnn). When the originating party is an
incoming CO trunk, Tnnn appears on the record, where nnn is the number of the trunk. If
the trunk number is less than three digits long, it is left-padded with zeros. If the extended

Table 9 - 1 SMDR search results information
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Column
heading Description

digit length option is enabled, the trunk number nnnnmay be up to four digits long, left-
justified and without leading zeros. When the originating party is an incoming non-CO
trunk, Xnnn appears in the trunks record. The T orX ensures that CO trunks and CO
Attendant trunks can be distinguished from tie trunks. The trunk number is the trunk ID
specified during customer data entry in the Trunk Assignment form.

Attendant flag This 1-digit box contains an asterisk [*] when a call is assisted by, or initially answered by,
an attendant. This flag will not appear if a call is transferred to an attendant.

Time to answer
(Time to Ans)

This is the number of seconds from the time an incoming external call rings the destination
until the call is answered. If a call is never answered, this box displays three asterisk [***].
Leading zeros are output and the box remains at 999 when an overflow is reached. If the
MITELCall Distribution (MCD) feature package is installed, and theMCD report transfers
option is enabled, this box contains the total time to answer regardless of the number of
times the call is rerouted. This box does not apply to Internal SMDR.
NOTE: Time to answer does not include the duration the request waits in queue outside of
regular business hours.

Digits dialed

External SMDR
External SMDR records the digits dialed on the outgoing trunk. A maximum of 26 digits is
recorded. This number is reduced to 20 when the Report Meter Pulses option is selected in
CDE. This box does not include the trunk group access code on outgoing calls. The digits
recorded are the actual digits outpulsed on the trunk after digit modification has been
performed. On incoming calls, the digits dialed in on the trunk are recorded. The digits
dialed field contains the digits the telephone system used to route the call. For an incoming
call this could be the extension or the path to which the call is being routed. For outgoing
calls this is the number the caller dialed. Whenmore than 26/20 digits are dialed, the
remaining digits are ignored.
If theMCD option is enabled, each device is listed whenever the call is rerouted, rather
than the last device as in non-MCD loads. To reflect theMCD option, the Digits dialed on
the Trunk box displays dd1 ddd2 ddd3.
Internal SMDR
Internal SMDR records the digits dialed on an internal line. Up to 26 digits are recorded.
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Column
heading Description

Call completion flag

External SMDR (Outgoing calls)
This reports the completion status of an outgoing call in so far as the telephone system is
able to determine it. When an outgoing call fails toll-deny checking and is dropped, this box
contains a T. When the trunk group is programmed to receiveAnswer Supervision and a
supervision is received, anA is reported. When the trunk group is programmed for Toll
Reversal and a supervision is received, a T is reported.
External SMDR (Incoming calls)
The telephone system canmonitor the outcome of a call and can provide a comprehensive
report on call completion. When the station or hunt group to which a call is directed is busy,
aB is recorded. When an incoming trunk accesses an invalid number and receives reorder
tone, anE is reported. AnE is also reported for incomplete calls. A T is reported if the
incoming trunk is answered with Trunk Answer From Any Station (TAFAS) and if an
outgoing trunk call is toll denied, or if the call is Pickup answered.
When an incoming call is forwarded by an attendant to a busy station, aB appears in the
call completion status box, the number called appears as the third party, and the Attendant
appears as the called party.
Internal SMDR
An I indicates that an internal call was completed.
Speed Call or Call forward flags (S or F)
This box contains anS when the number is speed dialed, and an Fwhen an external call is
forwarded through the external call forward feature.
If Internal SMDR is enabled, an F is also recorded when an internal call is forwarded
through the call forward feature. However, for internal calls the Third Party box does not
contain the number of the station that initiated the call forward feature. The Third Party box
is left blank because the Digit dialed box identifies the station that has call forward
enabled.

Speed call forward
The Speed call/Forward check boxes search for call records involving a speed dial and/or
conference function. When the Blank check box is selected, the search output contains
records where there is nothing recorded in the Speed or Fwd check boxes.

Called party

A Called party can be a station number, an attendant, or for outgoing calls, the outgoing
trunk number. The Called party output format is identical to that used for the Calling party.
SeeCalling party. For incoming calls to an attendant, the called party is recorded as the
attendant unless the attendant transfers a call to a station. For direct-in-lines, it would be
the station number. On outgoing calls handled by an attendant, the called party would be
the outgoing trunk’s ID.

Transfer/Conference
call (Trans Conf)

This box identifies calls involving three or more parties. It contains a T for supervised
transfers, X for unsupervised transfers (that is, transfer in to busy reports a T, transfer in to
ringing reports anX), and aC for 3-way conversations or conferences.

Third party

The Third party box contains the number of the station to which a trunk call has been
transferred. When several transfers take place during a trunk call, the first party is the only
one reported, as long as MCD Report transfers = No, and Record transfers = No.
If an external call is made to a station whose call forwarding is set to an external number,

SMDR Inspector



Call Accounting User Guide

- 181 -

Column
heading Description

the Third party box contains the number of the station that initiated the call forward feature.
For internal calls, the Third Party box is left blank because the Digit dialed box identifies
the station that has external call forward enabled.

Account Code
Enabling the report account codes option in the SMDR Options Assignment form allows an
account code of two to 12 digits to be recorded here, if one is used tomake a call. Leading
zeros are reported if they are entered.

Route optimization
flag

At the starting and end nodes of a network call a flag will appear in this box if route
optimization has taken place. A route optimized call involves two different trunks to the
same party: the pre-optimization trunk and the post-optimization trunk. An SMDR record
will be produced for both trunks, which will be distinguished by a lower case r for the pre-
optimization trunk, and an upper caseR for the post-optimization trunk. Route optimization
is only available with theMSDN/DPNSS Voice IV feature package.

ANI/DNIS
ANI/DNIS digits are recorded in this box. ANI and DINS numbers can be up to 10 digits in
length, and are recorded for incoming calls on ANI/DNIS trunks. COS option ANI/DNIS
reportingmust be enabled.

System identifier

This optional 3-digit box may contain values from 000 to 999. 000 indicates that no
identifier has been entered. In the absence of a System identifier, a Node identifier is
printed (when programmed). Whenmore than one node identifier exists, the first one on the
programmed list is printed. When both a System ID and a Node ID are programmed, the
System ID takes precedence. Programming of System Identifiers and Node Identifiers is
described in the Customer data entry volume.

Call ID The Call ID box specifies the call number to which the record relates.

Call ID seq The Sequence ID box specifies the sequence number assigned to the call record.

Assoc call ID The Associated ID box specifies the number attached to associated data records of the
call.

System ID

This optional 3-digit box may contain values from 000 to 999. 000 indicates that no
identifier has been entered. In the absence of a System identifier, a Node identifier is
printed (when programmed). Whenmore than one node identifier exists, the first one on the
programmed list is printed. When both a System ID and a Node ID are programmed, the
System ID takes precedence. Programming of System Identifiers and Node Identifiers is
described in the Customer data entry volume.

Record See "SMDR record boxes" on page 182.
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SMDR record boxes
This section describes the SMDR search output records available.

The telephone system records SMDR data in table format. Table 9 - 2 provides information used to interpret
the SMDR Inspector search output. It summarizes the SMDR record boxes and provides themeaning of the
symbols used.

Name Format Definition Notes

Date mm/dd mm = Month
dd = Day

mm = 01 - 12
dd = 01 - 31

Start time hh:mmp
hh = Hours
mm = Minutes
p = pm

hh = 00 - 12 or 00 - 23
mm = 00 - 59
p = P.M. (12-hour clock)

Duration of
call

hh:mm:ss

hhhh:mm:ss

hh:mm:ss = duration in
hours:minutes:seconds

hhhh:mm:ss = duration in
hours:minutes:seconds

hh = 00 - 99
mm = 00 - 99
ss = 00 - 99
hh hh = 0000 - 9999
mm = 00 - 99
ss = 00 - 99

Calling party

pppp

ppppppp

cccc = Extension #
Tnnn = Trunk # (CO)
Xnnn = Trunk # (non-CO)
ATTm = Attendant

ccccccc = Extension #
Tnnnn = Trunk # (CO)
Xnnnn = Trunk # (non-CO)
ATTmm = Attendant

c = 0 - 9, *, #
nnn = 000 - 999

m = Console # (ATmm for
Attendant 00 - 99)
c = 0 - 9, *, #
nnnn = 0000 - 9999

mm = Console #

Attendant f * = Attendant
-- = Attendant not involved

Attendant answered or
initiated the call, then
transferred it to an extension

Time to
answer ttt

ttt = time in seconds (000 - 999)

*** = Call unanswered

Leading zeros output.
Incoming calls only.

Digits dialed
on the trunk

xx...x

x...x y...y
or
Tx...x y...y
(Network Format)

Up to 26 (20 if metering) digits
dialed on the trunk
Network Format: up to 26 digits (20
if metering) in total

x = 0 - 9, *, #
y = 0 - 9, *, #
x...x = Node ID & Extension #
(up to 14 digits); y...y = actual
digits dialed
Tx...x = Node ID & Trunk #

Table 9 - 2 Summary of boxes in SMDR records

SMDR Inspector
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Name Format Definition Notes

Call
completion
status

h

A = Answer supervision
B = Called party busy
E = Caller error
I = Internal call
R = re-queue call
T = Toll-denied, TAFAS answered,
or Pickup answered

Outgoing
Incoming Direct/Dial-in
Incoming/Dial-in incoming
Incoming/Outgoing

Speed call or
Call fwd flags S or F

S = Number was Speed called
F = External call forwarded through
External call fwd feature or internal
call forwarded through Call forward
feature

Outgoing

Called party

qqqq

qqqqqqq

cccc = Extension #
Tnnn = Trunk # (CO)
Xnnn = Trunk # (non-CO)

ATTm = Attendant

ccccccc = Extension #
Tnnnn = Trunk # (CO)
Xnnnn = Trunk # (non-CO)
ATTmm = Attendant

c = 0 - 9, *, #
nnn = Range specified in
telephone system form
programming
m = Console # (ATmm for
Attendant 00 - 99)
c = 0 - 9, *, #
nnnn = 0000 - 9999

mm = Console #

Transfer/
Conference
call

K

T = Supervised transfer
X = Unsupervised transfer
C = 3-Way or Conference
U = Path unavailable
I = Interflow

U and I only apply to
ACD TELEMARKETER®
2000.

Third party rrrr
rrrrrrr

cccc = Extension #
cccccccc = Extension #

c = 0 - 9, *, #
c = 0 - 9, *, #

Account
Code (opt.) aa....a Length of 2 to 12 digits a = 0 - 9, space-filled

Route
optimization
flag (opt.)

s
r = pre-optimization trunk
R = post-optimization trunk
- = Space (no route optimization)

System
identifier
(optional)

iii Entered by System ID

i = 0 - 9
iii = 000 - 999
000 = No code entered
In the absence of a System
ID, a Node ID is printed (if
programmed). When both
System ID and Node ID are
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Name Format Definition Notes

programmed, System ID takes
precedence.

ANI/DNIS xx...xxxxxxx

Format:
-aaaaaaaaaa-dddddddddd
- = blank
a = ANIS digit
d = DNIS digit
Extended digit length format:
-aaaaaaaaaa-ddddddd

For Extended digit length
format only the 7 right most
DNIS digits are recorded.

Running call parties searches
You run a Call parties search to find out who/what phone numbers an extension called within a selected date
range.

To run a Call parties search
 1. Click the SMDR Inspector criteria tab.

TheOptions tab opens.
 2. Click theCall parties tab.
 3. Click Select dates and select the dates for which to run the search, for example, September 27, 2004 to

October 07, 2004.
 4. UnderSelect media servers, select the Call Accounting server, for example, 3300 ICP.
 5. UnderCall parties, type the Calling party, for example, extension 1104.
 6. Click Start search.

The SMDR Inspector results - SMDR Search results screen opens.

Call parties search results
The SMDR Search results tab displays the results of who extension 1104 called (Calling Party). On line one of
the results, extension 1104 called 592-2122 (Digits dialed). On line five, the extension 1104 checked his voice
mail (70). On line six, extension 1104 called extension 1124. (See Figure 9 - 4.)

SMDR Inspector
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Figure 9 - 4 SMDR search results tab - Call parties search

Running call types searches
You run a Call types search to narrow down aCall parties search. If you have completed a Call parties search
for all calls made by an extension, for a selected date range, you can now narrow the search to include only
outbound calls.

To run a Call types search
 1. Click the SMDR Inspector criteria tab.

TheOptions tab opens.
 2. Click theCall parties tab.
 3. Click Select dates and select the dates on which to run the search, for example, September 27, 2004 to

October 7, 2004.
 4. UnderSelect media servers, select the Call Accounting server, for example, 3300 ICP.
 5. UnderCall parties, type the Calling party, for example, extension 1104.
 6. Click theCall types tab.
 7. UnderCall types, clear the check boxes for all criteria but Outbound.
 8. Click Start search.

The SMDR Inspector results - SMDR Search results screen opens.

Call types search results
The SMDR search results tab displays the call parties/call type results. All Outbound calls made by extension
1104 from September 27, 2004 to October 7, 2004 are displayed. (See Figure 9 - 5.)
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Figure 9 - 5 SMDR search results - Call types search

Running options searches
You runOptions searches to narrow down further, Call types and Call parties searches. If you have completed
a Call parties search for all outbound calls made by an extension, for a selected date range, you can now
search for outbound calls that occurred within a specified time frame.

To run anOptions search
 1. Click the SMDR Inspector criteria tab.

TheOptions tab opens.
 2. Click theCall parties tab.
 3. Click Select dates and select the dates for which to run the search, for example, September 27, 2004 to

October 7, 2004.
 4. UnderSelect media servers, select the Call Accounting server, for example, 3300 ICP.
 5. UnderCall parties, type the Calling party, for example, extension 1104.
 6. Click theCall types tab.
 7. UnderCall types, clear the check boxes for all criteria but Outbound.
 8. Click theOptions tab.
 9. Under Time ranges, after the Start At time, type the start time, for example 18:00:00.
 10. Under Time ranges, after the End At time, type the end time, for example 24:00:00.
 11. Click Start search.

The SMDR Inspector results - SMDR Search results screen opens.

SMDR Inspector
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Options search results
The SMDR search results tab displays the call parties/call type/options results. Extension 1104made three
calls after 6:00 P.M. between September 27, 2004 andOctober 7, 2004. Were these expensive calls?Were
these legitimate calls? Run an extension report to find out. (See Figure 9 - 6.)

Figure 9 - 6 SMDR Search result - Options search

Running searches for error and information records
With the Option tab you can run a search for error and information records. The error messages are records of
sequence errors. The information records are records of when the Collector restarts.

If you have completed a Call parties search for all outbound calls made by an extension, for a selected date
range and within a specified time frame, you can also run a search for error and information records.

To run an Exception event search
 1. Click the SMDR Inspector criteria tab.

TheOptions tab opens.
 2. Click theCall parties tab.
 3. Click Select dates and select the dates for which to run the search, for example, October 12, 2004.
 4. UnderSelect media servers, select the Call Accounting server, for example, 3300 ICP.
 5. UnderCall parties, type the Calling Party, extension 1104.
 6. Click theCall types tab.
 7. UnderCall types, clear the check boxes for all criteria but Outbound.
 8. Click theOptions tab.
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 9. Under Time ranges, after the Start At time, type the start time, for example, 8:00:00.
 10. Under Time ranges, after the End At time, type the end time, for example, 12:59:59.
 11. UnderExceptions, select theError records and Information records check boxes.
 12. Click Start search.

The SMDR Inspector results - SMDR Search results screen opens.

Exception search results
There was an information record produced every fiveminutes. Either the alarm is set incorrectly (the system
thinks it should be receiving data because the business hours indicate the business is open), or the
connection has died. The Exception results tab displays error and information records. (See Figure 9 - 7.)

The Exception search results information is as follows.

Media server
TheMedia server box identifies the telephone system that produced the event record.

Record
The Data record box displays detailed information on the exception record.

SMDR Inspector
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Figure 9 - 7 SMDR search results - Exception results tab

Wild card searches
NOTE:

l To search for a string of numbers within a digits dialed string, enclose the string of numbers in
parenthesis, such as “8905”. The search will produce only records that include 8905 in the digits dialed
string.

l To search for records where the calling, called or third party involved a trunk (BOTH T and X in one
search), put a C in the calling, called or third party box.

When performing searches on theQueue Events tab, you can enter aP800 under Queue information and the
search will produce records involving Queue 800 only. Alternatively, you can run wild card searches. When
you perform wild card searches, you use * to represent the wild card. For example, if you enter “*00” under
Queue information on theQueue events tab, the search will produce records for all of the Queues or Agent
groups that end in “00” (for example, 200, 300).
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Exporting search results
You can save the SMDR Inspector search results in the following formats:

l HTML
l Microsoft Excel
l Microsoft Access
l XML
l Text

To export the search results
 1. Click Save search.

The Inspector Search Results Export window opens.
 2. Select the format in which to save search results: HTML,Microsoft Excel,Microsoft Access, XML, or

Text.
 3. Click Next.
 4. Click the ellipses to select the location to save the file.
 5. After File name, type the file name.
 6. Click Save.
 7. Click Next.
 8. Click Next to confirm the format in which to save the file and the location of the file.

A window opens with themessage “Inspector Search Results export to [export type] complete.”
 9. Click OK.
 10. Click Finish.

A window opens with themessage “Would you like to view/open this file now?”
 11. To view the file immediately, click Yes.

The file opens.

SMDR Inspector



- 191 -

Chapter 10

Call Accounting Node

Call Accounting Node Configuration
Call Accounting Node Installation



- 192 -

Call Accounting Node
NOTE:

l A single Call Accounting Node can collect data for one voicemedia server. If you have two voice
media servers, you require a second Call Accounting Node license.

l Real time synchronization between the remote nodes and 5000/Axxess media servers is not
supported. All synchronization with remote 5000/Axxess telephone systems must be performed using
Synchronization in YourSite Explorer or manually.

The Call Accounting Node enables you to set up a remote collection point at a separate location. It is an add-
on application that provides multi-site capabilities using a single-server configuration.

Call Accounting Node software
Call Accounting Node software collects raw data from the remotemedia server and both files the data to the
local hard drive and streams it to the prairieFyre Collector Service (on the Enterprise Server) over TCP/IP. The
prairieFyre Collector Service gathers the data, and the Enterprise Servicemakes it available for enterprise-
wide real-timemonitoring and reporting.

Call Accounting Node software does not require SQL, IIS, or other server support applications at your remote
sites. This results in significant cost savings. In addition, the redundant data collection provides added
security in case of network outages.

The Call Accounting Node software performs the following functions:
l Collects SMDR data from single or co-located telephone systems
l Stores SMDR data on the local Call Accounting Node server
l Streams real-time SMDR data to the Call Accounting Server for enterprise-wide real-time statistics

which automatically synchronizes and stores all statistics on the Enterprise Server for accurate, multi-
site, historical reporting

l Uses a telephone system neutral collection process that allows you to collect data and run reports on
companies with various Mitel telephone systems

Call Accounting Node license
A Call Accounting Node license enables a company to collect call costing data from co-located or
geographically dispersed telephone systems beyond the single telephone system collection license included
in Call Accounting.

Enterprise reporting
Enterprise reporting relies on two types of collectors: the Call Accounting Node - located at branch offices
(remote sites), and the prairieFyre Collector Service - the remote node is a collector service that
communicates with the Enterprise Service.

In order for data to be collected at a remote site, the Call Accounting Node softwaremust be deployed at that
site. The Call Accounting Node contains a data collector. It collects data from aMitel telephone system or
from other media types, and stores the information at that site. The prairieFyre Collector Service, which
resides at the Enterprise Server site, gathers the information from your remote site server (Call Accounting
Node server) and stores it as raw data. The Enterprise Service, which also resides on the Enterprise Server,
summarizes and then stores the data (SQL), and produces real-time data for the real-timemonitors.
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Call Accounting Node versus Enterprise Server
The Call Accounting Node collector collects raw data from a single media server at the remote site. The Call
Accounting Node streams this data to the Enterprise Server.

The Enterprise Server consists of the prairieFyre Collector Service and the Enterprise Service. The
prairieFyre Collector Service collects raw data from all of the (both local and branch office) media servers. The
Enterprise Service summarizes the raw data, stores it on the SQL Server, and produces enterprise-wide data
for the real-time and reporting applications.

Call Accounting Node Configuration
NOTE: If theWide Area Network (WAN) link between a remote site and the Enterprise Server goes down, the
managers and supervisors at the remote site cannot view real-time data on their site until theWAN connection
is restored. However, if theWAN link is down, data collection at the remote site continues.

You can run both the Call Accounting Node software and the Enterprise Server on a single computer or on
separate computers.

Setting up Call Accounting Node examples
You can set up Call Accounting Node in the following ways.

l Call Accounting Node server at the remote site
l No dedicated server at the remote site

Scenario 1 - With a dedicated server at the remote site
In this example, the enterprise consists of the following.

Office 1 - Kanata (prairieFyre Collector Service) with one media server (3300 ICP)
The Enterprise Server resides at site 1 in Kanata. The prairieFyre Collector Service collects data from all of
themedia servers at that site. There is onemedia server at the Kanata site (3300 ICP). No Call Accounting
Node is required at this site.

Then setting up your enterprise, you add the first site (Kanata) and then add the first media server (3300 ICP).
The first media server has the IP address 28.1.1.1 and IP port 5400.

Office 2 - Boston (Call Accounting Node) with one media server (3300 ICP)
The secondmedia server resides at site 2 in Boston. Themedia server in Boston is a 3300 ICP. You do not
require a dedicated server because you have a 3300 ICP media server. However, youmust install a remote
node at the remote site if themedia servers communicate over RS-232, and not TCP/IP. Media servers like
the 3300 ICP, which communicate over TCP/IP, have the unique ability to send data over TCP/IP without the
use of a dedicated server. However, to prevent data loss from the Boston site should theWAN go down, you
decide to install a dedicated server in Boston. The Call Accounting Node software is deployed on the
dedicated server. Therefore, all of the Boston raw data is stored on the dedicated server in Boston. If theWAN
goes down, data is still collected locally in Boston: no data is lost. Also, all of the raw and summarized data is
stored at the site with the Enterprise Server (Miami) by the prairieFyre Collector Service.

Continuing to set up your enterprise, you add the second site (Boston) and then add the Bostonmedia server
(3300 ICP). The Bostonmedia server has the IP address 256.1.1.1 and IP port 5401. Youmust have the Call
Accounting Node license to add the remote site to your enterprise.
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Scenario 2 - No dedicated server at the remote site
CAUTION: If you do not have a dedicated server at the remote site, data at the remote site is permanently
lost if theWAN goes down.

In this example, the enterprise consists of the following.

Office 1 - Miami (prairieFyre Collector Service) - with one media server (3300 ICP)
The Enterprise Server resides at site 1 in Miami. The prairieFyre Collector Service collects data from all of the
media servers at that site. There is onemedia server at theMiami site (3300 ICP). No Call Accounting Node
is required at this site. When you set up the enterprise, you add the first site (Miami) and then add the first
media server (3300 ICP). The first media server has the IP address 73.1.1.1 and IP port 5400.

Office 2 - Houston (Call Accounting Node) with one media server (3300 ICP)
The secondmedia server resides at site 2 in Houston. Themedia server in Houston is a 3300 ICP. A
dedicated server is not required because of the 3300 ICP media server. This means a Call Accounting Node
license is required but the Call Accounting Node software is not deployed at the remote site. The 3300 ICP
media server has the unique ability to send data over TCP/IP without the use of a dedicated server. Therefore,
all of the raw and summarized data is stored at the site with the Enterprise Server (Miami) and no data can be
stored at the Houston site. While theWAN is down, all of the data produced in Houston is lost.

Continuing to set up your enterprise, you add the second site (Houston) and then add the Houstonmedia
server (3300 ICP). The Houstonmedia server has the IP address 73.1.1.1 and IP port 5401. Using this set up
the prairieFyre Collector Service collects the raw data from the Houston site, therefore, you use theMiami IP
address. Youmust have the Call Accounting Node license to add the remote site to your enterprise.

Call Accounting Node Installation
In multi-site companies that use Call Accounting, it is necessary to install a Call Accounting Node at each site
except the site where the Enterprise Server resides (a remote site with amedia server that communicates
over TCP/IP is the exception). The prairieFyre Collector Service resides at the office that has the Enterprise
Server software installed and it collects data at that site. See "Scenario 2 - No dedicated server at the remote
site" on page 194.

Call Accounting Node software collects the raw data from all of themedia servers at the remote site. The Call
Accounting Node enables supervisors at remote sites tomonitor activities in real-time and run reports on their
sites without having to install an Enterprise Server at that site.

Installing Call Accounting Node software
To install Call Accounting Node software on the remote site server
 1. Log on to the Enterprise Server with aWindows administrator account.

The account must have full administrative privileges.
 2. Ensure all of theWindows programs are closed.
 3. Using a web browser browse to http://www.mitel.com.
 4. Click Login.
 5. Type yourMOL User ID andPassword and click Log in.
 6. UnderSupport click Software Downloads.

Call Accounting Node Installation
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 7. To download
l Call Accounting software, click Call Accounting =>Call Accounting Software Download.
The Knowledge Base article pertaining to Call Accounting will open.

 8. AfterDownload the Mitel Networks Call Accounting, click CA_FullRelease.
The Download Center opens.

 9. Review and ensure you have performed all steps included in the Before you begin and Installing
prerequisite software sections of the Download Center.

 10. Under Installing optional applications, click aWeb or FTP Download link to install the latest version
of Call Accounting Node software.
TheMitel Contact Center Solutions 6.0 self-extracting wizard opens.

Viewing the status of the data collection
Call Accounting Node software collects the data from all of themedia servers at the remote site (a remote site
with amedia server that communicates over TCP/IP is the exception). See "Scenario 2 - No dedicated server
at the remote site" on page 194.

You can use Network Monitor to verify you are collecting data and to view the status of data collection.

Viewing the Network Monitor
NOTE:When you open Contact Center Client, it automatically points Network Monitor to the Enterprise
Server default IP address. If you havemore than one server at your site, ensure that Contact Center Client is
pointing to the correct server.
To view the Network Monitor
 1. Open Contact Center Client.
 2. If prompted, type your user name and password.
 3. Select a profile to load.
 4. Click OK.

The Contact Center Client window opens.
 5. Click Network Monitor in the Contact Center Client ribbon.
 6. Click the Network Monitor icon that opens in the toolbar.

When active, a green arrow displays.
The Network Monitor displays.
See Figure 10 - 1.



- 196 -

Figure 10 - 1 Network Monitor

After you open Network Monitor, you canminimize it or close it. When you close Network Monitor, it resides
in the Network Monitor toolbar.

Opening the Network Monitor
After viewing the Network Monitor, you can close or minimize it. When you close the Network Monitor, it
resides in the Network Monitor toolbar.

To open the Network Monitor from the toolbar
l Double-click the Network Monitor toolbar.

Network Monitor opens.

Call Accounting Node Installation



Call Accounting User Guide

- 197 -

Viewing alarms
In Network Monitor, the EnterpriseWindow displays critical alarms and warning alarms. Critical alarms are
activated when Collector Service is not receiving data, the Enterprise Server disk space is low, and in other
instances where the Enterprise Server is prevented from functioning optimally. When there is a critical alarm,
Network Monitor displays the alarm and you are emailed a notification. Warning alarms are activated when
license violations occur, duplicate records are created, and for other non-critical issues. When there is a
warning alarm, the Network Monitor icon in the System Tray blinks.

The overall alarming state is displayed in Network Monitor with a circular, colored status indicator. The color
indicates the highest level of severity for all alarms currently alerting (Normal = Green, Minor = Yellow, Major
= Orange, Critical = Red, Unknown = Gray). If needed, you can click on the RSS Feeds link for more specific
alarm details.

NOTE:Youmust configure settings for your SMTP mail server in YourSite Explorer in order to receive alarm
notifications by email.

In YourSite Explorer, you can configure alarms to notify you if Collector Service is not receiving data or if the
server disk space is low. See "Configuringmedia server alarms" on page 75.

The current alarm status displays in the Network Monitor ribbon, as illustrated in Figure 10 - 2.

Figure 10 - 2 Network Monitor - Current alarm status

To open Network Monitor from the toolbar
l Double-click the Network Monitor toolbar.

To view a summary of alarms and the status of the Enterprise Server
l In the Enterprise window, under Description, view if there are any critical alarms and if the Enterprise

Server is online.

To view the status of the alarms
l In the bottom window, view any Critical alarms andWarning alarms.

TheMedia Servers window displays all critical and non-critical alarms for themedia servers installed on
the Enterprise Server and Remote Servers.

To view data and system alarms with Administrative tools
l On the Enterprise Server, inWindows, navigate to theEvent Viewer to seemore information on the

error.
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Subscriber Services
Subscriber Services is an optional application to Call Accounting. Using Subscriber Services, you can create
customized plans to cost subscriber calls. Because the plans are customizable, you can bill back some
subscribers a fraction of the cost of their calls and others you canmarkup the cost of the calls. Using
Subscriber Services you can also add surcharges for the billing period.

Subscriber reports provide call statistics that help you track subscriber call activity and cost. You can report
on all types of calls—-inbound, outbound, local, long distance—-and create reports to provide to subscribers.

Subscribers
A subscriber is someone to whom you provide a communication product or service, such as a student in a
dormitory, or a tenant in a rooming house. Subscriber Services is themeans by which youmark up or discount
call costs.

You configure subscriber devices in YourSite Explorer. Tomark up or discount phone use costs, or add billing
options for subscribers, youmust associate subscriber plans to subscriber devices. Tomark up or discount
phone use costs, or add billing options for employees, youmust associate subscriber plans to employee
devices. You identify a subscriber by associating the subscriber with an extension or Account Code.

Subscriber plans
Subscriber plans help you cost the calls made by subscribers or employees, and enable you to charge a
markup/discount for each call or add a billing option. Billing options are one-time surcharges per subscriber
report.

You can create basic subscriber plans or advanced subscriber plans.

NOTE:Basic and advanced subscriber plans are not associated with carrier plans. Changes to carrier plans
do not effect subscriber plans.

Basic subscriber plans
You use a basic subscriber plan if you want to either mark up or discount carrier costs, or specify calls as
outbound, inbound, or internal.

Advanced subscriber plans
When you specify call types or call rates for outbound, inbound, or internal calls, a basic subscriber plan
becomes an advanced subscriber plan.

Licensing
You license Subscriber Services based on the total number of subscribers on which you report. Your license
reflects themaximum number of subscribers on which you can generate reports.

To view details on your software license
l Click Help=>About your Mitel applications.

Subscribers
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Subscriber Services configuration
Youmust configure Subscriber Services before you are able to report on subscriber call activity. You
configure devices in the following order. (See Figure 11 - 1.)
 1. In YourSite Explorer, under YourSite, if you have not done so previously, add

l Employees and employee groups (optional)
See "Adding employees" on page 94.

l Extensions and/or Account Codes
See "Adding Account Codes" on page 102.

 2. In YourSite Explorer, under Call Accounting, if you have not done so previously, add
l Call types

See "Adding call types" on page 105.
l Time slots

See "Adding time slots" on page 106.
l Call rates

See "Adding call rates" on page 106.
l Subscribers and subscriber groups (optional)

See "Adding subscribers" on page 112.
See "Adding subscriber groups" on page 112

l Billing options
See "Adding billing options" on page 112.

l Subscriber plans
You can associate either subscribers or employees to the subscriber plan.
You can optionally associate billing options.
See "Adding subscriber plans" on page 113.

Figure 11 - 1 Subscriber Services configuration steps

Troubleshooting Subscriber Services configuration issues
When Subscriber Services is configured so that you could either cost calls by an extension associated to an
subscriber or by an Account Code associated to an employee, the Account Code cost overrides the extension
cost. See the example below.
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ABC Travel uses Contact Center Management, Call Accounting, and Subscriber Services. It has several
satellite offices around town. Each satellite office is configured as a subscriber, so that call costs can be
attributed to the office that generated them.

Current configuration
At ABC Travel, employees use Forced Verified Account Codes to gain access to an outside line. Jenny, a
new employee, (Employee 8856) is associated with Account Code 8856 and Extension 8856. Her boss has
not yet associated her with a subscriber.

Action
Jenny’s boss accidentally disassociates her extension, then associates the extension (Extension 8856) with
Subscriber A. The boss associates Subscriber A to a subscriber plan.

Result
Any calls made using Extension 8856 get pegged to Subscriber A and any calls made using Account Code
8856 get pegged to Employee 8856. If there is a conflict, Account Code overrides extension. For example, if
Jenny uses Extension 8856 and punches in her Account Code tomake a call, the calls get pegged to
Employee 8856, not Subscriber A.

Subscriber Services configuration
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Traffic Analysis
Traffic Analysis is an optional application that works with Call Accounting and Contact Center Solutions.
Traffic Analysis works in conjunction with the 3300 ICP telephone system.

In order to have summarized data for Traffic Analysis reports youmust wait until the nightly maintenance
routine runs the summary (at midnight each night). The data for these reports is derived from the traffic
stream. Traffic Analysis reports are not available in real-time.

For detailed information about traffic reports, refer to theCall Accounting Reports Guide. Traffic reports
provide call statistics on DTMF receivers, route lists, route plans, routes, and trunks. You can create the
following on-demand and scheduled traffic reports:

l Attendant Console Traffic by Interval report
l Attendant Traffic by Interval
l Attendant Group Traffic by Interval
l DTMF Receiver Group Traffic by Interval
l Route List Traffic by Interval
l Route Plan Traffic by Interval
l Route Traffic by Interval
l Trunk Traffic by Interval
l Trunk Busy Hour Traffic by Day of theWeek
l Trunk and Trunk Group Traffic Usage by Day of theWeek
l Trunk GroupOutgoing Traffic by Interval
l Trunk GroupOutgoing Traffic Usage by Day of theWeek
l Trunk GroupOutgoing Busy Hour Traffic by Day of theWeek

Using Traffic Analysis
Before you generate Traffic Analysis reports youmust configure data collection for Traffic Analysis.

To configure data collection for Traffic Analysis
 1. Set up the telephone systems to collect traffic data
 2. Configure themedia servers in Call Accounting for traffic data collection

Setting up telephone systems to collect traffic data
You can collect traffic data from a 3300 ICP telephone system over TCP/IP.

Setting up the 3300 ICP
Youmust specify traffic data options on the 3300 ICP Traffic Options Assignment form in order to collect
traffic data and produce reports with the Traffic Analysis application.

Using Traffic Analysis
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The Traffic Options Assignment form is a form-drivenmethod to obtain time-based traffic reports on telephone
system usage. You can generate reports that cover attendant usage, channel utilization, system activity, data
station usage, delay to dial tone, extension-to-extension calls, feature usage, and trunk use.

NOTE:
l You can define up to six different time slots.
l If the start and stop time are blank while the time slot is active, an error message is displayed when the

commit operation is attempted; in this case, the changes will not be committed.
l No two traffic slot stops should be less than 5minutes apart. This time is required for the system time

to generate the previous report.
l Making changes to the data in this form and recommitting interrupts a traffic report that is running.

Programming the Traffic Options Assignment form
To program the Traffic Options Assignment form
 1. Log onto the 3300 ICP telephone system.
 2. Browse to the Traffic Options Assignment form.
 3. Click Change.
 4. Configure the traffic options as described in Table 12 - 1.

Option Value

Time Slot Active

Select Yes to start a traffic session at the time specified in Start
Time field and finish at the Stop Time field for each of up to six
different slots. The report is resumed the next day at the same time.
Select No to suspend the traffic report for the associated time slot.
The traffic report will not run until Yes is entered and the form
recommitted. Default is No. There can be no overlapping of ACTIVE
time slots. Select: Yes

Start Time
(-Hours, -Minutes)

Select the time the traffic report is to start running. Default is blank.
The start timemust be assigned for active time slots; it can be blank
for inactive time slots. If the start time equals the stop time then the
time period is 24 hours. Select: 00:00

Stop Time
(-Hours, -Minutes)

Select the stop time for the report. If the session is to run for 24
hours, enter the same time as the start time. Default is Blank. The
stop timemust be assigned for active time slots; it can be blank for
inactive time slots. If the start time equals the stop time then the time
period is 24 hours. Select: 24:00

Period Length
Select the length of time(15, 30, or 60minutes) that data is to be
collected for the session before a traffic report is formatted and
output. Default is 60minutes. Select: 15

Usage Units Select the type of units the report will use. Default is Erlangs. Select:
Erlangs

Table 12 - 1 3300 ICP Traffic Options Assignment form
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Option Value

Autoprint

Select Yes to spool the traffic report to the printer assigned to this
function in the Application Logical Port Assignment form. Default is
No. Wewill be using the LPR1 Port 1754 to output traffic.
Select: Yes

Maximum Number of Traffic Files Enter themaximum number of traffic reports to be stored in disk.
Default is 10. Select: 10

Sections to include in Traffic Report

Select Yes to enable the collection of data for each resource group
you want to include in the traffic report. The default is No.

Route Plans Yes

Route Lists Yes

Routes Yes

Trunk Groups Yes

Trunks Yes

Links No

Groups of Links No

Channels No

DTMF Receivers Yes

Data Transceivers No

ModemGroups No

Data Station Groups No

Attendant Groups Yes

Attendant Consoles Yes

Attendants Yes

Using Traffic Analysis
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Assigning ports
Youmust assign a port to the 3300 ICP to output traffic data.

To enable traffic data output
 1. Log on to the 3300 ICP telephone system.
 2. Browse toApplication Logical Port Assignment.
 3. Select Traffic Report Port.
 4. Click Change.
 5. UnderPort Physical Name, type LPR1.
 6. Click Save.

Verifying the traffic output
Before you configure traffic collection settings for the 3300 ICP, verify traffic data is being output through port
1754.

To verify traffic is being output through port 1754.
 1. Click Start=>Programs=>Accessories=>Communication=>Hyperterminal.
 2. AfterName, type Traffic.
 3. Click OK.
 4. AfterHost address, type the IP address of the 3300 ICP
 5. After Port number, type 1754.
 6. AfterConnect using, select TCP/IP.
 7. Click OK.
 8. Wait the interval time you selected in the Traffic Options Assignment, for example 15, 30 or 60minutes.

The traffic should then output to your screen.
 9. After the output is complete, you can disconnect and close the hyper terminal window.

Configuring media servers
Youmust configure traffic collection settings in YourSiteExplorer for themedia servers from which you collect
traffic data.

3300 ICP
You do not require a dataset to collect traffic data from a 3300 ICP. The traffic data is directed to the printer
port, 1754, on the 3300 ICP telephone system.
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Verifying traffic data is saved on the Enterprise Server
To verify the traffic collection for the 3300 ICP
 1. Start Internet Explorer and type your Enterprise Server IP address http://[your Enterprise Server IP

address]/CCMWeb/.
 2. Using an administrative username and password, log on to the Call Accounting website.
 3. Click YourSite=>Enterprise.
 4. Expand the tree of the site for which you want to configure traffic options.
 5. Click a 3300 ICPmedia server.
 6. Click theData Collection tab.
 7. Verify the Traffic Analysis check box is selected and the port is 1754.
 8. Wait the interval time you selected in the Traffic Options Assignment, for example 15, 30 or 60minutes.
 9. On the Enterprise Server, browse to drive letter:>\Program Files\prairieFyre Software

Inc.\6100CCS\6110\Data Directory\Node_0X.
This is the directory of themedia server for which you configured traffic options.
You should see a new file with the following naming convention, TYYYYMMDD.txt. For example,
T20050127.txt, where YYYY is the year, MM is themonth, and DD is the day.

 10. Double-click the file to open it and view the traffic data.

Using Traffic Analysis
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Contact Center PhoneSet Manager and Contact
Center Softphone
The Contact Center PhoneSet Manager and Contact Center Softphone applications provide employees with
the ability to use their desktop computers as IP-based phones. Contact Center PhoneSet Manager and
Contact Center Softphone are designed for the 3300 ICP telephone system.

NOTE:Soft phone is not supported on the Enterprise Server.

Using Contact Center PhoneSet Manager and Contact
Center Softphone
Contact Center PhoneSet Manager and Contact Center Softphone enable employees to use their desktop
computers as IP-based phones. Contact Center PhoneSet Manager automates Mitel IP phone sets from the
computer desktop. An employee who uses Contact Center PhoneSet Manager has a headset connected to a
desk phone. Contact Center Softphone provides complete phone set functionality from the computer desktop.
A computer and wired or wireless USB headset deliver calls to the employee.

Starting Contact Center Client
Contact Center Softphone and Contact Center PhoneSet Manager reside in Contact Center Client.

Tested headsets
Wehave tested the following headsets to confirm they work with Contact Center PhoneSet Manager:

l GN Netcom GN 6120 Bluetooth office headset—wireless (part number GN 6120)
l Plantronics SupraPlus Noise-Canceling—monaural (part number H251N)
l Plantronics SupraPlus Noise-Canceling—binaural (part number H261N)
l GN NetcomMonaural over-the-head, SoundTube clarity (part number GN 2110 ST)
l GN Netcom Binaural over-the-head, SoundTube (part number GN 2115 ST)

NOTE: In order for the Plantronics andGN Netcom headsets to work with Contact Center PhoneSet Manager
youmust have the correct amplifier adaptor for theMitel phones.

We have tested the following headsets to confirm they work with Contact Center Softphone:
l Plantronics DSP PC 500—binaural (part number DSP 500)
l Plantronics CS50Wireless Office Headset System (part number CS50)
l Plantronics SupraPlus Noise-Canceling—monaural (part number H251N)
l Plantronics SupraPlus Noise-Canceling—binaural (part number H261N)
l GN NetcomMonaural over-the-head, SoundTube clarity (part number GN 2110 ST)
l GN Netcom Binaural over-the-head, SoundTube (part number GN 2115 ST)

NOTE: In order for the Plantronics andGN Netcom headsets to work with Contact Center Softphone you
must have the correct USB adaptor.
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USB-to-headset adaptors
For Contact Center Softphone, the Plantronics H251N and H261N and theGN Netcom GN 2110 ST andGN
2115 ST headsets must be connected to your computer by a USB-to-headset adaptor. We have tested the
following USB-to-headset adaptors to confirm they work with Contact Center Softphone:

l Plantronics DA60 USB-to-Headset Adaptor (part number DA60)
l GN Netcom USB-to-headset adaptor (part number GN 8110)
l GN Netcom USB-to-headset adaptor (part number GN8120)

You can integrate the GN 8120 with Contact Center Softphone and use the three different function buttons on
theGN 8120 to perform specific functions in Contact Center Soft phone. Table 13 - 1 shows theGN 8120
button functions.

Button State Action

Blue volume
control Any state

Increases or decreases the
headset speaker volume, which
controls the volume at which you
can hear a caller

White button Any state Turns themute function on or off

Green button

Incoming call is ringing on one of your line
appearances

You are currently talking to someone and you do not
have anyone on consultation hold

You are currently talking to someone and you have
someone on consultation hold

Answers a call

Hangs up a call

Performs a swap with the party
on hold

Red button

You are currently talking to someone, and you do not
have anyone on consultation hold

You currently have someone on hold

You are currently talking to someone and you have
someone on consultation hold

Places the current call on hold

Retrieves the call on hold

Cancels the current call and
returns you to the party on hold

Table 13 - 1 GN 8120 button functions

Table 13 - 2 shows the various situations where the LEDs will be lit or flashing based on the state of Contact
Center Softphone.
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What you are doing GN 8120 LED displays

All lines are active, and themute function is off All LEDs are off

Themute function is on Blue LED above the white button is on

A call is ringing Green LED above green button is flashing

You are currently dialing, waiting for an answer, or
talking to someone, and you do not have anyone on
hold

Green LED above green button is on

You are currently talking to someone, and he has put
you on hold Green LED above green button is flashing

You put someone on hold Red LED above red button is on

You are currently talking to someone, and you have
someone on consultation hold

Green LED above green button is on
Red LED above red button is flashing

Table 13 - 2 GN 8120 LED displays

Integrating the GN 8120 with Contact Center Softphone
To integrate the GN 8120 with Contact Center Softphone
 1. Log on to Contact Center Client.
 2. On themainmenu, click View=>Soft phone.
 3. Click Soft phone.
 4. After Input audio device, choose the GN 8120.
 5. AfterOutput audio device, choose the GN 8120.
 6. Click OK.

For more information about the GN 8120, visit the product page onGN Netcom’s website at
http://www.gnnetcom.com/US/EN/MainMenu/Products/Computer-VoIP/GN8120USB.htm.

Setting up the soft phone
The functionality of Contact Center PhoneSet Manager and Contact Center Softphone is similar. For
simplicity, we will use soft phonewhen referring to features and functionality common to both applications.

NOTE:
l Before you set up the soft phone on your client computer, ensure your network administrator has

configured your soft phone as a 5020 IP phone on the telephone system.
l Users who are upgrading to Call Accounting Version 6.0 or greater must uninstall MiAUDIODesktop

Edition before they use Contact Center Softphone. MiAUDIO is now bundled in the Call Accounting
software and no longer runs as the IP Phone Emulation Service.

l Although Inter-Tel users can log in tomultiple extensions simultaneously, this functionality is not
currently supported by Contact Center Solutions applications.
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To set up a client computer to use the soft phone
 1. Consult your network administrator to confirm your soft phone extension number.
 2. Ensure your headphone is connected.
 3. Configure sound and audio device properties.

See "Configuring sound and audio device properties" on page 212.
 4. Run Client Component Pack.

See "Installing the latest version of Client Component Pack" on page 27.

Configuring sound and audio device properties
To configure sound and audio device properties forWindows XP and Vista operating systems, youmust set
the PC speakers as the default audio device and adjust the volume of the PC speakers, headset speakers,
and headset microphone.

Configuring sound and audio device properties for Windows Vista
The following procedures describe how to configure sound and audio device properties forWindows Vista.

To set the PC speakers as the default audio device
 1. In Control Panel, double-click Sound to open the Sound dialog box.
 2. Select thePlayback tab.
 3. Click theSpeakers icon.
 4. Click theSet Default button.
 5. Click OK to save the Speakers as your default device.

This enables your PC speakers to be used as the default audio device, so when you receive calls on
the soft phone, the ring tone plays through your headset and your PC speakers.

To adjust the PC speaker volume
 1. In Control Panel, double-click Sound to open the Sound dialog box.
 2. Select thePlayback tab and double-click theDigital Output Device icon.
 3. Select the Levels tab and adjust the PC speaker volume by moving theDigital Output Device volume

slider from left to right.
 4. Click OK to save your volume setting.
 5. Click OK to close the Sound dialog box.

To adjust the headset speaker volume
 1. In Control Panel, double-click Sound to open the Sound dialog box.
 2. Select thePlayback tab and double-click theSpeakers icon.
 3. Select the Levels tab and adjust the headset speaker volume by moving theAudio output volume

slider from left to right.
 4. Click OK to save your volume setting.
 5. Click OK to close the Sound dialog box.

To adjust the headset microphone volume
 1. In Control Panel, double-click Sound to open the Sound dialog box.
 2. Select theRecording tab and double-click theMicrophone icon.
 3. Select the Levels tab and adjust the headset microphone volume by moving theMicrophone volume

slider from left to right.
 4. Click OK to save your volume setting.
 5. Click OK to close the Sound dialog box.
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Configuring sound and audio device properties for Windows XP
The following procedures describe how to configure sound and audio device properties forWindows XP.

To set the PC speakers as the default audio device
 1. In Control Panel, double-click Sounds and Audio Devices.
 2. Select theAudio tab and select your sound card device from theDefault device drop-down under

Sound playback.
This enables your PC speakers to be used as the default audio device, so when you receive calls on
the soft phone, the ring tone plays through your headset and your PC speakers.

 3. Click OK to save your settings.

To adjust the PC speaker volume
 1. In Control Panel, double-click Sounds and Audio Devices.
 2. Select theVolume tab and adjust the PC speaker volume by moving theDevice volume slider from left

to right.
 3. Click OK to save your settings.

To adjust the headset speaker volume
 1. In Control Panel, double-click Sounds and Audio Devices.
 2. Select theVoice tab and select your headset device from theDefault device drop-down list under

Voice playback.
 3. Click theVolume button, located underVoice Playback.
 4. Adjust the headset speaker volume by moving theVolume slider, located underSpeaker, up or down.
 5. Click OK to save your settings.

To adjust the headset microphone volume
 1. In Control Panel, double-click Sounds and Audio Devices.
 2. Select theAudio tab and select your headset device from theDefault device drop-down list under

Sound recording.
 3. Click theVolume button, located underSound recording.
 4. Adjust the headset microphone volume by moving theVolume slider up or down.
 5. Click OK to save your settings.

Opening the soft phone
To open the soft phone
 1. In the Contact Center Client ribbon, click Soft Phone
 2. Click theSoft Phone icon in the toolbar ribbon.

The Soft phone configuration window opens.
See Figure 13 - 1.
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Figure 13 - 1 Soft phone configuration window

 3. Click Add Extensions to search and select from all internal standard extensions, hot desk extensions,
and external hot desk user extensions.

 4. Select your phone extension from the list of extensions.
NOTE:Although Inter-Tel users can log in tomultiple extensions simultaneously, this functionality is
not currently supported by Contact Center Solutions applications.

 5. If you have Contact Center PhoneSet Manager, click Desk phone. If you have Contact Center
Softphone, click Soft phone.

 6. To log on automatically to the soft phone with your phone extension the next time you open the current
profile, select theRemember my extension check box.
Youmust save the current profile before you quit the soft phone for this option to work.
If you are a hot desk user who participates in the use of PINs, the PIN login dialog box opens. If you are
a hot desk user who does not participate in the use of PINs, go to step 10.
NOTE:When logging in as an external hot desking agent or a hot desking user who is not set up to use
a PIN login, if the PIN entry window displays, do not enter a PIN; just click Login.

 7. Type your Login PIN.
If you want Contact Center Client to remember your Login PIN, select the Remember your credentials
check box. This option is not available if your Contact Center Client profile is shared.
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 8. Click Login.
NOTES:

l If the Login PIN you entered is invalid the login will fail and you will be asked to enter a valid
Login PIN.

l Advanced supervisor or System Administrator will not be prompted to enter a PIN provided third
party call control is configured under security in the Contact Center Management website and on
the telephone switch.

 9. If you want Contact Center Client to be the top-most window on ringing, select theBring to front on
ringing check box.

 10. If you want Contact Center Client to not display the screen pop window when calls are ringing on the
desktop, enable theDisable toaster on ringing check box.

 11. If you selected Soft phone in step 6, underSoft phone settings, configure soft phone options.
 12. AfterAddress book source for contacts, select YourSite contacts orOutlook contacts.

Contact Center PhoneSet Manager and Contact Center Softphone users can access YourSite
database phone extensions or Outlook Personal Contact or Global Address List phone numbers when
they handle calls.

 13. To automatically log off the agent from the telephone system when closing the soft phone, select the
Automatically log off this ACD agent when closing the soft phone check box.
NOTE: This option does not apply to Call Accounting users.

 14. If you want to synchronize online presence indicators with phone states in real-timemonitors, select the
Synchronize my Lync presence with my phone state check box.

 15. To display call notes on the soft phone display and on the Call Notes monitor, ensure theEnable call
notes check box is selected.

 16. Click OK.
The Contact Center Client window displays the soft phone, Phone and Functions toolbars.
See Figure 13 - 2.

Figure 13 - 2 Soft phone toolbars

 17. If you want to be able to position the soft phone toolbar elsewhere on your desktop, enable the Float
check box.

 18. Tomove the soft phone toolbar, hover themouse over the perforated line on the left-side of the toolbar
until the four-headed arrow displays. Then click, drag, and drop it to the desired position on your
desktop. To reanchor the toolbar to the ribbon, drag and drop it into position under the ribbon.

 19. If you want to modify the soft phone configuration, click theConfiguration icon in the toolbar to reopen
the Soft phone configuration window.

Using your hot desking extension, log on to the telephone
system
Extensions can log on to the telephone system by selecting the Superkey button in Contact Center
Softphone. See "Contact Center PhoneSet Manager and Contact Center Softphone" on page 209.

We recommend that soft phone users who are hot desking log on to their extension using the soft phone
Actions menu. This enables the soft phone to identify extensions.
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NOTE: If you are an external hot desking agent or a hot desking user who logged in internally, logged out, and
then chose to log back in externally, you will not be able to log on with the soft phone Actions menu. In order to
access this functionality, youmust first close and reopen the soft phone toolbar (View=>Deselect and
reselect the soft phone option).

To log on to the telephone system
l On the soft phone Functions toolbar, click Actions=>Log on and select an extension.

To log on an external hot desking user
l On the soft phone Functions toolbar, click Actions=>Log on=>Hot Desking Users.

NOTE:When a hot desk agent logs in to the ACD a 3300 ICP user license is taken from the available
licensing pool and when the agent logs out the license is released back to the licensing pool. Agents are
notified upon login attempt if the number of concurrent logins exceeds the number of available user licenses. If
there are no available user licenses the login attempt will fail.

Phone and Functions toolbars
The Phone toolbar displays your

l Extensions (grey oval buttons)
l Hold button (red oval button)
l Superkey button (blue oval button, for Contact Center Softphone only)
l Current phone state box with a down arrow that displays a call details window
l Dial box (field for dialing extensions or phone numbers)
l Dial button (Contact Center PhoneSet Manager only)
l Redial button (Contact Center Softphone only)
l Cancel button (Contact Center Softphone only)
l Message button (for retrieving voicemail messages, Contact Center Softphone only)

The Functions toolbar displays
l Your current state (active, inactive, extension inbound, extension outbound)
l Telephony buttons

See "Displaying, hiding, and retiring toolbar buttons" on page 219.

Phone functions
You can readily answer calls or forward them to extensions or phone numbers using the soft phone. You can
select extensions from contact and speed dial lists, and perform the following actions: Redial (Contact Center
Soft phone only), Transfer, Conference, Mute, Forward, Request help, Hold, Retrieve, Split, Swap, Camp on,
Leave amessage, Retrieve amessage, Call me back, Hang up, and Cancel.

NOTE:External hot desk users access the "Answer" and "Hang up" functions using their external device and
not the soft phone toolbar.

Table 13 - 3 lists the soft phone telephony options and their correspondingmeanings.
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Icon Meaning

Account Code tags a call with an Account Code

Answer answers a ringing call

Auto answer if enabled, answers a ringing call without you having to click Answer

Call me back notifies you as soon as the extension number you are trying to call is
available

Camp on notifies an employee you are attempting to call with a series of audible
beeps

Cancel terminates your connection to a caller

Conference connects three or more people together for a conversation

Dial pad enables you to dial a number using a keypad

Forward forwards a call to a phone number or extension

Hang up terminates a call

Table 13 - 3 Extension actions
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Hold places the current call on hold

Leave amessage leaves amessage waiting notification on an employee’s extension

Mute if you have Contact Center Softphone, disables your microphone so you
can consult privately with another employee while on a call

Request help calls an employee who can click Answer and listen to an in-progress call
without the caller knowing

Retrieve picks up a call that is held or camped on to your extension

Speed dial enables you tomake a call to a specified number with onemouse click

Split disconnects one person from a conference call

Swap swaps between the current and the held party

Transfer forwards an in-progress call to another answer point

Transfer/Conference places a caller on hold andmakes a consultation call

Volume if you have Contact Center Softphone, adjusts the volume of your
speakers and/or microphone
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Call Notes enables you to add notes to a call

Customizing the soft phone
You can enhance productivity by configuring the following time-saving options in the soft phone:

l Toolbar customization
l Sounds and notifications
l Call forward destinations
l Speed dial contacts
l Shortcut keys
l Pre-announcement messages

Configuring soft phone settings
To specify soft phone settings
 1. Right-click the Phone toolbar and click Configure.
 2. After Input audio device, select an audio device for your microphone.
 3. AfterOutput audio device, select an audio device for your speakers or headset.
 4. Click OK.

Specifying the address book source for contacts
To specify the address book the soft phone uses for contacts (Microsoft Outlook or the Call Accounting
website, on theMy options link.)
 1. Right-click the Phone toolbar and click Configure.
 2. AfterAddress book source for contacts, select YourSite contacts orOutlook contacts.
 3. Click OK.

Resizing toolbar buttons
To resize toolbar buttons
 1. Right-click the Phone toolbar and click Configure.
 2. Click the Toolbars tab.
 3. After Functions toolbar, select a size for displaying the Functions toolbar buttons.
 4. AfterPhone toolbar, select a size for displaying the Phone toolbar buttons.
 5. Click OK.

Displaying, hiding, and retiring toolbar buttons
You can display telephony buttons, hide them so they appear on the Functions toolbar only when required, and
retire them for actions you rarely perform, such as Camp on and Request help.

To display telephony buttons
 1. Right-click the Phone toolbar and click Configure.
 2. Click the Toolbars tab.
 3. UnderSelected buttons, select the check boxes of the telephony buttons to be displayed.
 4. Click OK.
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To hide telephony buttons
 1. Right-click the Phone toolbar and click Configure.
 2. Click the Toolbars tab.
 3. UnderSelected buttons, clear the check boxes of the telephony buttons to be hidden from view.
 4. Click OK.

To retire telephony buttons
 1. Right-click the Phone toolbar and click Configure.
 2. Click the Toolbars tab.
 3. UnderSelected buttons, select the telephony buttons to be retired and click the left arrow to add these

buttons to the Available buttons list.
 4. Click OK.

To restore telephony buttons
 1. Right-click the Phone toolbar and click Configure.
 2. Click the Toolbars tab.
 3. UnderAvailable buttons, select the telephony buttons to be restored and click the right arrow to add

these buttons to the Selected buttons list.
 4. Click OK.

Repositioning toolbar buttons
To specify the order in which telephony buttons appear
 1. Right-click the Phone toolbar and click Configure.
 2. Click the Toolbars tab.
 3. UnderSelected buttons, select a telephony button.
 4. Click the up or down arrow to change the position of the button relative to other buttons on the Functions

toolbar.
 5. Click OK.

Configuring sounds and notifications
You can configure sounds for individual phone events for incoming calls, secondary incoming calls, and/or the
digits dialed on your primary extension, or on all extensions. A primary incoming call is a call you receive while
you are in the active state and are available to take the call. A secondary incoming call is a call you receive
while you are on an extension outbound call or an extension inbound call.

Every time you receive a call a pop-up window notifies you the call has arrived. You can disable the pop-up
notification.

To configure a sound for a phone event
 1. Right-click the Phone toolbar and click Configure.
 2. Click theSounds tab.
 3. Select the Incoming calls, Secondary incoming calls, and/orPlay sounds when dialing digits

check boxes.
 4. AfterPhone events, select a phone event.
 5. AfterSound file name, click Browse and select a sound file.
 6. To play the sound file when the phone event occurs on any of your extensions, click Apply to all lines.
 7. Click OK.
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To disable the call arrival pop-up notification
 1. Right-click the Phone toolbar and click Configure.
 2. Click theSounds tab.
 3. UnderPhone events, click a phone line.
 4. Clear theDisplay pop-up notification for incoming calls check box.
 5. Click OK.

Making calls ring through your computer speakers
You canmake calls ring through your computer speakers instead of your headset.

Tomake calls ring through your computer speakers
 1. Right-click the Phone toolbar and click Configure.
 2. Click theSounds tab.
 3. AfterPlay the rings sounds on select the sound output device for your computer speakers.

Adjusting the volume of your speakers and microphone
If you have Contact Center Softphone, you can adjust the volume of your speakers andmicrophone.

To adjust the volume of your speakers
 1. Right-click the Phone toolbar and click Configure.
 2. Click theSounds tab.
 3. Adjust the volume by moving the speaker slider.

To adjust the volume of your microphone
 1. Right-click the Phone toolbar and click Configure.
 2. Click theSounds tab.
 3. Adjust the volume by moving themicrophone slider.

Configuring call forward destinations
You can forward calls manually to pre-configured call forward destinations. In addition, you can configure and
enable call forwarding so the telephone systems forwards calls to other answer points when you are
temporarily away from the office. For example, you could specify all External call busy calls you receive be
forwarded to a co-worker’s extension. Rather than directing these call to voicemail, the telephone system
would forward these calls to your co-worker.

To configure call forward destinations for calls you will forwardmanually
 1. Right-click the Phone toolbar and click Configure.
 2. Click theCall forward tab.
 3. UnderName, type the name of the person to whom you will forward calls.
 4. UnderNumber, type an extension or phone number (preceded by a number you dial to access an

outside line).
 5. Click OK.
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To configure and enable call forward destinations for calls the telephone system will forward
 1. Right-click the Phone toolbar and click Configure.
 2. Click theCall forward tab.
 3. Specify destinations for the following call types:

l All calls (all calls you receive)
l External call busy (external calls to your extension when you are on an extension inbound or

extension outbound call)
l External call no answer (external calls to your extension that you do not answer)
l Internal call busy (internal calls to your extension when you are on an extension inbound or

extension outbound call)
l Internal call no answer (internal calls to your extension that you do not answer)

 4. To activate the call forwarding rules immediately, select theEnabled check boxes of the call forwarding
types to be activated.

 5. Click OK.

Configuring speed dial numbers
When you pre-configure speed dial numbers in Contact Center Softphone, these contacts are available in
drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the Functions toolbar.

You can display a button for each speed dial number or display one button with a down arrow that lists all of
the speed dial numbers you have configured. You can speed dial calls manually to pre-configured extensions
and phone numbers.

To configure a speed dial number
 1. Right-click the Phone toolbar and click Configure.
 2. Click theSpeed dial tab.
 3. UnderName, type the name of the person to whom you will speed dial calls.
 4. UnderNumber, type an extension or phone number (preceded by a number you dial to access an

outside line).
 5. Click OK.

Configuring shortcut keys
You can assign a shortcut key to a telephony function to perform it with a simple keystroke. This enables you
to perform telephony functions while the soft phone is minimized or another application is currently selected.

To configure a shortcut key for a telephony function
 1. Right-click the Phone toolbar and click Configure.
 2. Click theShortcut keys tab.
 3. UnderShortcut key, select a telephony function.
 4. Click the down arrow, select Ctrl, Alt, Shift, orWin, and select a keyboard number, letter, or function

from the list.
 5. Click OK.

Making and terminating calls using Contact Center Phoneset
Manager
When youmake calls, on the Functions toolbar you can readily select contacts you pre-configure in Microsoft
Outlook, or speed dial numbers you configure in Contact Center PhoneSet Manager. See "Configuring speed
dial numbers" on page 222 and "Displaying, hiding, and retiring toolbar buttons" on page 219.
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You can dial any extension number or phone number. Contact Center PhoneSet Manager typically uses your
primary extension tomake calls. You can optionally select a different extension on the Phone toolbar to make
calls.

Making calls
To dial by phone number or extension number using Contact Center PhoneSet Manager
 1. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the dial box and type a number or extension on the
dial pad.

 2. Click Dial.
 3. To view the call details window, click the down arrow adjacent to the box that displays your current

phone state.
See Figure 13 - 3.

To dial internally from a real-timemonitor using Contact Center PhoneSet Manager
l From any real-timemonitor, right-click an agent, employee, or extension cell and click Call.

Figure 13 - 3 Making a call

Making calls to your contacts
Tomake a call to an extension in your contact list
 1. Click the arrow adjacent to the dial box and click theContacts tab.
 2. Select a contact in the list.
 3. Click Dial.

Making calls using speed dial
To dial using speed dial

l Click Speed dial and select a name in the list.
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Terminating calls
To terminate a call

l Click Hang up.

Forwarding and answering calls using Contact Center Phoneset
Manager
You can forward calls manually to pre-configured call forward destinations without having to speak to the
caller first. In addition, you can configure and enable call forwarding so the telephone system forwards calls to
other answer points when you are temporarily inactive. See "Configuring call forward destinations" on page
221.

If a call is ringing on your extension and you click the Forward button, the call will be forwarded to the default
call forward destination configured in the telephone system. If you click the down arrow adjacent to the
Forward button, you can select an extension or phone number for call forwarding.

Forwarding calls
When a call is ringing on your extension, to forward the call using Contact Center PhoneSet Manager
 1. Click Forward.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Forward button and select a contact.
 3. Click Dial.

Answering calls
When an employee receives a call with Contact Center PhoneSet Manager detailed caller information is
displayed on the desktop. (See Figure 13 - 4.) Additionally, the display can provide access to call notes, which
are notes an employeeadds to the call before transferring it. See "Adding call notes to a call" on page 225.

If configured and available the following information is provided in the soft phone display
l Caller name—name of the caller
l ANI—telephone number of the caller
l DNIS—telephone number the caller dials
l DNIS name—the name associated to the DNIS number in YourSite database
l Extension ID—extensionwho transferred the call
l Extension—extension from which the call was transferred
l Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a customer

site key (Intelligent Queue required)
l Customer Collected Information—information collected from a third party OBDC database.

Customer Collected Information requires Intelligent Queue and Verified Collected Digits, and
optionally, Remote Database Verification or CTI Developer Toolkit

l Call notes—notes added by an agent

You can answer calls by right-clicking the Contact Center PhoneSet Manager system tray icon and selecting
Answer, or by clicking the Answer toolbar button.
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Figure 13 - 4 Contact Center PhoneSet Manager display

To answer a call using Contact Center PhoneSet Manager
l Click Answer.

Handling calls using Contact Center PhoneSet Manager
You can handle calls by right-clicking the Contact Center PhoneSet Manager system tray icon and selecting
telephony functions, or by selecting telephony buttons on the Functions toolbar. The telephony buttons
available depend on the action you last performed. You can configure the toolbar buttons so they are always
visible, or visible only when required. See "Displaying, hiding, and retiring toolbar buttons" on page 219.

When you pre-configure speed dial numbers in Contact Center PhoneSet Manager, these contacts are
available in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the
Functions toolbar. See "Configuring speed dial numbers" on page 222.

Placing calls on hold
To place a call on hold

l Click Hold (red oval button).

Retrieving calls
You can retrieve a held call, or retrieve a call when a call is camped on to your extension.

To retrieve a call
l Click Retrieve.

Adding call notes to a call
When employees are speaking with customers, they can add notes to calls to share with other employees
involved in the call. This ensures all employees have context on calls and know what information has been
provided to customers upon call transfer.

When a call is being transferred to another employee or supervisor, the soft phone display shows themost
recent note associated with the call. When the employee answers the call, Contact Center Client appears on
top of all other open applications and displays the Call Notes monitor. Themonitor includes all of the call notes
associated with the current call.
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Employees can add notes each time a call is transferred, and employees on conference calls can add notes
simultaneously. Each set of notes includes the employee’s name and a date/time stamp. When an employee
completes a call and answers a new call or closes the Call Notes monitor, all call note information is saved
and available in the Lifecycle reports.

NOTE:
l On the Soft phone configuration window, you can clear the Enable call notes check box to hide the Call

Notes monitor and prevent call notes from being displayed.Optionally, you can enable the Bring to front
check box to ensure call notes display on top of all other windows when calls are received.

l Youmust have Contact Center PhoneSet Manager or Contact Center Softphone open in order to view
or add call notes.

l For 5000/Axxess configurations that use CT Gateway, time stamps are based on the Enterprise
Server’s PC clock. If the 5000/Axxess configuration includes Remote Servers, then time stamps are
based on the Remote Server’s PC clock. For the 3300 ICP, time stamps are based on the telephone
system clock.

To add a call note
 1. As a call is ringing on your extension, on the soft phone display click Answer to answer the call.

Contact Center Client appears on top of all open applications and displays the Call Notes monitor.
 2. AfterEnter a new call note, type a note.

Call notes can include amaximum of 100 characters.
 3. Click Add.

The call note is added to the Call notes text box and is included in the soft phone display upon call
transfer.

Transferring calls
You can perform a blind transfer or a supervised transfer.

To perform a blind transfer using Contact Center PhoneSet Manager
 1. While on a call, click Trans/Conf.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line if required). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a
contact.

 3. Click Dial.
 4. Click Hang up.

To perform a supervised transfer
 1. While on a call, click Trans/Conf.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
 3. Click Dial.

The system places the caller on Hold.
 4. Wait for the called party to answer. If you receive a busy signal or a voicemail greeting, click Cancel to

return to the initial party. Otherwise, speak to the employee and identify the caller.
 5. Click Transfer to transfer the call.



- 227 -

Conferencing calls
You can include up to eight people in a conference call. The following example illustrates a three-way
conference call.

To set up a conference call
 1. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line).
 2. Click Dial.
 3. After you speak with the person who answers, click Trans/Conf to add a person to an in-progress call.

The system places the person on Hold.
 4. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
 5. Click Dial.
 6. Speak to the person who answers.
 7. Click Conference to initiate a three-way conference call.

To split a conference call
l Click Split.

The last person you added to the conference call is placed on hold, and you can speak privately with the
first person.

Consulting with people while on calls
To consult with a person while on a call using Contact Center PhoneSet Manager
 1. Click Trans/Conf to conference in the person.

The system places the initial party on Hold.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
 3. Click Dial.
 4. After you consult with the person, either click Conference to conference in the person, click Cancel to

hang up on the person, click Transfer to transfer the call to the person, or click Swap to talk to the initial
party.

Requesting help while on calls
To request help while on a call using Contact Center PhoneSet Manager
 1. Click Request help.
 2. On the dial pad, type the extension number of the employee to be called. Otherwise, click the down

arrow adjacent to the Request help button and select a contact.
 3. Click Dial.

The system calls the employee. The employee can click Answer and listen in on the call without the
caller knowing and can click Conference to join the conversation at any time.
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Using Camp on
The Camp on feature is available when youmake a call to an extension and receive a busy signal because the
employee is already on a call. Camp on notifies the employee you are attempting to call with a series of
audible beeps.

NOTE:
l Callers cannot camp on to your extension if you have call forwarding or voicemail configured on the

extension.
l You cannot camp on to an extension that is in Make Busy or Do Not Disturb.

To camp on to an extension
 1. In the dial box, type an extension number.
 2. Click Dial.
 3. If you receive a busy signal, click Camp on.

The employee you called will hear a series of beeps and can click Retrieve to place the caller on hold
and speak with you. After speaking with you, the employee can click Swap to return to the caller.

Leaving and retrieving messages
The Leave amessage feature is available when youmake a call to an extension that is active. Youmust use
the dial pad to type a number when you are retrieving amessage.

To leave amessage
 1. In the dial box, type an extension number.
 2. Click Dial.
 3. If the employee does not answer, click Leave a message.

The telephone system leaves amessage waiting notification on the employee’s extension and the
Contact Center Client icon flashes red and white in the employee’s system tray.

To retrieve amessage
 1. Click Dial pad and type the number configured in the telephone system for message retrieval.
 2. Press Enter.

The automated attendant will ask you for your password.
 3. Type your password on the dial pad.
 4. Follow the instructions provided by the automated attendant to retrieve themessage.

NOTE: If you are left Call me back messages youmust use your physical phone set to retrieve the
messages.
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Using Call me back
The Call me back feature is available when youmake a call to an extension that is active. When you select
the Call me back button, the telephone systemmonitors the called employee’s other extension. When the
employee’s other extension returns to active, your phone rings. If you pick up the call, the employee’s phone
will ring. If you do not pick up the call, the callback will expire.

To leave a callback message
 1. In the dial box, type an extension number.
 2. Click Dial.
 3. If the employee does not answer, click Call me back.

The telephone systemmonitors the called employee’s extension. Your phone will rings when the called
employee’s other extension returns to the active state.

 4. When your phone rings, click Answer to pick up the call and speak with the employee.

Tagging calls with Account Codes
You can tag calls with Account Codes you pre-configure in Contact Center Client.

To tag an in-progress call with an Account Code or a Classification Account Code
l Click the down arrow adjacent to the Account Code button and select a traditional Account Code or a

Classification Account Code.

After hanging up, while in work timer mode, you can tag calls with Classification Account Codes.

To tag a call, after hanging up, with a Classification Account Code
 1. Click the down arrow adjacent to theAccount Code button.
 2. Select After Call Classification and select the appropriate Classification Account Code from the drop-

down list.

Making and terminating calls using Contact Center Softphone
When youmake calls, on the Functions toolbar you can readily select from contacts you pre-configure in
Microsoft Outlook, or speed dial numbers you configure in Contact Center Softphone. See "Configuring speed
dial numbers" on page 222 and "Displaying, hiding, and retiring toolbar buttons" on page 219.

You can dial any extension number or phone number. Contact Center Softphone typically uses your primary
extension tomake calls. You can optionally select a different extension on the Phone toolbar to make calls.

For information on how to use the superkey and phone book functionality of Contact Center Softphone, refer
to the 5220 IP Phone User Guide at http://edocs.mitel.com/UG/Index.html.

Making calls
To dial by phone number or extension number using Contact Center Softphone
 1. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the dial box and type a number or extension on the
dial pad.

 2. To view the call details window, click the down arrow adjacent to the box that displays your current
phone state.
See Figure 13 - 5.
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To dial internally from a real-timemonitor using Contact Center Softphone
l From any real-timemonitor, right-click an agent, employee, or extension cell and click Call.

Figure 13 - 5 Making a call

Making calls to your contacts
Tomake a call to an extension in your contact list
 1. Click the arrow adjacent to the dial box and click theContacts tab.
 2. Double-click a contact in the list.

Making calls to contacts who have called you recently
Tomake a call to a contact who has called you recently
 1. Click the arrow adjacent to the dial box and click theRecent tab.
 2. Double-click a contact in the list.

Making calls using speed dial
To dial using speed dial

l Click Speed dial and select a name in the list.

Redialing numbers
To dial the contact who last called you

l Click Speed dial and select a name in the list.

Terminating calls
To terminate a call

l Click Hang up.
Alternatively, on the Phone toolbar, click Cancel.
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Forwarding and answering calls using Contact Center Softphone
You can forward calls manually to pre-configured call forward destinations without having to speak to the
caller first. In addition, you can configure and enable call forwarding so the telephone system forwards calls to
other answer points when you are temporarily inactive. See "Configuring call forward destinations" on page
221.

If a call is ringing on your extension and you click the Forward button, the call will be forwarded to the default
call forward destination configured in the telephone system. If you click the down arrow adjacent to the
Forward button, you can select an extension or phone number for call forwarding.

Forwarding calls
When a call is ringing on your extension, to forward the call using Contact Center Softphone
 1. Click Forward.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Forward button and select a contact.

Answering calls
When an employee receives a call with Contact Center Softphone detailed caller information is displayed on
the desktop. (See Figure 13 - 6.) Additionally, the display can provide access to call notes, which are notes an
employee adds to the call before transferring it. See "Adding call notes to a call" on page 225.

If configured and available the following information is provided in the soft phone display
l Caller name—name of the caller
l ANI—telephone number of the caller
l DNIS—telephone number the caller dials
l DNIS name—the name associated to the DNIS number in YourSite database
l Extension ID—extension who transferred the call
l Extension—extension from which the call was transferred
l Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a customer

site key (Intelligent Queue required)
l Customer Collected Information—information collected from a third party OBDC database.

Customer Collected Information requires Intelligent Queue and Verified Collected Digits, and
optionally, Remote Database Verification or CTI Developer Toolkit

l Call notes—notes added by an agent

You can answer calls by right-clicking the Contact Center Softphone system tray icon and selecting Answer,
or by clicking the Answer toolbar button.
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Figure 13 - 6 Contact Center Softphone display

To answer a call using Contact Center Softphone
l Click Answer.

Handling calls using Contact Center Softphone
You can handle calls by right-clicking the Contact Center Softphone system tray icon and selecting telephony
functions, or by selecting telephony buttons on the Functions toolbar. The telephony buttons available depend
on the action you last performed. You can configure the toolbar buttons so they are always visible, or visible
only when required. See "Displaying, hiding, and retiring toolbar buttons" on page 219.

When you pre-configure speed dial numbers in Contact Center Softphone, these contacts are available in
drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the Functions toolbar.
See "Configuring speed dial numbers" on page 222.

Placing calls on hold
To place a call on hold

l Click Hold (red oval button).

Retrieving calls
You can retrieve a held call, or retrieve a call when a call is camped on to your extension.

To retrieve a call
l Click Retrieve.

Using Mute
To useMute
 1. Click Mute.

The system disables your microphone so you can consult privately with another employee.
 2. To restore your microphone, click Resume.
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Transferring calls
You can perform a blind transfer or a supervised transfer.

To perform a blind transfer using Contact Center Softphone
 1. While on a call, click Trans/Conf.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
 3. Click Hang up.

To perform a supervised transfer
 1. While on a call, click Trans/Conf.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
The system places the caller on Hold.

 3. Wait for the called party to answer. If you receive a busy signal or a voicemail greeting, click Cancel to
return to the initial party. Otherwise, speak to the extension and identify the caller.

 4. Click Transfer to transfer the call.

Conferencing calls
You can include up to eight people in a conference call. The following example illustrates a three-way
conference call.

To set up a conference call
 1. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line).
 2. After you speak with the person who answers, click Trans/Conf to add a person to an in-progress call.

The system places the person on Hold.
 3. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
 4. Speak to the person who answers.
 5. Click Conference to initiate a three-way conference call.

To split a conference call
l Click Split.

The last person you added to the conference call is placed on hold, and you can speak privately with the
first person.

Consulting with people while on calls
To consult with a person while on a call using Contact Center Softphone
 1. Click Trans/Conf to conference in the person.

The system places the initial party on Hold.
 2. In the dial box, type an extension or phone number (preceded by a number you dial to access an outside

line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.
 3. After you consult with the person, either click Conference to conference in the person, click Cancel to

hang up on the person, click Transfer to transfer the call to the person, or click Swap to talk to the initial
party.
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Requesting help while on calls
To request help while on a call using Contact Center Softphone
 1. Click Request help.
 2. On the dial pad, type the extension number of the employee to be called. Otherwise, click the down

arrow adjacent to the Request Help button and select an employee.
The system calls the employee. The employee can click Answer and listen in on the call without the
caller knowing and can click Conference to join the conversation at any time.

Using Camp on
The Camp on feature is available when youmake a call to an extension and receive a busy signal because the
employee is already on a call. Camp on notifies the employee you are attempting to call with a series of
audible beeps.

NOTE:
l Callers cannot camp on to your extension if you have call forwarding or voicemail configured on the

extension.
l You cannot camp on to an extension that is in Make Busy or Do Not Disturb.

To camp on to an extension
 1. In the dial box, type an extension number.
 2. If you receive a busy signal, click Camp on.

The employee you called will hear a series of beeps and can click Retrieve to place the caller on hold
and speak with you. After speaking with you, the employee can click Swap to return to the caller.

Leaving and retrieving messages
The Leave amessage feature is available when youmake a call to an extension that is active.

To leave amessage
 1. In the dial box, type an extension number.
 2. If the employee does not answer, click Leave a message.

The telephone system leaves amessage waiting notification on the employee’s extension and the
Contact Center Client icon flashes red and white in the employee’s system tray

To retrieve amessage
 1. In the dial box, type your voicemail access number.

The automated attendant will ask you for your password.
 2. In the daily box, type your password.
 3. Follow the instructions provided by the automated attendant to retrieve themessage.

NOTE: If extensions leave Call me back messages for you to check your messages, your Contact Center
Client tray icon will not clear themessages once you have checked your messages.

To clear amessage
 1. On the Phone toolbar, click Message.
 2. AfterCALL ME BACK?, click Yes.
 3. Click Erase.

The telephone image displays NO MORE MESSAGES.
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Using Call me back
The Call me back feature is available when youmake a call to an extension that is active. When you select
the Call me back button, the telephone systemmonitors the called employee’s other extension. When the
employee’s other extension returns to active, your phone rings. If you pick up the call, the employee’s phone
will ring. If you do not pick up the call, the callback will expire.

To leave a callback message
 1. In the dial box, type an extension number.
 2. If the employee does not answer, click Call me back.

The telephone systemmonitors the called employee’s extension. Your phone will rings when the called
employee’s other extension returns to the active state.

 3. When your phone rings, click Answer to pick up the call and speak with the employee.

Tagging calls with Account Codes
You can tag calls with Account Codes you pre-configure in Contact Center Client.

To tag an in-progress call with an Account Code or a Classification Account Code
l Click the down arrow adjacent to the Account Code button and select a traditional Account Code or a

Classification Account Code.

After hanging up, while in work timer mode, you can tag calls with Classification Account Codes.

To tag a call, after hanging up, with a Classification Account Code
 1. Click the down arrow adjacent to theAccount Code button.
 2. Select After Call Classification and select the appropriate Classification Account Code from the drop-

down list.

Making and handling calls using Contact Center Client
You can open an Extension by Positionmonitor and either right-click an extension and select telephony
functions or access telephony functions by selecting an extension and accessing the options in the Contact
Center Client ribbon. For example, when you are on a call you can consult with an employee by right-clicking
the extension cell and clicking Transfer/Conference, or by sending the employee an instant message.

Making calls
To call an extension using Contact Center Client

l Right-click an active extension and click Call.

Alternatively:
 1. Select anactive extensionin an openmonitor.
 2. Click theSoftphone button under the Extension Control tab in the Contact Center Client Real Time

ribbon.
 3. Choose theCallmenu item.

Forwarding calls
If a call is ringing on your extension, to forward the call using Contact Center Client

l Right-click an active extension cell and click Forward.
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Answering calls
If a call is ringing on another extension, to pick up the call using Contact Center Client

l Right-click the cell and click Pick up.

Adding call notes
When employees are speaking with customers, they can add notes to calls to share with other employees
involved in the call. This ensures employees have context on calls and know what information has been
provided to customers upon call transfer. If the call is transferred or parked, call notes are preserved. See
"Adding call notes to a call" on page 225.

NOTE:Before adding call notes, ensure the "Display call notes" option is enabled in the Softphone
configuration window. This option is disabled by default.

To add a call note
 1. As a call is ringing on your extension, on the soft phone display click Answer to answer the call.

Contact Center Client appears on top of all open applications and displays the Call Notes monitor.
 2. AfterEnter a new call note, type a note.

Call notes can include amaximum of 100 characters.
 3. Click Add.

The call note is added to the Call notes text box and is included in the soft phone display upon call
transfer.

Recording calls
There are occasions when an agent wants to temporarily stop recording a call for confidentiality reasons, or, if
the call is not currently being recorded, the agent may want to start recording if the conversation becomes
hostile or sensitive in nature and a call recordmay be required. On the Agent State by Time, Agent State by
Position, and Agent State by Queue by Timemonitors, the Call recording option enables you to start, stop,
and restart call recording at any time during a call, using OAISYS call recording functionality. Requirements
for this on-demand call recording feature are Contact Center Management, Contact Center PhoneSet
Manager or Contact Center Softphone, Interactive Contact Center, and the OAISYS call recording connector.

To record a call
 1. Right-click the associated cell of an agent and select Call Recording=>Start Recording.
 2. To stop recording, right-click the cell and select Call Recording=>Stop Recording.

Alternatively:
 1. Select the cell of an agent in amonitor whose call you want to record.
 2. In the Contact Center Client Real Time ribbon, under theAgent Control tab, select Start Recording

from the drop-down list in theCall Recording column.
 3. To stop recording, select Stop Recording from the drop-down list in theCall Recording column.

See Figure 13 - 7.
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Figure 13 - 7 Call recording

Transferring calls
To perform a blind transfer using Contact Center Client

l While on a call, right-click the cell of an active extension and click Transfer call.

Consulting with employees while on calls
To consult with an employee while on a call using Contact Center Client
 1. Right-click the cell of an active extension and click Transfer/Conference.

The system places the initial party on hold.
 2. In the dial box, type an extension or phone number. Otherwise, click the down arrow adjacent to the

Transfer/Conference button and select a contact.
 3. Click Dial.
 4. After you consult with the employee, either click Conference to conference in that person, click

Transfer to transfer the call to the employee, click Swap to talk to the other party, or click Cancel to
end the consultation call.

Requesting help while on calls
To request help while on a call using Contact Center Client

l Right-click the cell of an active extension and click Request help.
The system calls the employee. The employee can click Answer in the soft phone and listen in on the
call without the caller knowing. The employee can click Conference in the soft phone to join the
conversation at any time.

Using Contact Center PhoneSet Manager and Contact Center Softphone



- 238 -

Chapter 14

Contact Center Screen Pop

Using Contact Center Screen Pop
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Contact Center Screen Pop
Contact Center Screen Pop is an optional application that requires Contact Center Management, and Contact
Center Softphone or Contact Center PhoneSet Manager. Optionally, if you want to screen pop based on caller
entered digits, you require Intelligent Queue with the Collect Caller Entered Digits options.

Contact Center Screen Pop launches applications orWeb pages. In addition, it enables agents to
automatically receive caller and account information via pop-ups on their computer monitors every time they
receive calls. Contact Center Screen Pop provides agents with the caller name, caller phone number (ANI),
called number (DNIS), and the queue used in the call. Optionally, if you have the Intelligent Queue Collect
Caller Entered Digits option, Contact Center Screen Pop displays the digits the customer entered.

Using Contact Center Screen Pop
When an agent receives a call, Contact Center Screen Pop can launch an application orWeb page. For
example, when integrated with a Customer Relationship Management (CRM) database, Contact Center
Screen Pop can launch a customer account page from the CRM database based on call information.

For businesses that have Contact Center Screen Pop, the pop-up provides
l Caller name—name of the caller
l ANI—telephone number of the caller
l DNIS—telephone number the caller dials
l DNIS name—the name associated to the DNIS number in YourSite database
l Extension ID—extension who transferred the call
l Extension—extension from which the call was transferred
l Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a customer

site key (Intelligent Queue required)
l Customer Collected Information—information collected from a third party OBDC database.

Customer Collected Information requires Intelligent Queue and Verified Collected Digits, and,
optionally, Remote Database Verification or CTI Developer Toolkit.

l Call notes—notes added by an agent

Configuring options in YourSite Explorer
You configure Contact Center Screen Pop options in YourSite Explorer. You can specify which information
fields the pop-up displays and whether an application orWeb page is launched when an extension receives a
call. See "Configuring Contact Center Screen Pop options" on page 240.

Enabling Contact Center Screen Pop
To enable Contact Center Screen Pop
 1. Start Contact Center Client.
 2. Right-click the Phone toolbar and click Configure.
 3. Click theScreen pop tab.
 4. Select theDisplay Contact Center Screen Pop check box.
 5. Click OK.
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Configuring Contact Center Screen Pop options
To configure Contact Center Screen Pop options
 1. In YourSite Explorer, click YourSite=>Enterprise.
 2. Click theScreen pop tab.
 3. Ensure theDisplay Intelligent Queue licensed options (ANI, DNIS, and Collect Caller Entered

Digits) on the soft phone pop-up check box is selected.
 4. To launch an application orWeb page when extensions answer a call, select the Launch an

application or Web page when a call is answered check box.
l To launchOutlook contact information for callers and create a journal entry for each caller, select

Display caller-specific Microsoft Outlook Contact information and create Journal entries.
This is the default option. Microsoft Outlook will display the contact information of that caller,
using the name and/or number of the caller to find their file in the Personal Address Book. A
journal entry will also be created for the call. If you select this option, ensure that you complete
"Configuring Contact Center Screen PopOutlook options for journal entries" on page 242 and
"Configuring Contact Center Screen Pop to display Outlook contacts" on page 243. A default
path or URL is automatically entered in the Contact Center Screen Pop tab. Contact Center
Screen Pop will launch this application orWeb page box when it is used.

l If you want to display call statistics for incoming ACD calls, select Display the caller-specific
Inbound trace report Web page. The Inbound Trace report tells you the number of times the
caller has called in the last seven days and contains the following fields: Call Start Time, Call
Duration, DNIS name, Agent name, Extension, and Account Code. (See Figure 14 - 1.)

l A default path or URL is automatically entered in the Contact Center Screen Pop tab. Contact
Center Screen Pop will launch this application orWeb page box when it is used.

l If you have created aWeb page or an application to launch when extensionsanswer calls, select
Display a specific application or Web page and type the path for the executable file or the
URL of theWeb page. Click How do I enter this value? for instructions. See "Configuring
Contact Center Screen Pop display variables" on page 241.
If you have typed text into theContact Center Screen Pop will launch this application or
Web page box, Display a specific application or Web page is automatically selected.

l If prairieFyre Professional Services has provided you with an integrated custom screen pop
select Display this Professional Services custom executable file or Web page. Click
Manage to review the Professional Services custom screen pop options.

 5. Click Save.

Figure 14 - 1 Inbound Customer Trace Report
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Configuring Contact Center Screen Pop display variables
The variables described in Table 14 - 1 are used by Contact Center Screen Pop to determine the application
area orWeb page that launches when an agent answers an ACD call. Ensure the required Intelligent Queue
options are enabled to use these variables.

NOTE: The variable names are case-sensitive.

Table 14 - 1 Contact Center Screen Pop display variables

Variable Intelligent Queue
feature required Description

%PFCALLERNAME% ANI/DNIS routing option, enabled
Caller name as provided by the
telephone carrier. For example,
"John Smith"

%PFANI% ANI/DNIS routing option, enabled
Caller number (ANI), the telephone
number of the calling party. For
example, "6135990045"

%PFDNIS% ANI/DNIS routing option, enabled

Dialed Number Identification
Service (DNIS), numbers passed
from the public telephone network
to identify what phone number the
caller dialed. This is typically used
to identify different 1-800 or 1-900
numbers. For example, "9875"

%PFVERIFIEDCOLLECTEDDIGITS% Collect Caller Entered Digits
option, enabled and configured

The digits entered by the user
during the call. For example,
account number "78831"

%Queue% ANI/DNIS routing option, enabled
Name of the queue from which the
call is answered. For example,
"Sales"

%ReceivingAgent% N/A Contains the Agent ID for the agent
receiving the current call

%ReceivingExtension% N/A Contains the Extension ID for the
extension receiving the current call

%SendingAgent% N/A
Contains the Agent ID for the agent
sending or transferring the call to
the current recipient

%SendingExtension% N/A
Contains the Extension ID for the
extension sending or transferring
the call to the current recipient
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To launch an application
l Type the URL of the executable file followed by the required variables.

For example, C:\MyProgram\CustomerManagement.exe "%PFCALLERNAME%"
"%PFANI%""%PFDNIS%""%PFVERIFIEDCOLLECTEDDIGITS%""%Queue%"
NOTE:Variables must be in quotes and be separated by a space.

If John Smith calls 1-800-266-9875 from 613-599-0045, is prompted to enter his account number (78831), and
is then routed to the Sales queue, the executable file will use the actual values of the call, for example,
C:\MyProgram\CustomerManagement.exe "John Smith""6135990045""9875""78831""Sales".

To launch a Web page
l Type the URL of theWeb page followed by the required variables, as per standard HTTP protocol.

For example,
http://myintranetsite.business.com?CALLERNAME=%PFCALLERNAME%&ANI=%PFANI%&DNIS=%PFDNIS%
&CO-
LLECT-
EDDIGITS=%PFVERIFIEDCOLLECTEDDIGITS%=%PFVERIFIEDCOLLECTEDDIGITS%&QUEUE
=%Queue%

If John Smith calls 1-800-266-9875 from 613-599-0045, is prompted to enter his account number (78831), and
is then routed to the Sales queue, theWeb page will use the actual values of the call, for example,
http://myintranetsite.business.com?CALLERNAME=John%20Smith&ANI=6135990045&DNIS=9875&COLLECTEDDIGITS=
78831&QUEUE=Sales.

Configuring Contact Center Screen Pop Outlook options for journal
entries
NOTE:Contact Center Screen Pop can search the contacts available in Outlook Personal Contacts only.

You can configure Contact Center Screen Pop to automatically record information in journal entries. Youmust
complete the following instructions if you selected Display caller-specific Microsoft Outlook Contact
Information and create Journal entries in "Configuring Contact Center Screen Pop options" on page 240. This
stepmust be performed on every employee computer that uses Contact Center Screen Pop.

For information on viewing and searching for journal entries, seeMicrosoft Office Outlook Help.

To configure Contact Center Screen PopOutlook options for journal entries
 1. Start Contact Center Client.
 2. Right-click the Phone toolbar and click Configure.
 3. Click theScreen pop tab.
 4. Click Configure Outlook screen pop options.
 5. Select Create a journal entry for each incoming call and include the following properties.
 6. Select the properties to be included in your journal entries.

l Name—caller name as provided by the telephone carrier (for example, John Smith)
l Phone number—telephone number of the caller (for example, 6135990045)
l DNIS—numbers passed from the public telephone network that identify the phone number the

caller dialed. DNIS is typically used to identify different 1-800 or 1-900 numbers (for example,
9875)
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l Queue—queue from which the call originated. Only the first word of the queue name is recorded.
l Caller entered digits—the Collect Caller Entered Digits option, enabled and configured. These

are the digits entered by the user during the call (for example, account number 78831)
 7. Click OK.

Configuring Contact Center Screen Pop to display Outlook contacts
Contact Center Screen Pop searches the Outlook contact list for a caller’s information and displays it in an
Outlook window. Youmust complete this section if you selected Display caller-specific Microsoft Outlook
Contact Information and create Journal entries in "Configuring Contact Center Screen Pop options" on page
240.

To configure Contact Center Screen Pop to display Outlook contacts
 1. Start Contact Center Client.
 2. Right-click the Phone toolbar and click Configure.
 3. Click theScreen pop tab.
 4. Click Configure Outlook screen pop options.
 5. Select theSearch for an Outlook contact check box.

l To search for a contact using their name, select By name.
l To search for a contact using their telephone number, select By number.
You can select both By name and By number to enable Contact Center Screen Pop to search for
contacts using either method.

 6. Click OK.

Configuring Contact Center Screen Pop to display Goldmine contacts
The FrontRangeGoldmine connector for Contact Center Screen Pop searches Goldmine contact lists for
caller phone numbers and displays the caller’s contact page. The following procedures detail how to configure
Contact Center Screen Pop to display FrontRangeGoldmine contact information.

To configure Contact Center Screen Pop to display FrontRangeGoldmine contacts
 1. In YourSite Explorer, click YourSite=>Enterprise.
 2. Click theScreen pop tab.
 3. Select the Launch an application or Web page when agents answer ACD calls check box.
 4. Select Display a specific application or Web page.
 5. UnderContact Center Screen Pop will launch this application or Web page, type the path of the

executable file followed by the required variables: <drive>:\Program Files\prairieFyre Software
Inc\CCM\Applications\ContactCenterClient\GoldmineScreenPopConnector.exe"%PFANI%"
If you want to suppress Goldmine frommaximizing and being popped to the front of all active windows,
follow the above string with -s.
See "Configuring Contact Center Screen Pop options" on page 240 and "Configuring Contact Center
Screen Pop display variables" on page 241.

 6. Click Save.

If you do not want Contact Center Screen Pop to display Goldmine contacts, you can disable this option for
individual desktops using Contact Center Client.

To disable the FrontRangeGoldmine screen pop on individual desktops
 1. Start Contact Center Client.
 2. Click View=>Soft phone.
 3. Right-click the Phone toolbar and click Configure.

Using Contact Center Screen Pop
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 4. Click theScreen pop tab.
 5. Ensure theDisplay Contact Center Screen Pop option is deselected.
 6. Click OK.

Testing Contact Center Screen Pop search functions
This test will confirm that Contact Center Screen Pop will function with the software you selected. For
example, if you selected theDisplay caller-specific Microsoft Outlook Contact Information and create
Journal entries option, the test will attempt to pop up a sample caller-specific Outlook Contact window, and
create a sample Journal entry. See "Configuring Contact Center Screen Pop options" on page 240.

To test the search function in Contact Center Screen Pop
 1. Start Contact Center Client.
 2. Right-click the Phone toolbar and click Configure.
 3. Click theScreen pop tab.
 4. Click Test.
 5. Type the variables using the described format.

PFCALLERNAME—first name followed by last name, separated by a space (for example, John
Smith)
PFANI—phone number (including area code if relevant) with no spaces, dashes, or brackets (for
example, 6135558769)
PFDNIS—phone number (including area code if relevant) with no spaces, dashes, or brackets (for
example, 8005556598)
PFVERIFIEDCOLLECTEDDIGITS—all digits the caller has entered since entering the telephone
system, with no spaces, dashes or brackets (for example, 1113)
Queue—queue that the caller first entered (for example, P500)

 6. Click OK.
A screen pop that contains the test parameters you specified will display. The outcome of the Contact
Center Screen Pop test will change depending on the type of screen pop you have configured and the
test parameters you entered.

Disabling Contact Center Screen Pop
If you prefer some client computers do not use Contact Center Screen Pop, you can disable it on one or more
computers. This procedure affects one profile only.

To disable Contact Center Screen Pop on a client computer
 1. Start Contact Center Client.
 2. Right-click the Phone toolbar and click Configure.
 3. Click theScreen pop tab.
 4. Clear theDisplay Contact Center Screen Pop check box.
 5. Click OK.
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Chapter 15

CTI Developer Toolkit

Functional overview
Primary object classes
Sample applications
Common user scenarios and source code examples
Troubleshooting
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CTI Developer Toolkit
NOTE:

l CTI Developer Toolkit is currently supported for use with the 3300 ICP only.
l If you require the calculations used to populate Contact Center Management and Call Accounting

reports to use in your custom application built with the CTI Developer Toolkit, a subset of these
calculations can be found in the Advanced Data Access Guide, which can be found at
ftp://www.prairiefyre.com/support/download-software/.

Mitel Computer Telephony Integration (CTI) Developer Toolkit is a programmable .NET C#Dynamic-link
library (DLL) that can be used in any .NET 4.0 application or website. The CTI Developer Toolkit completes
themigration fromMitel Agent Portal to Mitel Contact Center Screen Pop.

The CTI Developer Toolkit is offered in two forms: server side and client side license. The server side license
provides the ability to insert custom real-time IVR collected data to each incoming call. It also uses the
Contact Center Screen Pop infrastructure to deliver third-party data to agent desktops (using either the client
side license or Contact Center PhoneSet Manager). The client side license provides basic telephony
functions (answer, hang up, transfer, and hold), provides agent control (such as set/removeMake Busy) and
delivers caller information such as ANI, DNIS, Collected Digits, and call notes in real time as calls arrive. The
client side licensemay be used to display information in CRM, Microsoft Outlook, or custom applications.

If you want to route or screen pop on digits or other data sets collected from a third-party IVR, youmust
adhere to the following conditions:

l Youmust have a CTI Developer Toolkit Server license
l The third-party vendor must be aMitel MSA Development partner. As aMitel MSA Development

partner, they must have completed aMiTAI (API) integration that allows them to pass the collected
digits or other data set, along with a unique call ID provided by this API, enablingMitel's Contact Center
software to associate the collected digits to a particular call with unique call ID matching.

l If you want to route or screen pop on ANI or DNIS or on digits collected within theMitel IVR, the above
are not required.

For installation information and procedures, see theCall Accounting Installation Guide.

NOTE:Once you have installed the CTI Developer Toolkit, typically to <installation_drive>:\Program
Files\prairieFyre Software Inc\CTI Developer Toolkit, you can access the DLLs required to create customized
applications in the CTI Developer Toolkit\Redist folder. Youmust include the entire Redist folder with your
final compiled custom application or it will not function properly.

The CTI Developer Toolkit includes a number of sample applications, including source code, that can be used
to test CTI Developer Toolkit functionality. For a complete overview of the sample applications included, see
"CTI Developer Toolkit sample applications" on page 251.
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The CTI Developer Toolkit is currently available with the following functionality:
l Connect and disconnect from the Contact Center Management Enterprise Server with user

authentication
l Retrieve devices from the Contact Center Management configuration database, based on all

l All agent devices for the user currently logged on to the system
l All agent devices associated with employees
l All extensions
l All queues

l Set real-timemonitors on agents, extensions, and queues to receive notification when
l A call is received (including call detail information)
l A device state changes (for example, idle, ACD, and hold)

l Set phonemonitors on agents and extensions to receive notification when
l A call is received (including call detail notification)
l A call is made
l A call is cleared
l A call is transferred
l A call is conferenced
l A call is established
l A call fails

l Control a device (for example, set/remove DoNot Disturb or Make Busy)
l Make calls from agent or extension devices
l Place calls on hold
l Retrieve calls that are on hold
l Remove calls from queues
l Redirect calls from queues to agents/extensions
l Transfer or conference calls between agent and extension devices
l Clear calls for agent and extension devices
l Add call detail information from third-party IVRs and dialers. This information is available to client

applications in the Call Received event

Table 15 - 1 lists themajor areas of functionality exposed with each version of the CTI Developer Toolkit. The
version specified indicates themost recent version, including any service packs available to customers.
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Table 15 - 1 Supported functionality by version

Functional Area Version
5.4

Version
5.5

Version
5.6

Version
5.7

Version
5.8

Version
6.0.2

Application events

l Connection state
changes x x x x x x

l Configuration
loaded x x x x

Device Information

l Get all devices x x x x x x

l Get all extension x x x x x x

l Get all agents x x x x x x

l Get all queues x x x x

l Get agents by
login x x x x x x

l Get agents for all
employees x x x x x x

Device events1

l Device state
changed x x x x x x

Voice events2

l Call info received x x x x x x

l Call delivered x x x x x

l Call received x x x x x

l Call cleared x x x x x

l Call transferred x x x x

l Call established x x x x

l Call failed x x x x

l Call diverted x x x
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Functional Area Version
5.4

Version
5.5

Version
5.6

Version
5.7

Version
5.8

Version
6.0.2

l Call originated x x x

l Call retrieved x x x

Extension events

l Extension state
changed x x x x

Agent events

l Agent state
changed x x x x

Queue events

l Queue Now
statistics x x x x

l Queue totals
statistics x x x x

l Interactive
Visual Queue
delta

x x x x

l Interactive
Visual Queue
snapshots

x x x x

Voice control3

l Make call x x x x x x

l Clear call x x x x x x

l Answer call x x x x x

l Hold call x x x x x

l Retrieve held call x x x x x

l Conference call x x x x x

l Transfer call x x x x x

l Make
consultation call x x x
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Functional Area Version
5.4

Version
5.5

Version
5.6

Version
5.7

Version
5.8

Version
6.0.2

l Transfer
consultation call x x x

l Cancel
consultation call x x x

l Trade call x

Agent control

l Login x4 x x x x x 5

l Logout x x x x x x 5

l Set Make Busy x x x x x x

l RemoveMake
Busy x x x x x x

l Set Do Not
Disturb x x x x x x

l Remove DoNot
Disturb x x x x x x

l Cancel work
timer x x x x x x

l Cancel reseize
timer x 6

l Conference call x x x x x

Queue control

l Redirect call x x x x

l Remove call x x x x

IVR integration

l Add call detail7 x x x x x

1 Device events are supported byall device types.
2 Voice events are supported byextension and agent devices
3 Voice control is supported byextension and agent devices.
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4Only hot deskagent logins are supported in Version 5.4. Both hot desking and traditional agent logins are supported with Version 5.5
SP1 or greater.
5 SupportsExternal hot deskagent and External hot deskuser functionality.
6 The Cancel reseize timer agent control function requiresExternal hot deskagent functionality.
7 The AddCallDetailmethod requiresa CTI Developer Toolkit server license.

NOTE: The CTI Developer Toolkit may also be referred to as the prairieFyre.CallControl.Toolkit namespace
throughout this chapter and in the CHM help file documentation, as the CHM help file included with the CTI
Developer Toolkit is sourced from the source code, which refers to the namespace by this name.

Table 15 - 2 lists and describes the top level classes available with the CTI Developer Toolkit.

Table 15 - 2 Primary object classes

Class Description

DeviceManager This class contains functionality to manage the connection to the Enterprise Server
and provides access to configured agents, extensions, and queues.

Device This abstract class includes the core properties for all device types. Objects of this
class may not be directly instantiated.

Voice
This class is derived from the Device class and serves as the base class for the
agent and extension classes. It includes properties and functionality that is specific
to devices with voice characteristics.

Agent
This class is derived from the Voice class. It represents both traditional ACD and
hot desking agents. Specialized functionality handled in this class includes agent
control operations, such as agent login and set/removeMake Busy.

Extension This class is derived from the Voice class. It represents configured extensions.

Queue

This class is derived from the Device class. It represents configured queues. It
includes properties and functionality that is specific to the queue device. Specialized
functionality handled in this class includes set/remove DoNot Disturb, redirect call,
and remove call.

CTI Developer Toolkit sample applications
There are currently four sample applications, including source code, that are included with the CTI Developer
Toolkit.

Device Monitor
The DeviceMonitor sample application provides a graphical user interface that enables developers to connect
to the Contact Center Solutions Enterprise Server, retrieve a list of devices, perform agent control activities
on the retrieved devices (for example, login/logout, set/removeMake Busy, etc.), perform call control
activities (for example, make call, answer call, clear call, etc.), and retrieve call event notifications. (See
Figure 15 - 1.)
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Figure 15 - 1 Device Monitor sample application

To use the CTI Developer Toolkit DeviceMonitor sample application
 1. InWindows, navigate to theCTI Developer Toolkit and openDevice Monitor.
 2. Click File=>Connect.
 3. Type the IP address of the Enterprise Server, user name, and password and click OK.
 4. Click Devices and select one of the following options:

l Retrieve agents for current login
l Retrieve agents for all employees
l Retrieve all agents
l Retrieve all extensions
l Retrieve all queues
l Retrieve all devices

 5. Once the devices you selected have loaded, you perform actions on the selected device(s) by clicking
Actions and selecting an available action or by right-clicking and selecting an available action from
the list:
l Set monitor=>Phone, Real time, All
l Removemonitor=>Phone, Real time, All
l Login
l Logout
l Set Make Busy
l RemoveMake Busy
l Set DND
l Remove DND
l Cancel work timer
l Make call
l Answer call
l Hold call
l Retrieve call
l Transfer call

CTI Developer Toolkit sample applications
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l Conference call
l Clear call
l Add call notes
l Make consultation call
l Transfer consultation call
l Cancel consultation call
l Trade call

Queue Monitor
TheQueueMonitor sample application displays the functionality and support for queue device types included
with the CTI Developer Toolkit. TheQueueMonitor application is similar to the optional Interactive Visual
Queuemonitor that is housed in Contact Center Client. It enables developers to connect to the Contact
Center Solutions Enterprise Server, load a set of queues, and view real-time call activity (calls entering and
exiting queues) and queue statistics (for example, calls waiting, number of agents available, longest waiting,
etc.). (See Figure 15 - 2.)

Figure 15 - 2 Queue monitor sample application

To use the CTI Developer Toolkit QueueMonitor sample application
 1. InWindows, navigate to theCTI Developer Toolkit and openQueue Monitor.
 2. Click File=>Connect.
 3. Type the IP address of the Enterprise Server, user name, and password and click OK.
 4. Click Actions.
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 5. Select one or more queues to open.
 6. Click OK.

If you selectedmultiple queues, you can toggle between them using the tabs at the bottom of the queue
monitor.

 7. Once the queues you selected have loaded, you perform actions on the selected device(s) by clicking
Actions and selecting an available action or by right-clicking and selecting an available action from the
list:
l Open queue
l Close queue
l Set DND
l Remove DND
l Redirect call
l Remove call

Console Call Monitor
The ConsoleMonitor sample application displays call received information for either single or multiple agents
or extensions in a simple console application window. It is intended to be a very brief example, with little error
handling, that can be used to demonstrate the basics of coding screen pop displays.

To use the CTI Developer Toolkit ConsoleCallMonitor sample application
 1. InWindows, open the command prompt window.
 2. Type cd "<installation_drive>:\Program Files\prairieFyre Software Inc\CTI Developer

Toolkit\Samples\ConsoleCallMonitor\bin" and click Enter.
 3. TypeConsoleCallMonitor.exe Device Number/Telephone System IP Address/Type and click

Enter.
The ConsoleCallMonitor application takes multiple parameters in the following form, Device
Number/Telephone System IP Address/Type. For example, 2000/10.1.1.1/Agent
1800/10.1.1.10/Extension would invoke agent 2000 on telephone system 10.1.1.1 and extension 1800
on telephone system 10.1.1.10.

Console Queue Monitor
The ConsoleQueueMonitor sample application displays information on calls entering/exiting queues and
queue statistics in a simple console application window. Similar to the Console Call Monitor application, it
represents aminimal set of code required to build a real-time queuemonitoring application.

To use the CTI Developer Toolkit Console QueueMonitor sample application
 1. InWindows, open the command prompt window.
 2. Type cd "<installation_drive>:\Program Files\prairieFyre Software Inc\CTI Developer

Toolkit\Samples\ConsoleQueueMonitor\bin" and click Enter.
 3. TypeConsoleQueueMonitor.exe Queue/Telephone System IP Address and click Enter.

The ConsoleQueueMonitor application takes multiple parameters, in the following form:
Queue/Telephone System IP Address. For example: P200/10.1.1.1 P180/10.1.1.10 would invoke
monitoring calls on two queues, queue P200 on telephone system 10.1.1.1 and queue P180 on
telephone system 10.1.1.10.

CTI Developer Toolkit sample applications
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Best practices for custom development
The following best practices must always be followed when developing custom developments to work in
conjunction with Contact Center Solutions software.

l Before you begin development
l Verify that the CTI Developer Toolkit and Contact Center Solutions software are the same version

and that you are properly licensed for all desired functionality
l Verify that you have access to the Contact Center Management Enterprise Server
l Verify that the Contact Center Solutions Enterprise Server has been properly set up and configured

with the extensions, agents, and queues that you will be using with your custom application
l Verify that the telephone system(s) in your enterprise has been properly set up and configured with

the extensions, agents, and queues that you will be using with your custom application
l Verify that all pre-installation and post installation steps have been completed. See theCall

Accounting Installation Guide.
l Confirm the telephone system conforms to the guidelines stated in the Golden Rules document. In

particular, aspects of the CTI Developer Toolkit rely on the ability to set MiTAI monitors on devices.
As such, the "HCI Options" must be enabled for the Class of Service on all monitored devices. See
http://www.prairiefyre.com/wp-content/rscs/documentation/Golden%20Rules.xls

l Verify you haveMicrosoft .NET Framework Version 4.0 or greater installed on your workstation
l Verify you have an IDE installed on your workstation, either Visual Studio 2005/2008 or

SharpDevelop
l When developing custom applications and integrations

l Verify the what you are attempting to build is possible by attempting the functions from an alternate
client application, such as Contact Center Client, the DeviceMonitor sample application, or MiTAI
Browser

l Routinely check the log files of all related services, specifically the Enterprise Server, Collector, and
MiTAI Proxy Server to ensure there are no unusual or unexpected warnings or errors

l Routinely check the log files of alternative client applications for any unusual or unexpected
warnings or errors (as listed in the previous bullet)

The following best practices must always be followed when developing custom connectors to third-party
IVRs.

l Third-party IVR ports and Intelligent Queue ports must all be programmed in YourSite Explorer as an
extension type=>Messaging Port or RAD Port. When configuring the extension as a port type, the
disable real-timemonitoring option will not be configurable.

l In addition to whatever custom data your third-party IVR is sending, it must also send the same data
that Intelligent Queue does (using the same naming conventions). These are PFANI,
PFCALLERNAME, and PFDNIS. This will ensure that the existingMiTAI record linking logic within the
Contact Center Management Enterprise Server gets the correct information, which is typically at the
first controller/port

Common user scenarios and source code examples
This section details the following common user scenarios for developing custom integrations and applications
using the CTI Developer Toolkit

l Click to dial
l Call received notification
l Add call detail (using a third-party IVR)
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Click to dial
NOTE: This code sample is not included in the sample project that is included with the CTI Developer Toolkit.

The following C# code fragment provides sample source code that can be used to build a console application
with click-to-dial functionality.

static void Main()
{
DeviceManager dm = DeviceManager.Instance;
string pbxIpAddress = "10.1.1.10";
string server = "the-CCM-server-IP-address-here";
string username = "your-username-here";
string password = "your-password-here";
Voice extension;

if (!dm.Connect(server, 5024, username, password))
{
Console.WriteLine("Uable to connect to server");
return;
}

extension = dm.GetDevice("1100", pbxIpAddress, DeviceType.Extension) as Voice;

if (extension == null)
{
Console.WriteLine("Unable to retrieve extension device");
return;
}

if (!extension.SetMonitor())
{
Console.WriteLine("Unable tomonitor extension");
return;
}

extension.MakeCall("16135990045");

dm.ReleaseAllDevices();
dm.Disconnect();
Console.WriteLine("Exit application");
}

This source code will connect to the specific Enterprise Server using the supplied username and password. It
then initiates a call from extension 1100 on the telephone system with IP address 10.1.1.10 to the phone
number 16135990045.

Call received notification
The following C# code fragment shows a condensed version of the source code provided with the
ConsoleCallMonitor sample application that is shipped with the CTI Developer Toolkit.

Common user scenarios and source code examples
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static void Main()
{
DeviceManager dm = DeviceManager.Instance;
string pbxIpAddress = "10.1.1.10";
string server = "the-CCM-server-IP-address-here";
string username = "your-username-here";
string password = "your-password-here";
Voice extension;

if (!dm.Connect(server, 5024, username, password))
{
Console.WriteLine("Uable to connect to server");
return;
}

extension = dm.GetDevice("1100", pbxIpAddress, DeviceType.Extension) as Voice;

if (extension == null)
{
Console.WriteLine("Unable to retrieve extension device");
return;
}

if (!extension.SetMonitor())
{
Console.WriteLine("Unable tomonitor extension");
return;
}

device.CallInfoReceived += CallInfoReceivedHandler;

Console.WriteLine("Listening for calls on extension 1100");
Console.WriteLine("Press any key to end application.");
while (!Console.KeyAvailable) ;

dm.ReleaseAllDevices();
dm.Disconnect();
Console.WriteLine("Exit application");
}

static void CallInfoReceivedHandler(object sender, CallInfoReceivedEventArgs e)
{
Console.WriteLine("-----------------------------------------------");
Console.WriteLine("Call Info Received:");
Console.WriteLine(" Caller Name : " + e.Info.CallerName);
Console.WriteLine(" Caller Number : " + e.Info.CallerNumber);
Console.WriteLine(" DNIS : " + e.Info.DNIS);
Console.WriteLine(" Collected Digits : " + e.Info.CollectedDigits);
}
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Add call detail (using a third-party IVR)
The following C# code fragment shows a condensed version of using the AddCallDetail method to toolkit
users can invoke to add custom key/value pairs into call information.

In summary, this code fragment does the following:
l Device_CallReceived is an event handler that is invoked whenever amonitored IVR extension/port

receives a call. This is needed to acquire theMiTAI Call ID which is used to link these extra information
records (--w records in ACD data files) to other call records

l When this event handler is invoked, it makes three sequential calls to the AddCallDetail method,
adding call values for the following keys: PFANI, PFCALLERNAME, and PFDNIS

l The keys used above are the ones that the default screen pop display recognizes but developers can
easily make up their own key names as well, provided they have toolkit code on the client side to pull
the custom information from the CallInfoReceivedEvent notifications

public void Device_CallReceived(object sender, CallReceivedEventArgs e)
{
Device device = sender as Device;

DeviceManager.Instance.AddCallDetail(
e.CallingDevice.CallReferenceID, device.PBXIPAddress, device.DeviceID,
"PFANI", "6135990045");

DeviceManager.Instance.AddCallDetail(
e.CallingDevice.CallReferenceID, device.PBXIPAddress, device.DeviceID,
"PFCALLERNAME", "John Smith");

DeviceManager.Instance.AddCallDetail(
e.CallingDevice.CallReferenceID, device.PBXIPAddress, device.DeviceID,
"PFDNIS", "8001");
}

Troubleshooting CTI Developer Toolkit issues
Diagnosing any issues experienced while using the CTI Developer Toolkit requires a high level of familiarity
with Contact Center Solutions and Call Accounting applications and CTI Developer Toolkit functionality. This
section details several troubleshooting tips and tricks when encountering issues with CTI Developer Toolkit
functionality.

The CTI Developer Toolkit and any custom applications created using it rely heavily on the proper
configuration and operation of the Contact Center Solutions Enterprise Server. Ensuring that the server is
operating correctly is the first diagnostic step that should be taken when troubleshooting CTI Developer
Toolkit issues. This includes:

l Verifying that the CTI Developer Toolkit and Contact Center Solutions software are the same version
and that you are properly licensed for the desired functionality

l Verifying that all pre-installation and post installation steps have been completed. See theCall
Accounting Installation Guide

l Checking the log files of all related services, specifically the Enterprise Server, Collector, andMiTAI
Proxy Server to ensure there are no unusual or unexpected warnings or errors

Troubleshooting CTI Developer Toolkit issues
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l Attempting the same operation using an alternate client application. This can be any of the following,
depending on the underlying issue:

l Contact Center Client
l DeviceMonitor sample application
l MiTAI Browser

l Checking the log files of alternative client applications for any unusual or unexpected warnings or errors
(as listed in the previous step)

l Confirming the telephone system conforms to the guidelines stated in the Golden Rules document. In
particular, aspects of the CTI Developer Toolkit rely on the ability to set MiTAI monitors on devices. As
such, the "HCI Options" must be enabled for the Class of Service on all monitored devices. See
http://www.prairiefyre.com/wp-content/rscs/documentation/Golden%20Rules.xls

Troubleshooting specific issues
This section describes some specific problems that may be encountered when working with the CTI
Developer Toolkit and provides any recommended steps for diagnosing issues and potential solutions.

Retrieve All commands does not display any devices
If any of theRetrieve All commands in the DeviceMonitor application return an empty list of devices, there
may be a configuration problem with the IPAddress values stored in theCCMData database table named
tblEnterpriseConfig_Node.

To troubleshoot this issue, run the following SQL query and pay particular attention to values in the [IP
Address] column. This query simulates the query used by the CTI Developer Toolkit and will return a list of
agents and extensions for all voicemedia servers.

SELECT node.Name AS [Node],
node.IPAddress AS [IP Address],
'Agent' AS [Type],
device.FirstName AS [First Name],
device.LastName AS [Last Name],
device.Reporting AS [Reporting Number]
FROM tblConfig_Agent device INNER JOIN tblEnterpriseConfig_Node node
ON device.FKNode = node.Pkey INNER JOIN tblLookup_NodeType NodeType
ON node.FKNodeType = NodeType.Pkey
WHERE FKNodeFamily = 1
UNION
SELECT
node.Name AS [Node],
node.IPAddress AS [IP Address],
'Extension' AS [Type],
'' AS [First Name], -- No first name on extensions
'' AS [Last Name], -- No last name on extensions
device.Reporting AS [Reporting Number]
FROM tblConfig_Extension device INNER JOIN tblEnterpriseConfig_Node node
ON device.FKNode = node.Pkey INNER JOIN tblLookup_NodeType NodeType
ON node.FKNodeType = NodeType.Pkey
WHERE FKNodeFamily = 1
ORDER BY [Node], [Type]
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The [IP Address] values in the query results should contain the IP address of the telephone system that is
associated with the voicemedia server. If this value is incorrect or blank, use YourSite Explorer to set the IP
address to the correct value.

GetDevice method fails or returns null unexpectedly
If a custom applications calls theGetDevicemethod and returns null even though the device is valid and
programmed in Contact Center Management, theremay be a timing issue with the Connect operation. When a
custom application calls theConnectmethod in the CTI Developer Toolkit, the operation returns as soon as
an authenticated connection has been established with the Enterprise Server. However, theremay still be
some basic configuration loading occurring in the background, whichmust complete before calls toGetDevice
can be successful.

An event namedConfigurationLoaded is provided in the CTI Developer Toolkit, which is used to notify custom
applications that background configuration loading has completed. In previous versions, the DeviceMonitor
sample application used a workaroundmethod of issuing aSleepmethod call on the active thread to give
background configuration loading time to complete.

Agent control actions succeed while call control actions fail
In this scenario, agent control actions (for example, login, logout, and set/removeMake Busy) succeed, while
call control actions (for example, make call, answer call, and clear call) fail. The key difference between these
two types of operations is that call control actions require aMiTAI monitor set on the device and agent control
actions do not. Your investigation should start with an analysis of MiTAI related configuration, including:

l Verifying that theMitaiEnabled flag set properly for devices in the database
l Checking telephone system (for example, HCI Options enabled)
l Confirming the telephone system version is supported

Unable to set monitor on agent device
In some cases, using the DeviceMonitor to issue a Set Monitor operation on an agent will fail. If you have the
Errors view open in the application, it displays aMiTAI error, indicating "Operation failed: MessageTag[8]
ReturnCode [SXERR_FEATURE_NOT_ALLOWED]"
In this case, you should verify that the agent device is properly configured on the telephone system, including
HCI Options enabled for the associated Class Of Service. If the problem persists, check to see if the CTI
Developer Toolkit is Version 5.5 or earlier and if the agent is a traditional or hot desking agent. There was a
known issue settingmonitors on traditional ACD agents using the CTI Developer Toolkit that was corrected in
5.5 SP1. For earlier versions, one workaround is to set themonitor on the extension the agent logs in to.

Web service errors occurring in log files
If you encounterWeb service error messages in log files and an application built with the CTI Developer
Toolkit is experiencing errors, check to ensure that theMicrosoft.Web.Services3.dll file is present under the
Windows system directory or in the custom application directory.

Troubleshooting CTI Developer Toolkit issues
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"Softphone proxy did not respond after 30 seconds" error
If you encounter this message and the Contact Center Solutions software is Version 5.5 SP2 or earlier, there
is a known licensing issue where theMiTAI Proxy Server will fail to send clients messages unless there is at
least one Contact Center Softphone or Contact Center PhoneSet Manager license in your enterprise. This
issue was corrected in version 5.5 SP3.

To work around this problem, contact prairieFyre Software technical support at 613-599-0045 (North American
customers) or your approvedMitel vendor (for customers residing in Latin America, Europe, theMiddle East,
Africa, and Asia Pacific).and have them create new license files.
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Chapter 16

Salesforce.com Connector

Using the Contact Center Salesforce.com Connector
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Salesforce.com Connector
Salesforce.com Connector is an optional client application that works in conjunction with Contact Center
Management and/or Call Accounting and requires an account with Salesforce.com (Enterprise and
Professional editions of Salesforce.com), and, optionally, Intelligent Queue or IVR Routing (for Collect Caller
Entered Digits only).

NOTE:
l Salesforce.com Connector is currently supported for use with the 3300 ICP only.
l Whether Salesforce.com is running on the cloud or on a server within your organization, agents must

have the Contact Center Salesforce.com Connector installed and running on their client computers for
Salesforce.com Connector to function properly.

l The Contact Center Salesforce.com Connector refers to the Contact Center Softphone application as it
appears in Salesforce.com.

l If you use Internet Explorer, youmust run Internet Explorer 8.0 or Internet Explorer 9.0 for
Salesforce.com Connector to function properly.

l If you use Internet Explorer 8.0 or 9.0, ensure you have enabled the "Display mixed content" option in
Internet Explorer's local intranet security settings before logging into Salesforce.com.

Salesforce.com Connector enhances the functionality of Salesforce by embedding your Mitel phone directly
into the Salesforce user interface. This improves productivity by providing fast and easy access to accounts,
contacts, cases, and other Salesforce objects directly related to incoming calls. Using Salesforce.com
Connector enables your contact center employees to perform their job functions through a single user
interface.

Salesforce.com Connector is compatible with the Salesforce.comMicrosoft Outlook connector. Users can
synchronize their Salesforce.com contacts, tasks, and calendar events, associate Outlook email messages,
andmap custom fields in Salesforce.com to fields in Outlook.

Salesforce.com Connector manages interactions between the Contact Center Management server and the
hosted Salesforce.com server through the Salesforce user interface. Salesforce.com Connector offers a wide
variety of enhancements and capabilities to employees, including

l Unified login
Salesforce automatically retrieves agent IDs and extensions to enable users to log in to Contact Center
Management directly from Salesforce.com.

l Hot desking support
ACD hot desking agents and non-ACD general business hot desking extensions are supported for use
with the Salesforce.com Connector.

l Click to dial
Employeescan save time and avoidmisdialed calls by using click to dial to contact customers, co-
workers, or extensions.

l Screen pop
When an external call arrives, the relevant Salesforce customer record displays on the employee's
screen. Immediate access to customer information increases employeeproductivity and improves
customer satisfaction. Screen pop can be configured to work with Automatic Number Identification
(ANI), Dialed Number Identification Service (DNIS), or Collect Caller Entered Digits (requires
Intelligent Queue with the Collect Caller Entered Digits option or IVR Routing Premium ports).
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Pertinent customer information also displays in the Salesforce user interface, for example, Caller
Name, Collect Caller Entered digits, ANI, DNIS, and any search results you configure in the Salesforce
soft phone layout. For information on configuring soft phone layouts in Salesforce.com, see the
CallAccounting Installation Guide.
NOTE: If Salesforce is not providing Collect Caller Entered Digits in a screen pop, ensure you disable
caching if you use Internet Explorer.

l Call control
Employeescan save time by having all their typical desk phone functions embedded and available
directly from the Salesforce user interface. With complete customer information on the screen,
employeescan quickly access alternate numbers for customers.

l Call logging capabilities
Salesforce creates call tasks when employeesmake or receive internal or external calls. Use call tasks
to log caller information including notes, phone numbers, and the date and time of a call. This assists
compliance with your business processes by increasing consistency and providing improved reporting.

Using the Contact Center Salesforce.com
Connector
This section explains how to log into your Contact Center Salesforce.com Connector and discusses
operations you can perform once logged in.

Logging into your Contact Center Salesforce.com
Connector
The Contact Center Salesforce.com Connector refers to the Contact Center Softphone application as it
appears in Salesforce.com. To integrate with Salesforce.com, youmust first open Contact Center Client and
load the Contact Center Salesforce.com Connector toolbar. This sets theMiTAI monitor on the extension and
indicates to the telephone system that the extension is ready tomake and receive calls. Following this action,
you canminimize Contact Center Client and log in, log out, and perform all call control activities from within
the Salesforce.com client.

NOTE:
l The Salesforce.com Connector must be running before logging into the Salesforce.com website.

Before logging into the Salesforce.com website, verify the Salesforce.com Connector is running in the
system tray on your computer (next to the clock and volume controls). If the icon is displayed, the
Salesforce.com Connector is open.

l If you are using a desk phone, you do not need to open Contact Center Client before loading the
Contact Center Salesforce.com Connector toolbar.

l Your login for Salesforce.com is different than the login used for the Contact Center Salesforce.com
Connector.

l The Contact Center Salesforce.com Connector is located in the left pane of the Salesforce user
interface and appears only when you are assigned to a call center in Salesforce.
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To log into your Contact Center Salesforce.com Connector
 1. Start Internet Explorer and type http://login.salesforce.com/.
 2. In the Login pane, type your Salesforce.com User Name andPassword, and click Login.

See Figure 16 - 1.

Figure 16 - 1 Salesforce.com login pane

After you log in, the Contact Center Salesforce.com Connector will initialize in the top-left section of the
Salesforce.com webpage. (See Figure 16 - 2.)

 3. If you receive amessage asking if you want to see the page content that was delivered securely, click
No.
NOTE: Clicking Yes or closing the window will disable the Contact Center Salesforce.com Connector.

Figure 16 - 2 The initializing pane

Using the Contact Center Salesforce.com Connector
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 4. Type your call centerUsername, Password, Agent ID, andExtension.
NOTE: If you do not have an agent ID associated with your employee ID, you will not have ACD
functionality. However, you can continue to log in and use your desk phone or soft phone from within
Salesforce for non-ACD calls.

 5. To set Salesforce to remember your Contact Center Salesforce.com Connector login credentials every
time you log into Salesforce, enable theRemember me check box.
See Figure 16 - 3.

Figure 16 - 3 The login pane

 6. Click Log In.
The Contact Center Salesforce.com Connector will display "Logged In" when you are logged in as an
ACD agent.
See Figure 16 - 4.

Figure 16 - 4 The "Logged In" status display
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If no agent ID was provided with the login credentials and you are not logged in as an ACD agent, the
Contact Center Salesforce.com Connector functions as a soft phone and displays "Ready for Calls".
(See Figure 16 - 5.)

Figure 16 - 5 The "Ready for Calls" status display

To automatically log into your call center when logging into Salesforce
 1. In Salesforce, click your username and select Setup.
 2. UnderPersonal Setup, select Call Center Settings =>My SoftPhone Settings.
 3. Enable theAutomatically log into your call center when logging into salesforce.com checkbox.
 4. Click Save.

Salesforce.com Connector functionality
NOTE:

l If using a true soft phone, youmust first open Contact Center Client, click View => Soft phone and
configure soft phone options. Youmust keep Contact Center Client running in the background as you
use Salesforce. If you are using a desk phone there is no need to open Contact Center Client.

l Caller ANI/DNIS information is not included when you transfer a call between telephone systems.
When you transfer a call between telephone systems, the ANI/DNIS information that displays in the
screen pop for the receiving agent is that of the transferring agent, not the caller.

Using the Contact Center Salesforce.com Connector
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You can use Salesforce.com Connector to perform the following functions:

l Dial phone numbers
Dial a phone number by clicking Line 1, entering the number into the Contact Center Salesforce.com
Connector and clicking Dial. (See Figure 16 - 6.)

Figure 16 - 6 Dialpad

Alternatively, dial by clicking the icon next to a phone number associated with a contact, lead, activity,
account, or any other phone field you have created. (See Figure 16 - 7.) ACD agents can dial by clicking
on available employee or extension links. You can also dial numbers using the dial pad on your desk
phone.

Figure 16 - 7 The icon to dial a contact, lead, activity, account, or other phone field
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l Answer phone calls
Answer a phone call by clicking Answer or using your desk phone. If the caller's number is in your
Salesforce database, their customer information page appears. Salesforce.com Connector supports
one incoming line per user. (See Figure 16 - 8.)

Figure 16 - 8 Answer

l Place callers on hold
Place callers on hold by clicking Hold. Retrieve the call by clicking Retrieve from Hold. (See Figure 16 -
9.)

Figure 16 - 9 Retreive From Hold

Using the Contact Center Salesforce.com Connector
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l Perform one-step transfers (cold transfers)
A one-step transfer (cold transfer) is when you transfer a caller without speaking to the third party
destination first. Transfer a call directly to another number without speaking to the third party by clicking
Transfer, entering the third party’s phone number or extension, and clicking One Step Transfer to
complete the transfer. (See Figure 16 - 10.)

Figure 16 - 10 One-Step Transfer

l Perform initiated transfers (warm transfer)
An initiated transfer (or warm transfer) is when you place a caller on hold and speak to the third party
destination before transferring the call. To transfer a call directly to another number and speak with the
third party before transferring the call, click Initiate Transfer. Speak with the third party and once the call
is ready to be transferred click Complete Transfer to connect the caller and remove yourself from the
call.
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l Initiate conference calls
Initiate a conference call by clicking the Conference button while on a call, entering the phone number
to join to the conference and clicking Initiate Conference. Your caller is placed on hold while you dial the
third party to be added to the call. (See Figure 16 - 11.)

Figure 16 - 11 Initiate Conference

Using the Contact Center Salesforce.com Connector
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Once you have connected to the third party number, click Complete Conference to place all three
parties on the same line. (See Figure 16 - 12.)

Figure 16 - 12 Complete Conference

l Ending calls
End a call by clicking End Call. (See Figure 16 - 13.)

Figure 16 - 13 End Call
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l Set make busy codes (ACD agents only)
To set aMake Busy code, click on the arrow in the agent state bar and select Not Ready for Calls. (See
Figure 16 - 14.) Make Busy codes are entered in YourSite Explorer and should bemaintained by your
YSE Administrator.

Figure 16 - 14 Not Ready for Calls

Select from the list of available Make Busy codes. (See Figure 16 - 15.)

Figure 16 - 15 Make Busy codes

Using the Contact Center Salesforce.com Connector
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You will now appear as unavailable for calls. (See Figure 16 - 16.)

Figure 16 - 16 Agent Status

Remove theMake Busy code andmake yourself available for calls again by clicking Ready for Calls in
the agent state bar. (See Figure 16 - 17.)

Figure 16 - 17 Ready for Calls



- 275 -

l Create new leads while on calls
Once you have answered an internal/external call, the Contact Center Salesforce.com Connector will
display a New Lead button. Click the New Lead button to open a new lead and auto-populate the Lead
phone number field with the caller’s phone number. (See Figure 16 - 18.)

Figure 16 - 18 New Lead

Using the Contact Center Salesforce.com Connector
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l Relate Salesforce records to a call activity task
You can associate up to two records to a call. From the Related To list in the call log area, select the
Account, Opportunity, or Case to which you will associate the call. To associate a Contact or Lead to
the call, select it from the Name drop-down list in the call log area. (See Figure 16 - 19.)

Figure 16 - 19 Call Log and Related To

NOTE: The Related To record cannot be selected when Name is set to a Lead.

l Search on outbound calls
Search results for outbound calls display in the Contact Center Salesforce.com Connector user
interface, but do not generate screen pops.
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l Tag calls with account codes
Click on Show Account Codes to display a list of available Account Codes, then click on the account
code link that you want to apply. (See Figure 16 - 20.)

Figure 16 - 20 Account Codes

l Set wrap-up codes (ACD agents only)
When an external ACD call ends, select an appropriateWrap-up code (also known as a Call
Classification code) from the Call Result list of the Current Call Log window.

l Attach comments to a call
Attach comments to a call by typing text into the Comments field. When the call ends, the comments
are automatically saved. (See Figure 16 - 21.)

Using the Contact Center Salesforce.com Connector
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Figure 16 - 21 Attach comments to call

Call log information can be accessed from either theMy Calls Today section of the soft phone or by
scrolling to the Active History section of an object in Salesforce. (See Figure 16 - 22.)

Figure 16 - 22 Activity History
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l View recent call activity
Access recent call activities by clicking Last Call or My Calls Today. To edit one of the last call
activities created, click the Last Calls arrow in the Contact Center Salesforce.com Connector and enter
the new comments you would like to add before clicking the Save button. ClickingMy Calls Today will
take you to theMy Calls Today webpage where you can view all Call Activities that have been created
for the entire day. (See Figure 16 - 23.)

NOTE: If call duration is not accurately displayed inMy Calls Today, runWindows Update and install
themost recent updates on your work stations. For more information on runningWindows Update, see
theCall Accounting Installation Guide.

Figure 16 - 23 Call history

l Edit completed call logs
Call logs are automatically created for all external calls an agent makes or receives. Edit a call log by
clicking on the link to the call. (See Figure 16 - 24.)

Figure 16 - 24 Edit call logs

Using the Contact Center Salesforce.com Connector
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l Search on outbound calls
Search results for outbound calls display in the Contact Center Salesforce.com Connector user
interface within Salesforce, but do not generate screen pops. Enter the phone number into the dial pad
and click Dial. The search will return results in the Contact Center Salesforce.com Connector interface.
You can click Account, Contact, etc. to view the details of the search result. (See Figure 16 - 25.)

Figure 16 - 25 Search on outbound calls display
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Call Accounting terms and definitions

Account Code
Account Codes are classifiers that can be applied to call records and used to identify unique attributes about
the caller or call for individual departments, projects, or services to generate reports on them. As well, they
can be used by agents as classification codes for incoming calls. Account codes can be verified, non-verified,
fixed length, or forced.

See Classification Codes, Fixed Length Account Codes, Forced Account Codes, Non-Verified Account
Codes, Verified Account Codes.

ACD (Automatic Call Distribution)
ACD (Automatic Call Distribution) is a call distributionmechanism that distributes calls to a pool of available
agents, typically to the first available agent or the agent who has been idle the longest. ACD can also be
configured to distribute calls based on skills or preferred customers.

Active Directory
Active Directory is a directory service created by Microsoft that is used for managing a domain. In Call
Accounting, Active Directory is synchronized with YourSite Explorer to align Active Directory security groups
and users with Call Accounting employees and employee groups within selected organizational units.

Agent
An agent is a contact center employee configured on the telephony system to receive ACD calls with an agent
ID.

ANI (Automatic Number Identification)
ANI (Automatic Number Identification) is a service that provides receivers of telephone calls with the caller
information. ANI is used to create screen pops for agents, providing caller information or to route calls by
caller phone numbers.

Answered by
Answered by is the real-time name for the number of calls answered by the first, second, third, and fourth
answer points

Answering points
An answering point is a single point of communication available to callers where they can contact a contact
center or an employee, such as a queue, voicemail, or extension.

Billing options
Billing options are the surcharges that can be associated to a subscriber plan at a daily, weekly, monthly, or
yearly basis, as well as a single time as a flat rate.

Blocked call
A blocked call is a call that is unable to get into the contact center's telephone system because there are no
trunks available. The caller receives a busy signal.
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Call rate
A call rate is the amount charged by a company per call. Each digital pattern is associated with a call type and
call rate.

Call type
Call type categorizes calls employeesreceive, enabling them to be looked up in SMDR Inspector. Call types
include ACD or non-ACD, abandoned, interflowed, requeued, unavailable, or outbound.

Camp on
Camp on is a notification tool that enables callers to notify an employee, who is currently on a call, that they
are waiting to be answeredl. The employee is notified by a series of audible beeps.

Carrier plan
A carrier plan determines the cost of calls, based on the call rate charged by a phone carrier for phone service.
Carrier plans enable the costing of outgoing calls using digit patterns, cost incoming calls using DNIS rates,
and cost internal calls by assigning rates.

Charge bands
Charge bands are the rates charged by a carrier during time periods specified by associated time slots. Call
rates are composed of charge bands.

Clustered environment
A clustered environment is a network environment wheremultiple telephone systems are linked together to
function as a single system.

Cost ceiling
A cost ceiling is themaximum charge that can be applied to a call.

Crossing percentage surcharge
A crossing percentage surcharge is a percentagemarkup added to the total cost of a call once the duration
boundary of a call is reached.

Crossing surcharge
A crossing surcharge is a flat rate applied to a call after the duration boundary is crossed.

Customer Relationship Management
Customer Relationship Management (CRM) is amodel for customermanagement that relies on technology to
streamline andmanage interactions with customers.

Date stamp
SeeDate/Time stamp.

Date/Time stamp
A date/time stamp is an indicator attached to a record or statistic detailing when it was created.

Delayed call
A delayed call is a call that has been placed into an ACD queue to wait for an available agent because it
cannot be immediately handled by an agent.
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Dialable number
The dialable number is a digit or series of digits dialed by a caller to reach an answering point, such as an
employee, an extension, a queue, or voicemail.

Dialed Number Identification Service (DNIS)
Dialed Number Identification Service (DNIS) is a telecommunication service that identifies the phone
numbers dialed by inbound callers. DNIS can be used to route calls, enabling contact centers managing
multiple product lines or businesses to direct calls into the appropriate product or business queue.

Digit pattern
A digit pattern is one or more numbers used to identify and cost a call. A digit pattern can be part or all of a
phone number.

Discount
A discount is a percentage reduction applied to the entire cost of a call, such as for calls occurring during off-
peak hours.

Division
A division is a grouping of several employee or extension groups that enable a single report to be run for
several groups simultaneously.

DND
SeeDoNot Disturb (state).

DNIS
SeeDialed Number Identification Service.

Do Not Disturb (state)
DoNot Disturb (DND) is an agent presence state that disables the agent's extension to prevent any calls from
being routed to that extension.

Duration
The duration is themaximum call length before a surcharge is applied to a call.

Employee
An employee is a person who is employed by an organization and configured as an employee in Call
Accounting so that they have access to Call Accounting applications andmay have their associated devices
reported on.

Enterprise
An enterprise is both the single site where the Enterprise Server is installed and all the connected branch
offices that comprise a company.

Enterprise Server
The Enterprise Server is the central server upon which Call Accounting is installed and from which Call
Accounting runs.
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Extension
An extension is a telephone system answering point that has a specific dialing number.

First cost
First cost is the rate applied to the first segment of a call to the first cost interval. The first increment is always
charged at the full first cost, regardless of whether the call exceeds the first interval or not.

First cost interval
First cost interval is the duration of the first segment of a call, to which the First cost is applied.

Fixed cost
A fixed cost is the charge applied to all calls, regardless of their duration. Fixed costs cannot be combined
with any other costing rate.

Fixed cost markup/discount
A fixed cost markup/discount is the dollar amount added to or subtracted from the entire cost of a call.

Fixed Length Account Codes
Fixed Length Account Codes are verified and non-verified Account Codes that are automatically submitted to
the system when the correct number of digits has been entered.

Forced Account Codes
Forced Account Codes are verified and non-verified account codes that must be entered at a specific time in a
call. Forced verified account codes must be entered as soon as the phone is off the hook. Forced non-verified
Account Codes must be entered after the phone number is dialed. Systems may be configured to avoid the
requirement of entering a forced non-verified Account Code whenmaking a call that must not be charged (for
example, dialing a leading digit such as 8 tomake a call without entering an Account Code and dialing a
leading digit such as 9 tomake a call that requires an Account Code).

Hot desking agent
Hot desking agents are employees configured with a hot desking agent ID that enables them to sit at any
extension in a network and log on to that extension with all their regular work settings available. External hot
desking agents can hot desk remotely using any phone or headset.

Hunt group
A hunt group is a series of telephone lines grouped by the telephone system that rotates incoming calls
through the lines until an available line is found and the caller is connected.

Inbound
Inbound is a descriptive term applied to forms of contact or communication, such as calls or emails, to
indicate that it is being sent to a contact center from an external source.

Inbound calls
See Inbound.

Interactive Voice Response
Interactive Voice Response (IVR) is a technology that enables callers to interact with a contact center’s
phone system by pressing keys or speech recognition while following IVR dialog.



- 285 -

Internal calls
Internal calls are calls made from within a system to other answering points within the same system.

Make Busy (state)
Make Busy is an agent presence state applied to prevent an agent who is busy from receiving ACD calls.
While in Make Busy, an agent can receive calls dialed directly to their extension.

Media servers
A media server is a server or system, such as a telephone system, used to organize and distribute
communications (phone calls, email, etc.) throughout a contact center.

Minimum duration to cost
Theminimum duration to cost is the length of time that may pass before a call is costed.

Mitel OPS Manager
Mitel OPS Manager is aMitel software application that provides network-wide administration and
maintenance for MCD, 3300, and SX-2000 Network Elements or Nodes.

Non-verified Account Codes
Non-Verified Account Codes are numbers entered onto the SMDR record for billing and call management.
During a call, non-verified Account Codes can be entered as often a required.

Outbound calls
Outbound calls are calls made from within a contact center to external answering points.

Overflow
Overflow is a call distributionmechanism that queues calls against two or more agent groups to limit the delay
faced by callers. If a call in an ACD queue is not answered after the configured Overflow time, then it is placed
into the queue of a second agent group in addition to the first queue.

PBX
See Telephone system.

Peak Monday to Friday end hour
The Peak Monday to Friday end hour is the hour that ends the peak hour period. Regular rates apply during
peak hours, fromMonday to Friday.

Peak Monday to Friday start hour
The Peak Monday to Friday start hour is the hour that starts the peak hour period. Regular rates apply during
peak hours, fromMonday to Friday.

Percentage markup/discount
The percentagemarkup/discount is a percentile increase or decrease applied to the entire cost of a call.

Pooling principle
The pooling principle refers to the increased contact center efficiency gained by consolidating contact center
resources.
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Port
A port is a communications endpoint in Contact Center Solutions used to link services.

Probability of delay
The probability of delay is a statistic that measures the likelihood of a call being delayed in the ACD queue,
comparing the number of agents/extensions to the level of traffic carried by the trunks.

PSTN
See Public Switched Telephone Network.

Public Switched Telephone Network (PSTN)
The Public Switched Telephone Network is a global collection of Central Offices (CO) interconnected by long
distance telephone switching systems.

Reason Code
Reason codes are descriptive classifiers applied toMake Busy and DoNot Disturb agent states to provide
more detailed information as to why the agent applied the code.

Reporting number
A reporting number is the unique number assigned by the system to contact center resources for reporting
purposes.

Site
A site is a physical location of a contact center with one or moremedia servers. It may be the same location
where the Enterprise Server is installed or a branch office.

Spectrum
Spectrum is a reporting feature configured for queues that provides a frequency distribution of calls
abandoned, answered, or interflowed based on a defined time scale.

SQL
SQL is a standard query language used to enter, query, and change data in a database, as well as create and
administer databases. Administration of YourSite Explorer is done usingMicrosoft's SQL Server.

Subscriber
A subscriber is a client or customer outside of a company to whom the organization provides a communication
product or service, such as a student in a dormitory or a tenant in a rooming house.

Subsequent increment interval
Subsequent increment interval is the segment of a call that occurs after the first call interval to which the
subsequent increment cost is applied.

Surcharge amount
The surcharge amount is an additional amount charged to subscribers on a daily, weekly, monthly, yearly, or
one time basis.

Surcharge per call
The surcharge per call is an additional charge applied to calls regardless of their duration.
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Talk time
Talk time is themeasure of the time an employee spends talking to callers, excluding time spent on hold.

TCP/IP
TCP/IP is the basic communication protocol of the Internet and is used as a communication protocol in private
networks (intranets).

Telephone system
A telephone system is a private branch exchange (PBX) or business telephone switch used to process
incoming and outgoing calls to a contact center.

Time slot
A time slot is the days and hours that a rate for a call is active. Charge bands are composed of multiple time
slots.

Toll fraud
Toll fraud is themisuse of a telephone system, either from improper calling or from carriers over-charging. In
Call Accounting, toll fraud is user-defined andmay include specific digit patterns, internal calls, or calls that
cost more than a set rate.

Trunk
A trunk is a communication line between two telephone systems.

Trunk load
Trunk load is the duration of time from when a trunk receives a call to when the employee finishes handling the
call and disconnects. Trunk load does not includeWrap Up Time.

Unavailable
Unavailable is an agent and employee state real-time column in Contact Center Client that includes agents
unavailable to take calls due to being in DoNot Disturb, Make Busy, Work Timer, Reseize Timer, or
Unknown.

Updated Position in Queue (UPiQ)
Updated Position in Queue (UPiQ) is a notification feature that provides messages to callers informing them
of their position in queue and keeps them informed of their position if it changes, at preset intervals.

UPiQ
SeeUpdated Position in Queue.

Verified Account Codes
Verified Account Codes are numbers entered beforemaking a call to change the Class of Service or Class of
Restriction at the station. When the call ends, the station returns to normal. Verified Account Codes can be
tracked with SMDR for long-distance billing purposes andmay be reported in Internal SMDR logs.
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Mitel 5000/Axxess terminology compared
Table 18 - 1 compares Mitel Contact Center Solutions and telephone system terminology and the
correspondingMitel 5000/Axxess telephone system terminology and details any critical need-to-know
differences between the terms.

Mitel term 5000/Axxess
term Definition / Differences

Media Server
Media Servers are themeans by which the
customer communicates with you (for example,
anMitel 5000 or Axxess telephone system).

Queue Hunt group
5000/Axxess hunt groups are referred to as
queues when discussing routing and call
treatment options.

Agent Group Hunt group
5000/Axxess hunt groups are referred to as
agent groups when discussingmembership
roles.

Extension Endpoint (5000)
Station (Axxess)

5000/Axxess endpoints will be referred to as
extensions, except when discussing
5000/Axxess telephone system programming.

Presence Log in

Presence is a new Mitel term for when agents
log in to specific queues. Previously, agents
were logged in to all queues that they were
associated with. Presence enables agents to
control the queues they are present in.

Interflow Overflow

TheMitel concept of interflow is the path along
which a call is directed. The interflow time is the
time before the system removes the call from
the queue and redirects it to another answering
point. The interflow timer runs independently of
the Overflow timer.

Table 18 - 1 Mitel and 5000/Axxess terminology compared
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Mitel term 5000/Axxess
term Definition / Differences

Overflow N/A

While the 5000/Axxess telephone systems
have a concept of overflow, the 5000/Axxess
use of the term overflow is actually what Mitel
refers to as interflow (see above for a definition).
TheMitel concept of overflow is themechanism
that limits the delay faced by callers by queuing
calls against two or more agent groups. An ACD
call that cannot be answered immediately is
placed in an ACD queue. If the call is not
answered after a set amount of time (the
overflow time), it is placed in the ACD queue of
another agent group, in addition to keeping its
place in the first queue. The first available agent
in either group handles the call.

Recorded
Announcement Device
(RAD)

Call Routing
Announcement

A Recorded Announcement Device (RAD) is a
system that provides prerecordedmessages to
callers waiting in the ACD queue.

Reporting Number N/A

The reporting number is the number assigned to
contact center resources, such as trunks,
devices, and ACD queues, for reporting
purposes.

Dialable Number Endpoint (5000)
Station (Axxess)

The dialable number is the digit or series of
digits a caller dials to reach an agent at an
extension, an ACD queue, voicemail, or some
other answering point.

Make Busy DoNot Disturb (DND)

Make Busy is an agent state in which the agent
removes himself/herself from the ACD queue.
While in Make Busy, the agent does not receive
any ACD queue calls, but can receive calls
dialled directly to their extension.

Do Not Disturb (DND) DoNot Disturb (DND)

DoNot Disturb (DND) is an agent state in which
the agent disables their extension to prevent any
calls from being routed there. 5000/Axxess
concept of DoNot Disturb is more aligned with
Mitel’s concept of Make Busy, where an agent
removes himself/herself from the ACD queue,
but can still receive calls dialled directly to their
extension.
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Mitel/Contact Center Solutions and Call
Accounting terminology and concepts compared
Table 18 - 2 compares Mitel telephony system concepts and terminology to Contact Center Solutions and Call
Accounting concepts and terminology and details any critical need-to-know differences between the terms.
For more information on specific terms, see "Call Accounting terms and definitions" on page 281.

Contact Center
Solutions and
Call Accounting

Term

Mitel Term Definition / Differences

Agent group Agent skill group Agent group/Agent skill group is a group of
agents who handle calls from ACD paths.

Classification codes --

Contact Center Solutions and Call Accounting
treats classification codes as a type of Account
Code, which are used to categorize calls for
reporting.

Mitel does not use classification codes.

Employee / Agent Agent

For Contact Center Solutions and Call Account-
ing, employees correlate to a person who works
for your organization and requires a license for
access to Contact Center Solutions and Call
Accounting applications and to have their asso-
ciated devices reported on. Mitel only rec-
ognizes agents, who have agent IDs and are
associated with agent skill groups, which enable
them to receive ACD calls from associated
queues, be seen in real-time, and be reported
on.

Extension groups --
Extension groups are a Contact Center Solu-
tions and Call Accounting feature that has no
Mitel terminology equivalent.

Media server PBX / Telephone System

A telephone system is a private branch
exchange (PBX) or business telephone switch
used to process incoming and outgoing calls to
a contact center. A media server is a server or
system, such as a telephone system, used to
organize and distribute communications (phone
calls, email, etc.) throughout a contact center.

Table 18 - 2 Mitel/Contact Center Solutions and Call Accounting terminology compared
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Contact Center
Solutions and
Call Accounting

Term

Mitel Term Definition / Differences

Queue Path

A queue/path is an ACD tool that delays calls
rather than blocking them from entering the sys-
tem, holding them until an available agent can
handle them.

Queue groups --
Queue groups are queues grouped primarily for
reporting purposes. Contact Center Solutions
feature that has noMitel terminology equivalent.

-- Ring groups
Ring groups are an unsupportedMitel feature
that provides the ability to ring all members of a
group simultaneously or sequentially.

Work timer Work timer

Work timer is a feature that places an agent into
an unavailable state after completing a call to
provide them with time to complete after call
tasks before becoming available to handlemore
ACD calls. Mitel work timer is a feature on the
controller, while prairieFyre work timer is a soft-
ware feature.
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